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This legal document constitutes the complete agreement between you, the end user (either an 
individual or a single entity) and Odeon A/S. All rights not expressly granted in this License 
Agreement are reserved by Odeon A/S. 
 
The right to use the ODEON software is provided only on the condition that the user agrees to the 
following License Agreement. 

COPYRIGHT/PROPRIETARY PROTECTION 
The ODEON software, auxiliary applications, and documentation are owned by Odeon A/S and 
are protected by copyright laws and international copyright treaties, as well as other intellectual 
property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 
 
You shall be held legally responsible for any copyright infringement that is caused or encouraged 
by your failure to abide by the terms of this Agreement. 

OWNERSHIP OF ODEON 
Odeon A/S retains sole title and ownership of the ODEON software, regardless of the form or 
media in or on which the original and other copies may exist. As the licensee, you own the magnetic 
or other physical media on which the ODEON program is subsequently recorded or fixed. This 
Agreement is not a sale of the original ODEON software or any copy thereof. All rights are reserved 
by Odeon A/S. 

GRANT OF LICENSE 
In consideration of payment of the License fee, Odeon A/S grants each customer (a private person 
or a company registered in a country) a non-exclusive right to use the ODEON software. This 
Agreement grants you the right to make copies of the software for archival purposes, and to copy 
the software on the hard disk of your computer. The software may be loaded onto multiple 
computers, but can only be fully operational on a single computer at any given time. The computer 
operating the ODEON software needs to have the hardware key, which is delivered with the 
software, attached to the USB port. 

HARDWARE KEY 
A license for using the ODEON software is granted via a hardware key. The hardware key holds 
the license information and determines the version and edition of the ODEON software that can 
run when the hardware key is attached to the computer. If a hardware key is defective during the 
warranty period (first licensed year), Odeon A/S will replace the hardware key. The customer will 
pay the hardware key fee for replacing the hardware key should it become defective after the 
warranty period. The hardware key contains the name and country of the licensee which are 
displayed in the software, on print outs from the software and on graphics exchanged from the 
software. The ODEON Combined Demo version of ODEON has limited functionality and runs 
without a dongle. 

LICENSE RESTRICTIONS 
Modification, adaptation, translation, reverse engineering, de-compiling, disassembling, attempts 
to discover the source code of the software, or the creation of derivative work based on ODEON 
software are strictly prohibited. 
 

END USER LICENSE AGREEMENT 
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In no way may you transfer, assign, rent sublicenses, lease, sell, or otherwise dispose of any portion 
of the software on a temporary or permanent basis. 

TRANSFER RESTRICTIONS 
The ODEON software is licensed only to the licensee. In no way may you transfer, assign, rent 
sublicenses, lease, sell, or otherwise transfer any portion of the license on a temporary or permanent 
basis (this includes transfer between branches of international companies that are registered in 
different countries). The license may only be transferred to anyone if Odeon A/S accepts (e.g. in the 
case of merging two companies) and with the prior written consent of Odeon A/S. Any authorized 
transfer of the ODEON software shall be bound by the terms and conditions of this Agreement. 

TERMINATION 
This license is effective until termination. This license will terminate automatically without notice 
from ODEON A/S if you fail to comply with any provision of this Agreement. 
 
Upon termination, you shall destroy the written materials and all copies of the ODEON software, 
including archival copies, if any. 

NO LIABILITY FOR DAMAGES 
Neither Odeon A/S nor anyone else who has been involved in the creation, production, distribution 
or delivery of this program shall be liable for any direct, indirect, consequential, or incidental 
damages (including, without limitation, damages for loss of profits, business interruption, loss of 
information, incorrect results, recovery of data, or other pecuniary loss) resulting from any defect 
in the software, update version, or its documentation, or arising out of the use, the results of use, 
or inability to use the product, even if ODEON has been advised of the possibility of such damage 
or claim. 

LIMITED WARRANTY 
Odeon A/S makes no warranty or representation, either expressed or implied, including, but not 
limited to, implied warranties or merchantability and fitness for a particular purpose, with respect 
to this product. As a result, this software is sold "as is" and you the licensee are assuming the entire 
risk as to its quality and performance. No Odeon A/S Distributor, agent, or employee is authorized 
to make any modification, extension or addition that will increase the scope of this warranty. 

UPDATE POLICY 
Odeon A/S may create, from time to time, updated versions of the ODEON software. Odeon A/S 
reserves the right to make changes to the software or its documentation without notice. Major 
updates e.g. from ODEON 16 to ODEON 17 will be made available to registered users who have a 
valid Maintenance and Support Agreement or who purchase an upgrade. Minor service updates 
e.g. from version 16.0 to 16.01 or 16.1 may be made available for download and may also be used 
by the licensee without a valid Maintenance and Support Agreement if the hardware key permits 
running the update. 

USE OF ANECHOIC ORCHESTRA RECORDINGS DELIVERED WITH 
THE SOFTWARE 
The ODEON Auditorium and Combined versions (excluding the demo version) install with a 
number of anechoic recordings that may be used with the ODEON software without restrictions.  
Two separate installation packages, OdeonWavePack_I and OdeonWavePack_II, are available on 
the installation USB stick. These WavePacks install anechoic recordings of orchestra pieces along 
with room examples demonstrating the recordings. 
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For the orchestra recordings in OdeonWavePack_I special restrictions apply: 

• Customer acknowledges that the anechoic recordings are the sole property of TKK, 
Helsinki University of Technology. 

• Customer acknowledges the right to use the recordings for internal use only and the right 
to make one copy for archival and backup purposes. 

• Customer agrees not to modify or remove, and not to tamper with or disable any 
automated display, performance, or execution of, any credits, references or notices, 
without the prior written consent of TKK, Helsinki University of Technology. 

• Customer agrees not to copy, modify, adapt, combine, publish, rent, lease, sell, distribute 
the recordings or sublicense or otherwise transfer the sublicense. 

• If the anechoic recordings are used in the Customer's work in such a way that an ordinary, 
reasonable user familiar with the recordings would be likely to recognize it, Customer 
agrees to include the following notice in the resulting work: "Derived from anechoic 
symphony orchestra recordings by Jukka Pätynen and Tapio Lokki, Helsinki University of 
Technology and licensed from Odeon A/S". 

 
For the orchestra recordings in OdeonWavePack_II the following restrictions apply: 

• Customer acknowledges that the anechoic recordings are the sole property of Odeon A/S, 
Denmark. 

• Customer acknowledges the right to use the recordings for internal use only and the right 
to make one copy for archival and backup purposes. 

• Customer agrees not to modify or remove, and not to tamper with or disable any 
automated display, performance, or execution of, any credits, references or notices, 
without the prior written consent of Odeon A/S. 

• Customer agrees not to copy, modify, adapt, combine, publish, rent, lease, sell, distribute 
the recordings or sublicense or otherwise transfer the sublicense. 

• If the anechoic recordings are used in the Customer's work in such a way that an ordinary, 
reasonable user familiar with the recordings would be likely to recognize it, Customer 
agrees to include the following notice in the resulting work: "Derived from anechoic 
symphony orchestra recordings at the Technical University of Denmark and licensed from 
Odeon A/S". 

Additional anechoic recordings are available from the ODEON homepage at: 
https://odeon.dk/downloads/anechoic-recordings/ 
 

GENERAL 
This Agreement constitutes the entire agreement between you and Odeon A/S concerning the 
ODEON product. If any provision of this Agreement shall be declared void or unenforceable, the 
validity of this Agreement and all other provision shall not be affected. ODEON product support 
and service is only provided to registered ODEON users with a valid support agreement.  
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Thank you for using ODEON, the Room Acoustic Software package that helps you to make 
complete studies of room acoustics for any large space through simulations and measurements! 
We hope you will enjoy working with ODEON and that you will find it extremely useful in the 
acoustical design of new spaces and improvement of existing ones. ODEON has a very user-
friendly interface, which allows setting up a project very fast, and to create elegant presentation of 
results. 
 
This manual is intended to serve as an introduction on modelling room geometries in the ODEON 
software, on the features for measurements and simulations, and on the applied calculation 
principles. It will not cover all features included in the ODEON software in detail; explanations of 
displays, calculation parameters, results, etc. are available as context sensitive help from within the 
ODEON application (shortcut F1). It is recommended to use the context sensitive help to learn about 
the specific features available from the different displays, the interpretation of results, calculation 
parameters, etc.  
 

 A large number of comprehensive tutorial videos are also available from our home page – they 
can be accessed directly from within ODEON using the Shift+Ctrl+F1 shortcut or by clicking the 
Video tutorial icon in the ODEON toolbar.  
 
The contents of this manual are as follows: 
 
Chapter 1 covers installation of the program, changes from previous versions, etc. 
 
Chapter 2 covers geometry modelling, with important tips on how to make models for acoustical 
simulations. It also covers how to import geometry from 3D modelling software, and how to use 
the 3D modelling tools in ODEON.  
 
Chapter 3 describes types of sources and receivers, how to extend the library of source directivity 
patterns available for point sources, and the use of directivity patterns in the Common 
Loudspeaker Format (CLF). 
 
Chapter 4 deals with the acoustic materials to assign to the surfaces of rooms; absorption, scattering 
and transparency coefficients, as well as transmission data. Special materials that may speed up 
the modelling process, and how to manage the material library, are also covered in this chapter. 
 
Chapter 5 deals with different calculation options and associated results in the four editions of 
ODEON. 
 
Chapter 6 describes how to work with Colour Grids. 
 
Chapter 7 deals with the auralisation options in ODEON Auditorium and Combined; the hardware 
needed for auralisation, how to publish calculated sound examples, etc.  
 
Chapter 8 describes important calculated room acoustic parameters available in ODEON, how they 
are calculated, and how to interpret results. 
 

Introduction 
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Chapter 9 introduces the calculation principles used in ODEON, giving an idea on the capabilities 
and limitations of the simulations performed by the ODEON software. 
 
Chapter 10 describes the various calculation parameters available in the program. Most of the 
parameters are automatically set to reasonable values by ODEON; However, for special cases you 
may need to adjust some of the calculation parameters. 
 
Chapter 11 discusses quality of results and how to achieve good results. This chapter may be 
relevant once familiar with the program. 
 
Chapter 12 presents the integrated impulse response measuring system in ODEON. The chapter 
explains which measuring methods are used, how to obtain a healthy impulse response and how 
to obtain room acoustic parameters as the results. The chapter ends with an annex giving 
examples of good and bad impulse responses. 
 
Chapter 13 describes how to use ODEON’s Genetic Material Optimizer for calibrating a room model 
towards a real room. The Genetic Material Optimizer makes use of genetic algorithms in order to calibrate 
the materials (absorption coefficients) in the simulation model for good agreement between 
simulated and measured room acoustics parameters. 
 
Chapter 14 introduces the line array sources discussing some basic principles behind array source 
design. 
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To work with ODEON you need both an installation of the program on your PC, as well as a 
hardware key dongle (Rockey 6 Smart – R6 Smart). After purchasing ODEON, you receive the 
dongle with time limitation. Once full payment is completed, an update file is sent by Odeon A/S 
that removes the time limitation. The update file needs to be installed by you on the dongle.   

1.1 Installing and running the program 
To run ODEON, your PC must be running one of the operating systems supported: 
• 32 bit/64 bit Windows 10. 
• 32 bit/64 bit Windows 8. 
• 32 bit/64 bit Windows 7. 
• 32 bit/64 bit Windows Vista. 
 
ODEON comes in a USB drive containing the edition of ODEON that was purchased (Basics, 
Industrial, Auditorium or Combined). As an alternative, you may download the most recent updated 
version, including service updates that were developed since the production of the USB, from 
https://odeon.dk/downloads/odeon-installations-updates/. To install the program: 
 
a) Double-click on the file with the name of the edition you wish to install, e.g. 

InstallOdeon14Combined.exe to install the program. 
b) To run the program, the supplied hardware key dongle (Rockey 6 Smart – R6 Smart) must be 

inserted into the USB port on the PC. If you start the program without the hardware key, it 
can only be used in viewer mode. 

c) When you have installed the ODEON software, it will automatically check for updates. If there 
are updates available, ODEON will update your installation if you accept. 

d) Initially, the dongle ships with a time limitation. Once full payment is completed, send a 
request to sales@odeon.dk to remove the time limitation. You will receive an update file that 
needs to be installed on the dongle by choosing Tools>Download license update to dongle (.cif). 

1.2 Upgrading from previous versions 
If you are upgrading from previous versions of ODEON, read below to learn about the changes in 
ODEON. Below is a list of issues which you should be aware of when upgrading from previous 
versions. 

Upgrading to version 16 
ODEON version 16 runs on Windows 10 (32/64 bit editions) – ODEON 16 may be able to run on 
Windows Vista and Windows 8, but has not been tested on these operating systems which are 
unsafe and no longer maintained and supported by Microsoft. ODEON 16 is a major upgrade, 
please see sec. 1.3. Though ODEON 16 is capable of loading and converting older projects into 
version 16 format (forward compatibility), an older version of ODEON may not load a room once 
it has been loaded into ODEON 16. ODEON 16 includes a large number of enhancements – for a 
fairly complete list see sec. 1.3 or open the help file from within the ODEON software (press F1 
from within ODEON, then click the What’s new in ODEON 16 entry in the contents-menu). 

 ODEON Installations 

mailto:sales@odeon.dk
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Major upgrade  
If performing a major upgrade, typically a full version number or more, e.g. from version 15 to 
version 16, then ODEON will install to a new directory for that version without changing the 
existing installation. If you have no wishes to use the old version of ODEON then it is 
recommended to uninstall the version(s) using the Windows Start|Control Panel|Add/remove 
programs feature. 

If you have been using version 7 or earlier 
If you are used to versions earlier than version 8, it is essential to learn about the new methods for 
handling of scattering. Chapter 4 covers the material properties to assign to surfaces; Chapter 9 
covers the calculation principles including handling of scattering and Chapter 10 covers the choice 
of calculation parameters. 
 
If you are having problems loading a room, which was created and worked fine in an old version 
of ODEON, this is probably due to a change that has been made to the surface numbering 
mechanism applied in ODEON. The numbering mechanism has been changed slightly in order to 
avoid a conflict which appeared when using ‘symmetric surfaces’, along with modelling entities 
such as CountSurf, Box, Cylinder etc. and in particular to make the automatic surface numbering 
work without any problems (when the NumbOffSet is set to Auto). 
 
If having problems loading a room due to the reasons just mentioned, ODEON will either give an 
error message that surfaces are repeated in the geometry file or that materials are not applied to all 
surfaces. In these cases you may wish that ODEON uses the old numbering mechanism – this can 
be done using the Version4 .par file. At the first line in the geometry file, just after the ### sign, type: 
flag in the Version4 TRUE. 
 
Once the old incompatible code ends, Version4 may be set to FALSE again. 

If you have been using a version 6 and earlier  
If you are used to a version earlier than 6 then we do recommend that you read carefully through 
the manual as if you are a newcomer to ODEON. There are substantial differences between the 
early versions of ODEON and the ODEON software as it is today – modelling has been made easier, 
calculation principles have been enhanced and a huge number of new features has been added. 

Project files from very old versions of ODEON 
The only project file from Odeon versions earlier than 3.0, being fully compatible, is the surface file 
(.sur). The rest of the project files are no longer valid. And even though the .sur format is still valid, 
it is not recommended to model rooms in this format. The .par format is a much more efficient 
format. 
 
  

Remember: If keeping an earlier version, be careful not to mix the use of old and new versions – 
although we do strive to maintain forward compatibility, we cannot guarantee that a room which has 
been loaded into a newer version of ODEON will also load into an older version without problems. 
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1.3 What’s new in ODEON 16 
The new version of ODEON is packed with attractive features and enhancements, listed below. 
The headings will specify what editions of ODEON: (B) Basics, (I) Industrial, (A) Auditorium and 
(C) Combined, the feature is available in. If not specified, then it is available for all editions. 
 

 

Improved Reflectogram and 3D reflection-paths / Active-sources 
display (A)(C) 
The Reflectogram in the Single Point Response display has been greatly improved. It is possible to have 
the selected reflection or all the zoomed reflections displayed in 3D next to the Reflectogram, the 3D 
display is automatically updated when zooming or scrolling the Reflectogram graph to reflect the 
reflection currently visible. The reflection(s) can be coloured according to time of arrival or to 
reflection order. The colour scale can be selected by the user to be Auto, Music, Speech or Studio.  
 

 
 
 

Improved Decay Curve – intensity hedgehogs (A)(C) 

The Decay curve tabsheet of the Single Point Response has been enhanced to display direction of arrival 
of intensity components, 3D hedgehog graphs and allow tracing intensity components in the 3D 

View. The Decay curve for the selected band in the Single Point Response can be displayed next to the 3D 

View. This allows watching the direction of intensity peaks/slices inside the room model. It is 
possible to scroll through the peaks /slices in the intensity curve and see where each individual 
peak/slice comes from or to show a complete hedgehog for the intensity curve. When the curve is 
zoomed, the 3D display shows the corresponding part of the hedgehog. This is an invaluable tool 
for tracking down e.g. late echoes which cannot be identified in the Reflectogram.   

Remember: The ODEON software is only forward compatible. This means that you may load a room 
that has been created in ODEON 15 (or earlier versions down to ODEON 3.0) into ODEON 16. The 
opposite is not always the case. Once a room has been loaded into ODEON 16, there might be issues 
loading it into earlier versions. ODEON 16 will issue a warning before loading a room created in an 
earlier version - allowing you to make a backup copy for use in an older version of ODEON.   
 

mk:@MSITStore:C:%5CProgram%20Files%20(x86)%5COdeon16Combined%5COdeonHelp.chm::/html/idh_pointresponse.htm
mk:@MSITStore:C:%5CProgram%20Files%20(x86)%5COdeon16Combined%5COdeonHelp.chm::/html/idh_pointresponse.htm
mk:@MSITStore:C:%5CProgram%20Files%20(x86)%5COdeon16Combined%5COdeonHelp.chm::/html/idh_pointresponse.htm
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Improved sweep-measurement tool  
The Measure Impulse Response tool has been greatly enhanced. A sweep spectrum correction can be 
applied in order to obtain similar decay ranges in all active octave bands. If a measurement has 
obtained poor decay range in some octaves, then ODEON can calculate corrections to the sweep 
based on that measurement. The result is a sweep where less measurement time is spent on the 
octaves with high decay range and more time is spent on the octaves where poor decay range was 
obtained.  
The improved tool also allows up to 1st order ambisonic measurements (4-channels), which is fully 
compatible with the improved load impulse response tool (described below).   
 

 
 

mk:@MSITStore:C:%5CProgram%20Files%20(x86)%5COdeon16Combined%5COdeonHelp.chm::/html/idh_MeasureImpulseResponse.htm
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Support of ambisonic measurements (A)(C) 
The Measured Impulse Response tool can now recognize the 4 channels measured with an ambisonic 
microphone and visualize the intensity components of an impulse response. The four channels 
appear as W (omni) and X, Y, Z.  
 

  
 

Play it! An improved tool for auralisation of measurements(A)(C) 
The Play it! tool (in the last Tabsheet of the Measured Impulse Response) makes it possible to listen to the 
measured impulse response as well as to listen to a signal convolved with the same impulse 
response. This makes it possible to hear how the room measured sounds at the given measurement 
position with the given source(s). ODEON applies a new frequency dependent noise removal 
algorithm which removes the noise floor individually for each octave band of the impulse response, 
rather than just at what appears to be the broad band noise floor. This results in a much cleaner 
impulse response for auralisation. 
Virtual Dummy head! When viewing a measured (or simulated) 1st order B-Format impulse 
response, ODEON decodes the 4 channel B-format file into a binaural impulse response allowing 
play back of the impulse response over headphones as well as binaural playback of a signal 
convolved with this binaural impulse response. It is possible to transform the impulse response so 
one can listen to the impulse response coming from any direction e.g. from front, 45o left front or 
from 90o degrees left side. Echo problems are more audible when hearing them from the side rather 
than from in front. So being able to change listener orientation, can be valuable when listening to 
binaural playback.  
 
 

Material Archive in the Materials List 
A Material Archive functionality has been added to the Materials List. This allows to restore previous 
material configurations (without losing the current one). ODEON keeps a list of the last 10 material 
configurations ordered by date and with an optional description (such as "ceiling absorber and 
extra absorption on side wall"). The description(s) can be entered in the yellow field in the material 
list or in the Material archive display. 

mk:@MSITStore:C:%5CProgram%20Files%20(x86)%5COdeon16Combined%5COdeonHelp.chm::/html/idh_LoadImpulseResponse.htm
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Source Macro 
The Source macro in the Source-receiver list has been improved making it possible to align source 
positions relative to surfaces (e.g. to position musicians 1.2 metres above the floor) and making it 
possible to orient sources relative to a receiver (e.g. to make all musicians look at the conductor). 
 

 
 

file://OdeonNAS_DS216/development/OdeonHelp2020/htmlhelp/html/idh_sourcemacro.htm


15 
 

Source/Receiver align tool  
A new align tool allows aligning a source or a receiver relative to another source or receiver e.g. 
putting a receiver 2 metres from the source at an angle of 45o. 
 

 
 

List of Enhancements 

Improved CAD import 
The renovated interface has better support for AutoCAD drawings, accepting a large variety of 
CAD file formats. 

• AutoCAD own DWG format is supported directly, so no need to ask for the models to be 
exported to the DXF format, although ODEON supports that as well. At the same time, we have 
added a much higher support for the CAD entities that can be included in an AutoCAD file - 
BLOCKS, REGIONS, 3DSOLID, surfaces defined from POLYLINE etc. are directly supported 
by ODEON - press OK and off you go! 

• Geometry formats supported by ODEON 16 are; 3ds, .stl, .obj .step, .iges, .ply. 

Improved methods for headphone calibration (A)(C)  
With the installation also come measured headphone responses for the following inexpensive 
headphones allowing compensation for their frequency response:  AKGK72, AKGK240studio, 
Behringer HPS3000, Roland RH5 and Shure SRH240A. These responses have been averaged over 
a number of repeated measurements with repositioning of headphones for optimum 
compensation. 

Enhanced 3D Billiard (I)(A)(C) 
The enhanced 3D Billiard supports visualization of absorption in 3D. 

Support for drawing layers in the 3DEdit source displays 
The feature allows some parts of geometry to be removed from printouts and graphics exchange 
and while editing source positions. 
 

Support for editing and defining new sources/receivers 
It is possible to edit a source/receiver by clicking directly in the 3DEditSource display. Use CTRL+ 
RMB to open the context-sensitive menu and create a source or receiver 
 

file://OdeonNAS_DS216/development/OdeonHelp2020/htmlhelp/html/idh_aligntool.htm
file://OdeonNAS_DS216/development/OdeonHelp2020/htmlhelp/html/idh_headphonedisplay.htm
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Ruler functionality in the 3DView 
The tool can be used for indication of distance between points, and especially between corner 
points in the geometry. 
 

Ruler functionality implemented in the 3D Edit Source Receiver view 
For indication of distance between sources and receivers. The tool makes it easy to see the distance 
between source and receiver, source and source or receiver and receiver. 
 

Strength (G) parameter, according to ISO3382-1 
The G parameter used to be expressed as SPL under certain conditions, which has proven to be 
confusing when looking at results. Since ODEON 16 it is explicitly included as a room acoustic 
parameter in the Room Acoustics Parameter List. The G parameter is calculated in simulations if there is 
only one active source in the job of interest and that source is Omni directional (if the directivity file 
assigned is contains the word omni). The source power assigned to the source is not important -
ODEON will automatically normalize the results of the G-calculations to 31 dB source power per 
octave, as required by ISO3381-1. This means that it is possible to calculate e.g. absolute SPL values 
in a Job simultaneously with G and that the G parameter will be listed by its correct name. If the 
requirements for the G calculation are not meet then the results for G will be empty. 
 

New parameters: Gearly and Glate  
Gearly is the energy of G that arrives within 80 ms after the direct sound. Glate is the energy of G that 
arrives later than 80 ms after the direct sound.  
In addition, in ODEON Industrial and Combined, a Late Lateral G parameter (Lj ) is defined.  
 

ISO 3382-3 parameters 
To avoid confusion, parameters according to ISO 3382-3 (Open plan offices) are only calculated 
and displayed as part of the Multipoint response results if the following conditions are met: 
• ISO3382-3_OMNI.SO8 directivity has been assigned to the active source. 
• There is only one source active. 
 
 
 
 

file://OdeonNAS_DS216/development/OdeonHelp2020/htmlhelp/html/idh_3dview.htm
file://OdeonNAS_DS216/development/OdeonHelp2020/htmlhelp/html/idh_3deditsourcereceiver.htm
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ISO 14257 parameters 
To avoid confusion, parameters according to ISO 14257 (work rooms) are only and displayed as 
part of the Multipoint response results if the following conditions are met: 
• ISO3382-3_OMNI.SO8 directivity has been assigned to the active source. 
• There is only one source active. 
 

Background noise level in 3DGrid 
In the 3DGrid it is possible to transfer the estimated average SPL of the currently displayed grid to 
the Background noise level in the Room Setup. This is useful when a realistic background noise level 
needs to be defined in order to estimate speech intelligibility (STI). To do so, a job has to be defined 
with the appropriate active noise sources in order to estimate the SPL as the background noise. 
When the grid has been calculated open the 3DGrid, select the Fractiles tabsheet and press the S 
shortcut. 
 
 

1.4 Features of previous versions 
 
Below we have gathered the most important information of improvements in the previous ODEON 
versions. Please read more online at https://odeon.dk/product/whats-new/previous-versions. 

Features introduced with version 15 
In ODEON 15 an improved 3D Grid interface made it possible to define vertical grids, individual 
receiver heights for different surfaces and groups of grid surfaces (e.g. floor, 1. balcony, 2. balcony 
etc.). Parallel processing was applied in more places allowing faster multi source calculations, as 
well as multi source auralisation. STIPA and MTI parameters were added as well. In addition, a 
statistical tool for measurements was introduced to display statistics between multiple-loaded 
impulse response files. Regarding auralisation, a user-friendly interface for deriving inverse filters 
for headphones was added. Using this, the actual frequency response of a headphone pair is 
neutralized (flattened), so that colouration during auralisation becomes minimal. You can read 
more about the features added in ODEON 15 at https://odeon.dk/product/whats-new/previous-
versions/odeon-15-features/. 
 

Features introduced with version 14 
In ODEON 14 an improved 3D Grid interface made it possible to define vertical grids, individual 
receiver heights for different surfaces and groups of grid surfaces (e.g. floor, 1. balcony, 2. balcony 
etc.). Parallel processing was applied in more places allowing faster multi source calculations, as 
well as multi source auralisation. STIPA and MTI parameters were added as well. In addition, a 
statistical tool for measurements was introduced to display statistics between multiple-loaded 
impulse response files. Regarding auralisation, a user-friendly interface for deriving inverse filters 
for headphones was added. Using this, the actual frequency response of a headphone pair is 
neutralized (flattened), so that colouration during auralisation becomes minimal. You can read 
more about the features added in ODEON 14 at https://odeon.dk/product/whats-new/previous-
versions/odeon-14-features/. 
 

Features introduced with version 13 
In ODEON 13 an improved interface was implemtented for the Materials list, the Source-receiver list, the 
Job list, etc. They have all been equipped with sorting functions, better colour display and easier 

https://odeon.dk/product/whats-new/previous-versions
https://odeon.dk/product/whats-new/previous-versions/odeon-15-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-15-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-14-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-14-features/
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editing properties, such as multi-delete, copy-paste, etc. Another important tool was the Genetic 
Material Optimizer, an extension of the measuring system introduced in version 12. With this tool, 
the materials in a room model can be automatically adjusted in order to achieve better agreement 
between simulated parameters in the model and measured parameters in the real room. This makes 
it possible to “tune” or “calibrate” a model before starting the acoustic refurbishment. You can read 
more about the features added in ODEON 13 at https://odeon.dk/product/whats-new/previous-
versions/odeon-13-features/. 
 

Features introduced with version 12 
In version 12, simulations and measurements were brought together. A room impulse response 
measuring system was introduced, allowing the capture of impulse responses supported by a 
loudspeaker, a microphone and a laptop PC. The tool is available in all editions (from Basics to 
Combined) and offers easy-to-use simulations and measurements inside the same software 
package. Moreover, ODEON 12 was equipped with full support for ISO 3382-3 – Open Plan Offices, 
tools for grouping receivers in the multi-point response, two types of radiation in line and surface 
sources, calculation of the IACC parameter (Inter Aural Cross Correlation) and many more 
enhancements. Read more about them online on https://odeon.dk/product/whats-new/previous-
versions/odeon-12-features/. 

Features introduced with version 11 
Parallel processing was introduced with ODEON 11, providing faster calculations on multicore 
computers. The parallel processing is used for multi-point and grid responses, where many 
receivers have to be calculated at a time. In addition, a Fibonacci Spiral distribution used in ray 
tracing, allows an optimal distribution of source radiation pattern. A Room acoustic parameter list 
interface allows the user to edit existing parameters and create their own ones. This is a great 
feature for improving parameters or defining new ones, especially for research purposes. Apart 
from these, an improved calculation setup, improved grid scaling, echo detection curves, dynamic 
diffusion curves and many other features were introduced. You can read more online on 
https://odeon.dk/product/whats-new/previous-versions/odeon-11-features/. 

Features introduced with version 10 
ODEON 10 becomes Unicode (and utf-8) enabled, allowing text in complex character sets to be 
saved with your projects, whether this is in the text files such as the geometry files (.par) or texts 
composed in the various comment fields in ODEON (the material library is not fully Unicode 
enabled yet). In particular, Unicode allows text in Asian character sets (Japanese, Chinese and 
Korean) to be saved from within the ODEON application. It is also possible to save text which is a 
mix of texts in different character sets. When upgrading to version 10 or later, the order of materials 
in the Material list has been revised – please see Chapter 4. Read more on the features introduced 
with version 10 on https://odeon.dk/product/whats-new/previous-versions/odeon-10-features/. 

Features introduced with version 9.1 
Starting on version 9.1, ODEON is delivered with a new type of Dongle, which makes it easier for 
the user to install new upgrades. This is more thoroughly described below in Chapter 1.5 and at  
https://odeon.dk/downloads/dongle-license. 
Version 9.1 has a far better auralisation option than the previous versions for presenting through 2 
loudspeakers, called Super stereo. With the Super stereo you can make 2 loudspeakers have a much 
more spacious sound, and with the right frequency response for this type of auralisation.  
 
Some outdated directivity files such as TlkNorm.so8 have been replaced by TlkNorm_Natural.so8 
which is smarter for auralisation use. There might be a risk of adding the overall frequency 

https://odeon.dk/product/whats-new/previous-versions/odeon-13-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-13-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-12-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-12-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-11-features/
https://odeon.dk/product/whats-new/previous-versions/odeon-10-features/
https://odeon.dk/downloads/dongle-license
https://odeon.dk/downloads/dongle-license
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response twice to auralisation output; once from the directivity pattern and once more from the 
auralisation signal which inherently includes the same source spectrum (please see Chapter 6.1 for 
further information). With the ‘_Natural’ version of the directivity files it is possible to obtain 
correct equalization of auralisation output while also achieving correct prediction of SPL. Therefore 
the ‘_Natural’ versions of the directivity files should be used when defining new sources. The old 
versions of the files are kept in \old_so8\, a subdirectory to the \Dirfiles\ directory. If you wish to 
use the old directivities in old/existing projects, then open the Source receiver list and click the 
Repair broken directivity links button (shortcut Ctrl+L).  
 

1.5 How to upgrade or update your current license 
For ODEON (versions 9.1 and later) your ODEON software license is stored in a Smart Card based 
hardware key, the Rockey 6 Smart dongle. As an ODEON user, there are the following update 
situations. Please contact sales@odeon.dk if interested, to get assistance.  
 

• Sub version update: Version number can be updated free of charge in-between the full 
versions at  https://odeon.dk. E.g. from version 14.1 to version 14.2 

• Full version update: Your version can be updated to a full version number (E.g. version 
15) by requesting a remote licence update. If you have a valid Maintenance and Support 
agreement when a new version is released, you will automatically receive a remote license 
update at no additional cost. If you do not have a valid Maintenance and Support 
agreement, an upgrade can be purchased.  

• Change edition: It is always possible to upgrade your license to a higher edition if agreed 
with the sales department. Upgrade from ODEON Basics to Industrial, Auditorium or 
Combined, or update from ODEON Industrial or Auditorium to Combined. 

• Remove time license: All new licenses are shipped with a time limitation. If your license 
has a time limitation and the payment has been fully made, this time limitation can be 
removed by requesting a remote licence update.  

• Update user name: For copy protection purposes, your user name and country are 
embedded in the dongle, but this can be changed. The user name can only be updated 
separately from the other updates.  
 

Your update or upgrade interests could be a combination of the above 4 points, which can be 
fulfilled by generating a remote request file and following the steps described below. If you have 
any questions about updates, please send an e-mail to sales@odeon.dk. 
 

Remote License Update or Upgrade is divided into four steps: 
1. Generate a license request file and send it to sales@odeon.dk (see below) 
2. You will receive a mail with the license file, when your update or upgrade has been 

generated. 
3. Download the received license file to your dongle. 
4. Update your ODEON software installation as needed from the https://odeon.dk 

homepage. 
For more info on dongle update, please visit https://odeon.dk/downloads/dongle-license. 

Generating remote request file 
A remote request file has the extension .req. To generate a Remote request file follow these steps: 
1. Attach your ODEON dongle to the USB port on the PC. 
2. Run the ODEON program. 
3. Check what your current license includes using the Tools|License information menu entry. 

mailto:sales@odeon.dk
http://www.odeon.dk/
http://www.odeon.dk/
mailto:sales@odeon.dk
mailto:sales@odeon.dk
https://odeon.dk/
https://odeon.dk/downloads/dongle-license
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4. Generate your license request file using the Tools|Generate Remote Update Request file menu 
entry - this will display the dialog shown below. 

5. Email the generated request file (e.g. User2005_Dongle102009.req) to sales@odeon.dk. 
 

 
 
Once Odeon A/S has received your request file, an invoice will be processed and sent to you. When 
the invoice has been paid, an encrypted license file will be e-mailed to you, and this file has to be 
downloaded into your dongle for the license upgrade (see below). 

Updating the dongle – downloading license file (.cif) to dongle 
1. Extract the license update file from e-mail to your hard disk e.g. to your desktop. 
2. Attach your ODEON dongle to the USB port on the PC. 
3. Run the ODEON program. 
4. Use the Tools|Download license update to dongle menu entry. 
5. Select the file using the Select license update file (.cif) dialog (e.g. select 

User2005_Dongle102009_ODEON Industrial_VXX__Restricted_0h.cif). 

Update installation 
When the update has been downloaded to your dongle, you can find and install the new version 
or edition from the webpage https://odeon.dk/downloads/odeon-installations-updates/. You may 
choose to uninstall the previous version before installation. We recommend that you keep a safety 
copy of the installation file, e.g. if you at some point want to reinstall the downloaded version. 
 
  

mailto:sales@odeon.dk
https://odeon.dk/downloads/odeon-installations-updates/
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In order to make simulations of acoustics, ODEON needs a 3D model of the geometry in question. 
This easiest way to do this is by using a 3rd party modelling software, eg. SketchUp, to draw the 
geometry and then import it to ODEON. You can also change the geometry inside ODEON, but 
this is mainly for fixes in the geometry, if the software it was made in originally is not available for 
the ODEON user.   
 
Creating new room models is probably the most time consuming task in room acoustical 
modelling. However, good modelling practice will surely reduce the time used for modelling and 
re-modelling rooms.  

2.1 Pre-calculated Rooms 
Before making any models to be used in ODEON it is good idea to have a look at the pre-calculated 
rooms in your ODEON installation. You will see how a typical acoustic model looks quite 
simplified – which in principle differs substantially from an architectural model, where all details 
matter for visual purposes. In an acoustic model, only the most important details should be 
modelled. In paragraph What to model in Chapter 2.2 you can read more about the basic rules you 
should follow. 
 

 

Round Robin rooms 
ODEON has been part of the Round Robins, where simulations where compared with 
measurements for different acoustical prediction software and methods. In the Rooms folder of 
ODEON you will find two rooms used as test objects in the 2nd and 3rd Round Robins (Bork, 2000; 
Bork, 2005). You can check for yourself how the simulation matched the measurements, see how 
below. The rooms to open in ODEON is Elmia RoundRobin2 detailed.par and PTB_Studio open curtains detailed 

model.par. The geometry, absorption data, source and receiver positions as well as the measured 
room acoustical parameters are those supplied to all participants in the Round Robins, by the PTB 
in Germany. 
 
• Open the room in question. 
• Open the JobList (Shift+Ctrl+J shortcut). 
• Select one of the pre-calculated Multi point response jobs (job one or two) in the JobList and open 

it (Alt+M shortcut). 
• Select the Measured versus simulated tab-sheet in the Multi Point Display. 
• To select different parameters in the display, use “Arrow forward” or “Arrow backward” 
• To select different octave bands, use “Arrow Up” or “Arrow down” 
• To select another receiver, use the R-shortcut or Shift+R-shortcut. 
 
 

  Modelling Rooms  

Tip: Find the pre-stored rooms in the Rooms folder in your ODEON installation. The usual path is 
C:\Odeon15<edition>\Rooms, where <edition> stands for Basics, Industrial, Auditorium or Combined. You 
can see all relevant paths used by your ODEON installation by choosing Options>Program setup in the top 
menu bar. 
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CAHRISMA project rooms 
Hagia Irene.par is a model of a Byzantine church in Istanbul. 
Like the examples above, it also includes measured 
room acoustical parameters from the actual site. The 
church was modelled as part of the CAHRISMA 
project (Conservation of the Acoustical Heritage by 
the Revival and Identification of the Sinan's Mosques 
Acoustics). Hagia Irene has an approximate volume 
of 39.000 m3 and RT of 4,3 sec at 1000 Hz. You can 
find similar rooms in the CAHRISMA project 
subfolder. These rooms need to be calculated. Open 
any of the rooms, access the JobList and press ALT+A to 
run all jobs. 
 

ERATO project rooms 
Open the Jerash_Present_Empty.par ancient theatre and 
observe the bounding box around the room. The 
bounding box is not part of the actual geometry but 
it is necessary in such a case where the room is not 
watertight by itself (there is no ceiling). The box 
encloses the geometry and allows ODEON to 
perform calculations. All sides of this dummy box 
are assigned 100% absorption in order to successfully 
model the open air. You can find more models from 
ancient theatres in the ERATO project subfolder. 
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Noise control rooms 
The example Studstrup Power Plant.par, found in 
the main Rooms folder, is a model of a turbine 
hall at a power plant. Measured SPL(A) from 
the actual site is included in this example. 
Apart from the common point sources, surface 
sources that can model the radiation of sound 
from surfaces have been used as well. This is 
due to the assumption that an engine consists 
of a group of surfaces that radiate sound as 
they vibrate. 
 
The example Transmission rooms.par, which is 
also found in the main Rooms folder includes 
some walls with transmission properties and 
it serves as a good demonstration of sound 
insulation between rooms. You can read more 
about transmission modelling with ODEON 
in Appendix B. 
 
The room Oil rig.par is an example of an offshore 
oil platform where loudspeakers have been 
installed as part of a voice alarm system. Noisy 
sources have been taken into considerations 
and they are modelled as surface sources. 
 
This room has also been analysed in the 
application note Calculation of Speech 
Transmission Index in Rooms which can be 
downloaded from the application notes page 
https://odeon.dk/learn/application-notes/. 
 

 

 
 

Public Address Systems 
The model Copenhagen Central Station Array.par is 
available in the Auditorium and Combined 
editions of ODEON. This example 
demonstrates a PA system, installed by Duran 
Audio, which utilizes 20 beam steered line 
arrays. Several measured parameters are 
available including STI. 
 

 

Tip: Some of these rooms have been set up for very accurate calculations that can take longer time. If you 
wish to carry out faster calculations, you may enter the Room setup  and select the Engineering setting. 
This will provide results approximately twice as fast without much loss in quality in results. 
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2.2 Guidelines on room modelling 
You can choose between importing your rooms from SketchUp, from another CAD program, by 
typing your rooms directly into a text file, or by using the ODEON Extrusion Modeller. Further 
below there are some considerations that are common to the different cases, but first some 
guidelines of general nature are given here. 

Default coordinate system 
To make it as easy as possible to operate ODEON, the 
following orientation of room geometries should be 
applied (using a concert hall as the example): 
• X-axis pointing towards the audience 
• Y-axis pointing to the right as seen from the 

audience 
• Z-axis pointing upwards 

Recommended size of a surface 
An important theoretical consideration concerns the size of surfaces in a room model. The classical 
laws of geometrical acoustics are such that for the purpose of calculating how much energy is 
reflected; all surfaces are considered to be infinitely large in comparison to the wavelength. For 
practical room models surfaces are not infinitely large and ODEON is, to some point, able to take 
into account the limited size of surfaces in calculations – using the Reflection Based Scattering method 
(see Chapter 7.5). 
 
Still, surfaces should be kept reasonably large. Avoid using more surfaces than needed in order to 
mimic the geometry. Modelling a lot of very small surfaces to achieve high geometrical fidelity will 
not improve quality of results, but it will increase calculation time. It is difficult to put exact limits 
on the size of surfaces which should be used; there will always be a need for small surfaces to fill 
in awkward corners of the geometry. 
 

 
 
Often you will be in a situation where a few surfaces should be kept down to 0.20 metres or even 
0.10 metres. You can just keep these surfaces if they are relatively few compared to the total number 
of surfaces. 
 

 

Curved surfaces 
All surfaces in ODEON must be (almost) planar; so curved surfaces have to be approximated by 
dividing them into plane sections. But in the ODEON material list, there is a wall type called 
fractional which will make ODEON treat a number of flat surfaces as one curved one. How finely 
to subdivide the curve depends on the type of curved surface and how important the surface is. 
 
Convex curves naturally disperse sound energy, so if the surface is in an exposed position (e.g. the 
end of a balcony near the stage), it should be avoided, for example, to replace a quarter circle with 
a single plane at 45°, as this might instead act like a reflector. 
 

Remember: A rule of thumb may be to keep surface dimensions larger than one wavelength at the mid-
frequencies. One wavelength at 1000 Hz is approximately 0.34 metres. 

Tip: It should be possible to model most concert halls with a surface count in between 100 and 2000 
surfaces. 
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Concave curves naturally focus sound energy, and since focusing is a fault we wish to model, we 
must try to arrange this so that it is preserved. However, this does not mean that a large number 
of subdivisions are the solution. Using many surfaces in the model will: 
• Make the model visually complex, and increase the probability of errors in the model, typically 

small leaks may become a problem. 
• Not comply with the image source theory used for the early reflections (point sources). See more 

about calculation principles in Chapter 9. 
• Increase the calculation time. 
 
In order to calculate focusing from concave surfaces, it is extra important that the wall type of 
surfaces forming a concave shape is set to fractional in the Materials List. If not, the concave surface 
will scatter sound too much, taking into account the small areas of the individual surfaces forming 
the concave shape - rather than the total area of the concave shape. The Reflection based scattering 
method would produce too much scattering in this case. 
 

 
 

What to model 
Some simple tricks during modelling will 
save you a lot of time, improve the 
calculation speed and offer better results, 
without losing accuracy in the acoustical 
geometry. 

How to model an audience area? 
Modelling each step between the rows in an 
audience area is not recommended. The 
audience area can be simplified a lot 
without compromising the quality of the 
results – in fact, using the suggested method 
below is likely to produce better results: 
• Model the audience areas as 'audience boxes' with a height of approximately 0.8 metres above 

the audience floor. In the figure above, the audience boxes are indicated by blue colour. 
• Assign appropriate 'absorption material' e.g. ODEON material 11001. 
• Assign a high scattering coefficient of 0.7 to the surfaces of the ‘audience box’. See in Chapter 4 

how to assign scattering coefficient on a surface. 
• Place the receivers around 0.4 metres above the modelled 'audience box’. 
An obsolete alternative solution was to model the audience just as a flat absorptive surface on the 
floor, mainly for simplifying the model for computational issues. The main problem with this 
approach was that the absorption area of the room looked smaller, as more rays were likely to hit 
a hard surface (like the isles between audience areas,) than it would be in real life. In order to 
compensate for that, the same absorptive material had to be assigned to the isles too. Nowadays, 
there is no need to follow this approach. By modelling audience as a box this has been proved to 
be a realistic and reliable assumption, without affecting the computational cost. 

Remember: Subdivisions about every 10° to 30° will probably be adequate to reproduce focusing trends 
of concave surfaces, without excessive number of surfaces, thus walls in a cylindrical room may be 
modelled with 12 to 36 surfaces. A cylindrical column which disperses energy may probably be modelled 
with, say, 6 to 8 surfaces. 
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How to model the podium on stage? 
The same guideline as for the audience area works 
here. Rather than modelling each step of the 
podium on stage, the podium can be simplified 
into a few sloped surfaces. 

Should furniture such as tables, chairs and 
shelves be included in a model of an office? 
If a tabletop is close to a source or receiver point, 
then it is likely to produce a strong specular 
reflection towards the receiver, so if this is the case 
then it should be included. However, the legs of a 
chair or table should not be modelled in detail. Furniture such as shelves and screens in large office 
environments, which subdivide the room – breaking up long reflection paths and introducing extra 
absorption and scattering, should not be omitted. Furniture at more distant locations in the room, 
which does not produce any strong early reflections to the receiver, can easily be simplified, or 
even omitted from the model. This as long as the extra absorption and scattering produced by that 
furniture is somehow included on other surfaces in the same regions of the room. 

Orientation of surfaces – does tilt of a surface have any significance on room acoustics? 
Small changes to the orientation of surfaces can indeed cause dramatic changes. Making dominant 
surfaces slightly off-angle can cause extra scattering in the room, almost as if extra scattering had 
actually been assigned to the surfaces in the room. A typical example is a box-shaped room where 
a flutter-echo can be removed, by changing the angle of a surface by just a degree or two. 
 

2.3 Files created by ODEON 
When importing a geometry, ODEON creates a group of subsequent room files, calculation files 
and result files. These should normally not be accessed outside ODEON. 

All files share the same name - the name of the room - with a different extension added. Three main 
categories of files are used: 

• Room files, which contain data entered by the user. From these files both calculation and result 
files may be re-calculated. Some of the most important extensions are .par, which describes the 
whole geometry, .PcS that lists the sources, .PcR that lists the receivers and .Mat that includes 
the materials used in the model. 

• Calculation files, which hold data being re-used during calculations to speed up calculation (of 
point response calculations). These files can be erased once job calculations have been carried 
out, however if they are present, future calculations are sped up. 

• Result files, containing all results. For example, the extension .GNN refers to the grid response 
results in Job number NN. 

See the full list of files in the ODEON help which can be accessed from within ODEON by pressing 
F1 and searching for File management. 

  

 

O 
X 

Y 
Z 

 



27 
 

2.4 Importing Geometry to Odeon 

The geometry import format 
The file extension used for geometries in ODEON is .par. Most 3D modelling software will be able 
to export something ODEON can translate into the .par format. Read about importing to ODEON 
further down. The file containing the room model must be written as a text file (ASCII or UNI-
Code), having the file extension.par. The ‘old’ ODEON .sur file format is also allowed though not 
described in this manual.  
 
You can choose to create the geometry file by: 

• Using SketchUp (recommended) with the SU2Odeon plugin described in section 2.5. Today 
this is the fastest and simplest method, used by many ODEON users.   

• Using a third-party CAD program (e.g. IntelliCAD, Autodesk Revit, AutoCAD, 
3DStudioMax, MicroStation or Rhino) which is capable of creating 3D surface models and 
exporting these as .dxf files as described in section 2.6.  

• Using the ODEON Extrusion Modeller described in section 2.7.  
• Typing the model data directly into a text file in the supplied ODEON Text Editor, using the 

format described in Appendix D.  
• Finally, you may combine the different modelling methods; import a CAD model from a 

CAD program and extend or correct it using tools provided by ODEON. 
 

 

 
 
 

Tip: The .par file contains geometry in the Parametric modelling language file format. This format can be 
edited manually in the ODEON Text Editor (see Appendix F: Modelling rooms in the ODEON Editor). 
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2.5 Importing a model from SketchUp 
Our current most preferred program for room modelling is SketchUp (SU). We offer the SU2Odeon 
plug-in that allows you to make direct use of SU models in ODEON. SU is a 3D modelling software 
which is operated very intuitively and creates geometries directly compatible with ODEON. It is 
available in a free (educational) version, as well as a pro version for commercial use which can be 
downloaded at: https://www.sketchup.com/download/all. SU also allows you to create renderings 
of your rooms for impressive visualization. In order to learn how to use SketchUp, it is a must to 
watch some of the introduction videos at: http://www.sketchup.com/learn/videos. In a day or less 
you should have learned the basics. We have also created a few videos on modelling for ODEON 
with SU at: https://odeon.dk/learn/video-tutorials/import-export/. 
 
To make use of the SU models in ODEON, the SU2Odeon plug-in must be installed. It can be 
downloaded from https://odeon.dk/downloads/su2odeon/. The download includes installation 
instructions and last-minute instructions. Once you have installed SU and the plug-in SU2Odeon, 
you can start creating models for ODEON using SU. 
 
Save the SU model in the ODEON room folder and press the ODEON icon in SU menu bar. Then 
SU2ODEON will create a .par file which is saved in the same folder and can be opened directly in 
ODEON. 
 

 
 
The models created in SketchUp and exported by SU2ODEON are inherently compatible with the 
requirements set by ODEON: 

• Plane surfaces. 
• No repeated points. 
• No surfaces without area. 
• Multi loop surfaces are converted into single loop surfaces. 
• Layer support. 
• Automatic explosion of groups and components. 
• Unique surface numbers. 

Extra lines appearing in the ODEON model 
When a surface is created in the middle of another surface (e.g. a window on a wall), SketchUp 
automatically cuts this surface from the other surface, so that no overlap occurs. An extra line will 
appear when the model is imported into ODEON (see figure below). 

 

Warning: Note that for large models, the SU application may show the message “SketchUp is not 
responding” while it is in fact still working on creating the .par file - normally it only takes a few seconds 
but in some extreme cases it might take hours. 
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An extra line by ODEON indicates a healthy 
surface that has been cut to accommodate 
the window in the middle 

https://www.sketchup.com/download/all
http://www.sketchup.com/learn/videos
https://odeon.dk/learn/video-tutorials/import-export/
https://odeon.dk/downloads/su2odeon/
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This extra line is justified by the fact that each surface in ODEON needs to be formed as a series of 
points towards a fixed direction (clockwise or counter-clockwise). As a result, when placing a 
window in the middle of a wall, an extra line appears as a natural reaction by ODEON to help 
continuing the series of points. The line is not part of the actual geometry and it is just an indication 
of a healthy geometry. As can be seen in the next figure, surface No 4 (highlighted by red colour) 
created from 11 points. The line formed by point 9 and 10 serves as a connector between the points 
at the main wall circumference, and the points at the window circumference.  
 
You can open the display below by opening the 3DView  and pressing the N-key shortcut. Select 
another surface in the list in the bottom of the window using the mouse or using the arrow keys 
and press the N-shortcut again to view the points in that surface. 
 

 
 

 
 
 
 
 
 
 
 
 

 
 
Since ODEON version 11, the SketchUp file (.skp file) is automatically copied with an ODEON 
project when using the File>Copy files menu from within ODEON. 
 

Remember: Surface properties assigned in ODEON (such as materials, surface sources, reflectors and grid 
surfaces) are preserved when the model is re-modelled in SU and re-exported for ODEON. 

Remember: Always check the context-
sensitive menu that appears at the menu bar 
between the Toolbar and the Options menus. 
Please do so to view all functions available in 
the window you are currently working in, and 
their corresponding shortcuts. On the picture 
on the right the 3DView window is active and 
therefore the 3D_View menu appears in the 
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2.6 Importing CAD files  

3D CAD programs to use with ODEON 
If using models from AutoCAD it might be an advantage to use the .3ds file format for export from 
AutoCAD and Import into ODEON - rather than the .dxf format. This procedure will ensure that all 
relevant drawing data from the CAD drawing are exported in a way which can be used directly by 
ODEON. 
Generally, ODEON 16 supports not only .3ds and .dxf, but also stl, .obj .step (.stp), .iges (.igs) and .ply. 
 
The support for the DXF file format (Drawing eXchange Format), allows import of CAD models 
exported from modelling programs such as: 
 

CAD package Web links Demo available 
for download 

IntelliCAD http://www.autodsys.com or www.intelliCAD.com x 
SketchUp http://sketchup.com/ x 
AutoCAD  https://www.autodesk.com/products/autocad/overview  
3DS Max https://www.autodesk.com/products/3ds-max/overview x 
Rhinoceros www.rhino3d.com x 
Microstation https://www.bentley.com/en/products/brands/microstation x 

 
There are likely other programs around, capable of creating geometry data which can be used with 
ODEON.  

About CAD drawings 
The CAD import engine in ODEON supports a number of CAD entities which can be exported from 
these programs and imported directly by ODEON without any extra effort.  
Depending on the modelling program used and indeed how it was used by the user, different 
approaches may need to be taken into account to ensure that all, or most, of the drawing data is 
exported to the .dxf file in a form which can be understood by ODEON.  
If ODEON encounters entities in the import process which are not supported, but recognized, then 
you will be notified. 
 
The modelling programs should be true 3D modellers. Programs such as AutoCAD LT only have 
limited support for 3D modelling and are not recommended. Programs such as Rhinoceros, 
AutoCAD, IntelliCAD and 3DStudiomax are true 3D modelling programs and have been reported 
to be suited for the purpose. Other programs may work as well, but in any case, you may have to 
experiment in order to find the optimum way to export and import the geometries from the 
programs. 
 
Room models to be used by ODEON must be surface models defined from plane surfaces, 
regardless if the models are created in a CAD program or if they are modelled in the ODEON 
environment (e.g. using the ODEON .par format). Once a model has been successfully imported by 
ODEON, it is important to perform a thorough check – geometries which look fine in the ‘drawing 
program’ may still contain serious errors, such as repeated, misplaced or missing surfaces. 
 
 

http://www.autodsys.com/
http://www.intellicad.com/
http://sketchup.com/
https://www.autodesk.com/products/autocad/overview
https://www.autodesk.com/products/3ds-max/overview
http://www.rhino3d.com/
https://www.bentley.com/en/products/brands/microstation
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CAD entities supported by ODEON 

Irrelevant drawing entities which are not supported 
Many CAD drawings are in fact 2D “paper drawings” rather than 3D models. Such drawings do 
not contain sufficient information to create a 3D surface model and are ignored in the import 
process. Examples of drawing entities which are ignored are circles, dimensioning lines, texts, etc. 
2D drawing data may coexist peacefully in a drawing containing useful 3D data – as stated, the 2D 
data is simply ignored. 
It is possible to convert a few 2D entities into model data useful for ODEON if handled properly 
within the CAD program. See the 2½D entities paragraph. 

BLOCK’s are supported by ODEON 16 
  
AutoCAD native files (.dxf, .dwg) many times include block entities which are supported since 
ODEON 16. In older ODEON versions any BLOCK in a drawing which contains relevant 3D surface 
data must be exploded using the EXPLODE command before exported to the DXF file. ODEON will 
notify the user if the DXF file imported did indeed contain BLOCK’s. 

3D surface entities supported by ODEON 
• 3DFACE. 
• Poly meshes: MESH, WEDGE, PYRAMID, BOX, CONE, CYLINDER, SPHERE, DISH, DOME, TORUS, EDGESURF, 

RULESURF and any other entities based on poly-meshes. 
• Poly faces, the PFACE entity and any entity based on poly-faces. 

2½D entities supported by ODEON: LINE, POLYLINE, CIRCLE 
ODEON can import LINE, POLYLINE, ARC and CIRCLE entities, so called 2½D entities, when the elevation 
height is set to a value different from zero using the ELEV command in the CAD program. Using the 
ELEV command (at least, this is true in IntelliCAD and AutoCAD) makes it possible to convert parts 
of a flat line drawing into a 3D drawing – typically a 2D floor plan can be converted into a set of 
(vertical) walls. Use the CHANGE command in order to change elevation and height of these 
entities from within the CAD program. 

3DPOLY 
As an option it is possible to import 3DPOLY (3D polylines) as if they were surfaces when these lines 
are closed polygons. When ODEON exports surfaces containing more than four points these 
surfaces are exported as 3DPOLY-lines. 3DPOLY-lines will not respond to the HIDE or the RENDER 
commands when imported into e.g. AutoCAD, however it is possible to convert POLYLINE’s into REGION 
entities which are visualized correctly as surfaces in some CAD programs (if the 3DPoly’s are not 
plane, this may not work). In some cases it may be desirable to switch this import option off when 
importing to ODEON. The DXF file may contain entities which the modeller did not intend to 
include in the 3D surface model when being imported – the entities may have been modelled for 
other reasons e.g. as assisting lines in the modelling phase. 

POLYLINE (when the POLYLINE is closed and the elevation height is set to zero) 
This entity is not really a true surface; however in some cases it is being used by some CAD 
programs (including AutoCAD) in order to bypass the limitation of the maximum of four points in a 
surface. If a geometry which was exported from ODEON to the CAD program has to be imported 
into ODEON again, this option should be on in order to import all 3D data.  

3DSOLID, REGION, BODY – recognized and supported by ODEON 16 
These entities are ACIS solid modelling entities, which directly supported by ODEON 16, but not 
older editions.  
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Solid modelling is probably the most powerful way of creating 3D surface models allowing the use 
of commands such as UNION, SUBTRACT, INTERSECT, SLICE, INTERFERE etc.  
With a few steps it might be possible to convert these entities into something that is understood by 
ODEON 15 and older. 
 
In Cadopia IntelliCAD Professional, the 3DCONVERT command will convert above mentioned entities into 
entities recognized by ODEON (Poly-faces). It is recommended to perform this operation on a copy 
of the CAD file rather than on the original. 
 
In 3DStudioMax you select all the entities in the drawing using the Ctrl+A shortcut, then right-click the 
mouse on the drawing and select the Convert to|Polyfaces (other options may also work). It is 
recommended to perform this operation on a copy of the CAD file rather than on the original. 
 
Since AutoCAD 2000, the conversion process involves exporting to a .3ds file and re-importing the 
exported file: 
• Export the geometry into a 3D Studio file using the 3DSOUT command (this does not change your 

current CAD drawing) 
• Import the just created 3DStudio file back into a new (clean) drawing in AutoCAD, using the 3DSIN 

command. In this new drawing, the above entities has been converted to Polyface entities which 
are supported directly by ODEON. At the same time, all entities contained in BLOCK’s have been 
exploded, making them appear explicit, thus directly compatible with ODEON. 

 
If ODEON reports of any of the unsupported entities when the .dxf file has been imported, this is 
because some 3D data is available in the .dxf file in a format which cannot be converted by ODEON. 
Consider following the steps above in order to create a .dxf file which can be converted by ODEON. 
Do note that ACIS solid modelling extensions may not be available in all editions of the various 
modelling programs. 

Using layers in the CAD drawing 
Surfaces will when imported to ODEON carry the name of the layer on which they were drawn. 
Use the layer name to give the different parts of the geometry different names, e.g. draw the stage 
floor surfaces on a layer named Stage floor, the sidewalls on a layer named Sidewalls etc. 
 
If you are modelling subdivided surfaces such as Upper wall and Lower wall because you wish to be 
able to assign different materials to these parts of a surface, it is advisable to model these parts on 
different layers in order to avoid ODEON gluing these surfaces together (described below). If a 
drawing is subdivided into layers, this also makes it easier to assign materials to the surfaces in the 
Material List in ODEON because materials can be assigned to all surfaces on a layer in one operation. 

Exporting a geometry from ODEON to IntelliCAD or AutoCAD 
When ODEON exports surfaces containing more than 4 points each, these surfaces are exported 
using the 3DPOLY entity whereas all other entities are exported using the 3DFACE entity. The 3DPOLY 
will appear as 3DPOLY lines in the CAD program and does not respond to the HIDE and RENDER 
commands like entities such as 3DFACE do. However, using the REGION command it is possible to 
convert 3DPOLY’s into REGION’s which do respond to the HIDE and RENDER commands. 

Before exporting from the CAD program 
Remember that BLOCK’s are not supported by ODEON. BLOCK’s containing relevant 3D info must be 
exploded using the EXPLODE command in the CAD program (in AutoCAD this may also be done by 
exporting the file to the 3ds (3D Studio Max) format and importing it again as described in the 
Section on 3DSOLIDS). 
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3DSOLID, REGION and BODY entities are not supported by ODEON, so try using one of the approaches 
listed above in order to make the geometry compatible. 
 
A final remark is that it is always a recommended practice to make backup copies of your CAD 
files before making any conversions. 

Performing the import in ODEON 
 

The following steps are generic for the import of any CAD file. 
• Select Files>Import from file (dxf, dwg, 3ds, stl, obj, ply, cad, step, iges) or simply drop the file on the Canvas 

of ODEON. 
• Specify the input file e.g. MyCADRoom.dxf. 
• Specify the destination file e.g. MyCADRoom.par. 
 
Once the file names have been specified, the Import XXX file dialog (where XXX corresponds to the 
extension of the input file) appears, allowing miscellaneous import options to be specified. By 
default, most of the parameters may be left untouched – however it is important that the correct 
drawing unit is specified. If the geometry does not appear as expected, you may try other input 
parameters.  
 

 

Unit in input file 
Unfortunately, many CAD files are unit-less. It is important that the correct unit in which the 
geometry was modelled is selected in the import dialog. If the correct unit is not specified the 
import process may fail because the geometry seems to be only a few millimetres or several 
kilometres in size. 

Geometric rules, glue surfaces 
By nature, surfaces imported in the various CAD files are built from three or four sets of coordinates. 
When the glue option is activated, ODEON will try to glue (or stitch, if you prefer) these surfaces in 



34 
 

order to form fewer surfaces with larger areas. Do note that some surfaces (based on poly-faces) 
may not import correctly unless the glue option is activated (and the “don’t allow subtractive 
PolyFace” algorithm is turned OFF). 
 
ODEON will not combine surfaces with each other when they are situated on different layers in 
the CAD drawing. If you wish that certain surfaces are not glued together, e.g. if upper and lower 
part of a wall should be assigned different materials, then draw the surfaces on different layers in 
the CAD program (preferable) or turn off the glue surface's option (may lead to an excessive 
number of surfaces and may not work with poly-face surfaces). 

Max. point margin 
If points in the .dxf file are within this margin, the points will be considered equal. Allowing a 
certain amount of point margin will allow the Glue function to perform better if the coordinates in 
the model are not exact. However, if you have modelled both sides of a surface (e.g. outside and 
inside surface of a balcony front edge) the Max point margin should be smaller than the distance 
between these surfaces, otherwise the points on either side of the surface will be considered the 
same, resulting in an undesired outcome. 

Max. warp 
ODEON will split four point surfaces into 2 three-point surfaces, if the surface's warp exceeds this 
value. The glue option on the other hand will try to glue surfaces as long as this does not lead to a 
surface exceeding the Max. warp. 

Editing the imported geometry 
It may be necessary, or at least desirable, to repair or make changes to geometry after import. The 
3DView display, which displays the geometry when it has been imported, is a useful tool for this 
purpose. Please see the context sensitive help available in this display from within ODEON for 
further details (shortcut F1). 

Exercise: Importing a dxf file and changing its origo 
Try importing the file Elmia RoundRobin2 detailed.DXF, which is 
located in the \rooms\ directory in your ODEON 
installation. To make the operation of ODEON as smooth 
as possible it is desirable to move the Origo of this 
geometry. Once the geometry has been imported this 
change may be made as follows: 
 
Investigate the coordinates of the front edge of the stage: 
1. Turn on the modelling options in the 3DView (shortcut M) and move the mouse in order to 

investigate the corner’s coordinates. 
2. If pressing the Ctrl key while Left-clicking, then the data for the closest corner is copied to the 

clipboard – the data/text can be pasted into ODEON’s editor using the Ctrl+V shortcut. 
 

 
 
We may want to locate Origo at the front of the stage. This can be done using the Mtranslate 
statement in the geometry file in order to move the mid-point (average of the two points above) of 
the stage to (0,0,0) – open the .par file, clicking the ODEON editor icon, then just after the ### sign 
type: 

Pasted corner data from the 3DView 
Pt ?48? 10.500  -5.90000 24.00000 //for a left point on the stage 
Pt ?47? 10.500  -5.90000 24.00000 //for a right point on the stage 
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MTranslate  –(10.5+10.5)/2 -(-5.9+5.9)/2  -(24+24)/2 
 
At the end of the file just before the ### sign, type MReset in order to make the coordinate system 
neutral – this is desirable if  adding new surfaces to the geometry later on. 
Click the ODEON icon inside the editor in order to save the modified geometry and reload it into 
ODEON. 
 
Other coordinate manipulations to the geometry may be desirable; in particular the CoordSys 
statement described in Appendix F: Modelling rooms in the ODEON Editor may be useful. 
 

 

Trouble-shooting 
Common problems when importing are described below: 
 
Problem with zoom or translation in the 3DView:  
Model appears in a strange position on the screen and zoom /translation does not work as expected. 
This problem is probably caused by some small (invisible and irrelevant) surface(s) located at odd 
position(s) in the imported model. 
Solution 1: Try importing the geometry once again with some of the entities unchecked (turned 
off), it may be that some of the entities, such as 3DPOLY or the like were not intended to be surfaces 
in the surface geometry. 
Solution 2: Removing the unwanted surface: 
• In the 3DView turn on the 'Modelling options' (M-shortcut), look out for odd positioned points.  
• Move the mouse cursor to the position of the odd point - read one of these point numbers 
• Click the ODEONEditor icon to open the .par file, remove the point and try to reload the room by 

clicking the ODEON icon in the Editor. Now ODEON will hopefully report an error stating a 
surface is referencing the point (which no longer exists) 

• Remove that surface along with ALL the points it is referencing (out-comment them) 
• Reload the room. 

 
Problem with display of coordinate system: The blue coordinate system looks odd or behaves 
strangely. 
Solution: If the Origo is situated in a point far away from the geometry, the coordinate system may 
not display properly when projection is turned on – in that case turn off the projection using the P-
shortcut. In order to fully solve the problem, the position of the origo should be altered as described 
in the example above. 
 
The geometry displayed in the 3DView appears to be too small or large after re-import: 
If the geometry was initially imported using an incorrect unit then ODEON has defined its default 
view list in the 3DView in order to display the initial version of the geometry correctly. To reset 
the view list, use the Ctrl+DEL Shortcut from within the 3DView. 
 

Tip: In the DXF import dialog, multiple options are available allowing some common changes to the layout 
of the room coordinate system. The order of axis and/or the direction of axis can be changed. Also some 
simple changes to the position of the origo can be performed. 
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2.7 The ODEON Extrusion Modeller 
 

 A small modelling program; the ODEON Extrusion 
Modeller is included with ODEON. The program is found in 
the Windows start menu along with the ODEON program. It 
can also be launched from within the ODEON editor. 

 
The Extrusion modeller 
allows to model “extruded 
geometries” in a graphical 
environment, or in other 
words, to draw geometries 
using the mouse. An extruded surface is a flat 2D outline, 
drawn at a specified drawing depth (the third coordinate) and 
with an extrusion height. When assigning an extrusion height 
to the 2D outline, it becomes a holster outlined by the edges of 

the ‘extrusion surface’, if so desired this holster can have a bottom and a top. 
In the extrusion modeller, it is possible to make one drawing which contains multiple extrusion 
surfaces, each described by a 2D outline (a simple drawing) and the line properties; drawing depth, 
extrusion height, bottom check mark, top check mark and a name. If the extrusion is created in the 
XY- plane (the ground), then an extrusion surface may form a volume with walls and optional floor 
and ceiling, whereas other extrusion surfaces 
define tables, chairs or screens. 
 
For some geometry it may be more appropriate to 
draw the room in one of the other main planes (XZ 
and YZ planes). As an example the auditorium.par 
model in the figure to the right has been modelled 
in the XZ plane (starting from a wall), using 
separate extrusion surfaces for the room, the wall 
with windows holes, the table and the windows. 
 

The Extrusion Modeller and file formats 
The output from the extrusion modeller comes in two formats. The first is its own native format, 
an .oes file, where the extrusion model is saved. This file can be edited and extended at a later point 
in the extrusion modeller e.g. if wishing to change width of the auditorium above, to change some 
of the points in the drawing or to add other features. 
 
The other format is the ODEON .par format which is loaded into ODEON for calculations. The 
parametric format cannot be edited in the extrusion modeller; on the other hand it may be manually 
edited to any degree of freedom if needed and it is possible to make use of the benefits of the 
parametric format described in Appendix F: Modelling rooms in the ODEON Editor, e.g. when 
modelling geometric shapes such as cylinders and domes, when combining 2 extrusions in 
different planes, or when it is appropriate to describe parts of a geometry using parameters. The 
.par file can be edited in the ODEON Text Editor. The 3DView available in ODEON is a useful tool when 
investigating or modifying an already existing file; load the .par file into ODEON, study the room 
in the 3DView – please see the help text (shortcut F1) available from within this display, then make 
the changes in the editor which can be opened from within ODEON. 
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Using the Extrusion modeler 
Start the program; a shortcut to the program is found at the Windows Menu 
Start|Programs|ODEON|ODEON Extrusion Modeller. 
 

 

Initial settings 
Before starting to model geometry, select the 
drawing plane (XY, YZ or XZ) which is best 
suited for the geometry to be modelled. Also 
select properties for grid and snap spacing. 

Using a drawing of the floor plan as the 
layout 
It is possible to load a 2D background drawing 
section plan as basis for the geometry in various 
image formats (png, jpg, gif, emf, wmf,) and to 
use this drawing as the basis for the drawing. 

To load a background drawing 
• Use the File|Load backgound drawing menu to locate your image file. 
• Double click on your desired origo in the drawing as requested (could coincide with an 

intersection between a horizontal and a vertical module line). 
• Double click at a point having some horizontal distance from the origo as requested (could be 

another vertical module line). 
• Enter the distance between the two points (e.g. distance between vertical module lines). 
• If the drawing is very dark, this may be disturbing, use the File|Make background drawing lighter to 

lighten the drawing. (This can be repeated). 
 
The drawing has now been scaled and is fixed to the drawing canvas - when scrolling the drawing 
canvas or zooming, the drawing will adjust appropriately. If not satisfied with your scaling of the 
drawing, repeat the process above. 
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Drawing an extrusion surface 
Left click the mouse at the positions where the points in the surface are desired – if no points and 
lines are generated, then you need to bring the current surface in edit mode using the Insert (or Esc) 
shortcut or by double clicking a point in the surface. Once all points in the surface have been 
defined, finish the current extrusion surface by starting a new one, using the Ctrl+A shortcut or 
pressing the Insert or Esc shortcut. To assign a drawing depth (X,Y or Z) and an extrusion (dX, dY or 
dZ), select the surface in the Surface editor table where it can also be specified whether the extrusion 
surface should have a bottom and a top and where a Description may be entered. The drawing depth 
and extrusion for each extrusion surface is displayed graphically at the bottom of the application 
window. 

Editing or correcting an extrusion surface 
In order to make corrections to an extrusion surface, select it in the Surface editor table or click one of 
its points in the drawing area, then bring it into edit mode using the Insert (or Esc) shortcut. Once in 
edit mode, it is possible to change coordinates of the points, insert or delete points, and to move 
the surface using the mouse operations listed below. It is also possible to enter the precise 
coordinates of points in the Point editor table which list the points in the selected surface, so it is an 
option to draw a sketch using the mouse and then fine tune the coordinates afterwards in the Point 

editor table. 
 

Operation on surface Mouse operation 
Create a new point in selected surface LeftClick mouse 

Select the point in selected surface, which is closest to Mouse pointer Ctrl+LeftClick mouse 

Move closest point in selected surface Ctrl+Alt+LeftClick mouse 

Move selected surface Shift+LeftClick mouse 

Manipulating the viewport 
The viewport can be manipulated using the shortcuts listed below. It is possible to make changes 
to the view while drawing a surface. 

View operation Mouse operation 
Scroll drawing area  Right mouse button 

Zoom (In/Out)  Alt + Left mouse button 

Snap to grid 
Snap to grid enables points (new points or points being moved) to be positioned exactly at the 
intersection of the grid lines. In special cases the point can also be inserted at only one grid line 
when the other coordinate is that of an existing point (see below, snap to existing points). 

Snap to existing points 
Snap to existing points enables points to be precisely located on either or both reference coordinates 
of existing points. 
 

The snap point 
The snap point is a special case of snap to existing points. In some cases, you may want to move a 
surface to a precise location e.g. (0.33, 0.46) not being a point on the grid nor an existing point of 
another surface. In that case: 
• Create a new surface. 
• Click the approximate position of the reference point. 
• Change the coordinates to the exact position, e.g. (0.33, 0.46) in the Point editor. 
• Press Insert (or Esc) to finish editing the surface, the point will appear with the mark +Snap point. 
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• Select the fix point in the surface to be moved (left mouse button) and move it to the location of 
the snap point. Do note that Snap to existing coordinates option must be checked. 

 
Once the surface has been moved, the surface containing the snap point may be deleted; this is not 
a strict requirement as surfaces containing only one point, will not be transferred to the .par format 
to be used in ODEON. 

Coordinate snapping 
When entering new points (clicking the mouse), coordinates of points will be truncated to the 
nearest snap, e.g. if the snap is 0.25 and the X-coordinate of the clicked position was 0.15, then the 
X-coordinate of the point will be 0.25, if the Snap to grid option is enabled. But it is still possible to 
fine adjust the coordinates in the Point editor (lower right corner of the Extrusion modeller). If Snap to 

existing points is enabled, then the X,Y (or Z) coordinates of already defined points are also snap-able. 

Ortho snap 
Enable Ortho snap if the surface to be drawn has many edge angles of 90 (or 270) degrees. The option 
can be turned on and off while drawing a surface. 

Lock equal points 
When this option is enabled it becomes possible to move points in multiple surfaces if the X,Y (or 
Y,Z or X,Z) coordinates are equal. This is useful for multi-level rooms where e.g. X and Y 
coordinates are identical for multiple points while the Z coordinate differs. 

Snap to existing coordinates 
Makes it easy to draw new points making use of horizontal or vertical coordinates in existing points 
– also when these do not match current snap size. 

Lock H and V snap 
If this option is checked then Horizontal snap size will automatically be updated when the vertical 
snap size is changed and vice versa. 

Relative or absolute extrusions 
Use the Ctrl+H shortcut to toggle between relative or absolute extrusions in the Surface editor table. 
When extrusions are displayed in relative measures an extrusion may be defined as Z=10 and dZ=5, 
telling that the extrusion starts at a height of 10 and has an extrusion height of 5. If toggling to 
absolute extrusion then the same extrusion is displayed as Z1=10 and Z2= 15 telling that it starts at 
Z=10 and ends at Z=15. 

Modelling an array of surfaces 
Each extrusion surface has a set of array properties associated with it (Nx, Distx, Ny, Disty, Nz, Distz), 
a set for each of the three main orientations in the room. These properties can be found in the Surface 

editor and define how many times the surface should be repeated in each of the main directions and 
the distances between the repetitions. This feature is typically used in order to create a number of 
columns, beams, tables or chairs with a regular spacing. When editing an array surface e.g. 
modifying a point, all the repetitions of the surface will be changed accordingly. 

Exploding an array of surfaces 
If individual changes are needed, the arrayed surface must be ‘exploded’. Once this operation has 
been carried out, the surfaces in the arrayed surface have been turned into individual surfaces 
which can be modified surface by surface (e.g. delete some of them). It is not possible to perform 
the reverse of the explode operation so before exploding an arrayed surface, make sure all 
operations common to the surfaces in the array have been carried out. 
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Define Layers 
For later management of acoustics materials inside ODEON, the extrusion modeller has layers. 
This allows you to easily assign materials to all surfaces on one layer in the Material list within 
ODEON. Create a layer with a name and colour in the layer box (above the surface editor). 
 
You can deactivate layers to make them invisible in the extrusion modeller but 
deactivated/invisible layers will still be loaded into ODEON. 
 
The current layer (checked as Current in the Layer list) is the one that new surfaces are created on. 
By checking Move all objects on layer it is possible to move multiple surfaces in one operation. It is 
possible to change the layer of an extrusion surface in the Surface editor allowing you to group 
surfaces on one layer prior to moving them. 

Modelling a chair 
As an example, we will create a chair with the seat dimensions 0.4 x 0.4 and a back rest with the 
height of 0.4. Legs and other small details should be omitted. Therefore, if modelling a room in the 
XY Modelling plane then a chair may in effect be considered as an extrusion which excludes the 
top and three of its sides. To make things easier when modelling through the extrusion modeller, 
do the modelling around origin, then move the chair to its final location when finished. When 
modelling around the origin, it becomes easier to read the dimensions of the seat of the chair and 
to use grid and snaps without the need to calculate dimensions of the seat: 
• Set the grid and snap size(s) to 0.4 metres. 
• Click on 4 points of the grid, starting from x = 0 and y = 0, to form a square (seat of the chair). 
• Press Insert or Esc to stop drawing (Insert or Esc toggles point input on/off). The last dotted line 

should change to a solid line. 
• Change the Z coordinate to 0.4 metres in the Surface editor to define seat height. 
• Change dZ to 0.4 metres in the Surface editor in order to define the height of the back of the chair. 
• Uncheck Top in the Surface editor to disable the top surface. 
• Uncheck 3 points in the Point editor to disable extruding those sides. Only one side will be 

extruded (back of the chair).  
After following the steps above, the extrusion modeller window should look like the first figure 
below. Then, clicking the ODEON icon in the Surface editor produces the second figure below. 
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 Creating a circular surface 
To create a circular surface, first draw a line (a surface with two points) in order 
to specify centre and radius of the circle, then use the Ctrl+O shortcut to activate 
the circle tool and accept to create a circle from 12 points. If the circle tool is 
clicked when the selected surface contains less than two or more than three 
points then a help text is displayed, this text will also explain about ellipses. 
 

Make a circle into a half-circle 
Delete the 5 upper points in the circle in order to reduce the circle to a half-circle. 
At this point you should have created the half circle in middle of the Figure 
above. 
 
 
 

 Mirroring the surface 
Following from the creation of a half-circle, the mirror functionality can be used 
to create a table plate with circular ends; select the horizontal mirror and specify 
the coordinate of the mirror line (in the Figures the coordinate was -1.00). Select 
the first of the two points to be connected across the mirror line and finally use 
the Mirror shortcut Ctrl+M to create the full table. The position of the mirror is 
easily changed if holding down the Shift key while pressing Right-mouse button 
and moving it – if performing a very significant move in the horizontal or 
vertical direction this will toggle between a horizontal and a vertical mirror line (blue dashed line). 
 

Mirror manipulation Mouse operation 
Move mirror line /toggle between vertical and horizontal 
mirror line 

Shift+Right mouse button 

 Creating a mirrored copy 
Uses the current mirror line in order to create a copy of the currently selected surface 

Create scaled copy of surface (Alt+Ctrl+C shortcut) 
As above but a dialog appears, allowing input of a scaling factor. 

 Create copy of surface 
Will create a copy of the selected surface. The copy is offset slightly from the original one to make 
it visible. 

 Rotating a surface 
To rotate a surface, select the point in the surface in which the surface should be rotated, then 
activate the Rotate dialog using the Ctrl+R shortcut and enter the number of degrees to rotate the 
surface (positive rotation angles always counter-clockwise - CCW). A surface cannot be rotated 
around a point which is not included in the surface. However, you may rotate the surface around 
an arbitrary point with the trick explained below. 
• Select the surface. 
• Bring it into editing state (Esc or Insert shortcut). 
• Add the rotation point (it is not important where it is inserted in the sequence of points). 
• Rotate the surface. 
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• Delete the rotation point from the surface (Del/Delete shortcut). 
 

     
To rotate a surface around a point which is not included in the surface, a) Insert a rotation point in the surface, b) Use 
the Rotate surface shortcut Ctrl+R to activate the rotation dialog and specify the rotation angle – in this case 25 degrees, 
finally delete the rotation point from the surface. 

Examples 
A few examples on extrusion models are installed with ODEON – the examples are located in the 
\ODEON<Edition Name>\rooms\oes Directory. The best way to learn about benefits as well as limitations of 
the extrusion modeller is to load the examples, investigate the surfaces (e.g. scrolling the point and 
surface tables) and to load the models into ODEON. This way the models can be investigated when 
being extruded. 

Special extrusions 
There are a few extrusion surfaces which are treated differently by the extrusion modeller: 
1. A surface with an extrusion height of zero will produce one and only one ‘horizontal’ surface 

no matter if a Bottom or Top surface is selected. 
2. An extrusion surface which only contains two points will only produce one ‘vertical’ surface, 

no matter if Bottom or Top surface is produced. If only a single edge is extruded into a surface 
with a height of zero, then no surface is produced. 
 

2.8 Model check in ODEON 
When you open a room file with Files|Open Room model, ODEON will check the validity of the file. 
However, this only checks whether the format is correct and the data is consistent, not if a 
meaningful geometry is defined. Furthermore, it will not check if the model is watertight, or 
conversely if there are leaks. So, after opening a room file, you may start by verifying if the 
geometry is meaningful and without errors. 
 
This may involve: 
• Viewing the room in a 3DView. 
• Viewing the room in the 3DOpenGL display. 
• Analysing the geometry for unacceptable surface warps in the 3DGeometry Debugger. 

Analyzing the geometry for unacceptable surface overlap in the 
3DGeometry Debugger 
• Checking for missing surfaces in the room (forming holes in the geometry). The Unique edge's 

function available from the 3DView may help you (shortcut E). 
• Testing water tightness of the room, using either 3D Investigate Rays or 3D Billiard. 

Viewing the room in a 3DView 
The 3DView , displaying your room once loaded into ODEON, has a large number of features 
which can be useful when creating and verifying geometries for ODEON. 
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Viewing corners and coordinates in a selected surface using the N 
shortcut and highlighting corner and displaying the coordinates of 

the corner closest to the mouse pointer using the M- shortcut. 
 

 

The perspective option (shortcut P) allows you to turn off 
the perspective of the room, to get an isometric display of 
the room. This may prove valuable when investigating 
warped surfaces. 

The Unique Edges option in the 3DView display shows 
edges, which only occur on one surface. Such an edge is 
"free"; it might be the edge of a free-hanging reflector, but 
it also could be the result of an error whereby two 
surfaces, which should join along an edge, do not.  

Example: 
Modelling a box-shaped room consisting of 6 surfaces, but forgetting to define the 6th surface in the 
geometry file. This room will have a hole where the 6th surface is missing. The unique edge's 
function will show where the missing surface should have been. 

Using the 3D OpenGL display for model verification 
The 3D OpenGL display  is very useful for detecting holes in the geometries. Especially if 
stepping outside the model (Back-arrow shortcut) and rotating the model using the Ctrl+Arrow 
shortcut. See the corresponding 3DOpenGL dropdown menu for more shortcuts. When materials 
have not been assigned to all surfaces in the room, surfaces will appear in random colours making 
holes easier to spot. If materials have been assigned, the colours will by default reflect the acoustic 
properties of the surfaces, however it is possible to turn on the random colouring at will, using the 
R-shortcut. If the model contains layers it is also possible to show the layer colours using the Ctrl+L 
shortcut. 
 

  

3DGeometry debugger 
Overlapping and warped surfaces should be avoided in the room model specified in the geometry 
file, but a certain amount of overlap and warp (by default 50 mm) is allowed without generating a 
warning. By overlapping surfaces is meant surfaces, which define a part of the same plane in space. 
In the simple case this can be because the surfaces are simply duplicates, another case could be a 

Remember: The 3DOpenGL may occasionally fail to display complicated surfaces, including numerous 
holes correctly (typically surfaces created by CAD software using solid modelling techniques and 
subtractions) although the surfaces are perfectly legal with respect to ODEON. In these rare cases you 
may assure yourself that the model is in fact correct by putting point sources at various test positions 
and by conducting tests using the 3D Investigate Rays and 3D Billiard utilities. 

Remember: Always check the 
context-sensitive menu that appears 
at the menu bar between the Toolbar 
and the Options menus. Please do so to 
view all functions available in the 
window you are currently working in, 
and their corresponding shortcuts. 
On the picture on the left, the 3DView 
window is active and therefore the 
3D_View menu appears in the menu 
bar. 
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door, which has been defined in the same plane as the wall in which it is mounted. Overlapping 
surfaces should be avoided because it will not be clear which absorption coefficient should be 
applied at a reflection in case of overlapping surfaces with different materials. 
Warps can lead to "holes" in rooms at edges of joining surfaces, with erroneous results as a 
consequence and the surfaces will not be well defined. 
 
Using the 3DGeometry debugger  in ODEON, a list of warnings and a corresponding illustration 
in a 3D display will be generated, whenever an overlap or a warp exceeds the value specified in 
the Room setup|Model>Air conditions dialog. 
 
Overlapping surfaces are a tricky problem because it is usually invisible on 3D projections of the 
geometries, however such errors in the model may lead to unpredictable results, so always check 
models of considerable complexity for overlapping surfaces. 

Testing water tightness using 3D Investigate Rays 
Testing a new model for "water tightness" (i.e. whether it is completely closed) may be done using 
a 3D Investigate Rays window . 
 
The room model may not be watertight if: 
• Surfaces are missing from the model. 
• Surfaces are unacceptable warped. 
• Boundary surfaces have been assigned transparency coefficients greater than zero. 
• Boundary surfaces have been assigned Material 0 transparent. 
• Sources are located outside the room. 
 
Before investigating ray tracing, you will have to: 
• Make the boundary surfaces of the room "solid" by assigning materials to them. For the moment 

it does not matter what the materials are, as long as they are not transparent (Material 0) or fully 
absorptive (Material 1). Go into the Materials List and assign, e.g. 20% absorption to all surfaces (use 
Ctrl+Ins to do this in one keystroke). 

• Place a source somewhere inside the room. Sources are defined from the Source-receiver List. At 
first it may be a good idea to define a point source somewhere in the middle of the room. 

 
Open a 3D Investigate Rays display and run it with, e.g. 1000 rays, with a Max reflection order of zero. This 
will test whether any holes can be seen from the source-position and should reveal any large 
problems. The tracks of lost rays will show outside the room boundaries, and indicate whereabouts 
in the room, the problems occur. 
 
If rays are being lost, and you have an idea of which part(s) of the room is /are "leaky", a number 
of things may be done: 
 
• Reduce the value of Max. accept. warp in the Room setup at the Model|Air conditions page. Then run the 

3DGeomtry Debugger. Warnings will appear if surfaces have a warp or an overlap above the 
acceptable range. This may reveal slight warps of surfaces in the leaky region of the room which 
then have to be reduced as far as possible by revisions to the geometry file. 

• Use the 3DView or 3DOpenGL for inspection of the model to study the region(s) under suspicion. It 
may turn out that a surface is missing or does not join to its neighbours in the expected manner. 
It may help to zoom regions in question with the Highlight surfaces, Show corner numbers and coords and 
Modelling options switched on. 
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2.9 Combining geometries 
It is possible to combine geometries imported from an external CAD program with geometry 
modelled in the Extrusion modeller or modelled in the parametric modelling format of ODEON.  
When a geometry has been imported in ODEON it will have the .par format. This is a text format 
and the content of different room-files can be copy-pasted together to one room file. This is done 
in the Odeon Editor. Just copy the content in the Odeon Editor in one room, add in the Odeon 
Editor of another room and press “Save and Reload in Odeon” (the ODEON symbol in the Editor).  
  
Be aware that you need each surface number to unique. This, and other issues, can be solved by  
some facilities in the parametric modelling format: NumbOffset, CoordSys, Unit, MTranslate, MRotateX, 

MRotateY, MRotateZ, MScale, MReset and MPop.  
 
Below is an example/outline which illustrates how a number of geometries can be merged together 
into one parametric file: 
 

### 
CoordSys X Y Z 
.....1. model data....... 
.....1. model data....... 
 
NumbOffset 1000 ;avoid reusing point and surface numbers which have already been used 
CoordSys Y X Z ;swap coordinate axes if needed 
MTranslate 0 15 20 ;Translate /move geometries as needed 
.....2. model data....... 
.....2. model data....... 
 
NumbOffSet 2000 
MReset  ; restoring default origo 
CoordSys X Y Z; restoring default coordinate system 
 
..…More model data ??? 
### 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



46 
 

Once the geometry of a room has been loaded into ODEON, sources and receivers have to be placed 
through the Source receiver list  (shortcut  Shift+Ctrl+S), as described in the Quick Start Guide 
(available online at https://odeon.dk/learn/quick-start-guides/). This manual will not repeat the 
content of the Quick Start Guide, so please read that first. 
 
The sources could be an omnidirectional point source, a person speaking, a loudspeaker, a road 
with traffic, a large industrial machine, or something else.  
Depending on the sound source you need, four different types of sources are available in ODEON:  
 

• Point Sources. Available in all editions. Most common type of source where sound radiates 
spherically from a point. It is possible to define the directivity pattern of a point source, so 
many cases can be simplified to the use of point sources. Used e.g. for omnidirectional 
point sources, for people speaking, for instruments or simple loudspeaker setups.   
 

• Line Sources. Available in ODEON Industrial and Combined. Sound is radiated from a line. 
Used e.g for roads with traffic or pipes with running water. 
 

• Surface sources. Available in ODEON Industrial and Combined. Sound is radiated from one 
or multiple chosen whole surfaces in the room. Used for e.g. industrial machines or crowds 
of people in restaurants. 
 

• Array Sources. Available in ODEON Auditorium and Combined. Used for loudspeaker array 
setups.  

 
The receiver has a very simple form being just a “point” mono-microphone. For auralisation (see 
Chapter 7) the exact direction of the head is needed, this is something which can be adjusted in the 
JobList. 
 

3.1 Generic point sources 
Generic point sources such as the OMNI or SEMI directional sources are typically used for calculating 
the frequency response and the parameters characterizing the room-acoustics. It is typical for 
generic sources which are defined mathematically. 

3.2 Natural point sources 
With “natural sources”, we refer to sources such as human voice, an acoustical instrument or 
similar. Natural sources are typically used for auralisations and/or calculation of acoustical 
parameters that depends on a specific sound power of a natural source. E.g. speech intelligibility 
of a person or sound pressure level by a smaller machine. 

 Sources and Receivers 

https://odeon.dk/learn/quick-start-guides/
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A recorded signal for auralisation is 
associated with the directivity pattern of the 
actual source presented during the recording. 
In an auralisation, the directivity pattern for 
natural sources in ODEON is used together 
with the recorded frequency spectrum of e.g. 
a voice. If this isn’t handled correctly, this will 
result in an auralisation where the overall 
frequency response is included not once but 
twice; first time through the directivity 
pattern which includes the overall frequency 
response, second time through the recorded 
source signal, which inherently includes that 
response. 
 
For example, in order to estimate SPL or STI 
correctly and for calculation of acoustical 
parameters, it is desirable that the true 
frequency content is included in the 
directivity pattern. However, for an 
auralisation, the directivity pattern should be 
equalised with the inverse spectrum of that recorded at the font axis of the natural source signal 
(i.e. the wave file with human voice recorded with a microphone at the front axis). 
 
From ODEON version 8.5 and up, it is possible to create correct estimates of parameters from 
natural sources - and at the same time create correct auralisation, where the overall spectrum is 
included only once. It is necessary to use a source marked Natural. ODEON has some directivity 
patterns which have the word Natural attached to their names e.g. BB93_Normal_Natural.So8. When 
natural directivity patterns are selected from within Point Source Editor, a green natural-label is 
displayed next to the equalization entry fields. 
 
If having existing directivity patterns of natural sources which are not marked natural, this can be 
done by using the Tool>Directivity patterns|Mark So8 file as natural directivity. When creating new 
directivity patterns, this information is part of the input data. 
 
Always use the _Natural versions of the directivity files when defining new natural point sources. 
The old versions of the files are kept in \Old_So8\ a subdirectory to the \Dirfiles\ directory. If you wish 
to use the old directivities in old /existing projects, then open the Source receiver list and click the 

Repair broken directivity links button  (shortcut Ctrl+L). 
 

Samples on natural directivity patterns (BB93_Normal_Natural, 
BB93_Normal_Raised and Soprano ref. 42). 
The BB93_Normal_Natural source type (BB93, 2015) corresponds to a male speaker with a normal 
vocal effort. The gain and EQ fields in the Point source editor (inside ODEON) should be set to zero. This 
source is also a reasonable approximation to a female speaker, except that the 63 and 125 Hz band 
should be ignored. 
 
To simulate a trained speaker addressing an audience in a raised voice, use the TLKRAISE source. 
This has the same directivity as TLKNORM, but the levels in the eight octave bands are respectively 2, 
2, 5, 7, 9, 8, 6 and 6 dB higher.  

 

Directivity with spectrum 
of natural source 

Signal from anechoic 
recording with 
spectrum of source 

Calculating 
acoustical 
parameters 

Calculating BRIR 

Adding 
inverse 
spectrum 

Calculating reflections 
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The directivity pattern of Soprano ref. 42 is the directivity of a soprano singing opera (Parati, et al., 
2003). 
 

3.3 Common loudspeaker format, CF1 and CF2 files 
ODEON version 8 and up supports the Common Loudspeaker Format 
which is an open format for loudspeaker data, supported by several 
loudspeaker manufacturers as well as manufactures of software 
programs such as ODEON. The Common Loudspeaker Format was 
developed and also maintained by the CLF-group at 
www.clfgroup.org. It is an open, though secure, file format for 

loudspeaker performance data and polar plots. Loudspeaker manufacturers can use the CLF 
format to supply data to end users of professional room acoustic computer programs. 
 
CLF files are binary distribution files having the extensions CF1 and CF2. These file are created by  
loudspeaker manufactures or  independent measurement services which have obtained a license 
key for the CLF authoring kit (http://clfgroup.org/author.htm). The need for an authoring key 
for the authoring kit ensures that data distributed in the CLF format can be traced back to the 
author and that data can’t be modified by third party. In order to view all data in the CLF format 
you can download a free viewer from the CLF group home page. 
 
CF1 has a frequency resolution of 10 degrees, 1/1 octave and CF2 has a frequency resolution of 5 
degrees, 1/3 octave. If data are available in either format for a selected loudspeaker then the CF2 
format should be preferred because of its angular resolution. Currently ODEON does not make 
use of the higher frequency resolution of the CF2 format except for loudspeaker array modelling 
where ODEON makes use of the higher frequency resolution as well as of phase data (if available) 
for calculation of distance dependent directivity of the loudspeaker arrays (which are composed 
from multiple units added with phase). 
 
The CLF Group is providing a set of free tools for data editing, conversion from text to binary 
format, and viewing binary data. This allows loudspeaker manufacturers and independent 
measurement services to create, view and verify binary distribution files and ensures that it is easy 
for loudspeaker manufactures to make data available. Links to loudspeaker manufacturers 
currently providing binary distribution files can be found at the download page at 
www.clfgroup.org. If apparently the data of interest is not available from a manufacturer of 
interest, then assist the CLF-group by encouraging the manufacturer to make such data available 
– free tools for this purpose can also be obtained at the CLF group’s homepage see 
http://clfgroup.org/clfdocuments.htm and http://clfgroup.org/author.htm. 
 

3.4 Directivity files in the EASE 3 and EASE 4 formats 
Odeon currently supports .Lob + .Spk directivity files (EASE 3 and EASE 4). These files contain 
directivity patterns in 5 degrees resolution, 1/3 octave. These data are supported for use for simple 
point sources where they provide and angular resolution of 5 degrees and a frequency resolution 
of 1/1 octave. Currently Odeon does not support the use of .lob and .spk files for loudspeaker array 
modelling. A set of directivity in the EASE 3 and 4 formats may come with a number of files having 
the extensions .lob, .spk, .fed, .ffc, . fvt and .phs. Currently Odeon only makes use of .lob and .spk 
files which defines the directivity balloons and the sensitivity. Both the .lob and .spk files must be 
present for Odeon to recognise and use the given directivity. It is though recommended that all the 

http://www.clfgroup.org/
http://clfgroup.org/author.htm
http://www.clfgroup.org/
http://clfgroup.org/clfdocuments.htm
http://clfgroup.org/author.htm
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files are installed as Odeon may make use of these data in the future if available (phase data and 
data specifying the geometry of the speaker). 
Unlike the CLF data, the .lob and .Spk data formats does not ensure data integrity, it is not possible 
to see if data was created by loudspeaker manufactures or  independent measurement services or 
if it was created by someone needing the data and entering some data themself – therefore it is 
recommended that these data format should only be downloaded from trusted source (e.g. directly 
from the homepage of the loudspeaker manufacturer. If data is available in the CLF format then 
these data should be preferred! – and again you are urged to prompt the loudspeaker to make data 
available in the CLF format if they are not. 

File location for directivity files 
Regardless if files are in the .cf1, .cf2, .lob + . spk or in ODEON’s native formats (.So8, SoCF1Tab or 
SoCF2Tab), the files should be stored in ODEON’s directivity directory as specified inside ODEON 
at Options|Program setup|Directivity folder. The files may be stored in subdirectories to this directory 
allowing loudspeaker directivities of different brands to be located in separate directories e.g. 
C:\ODEON...\DirFile\ManufacturerA or C:\ODEON...\DirFile\ManufacturerB. We have taken the opportunity to 
create a number of folders for manufactures who supply loudspeaker directivity files in the CLF 
format. Using these predefined directories, it is easier to move a room from one PC to another 
without breaking file linkage. 
 

3.5 Creating new directivity patterns in the ODEON .So8 
format 

Tools for creating directivity patterns in the ODEON .So8 format can be found at the Tools>Directivity 

Patterns>Create directivity pattern in plot editor menu entry inside the ODEON program. The tools allow 
you to expand the set of source directivity pattern files available for point sources in ODEON. The 
ODEON directivity pattern file (Version 3 or later) contains information on the sound levels for the 
eight frequency bands 63 Hz to 8 kHz in dB for each 10° azimuth and 10° elevation. These files are 
binary and have the extension .SO8. An example on a directivity pattern is the pattern stored in 
OMNI.SO8. 

Entering a directivity plot using the Directivity polar plot editor 
The easiest way to enter a new directivity plot is to use the built-in polar plot editor which allows 
building a directivity plot from a vertical and a horizontal polar plot. Click Tools>Directivity 

Patterns>Create directivity pattern in plot editor. The following window appears: 
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Enter the dB values (sound pressure level) for the horizontal and vertical plots at the selected 
frequency band in the corresponding tables. The angular resolution is 100 degrees. If data is not 
entered for all angles (e.g. if the data are not available) ODEON will do interpolation between the 
angles entered. For angles between both polar plots, ODEON will perform elliptical interpolation. 

Equalization 
If the source to be used in ODEON has a fixed frequency dependent sound power level, the 
equalization option in the Polar plot editor is used for entering the dB values. 

Calibration 
Three different options are available in the Polar plot editor: 
• If No calibration is selected, ODEON will use the SPL dB values as entered in the polar plot table, 

adding the equalization values entered. This option is typically used if the source is a 
loudspeaker. 

• If Calibrated source is selected, ODEON will add the equalization if entered, then shift the resulting 
SPL's of the source in order to obtain a reference sound power level of 0 dB re 10-12 Watt at the 
selected Calibration frequency band (typically 1kHz). This calibration type is typically used when a 
generic source with an adjustable level is needed for calculations, such as the OMNI or SEMI 
directivity pattern, 

• If Sensitivity calibration is selected, the SPL's of the source will be shifted in order to obtain the SPL 
in dB on front axis of the source at the distance specified as Ref. distance metres at the selected 
Calibration frequency band. This calibration type is typically used if the free field sound pressure 
level measurement is available for a natural source. 

Maximum dynamic range 
The minimum level will be Max level minus Maximum dynamic range. If the range is large the display 
may be difficult to interpret /view in the directivity viewer. The source will usually have its max 
levels on its axis. 
 

Odeon directivity text import format 
Normally the text format should not be necessary to use, as most common sources are defined 
already in ODEON or available on www.clfgroup.org. 
 

http://www.clfgroup.org/
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The data entered in the text format should be in relative calibration across frequencies, but 
doesn’t need to be in any absolute calibration. The absolute calibration is an option, from within 
the program as described under the section below: “Creating a new directivity pattern using a 
text file as input”. 
 
The first non-comment line of the input file indicates whether the data is for: 
• POLAR set containing horizontal and vertical polar plots, for sources where only a horizontal and 

a vertical plot are known, e.g. a loudspeaker. 
• FULL set, for complex sources where directivity data is known for each 10° Azimuth and 10° 

Elevation. 
• SYMMETRIC set, for symmetric sources, e.g. a trumpet. 
 
The second non-comment line in the input file indicates whether the data represents a Natural 
source such as a musical instrument, or a person speaking - and also if it represents a source such 
as a loudspeaker which does not include the frequency response of the source signal. The purpose 
of this Boolean is to make auralisation correct for natural sources set NATURAL to: 
• TRUE for sources such as musical instruments. 
• FALSE for sources such as loudspeakers. 
 
Each of the subsequent lines of the input file should contain sound pressure levels in dB for a 
complete 180° of elevation (from the forward axis to the backward axis). The resolution must be 
10°, hence each line contains 19 values (0°, 10°, 20°, …, 160°, 170° and 180°). 
 
Lines containing comments, and empty lines, may be inserted anywhere in the ASCII input file, as 
long as they do not come between data items, which should occur on one line. Comment lines must 
begin with a colon (:), a semicolon (;) or an asterisk (*). 
 

When only horizontal and vertical polar plots are known (POLAR) 
The first non-comment line of the file should start with the word POLAR. In the polar case, there 
are four lines of data for each frequency band. The first four lines are for 63 Hz, the next four for 
125 Hz, and so on. 
 
For a given frequency, the first and last values must agree on all four lines, since all the polar plots 
meet at the front and back of the plot. The first line of a group of four is the upward vertical polar 
plot as seen from in front of the source (12 o'clock plot). Then the left horizontal plot (9 o'clock plot) 
appears downward vertical plot (6 o'clock plot) and finally the right horizontal plot (3 o'clock plot). 
As a minimum there must be 1 + 4 * 8 lines in a polar input file. 
 

Elliptical interpolation 
When ODEON translates the polar input file it has to interpolate values between the four polar 
planes given in the input data. This is done using elliptical interpolation independently for each 
frequency band, creating the 8 x 4 plots missing between the four input plots. 
 
An example: Polar_Omni.dat The polar input format can be found in the 
DirFiles\So8_ASCII_input_file_samples\ directory, created at the installation of ODEON. 

When the complete directivity characteristics are known (FULL) 
The first non-comment line of the file should start with the word FULL. In the full case there are 36 
lines of data for each frequency. The first 36 lines are for 63 Hz, the next 36 lines for 125 Hz, and so 
on. 
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As a minimum there must be 1 + 36 * 8 lines in a full input file. 
• 1st line is vertical upper plot 0° (12 o'clock plot, when looking from the front of the source 

towards it, e.g. at a loudspeaker membrane). 
• 10th line is horizontal left plot 90° (9 o'clock plot). 
• 19th line is lower vertical plot 180°  (6 o'clock plot). 
• 28th line is right horizontal plot 270°  (3 o'clock plot). 
 
An example; Full_Omni.dat The full input format can be found in the DirFiles\So8_ASCII_input_file_samples\ 
directory, created at the installation of ODEON. 
 

When the directivity pattern is rotationally symmetric (SYMMETRIC) 
The first non-comment line of the file should start with the word SYMMETRIC. In the symmetric 
case there is one line of data for each frequency. 
 
As a minimum there must be 1 + 8 lines in a symmetric input file. The symmetric sources could be 
a Trumpet or the Omni directional source. An example; Symmetric_Omni.dat on the symmetric input 
format can be found in the DirFiles\So8_ASCII_input_file_samples\ -directory, created at the installation of 
ODEON. 

Creating a new directivity pattern using a text file as input 
Once the text input file has been created in one of the formats specified above (e.g. in the ODEON 
editor; ODEONEdit), it can be translated into an ODEON Directivity file, which can be applied to any 
point source from within ODEON. 
 
To translate the created text file into an ODEON directivity file: 
• Select Tools|Create directivity (.So8) from ASCII file (.DAT). 
• Open the input file you have created. 
• Specify the name of the directivity file pattern you wish to create. 
• Select whether you wish a Calibrated source or not. 
• Apply calibration data as prompted for. 
 

Applying Calibration 
When creating a new directivity file you will be asked whether to create a calibrated source or not: 
 

Calibrated source (Sound Power Level = 0 dB re 10E-12 W at 1 kHz) ? [YES / NO] 

Calibrated Sources 
Press [YES] if a generic source with an adjustable level is needed for ODEON-calculations. 
 An example on this could be the OMNI or SEMI directional directivity pattern. When selecting a 
calibrated source, no data apart from the ASCII input file are required. The directivity represented 
by the text-file is preserved, but the values are simply shifted by a constant amount (the same for 
all bands), so the sound power level of the source is 0 dB re 10-12 Watts at 1 kHz. Please do note that 
the power in the other bands may differ from 0 dB. You may still alter the overall power response 
of the source by applying an EQ, however the power at 1 kHz will always end up as 0 dB, and the 
other bands shifted accordingly. 

NON-calibrated sources – Electro acoustical sources, machinery, natural sources etc. 
Press [NO] to preserve the sensitivity of an electro acoustical source or the absolute level of natural 
source, e.g. a human voice. When selecting the NON-CALIBRATED source you are allowed to enter 
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equalising, electric losses (zero for natural sources) and sensitivity at a selected frequency band 
(zero for natural sources). 
 
The addition of electrical sensitivity, electrical input power and electrical loss values completes the 
data necessary to generate a source directivity file directly readable by ODEON 3 or newer. 
 
Other directivity text import formats 
Odeon supports the text import format used as input for generating binary CLF files. The format 
is specified in the CLF Trial Authoring kit available at http://clfgroup.org/clfdocuments.htm. You 
will though probably not write data in this format yourself, but it may be used for importing data 
exported from other software such as EASE SpeakerLab Pro. Odeon will store the imported data 
in its own native format .SoCF1Tab and .SoCF2Tab – unlike the CLF data these data are not 
traceable  therefore encourage that you only make use of these files for internal use and that you 
do not distribute them to third party. Similar do not make use of these files from an external source.   

http://clfgroup.org/clfdocuments.htm
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When the room geometry has been created (e.g. imported for AutoCAD or exported from 
SketchUp) and assigned sources and receivers, a next important step is to assign the acoustic 
materials to the surfaces of the geometry you.  
 

The Material list  is described in short in the Quick Start Guide (available online at 
https://odeon.dk/learn/quick-start-guides/). This manual will not repeat the content of the Quick 
Start Guide, so please read that first. 
 
The Material list consists of a window containing two lists, the Surface list on the left and the Material 

library on the right. The Materials list is connected to the 3D Materials window; when selecting a surface 
in the Surface list, the surface is automatically highlighted in the corresponding 3D Materials window. 
 

 

4.1 Material Library (Right side of Material List) 

Categories in the material library 
The Material library holds the materials you can use for your project. You can add new materials, 
delete existing materials and change them as needed. However, by default there is a numbering 
system which you can use to keep the overview.  
 
The default material database is divided into different categories (e.g. gypsum, wood etc.). Most of 
the materials categories spans a range of 1,000 (except for the first two). In each category, the first 
100 materials should be reference materials within the category. ODEON has suggested a few to 
begin with. Hereafter it will be possible to include 9 different manufacturers lists (e.g. one 
manufacturer with numbers within 1100-1199 and another within 1200-1299). Following this 
convention, the leftmost digit defines the type, the next one the manufacturer and the last two the 
specific material. 

 Materials 

https://odeon.dk/learn/quick-start-guides/
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See the numbering of the main categories below: 
• 1-99    Special materials. 
• 100-999   Concrete. 
• 1000-1999   Brick. 
• 2000-2999   Ceramics. 
• 3000-3999   Wood. 
• 4000-4999   Gypsum. 
• 5000-5999   Steel. 
• 6000-6999   Vinyl/Plastic/Plexiglas. 
• 7000-7999  Carpets. 
• 8000-8999   Curtains and blinds. 
• 9000-9999   Natural materials (e.g. sand, grass, water, etc.). 
• 10000-10999   Doors/Windows/furniture/inventory (e.g. organ pipes, ventilation grills, 

bookshelves). 
• 11000-11999   Audience areas +/- people. 
• 12000-12999   Mineral wool. 
• 13000-13999   Wood wool and alternative porous absorbers. 
• 14000-14999   Slit absorbers/ Micro-perforated absorbers/ miscellaneous. 

 

4.2 Special Materials 
Material 0 (transparent) 
Assigning Material 0 to a surface corresponds to removing the effect of the surface completely from 
all calculations. Therefore, surfaces with this material assigned: 
• Offer no hindrance to rays, neither in energy or direction. 
• Are excluded from the calculated active surface area of the room, and therefore do not affect 

the estimate of the room's volume produced by Global Estimate or Quick Estimate 
Reverberation. 

 
This feature can be used to temporarily "remove" surfaces such as doors or reflectors from the room 
- or to define a phantom surface which has no effect on the room acoustics simulation but over 
which an energy map (a grid) can be plotted. 

Material 1 (totally absorbing) 
The totally absorbent material (Material 1) can be used for modelling outdoor situations, e.g. an 
open roof. This is the only material, which will stop the rays during ray tracing. No reflections will 
be generated from surfaces assigned this material. Using this material when it is known that some 
surfaces are truly 100% absorbing can speed up calculations considerably. 
 

4.3 Editing/extending the Material Library and Surface 
List 

You can edit materials and the library in a multiple ways. Before doing so, it is important to know 
the difference between the .mat file (displayed in the Surface List file) and the .li8 files (Material library 

files). 
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• The Surface List is stored with every room. It contains all the materials assigned to surfaces 

in the room, and how you have changed the absorption coefficients of the materials assigned 
to the room in the bottom of the Surface List window in the Material List. These are is the active 
absorption coefficients in the room and will be part of calculations and are not affected by any 
changes made to the actual material library files after the materials have been assigned to the 
room.  
 

• The Global material library is the default library to be shown in the right side of the Material 
list window. This library, and any changes you make to it, will be available every time you 
start a new or old project on your computer. The Global library is stored with Odeon on your 
PC, so if you make changes to it, it will be different from the Global library on another 
computer. This does not hinder that projects can be sent back and forth between colleagues, 
because the .mat file is not affected by changes to the library file unless the modified materials 
are reassigned to the room surfaces.  

 
• Additionally, you can make a Room material library. If you press the Toggle between global and 

local room library button, you will create a material library for the room you are in. It will only be 
active in that room and not globally on your computer. This is good as a sandbox, in order to 
avoid messing up the Global library when working.  

 
You can change from local to global as you please, the Surface List will not be affected by any change 
unless you actively change the assigned materials. 

Change materials in Surface List 
You can change the absorption data in the Surface List. The sound absorption values given in the 
bottom of the Surface List can be edited by clicking the cells and changing the values. These changes 
will affect all surfaces the material is assigned to but not the material library. If you have made 
changes in the library then the materials have to be reassigned for the new values to be used for 
the surfaces.  

Change materials in libraries 
There are several ways you can change the libraries. For both the local and global library, you can 
use the buttons add, edit and delete material. This will cause a change in the libraries, but not in 
the assigned materials (.mat file). You can also press the Edit material library file button to go to the text 
file of the library, where it is easier to make multiple changes to materials. You can also use an excel 
sheet or similar, as described later.  

Data format for materials in Material.Li8 
The data format for a material in Material.Li8 and [roomname].Li8 is very simple; each material is 
described by two lines: 
 

ID_Number   Descriptive_text  
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α63 α125 α250 α500 α1k α2k α4k α8K 
 
ID_Number must be a unique number between 0 and 2.147.483.647. 
 
Descriptive_text should inform details of the material and a reference to the source, where the 
absorption is documented. This reference can be a link to the manufacturer’s internet page or the 
measurement report written e.g. as http://odeon.dk or with the three w’s like www.odeon.dk. The 
reference link is displayed as an active link which can be clicked on within the material 
specification cell in the Materials List. Clicking the link will open the specified page in the default 
internet browser. 
 
The absorption coefficient α for each octave band should have a value above 0.00 and maximum 1.00. 
If no data is available for upper or lower bands, do not write 0.00. Instead, use the value of the 
neighbouring band (e.g. use the value in the 4 kHz band for the 8 kHz band as well). 

Import materials from an Excel sheet (or similar software) 
If you have many materials, or you have an old list of materials made in Excel or similar, there is 
a setup for Excel sheets that allow you to import it to Odeon. The way to do this and the setup 
can be found on https://odeon.dk/downloads/materials/acoustic-absorption-data/. 

Special Materials which should not be changed! 
There are three special materials in the library: 
• Material 0, transparent  
• Material 1, totally absorbent 
• Material 2, totally reflective 
 
Although the material library Material.li8 may be edited, material 0, 1 and 2 must remain as originally 
defined. 

4.4 Surface List (Left side of Material List window) 
In the surface list, you will find the material specifications assigned to the surfaces. The list consists 
of either all surfaces in the room, or a subset of chosen layers if using the Set Layers option (the Ctrl+L 
shortcut).  
 

 

http://odeon.dk/
http://www.odeon.dk/
https://odeon.dk/downloads/materials/acoustic-absorption-data/
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Surface number 
The Surface number is a unique number assigned to each surface in the geometry file. Odeon uses the 
surface number for attaching the correct material data (and grid surfaces, reflector surfaces etc. 
elsewhere in the software). If generating the geometry in SketchUp using the Odeon SU2Odeon plugin 
to export the geometry to Odeon then the numbers are generated and stored in the SketchUp model 
ensuring that numbers stay consistent even when making changes to the SketchUp model and 
reexporting it again. When importing a geometry e.g. in the .dwg, .dxf and .3ds file formats the surface 
number will be generated by Odeon – and the surface order may not be the same next time the 
geometry is reimported if changes was made (e.g. deleting, adding or changing some surfaces). 
Therefore, if reimporting geometry one should ensure that data e.g. material properties) assigned 
to surfaces are still correct and if not – correct them. 

Material number 
The number of the material that is assigned to the surface from the material library. This number 
and material correspond to the number listed in the material display, except when: 
• The material has been edited in the material library after the material was assigned to the 

surface (e.g. its absorption coefficients have been changed). 
• The material has been edited in the Surface List, where the absorption data can be edited.  
• The material was assigned on another computer where another material library was available, 

with different definitions of the material having this number. 
 

 

Scattering coefficient 
Here you assign the scattering coefficient of a surface, which by default is 0.01 (1%). Scattering is 
assigned per surface, not per material. This is because scattering depends on the roughness and 
structure of a surface and not the absorption coefficient. For example, two surfaces might have the 
same absorption coefficient (same material) but different structure. Therefore, scattering will be 
different for each of them. See more in the following section.   

Transparency 
By default, every surface is not transparent (0%). If there are some openings that could let sound 
travel through without being absorbed, then these openings can be considered as transparency, 
rather than be modelled explicitly. For example, for a layer of blinds being only 30% open, the  
transparency for that surface can be set to 0.3. See more about transparency in Sec. 4.6. 
Transparency should not be used for transmission calculations. See more about Transmission in Sec. 
4.7.   

Type  
By default, every surface is normal. In some cases the wall type should be changed to Exterior, 
Fractional and Transmission. See more in Sec. 4.7. 

Remember: Once a surface has been assigned a material, this material stays the same for that surface, 
even though the material has been changed in the material library (the Material.Li8 file) - thus calculated 
results stay consist with the materials assigned to the room even if the room is moved to another PC 
with a different material library. If you want to use an edited version of the material you can reassign 
the material, e.g. using the Global Replacement option. Another option is to change the absorption 
coefficients of a room material using the edit field below the surface list in the left side of the materials 
list – doing so will change the absorption of all surfaces which have been assigned that material –the 
material will not change in the material library in the right side of the Materials List. 
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Layer  
Shows the name of layer at which the surface is located in the SketchUp model or in your CAD 
application if the model is imported in the .dwg  or .dxf file formats. For .3ds  and .obj file, the layer 
name corresponds to the name of the material used. 

Area 
Shows the calculated area for each surface. Occasionally, a surface can get a wrongly calculated 
area which can even turn out to be 0. This will be the case if the edges of the surface are crossing 
each other, e.g. resulting in a so-called butterfly surface. It is always a good idea to eliminate such 
surfaces, by simplifying the model.  

4.5 Scattering coefficient 
While the absorption coefficient controls the amount of sound energy that is absorbed from a surface, 
the scattering coefficient determines the way sound energy is reflected. The basics will be explained 
below. For a deeper understanding of scattering coefficients, please refer to Chapter 9 (Calculation 
Principles). 
 
We can group reflections in rooms in three categories: 
• Specular reflections: where the angle of reflection is equal to the angle of incidence. 
• Diffuse reflections: where the angle of reflection is independent of the angle of incidence 

(memoryless reflection). 
• A mixture of the cases above. 
 
By default, ODEON uses a mixture, based on the scattering coefficients the user choses in the Surface 

List and scattering caused by diffraction (estimated by Odeon if Reflection Based Scattering is enabled in 
the Room Setup) You can change this to only using specular reflections in the Room setup, but this is 
only recommended for educational purposes and research). 
 
The scattering coefficient is assigned to each surface in the Surface List. It accounts for the roughness 
of the material at mid-frequencies (707 Hz). By default, ODEON will expand this scattering to 
appropriate scattering for the other frequency bands, using typical behaviour of scattering in 
relation to frequency.  
 

 
 
The frequency dependent scattering is described in more detail in Chapter 9 about Calculation 
Principles. The scattering coefficients can be assigned values between 0 and 1. 
 

 
 
If some details are not modelled in a room then the scattering coefficient may need to be increased 
– a coffered ceiling where the coffered cells have not been modelled may typically have a value of 
0.3 to 0.4 (for the mid frequencies, 707 Hz). 
 

Remember: As a user you can only assign one value of scattering coefficient per surface. This value 
corresponds to 707 Hz (the exact middle between 63 Hz and 8000 Hz, in a logarithmic scale). However, 
ODEON gives different weighting for the rest frequencies, according to the curves in Sec 9.5: Lower 
frequencies have less scattering, while higher frequencies have higher scattering.    

Note: Some acousticians call the scattering coefficient diffusion coefficient, but this is wrong. The diffusion 
coefficient describes the degree of diffusivity in the sound field in space or reflected from a surface, while 
the scattering coefficient determines the fraction of sound which not reflected in the specular way from 
a surface. A high scattering coefficient can lead to a high diffusion coefficient, but the two values are not 
directly linked. 
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The scattering coefficient (at the mid-frequency 707 Hz) that should be used for various materials 
is an ongoing research area. Our current recommendations are the following values: 
 

Material  Scattering coefficient at mid-frequency (707 Hz) 
Audience area 0.6–0.7 
Rough building structures, 0.3–0.5 m deep  0.4–0.5 
Bookshelf, with some books  0.3 
Brickwork with open joints  0.1–0.2 
Brickwork, filled joints but not plastered  0.05–0.1 
Smooth surfaces, general 0.02–0.05 
Smooth painted concrete 0.005–0.02 

 

With the suggested scattering coefficients, it is assumed that Reflection based scatter has been enabled 
in the Room setup, in which case Odeon will account for effects such as distance, angle of incidence 
and edge diffraction (read chapter about Calculation Principles for more info). If Reflection based 

scatter is not enabled, then it is recommended to use a higher scattering coefficient for general 
surfaces, such as 0.1 (0.3 may be more appropriate for disproportionate rooms such as class rooms).  
 
As it has been explained in Chapter 2, an architectural model may need to be simplified for room 
acoustic calculations. In the figure below, a typical cross section of a diffuser is shown. The surface 
is not planar; it has a pyramidal structure, which needs to be simplified as a flat surface. 
Compensation for this simplification can be made by using an appropriate scattering coefficient. 
 
 
 
 
 
 
 
 

 

 

For the depth of structure d2 , the scattering coefficient is found from the graph below. For example, 
if the depth of a 1D diffuser is 2d = 10 mm, the scattering coefficient will be approximately 0.005 
(0.5%). The same process can be applied for any rough surface – not only a uniformly shaped 
diffuser. In this case an average depth of structure should be used. It is important to understand 
that even a few rough objects sparsely placed on a surface increase the scattering coefficient a lot. 
The default scattering coefficient in ODEON is set to 0.01 (1%) which corresponds to a diffuser with 
a depth of around 15 mm. A scattering coefficient of 1% is on the low side, often a coefficient of 3-
5% is more realistic. Using the low scattering coefficient of 1% will highlight potential acoustics 

Suggested scattering coefficients to use for various materials. The given values are to be assigned to surfaces in 
ODEON and correspond to the middle frequencies at around 700 Hz. Suggestions may be subject to changes as 
more knowledge on the subject is achieved. 

A diffuser with a depth of structure equal to d2 . This type of structure is simplified in ODEON by modelling 
it as a plane surface and assigning scattering coefficient according the frequency functions described 
above. 

Remember: Structures with high roughness should be modelled as planar surfaces. The lack of detail can be 
compensated by choosing an appropriate scattering coefficient, according to the depth of the structure. 

2 
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problems like echoes and long reverberation times due to flutter echoes – only if you are fairly 
confident that the surfaces will provide more scattering should the default values be increased. 

Most of the times the surface does not need to have an exact shape as the example to provide high 
scattering. For example, a window or picture frame on a flat wall can introduce as much scattering 
as the uniform diffuser shown above. 

 

 

4.6 Transparency coefficient – semi-transparent 
surfaces 

A transparency coefficient can be assigned to each surface; this is a way to make the surface semi-
transparent. This feature may be used when modelling many small surfaces grouped together, in 
a simplified manner. E.g. a reflector panel built from many small surfaces with space in-between 
or an installation ceiling can be modelled as one large surface having a transparency coefficient of, 
e.g. 0.5. The transparency coefficient can be assigned values between 0 and 1: 
 
• 0.0 is the default value assigned to all solid walls. This value should always be assigned to the 

boundary walls of the room; otherwise rays will escape from the model. 
 

• Very small transparency coefficients should be avoided unless the number of rays is increased 
substantially. Instead consider modelling the surface as solid. Using a transparency coefficient 
larger than zero will cause the Image source method to be discarded for rays hitting such 
surfaces (only relevant for point sources). Another problem is that only very few rays will be 
transmitted, making the results on the other side of the surface statistically unreliable. 

 
• Very large transparency coefficients, e.g. 0.95 should also be avoided. Instead consider 

removing the surface from the model, or more easily, assign Material 0 (transparent) to the surface. 
 

 
 
The Transparency value should not be used for modelling sound transmission through walls - 
instead you should use the Transmission wall type for this purpose as explained below. 
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Note: If entering scattering and transparency coefficients between 1 and 100, ODEON will assume that 
the values are in percent and divide values by 100. 
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4.7 Different Wall Types 
The wall type controls what happens when a sound ray hits a surface in ODEON.  
 
There are four different wall types in ODEON. The Normal, Exterior and Fractional types relate to the 
way Reflection Based Scattering is calculated for sound reflecting from the surfaces. 
 
The Transmission type is for walls that transmit sound to another room. 
 
• Normal is the default value. It results in default handling of scattering and diffraction taking the 

Reflection Based Scattering method into account if it has been enabled in the Room setup. 
 

• Exterior forces a surface to be handled as an exterior surface even if it was not been detected as 
such by ODEON. The result is that less diffraction is applied at the lowest frequencies where 
offset in the wall is not sufficient to result in low frequency diffraction. 

 
• Fractional should be used for surfaces which are fractions of a bigger whole. This could be surfaces 

being part of a curved wall or a dome. These surfaces should not cause diffraction due to their 
individual area, and therefore the individual surfaces do not provide any significant edge 
diffraction.  
When setting the type to Fractional, the surface area used for calculating the Reflection Based 
Scattering Coefficient is determined from the box subscribing the room. If the construction part 
which the fractional surface is part of is considerably smaller that the 'room box', the scattering 
might be underestimated and a higher scattering coefficient should be assigned to the surface. 

 
• Transmission is for walls which transmit sound to another room. When this wall type has been 

selected, it is possible to edit the transmission data to specify the reduction index (transmission 
loss). It will also be possible to link the wall with another surface in case the wall is composed 
of two parallel surfaces with a distance between them, and possibly with different surface 
materials on either side.  
When the Transmission type is assigned to a surface, 90% of the rays hitting the surface will be 
reflected and 10% will be transmitted. The energy calculations are accomplished by multiplying 
each ray (or particle) with the appropriate frequency dependent energy parameters. 
Transmission is covered in Appendix B: Specify Transmission Though Walls. 
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4.8 Manage material library and material list 

Material Toolbar 
Below is a guide to the Material List Toolbar. For the “Repeat…” buttons described below, 
remember that the scattering coefficient, transparency or wall type of a surface needs first 
to be entered in the Surface list in the appropriate cell using the keyboard or mouse. 
 
• Assign Material : Assigns the material selected in the material list to the surface(s) 

selected in the surface list. 
 

• Global Replacement : Replaces all instances of a material. The material assigned to the 
selected surface in the Surface list will, at all instances, be replaced with the material 
chosen from the material list. This is useful if you wish to try out different materials 
on a number of surfaces that share the same material.  

 
• Global Assign to Layer : Assigns the selected material to all surfaces on the selected 

layer. 
 
• Assign Material for all Surfaces : Assigns the material selected in the Material list to all the surfaces in 

the Surface list. Using the Set Layers button explained further below, the material will only be 
assigned to the currently active surfaces. 

 
• Repeat Scattering Coefficient for Selected Surface(s) : Assigns the last scattering coefficient entered in 

the Surface List to the current selected surface. Select multiple surfaces to which you want to 
repeat the scattering by holding down Shift and using the arrows.  

 
• Assign Scattering Coefficient to All Surfaces : Assigns the scattering coefficient of the currently 

selected surface to all surfaces. 
 
• Repeat Transparency Coefficient for Selected Surface(s) : Assigns the last transparency coefficient 

entered in the surface list to the current selected surface. Select multiple surfaces to which you 
want to repeat the transparency by holding down shift and use the arrows.  

 
• Repeat Wall Type : Assign last chosen wall type entered in the surface list to the current selected 

surface. Select multiple surfaces of which you want to repeat the wall type by holding down 
Shift and using the arrows. 

 
• Quick Estimate : For a fast evaluation of reverberation times and listing of summarized 

absorption areas, while assigning materials, etc. Not as accurate as a full simulation, but useful 
for quickly experimenting with different configurations before running a more lengthy 
simulation. 

 
• Add material(s) /Edit a material /Delete Material /Edit Material Library File : These four buttons allow 

you to create new materials or to edit existing ones in the material library. The material editor 
also assists in mixing different materials into one. Alternatively, it is possible to edit materials 
directly in the material library file. 

 
• Reload Material Library : Loads changes that were made directly in the material library file. 
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• Search for Surface or Material with name… : Enable a search field in the Surface list to search for a 
surface based on any column. 

 
• Toggle interior/exterior : Cycle between showing interior surfaces, exterior surfaces, and both. 

 
• Set layers : Enable or disable layers from showing up in the surface list and in the model. 

 
• Toggle between Global and Local Material Library : Switch between the Global material library and 

Local material library. 
 
• Remove Extreme Absorption : Removes absorption coefficients below 0,05 and above 0,95 from the 

materials in the surface list. This should be used to make sure that the absorption is estimated 
correctly. This because the extreme values in selected absorption coefficients can have an 
extreme effect on results as well (Oppenheim, et al., 1989).  

4.9 Opening a room from an earlier version than version 
10  

The material library has been changed radically since Version 10. The numbering of materials in 
the Global material library has changed and many redundant materials have been removed. 
Therefore, some automatic update mechanisms of local material library have been implemented to 
make the transition as smooth as possible: 
 
If your model already had a local room library from the old version and you open it in ODEON 
Version 10 or later - then the Global material library will be the new ODEON library and the local 
room library will still be exact the same as you created in the old version. 
 
If your model did not have a local material library in the old version and you open it in ODEON 
Version 10 or later - then the numbers in the local room material library will automatically change 
depending on three criteria: 
1. Materials from the surface list that are matching the new global material library will stay the 

same. 
2. Materials that are not in the global material library – but where there is room for the original 

number from the surface list in the material list - is added to the room material library with the 
same number. 

3. Materials that are not in the global material library, but already have a number and which 
conflicts with a number from the new material library, will be re-numbered at the end of the 
local room material library. 

 
If you are not satisfied with the new global material library, the library can be replaced with another 
library in the materials folder which can be opened from the Options|Explore materials file folder menu.  
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This chapter covers the different calculation types available and the results they provide. To learn 
more in detail about acoustic parameters and decay curves, please read Chapter 8 and for the 
theory behind Odeon calculations read Chapter 9.  
The software is made in such a way that you can easily calculate the most common results, making 
it easy to get started as a new user. Using the available options from the context-sensitive menus and 
keyboard shortcuts, you have access to more advanced displays covering a broad range of results.  
 

 

5.1 Global Calculations 
Global calculations in ODEON are the ones that do not depend on receiver positions. They still 
use a source, but results refer to the room as a whole. 

Quick Estimate  
Quick Estimate is a fast calculation of reverberation time which is found in the Material List, t. It is based 
on analytical formulas like Sabine’s and Eyring’s, which do not take into account the actual 
geometry and position of materials in the room, but only the amount of absorption and volume.  
 

 
 

 Calculations and Results  

Remember: As Described in the Quick Start Guide, the menu between Toolbar and Options always gets 
updated with the active Window inside ODEON. Click that context-sensitive menu to retrieve all possible 
functions and Shortcuts for the corresponding Window.  
Always press F1 when you need to learn more about specific functions in ODEON. The smart help will 
open to a page related to the active window. The ODEON help file complements the manual and offers 
extra information.  
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The tool can be used for a fast overview of acoustics in a room, while assigning materials. Several 
informative tabsheets are available: 
• Estimations provides fast estimation of RT based on analytical formulas, not the geometry. Only 

for a first glance while working with materials. The estimated reverberation time is a good 
starting point to define the impulse response length in the Room Setup . A good rule of thumb 
is to set the impulse response length 2/3 of the maximum reverberation time in the Quick Estimate. 

• Material Overview offers an overview of used materials, with the corresponding absorption areas 
they occupy.  

• Unused absorption shows which surfaces/materials have a lot of unused absorption to offer. 
• Estimate area can calculate absorption area which needs to be added in order to meet a specific 

target for RT.  
• Alpha shows all the absorption coefficient curves for the different materials used in the room in 

one graph which can be used for a quick comparison or for inclusion in a report. 

Global Estimate  
The Global Estimate is found in the top toolbar. It makes use of ray tracing in order to calculate the 
overall/global reverberation time in the room. The tool is much more accurate than the Quick Estimate 
and it depends on the selected source at the bottom drop down menu. The  calculation is receiver-
independent, giving an average result for the whole room volume, while in reality there will be 
some local variation though normally the reverberation time is fairly constant for a room.  
 

 
 

5.2 Point response calculations 
A point response calculation gives the response of the room for a particular receiver position (with 
a given orientation). The point response is generated as a response to one or multiple sources 
emitting a Dirac delta function (see vocabulary) at the same time (each source can be assigned an 
individual delay). ODEON simulates the impulse response between the source(s) selected and each 
receiver, out of which all Room Acoustic Parameters are calculated (see Chapter 8). Point responses 
are managed from the Job List window  which can be populated by up to 1000 jobs. 
For each Job, the desired active sources can be selected from the available sources in the pane on 
the left side of the Job List (or upper side if the Job List window size is small). Please check the Quick 
Start Guide for an overview of the Job List, with examples of use.  
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Three types of calculations can be carried out with the source(s) selected for each job: 

Grid Responses (I)(A)(C) 
Room Acoustic Parameters (see Chapter 8) will be calculated for the surfaces selected in the Define 
Grid in form of colour maps. For an overview on defining grids see Chapter 6. To calculate a defined 
grid, make sure to tick both the Grid checkmark on top of the column, as well as the checkmark for 
a particular Job. Click the Run Job button  to run the job. Once the calculation is finished, the job 
turns green.   
To see a calculated Grid Response, click the calculated desired Job then click the View Grid Response button 

 (shortcut Alt+G).   

Multi Point Reponses (B)(I)(A)(C) 
Room Acoustic Parameters (see Chapter 8) will be calculated for ALL receivers defined in the Source 

Receiver list. This allows to see parameters for each receiver alone or statistics for them. After point 
responses have been calculated for all receivers it is possible to create groups of receivers allowing 
results, statistics etc. to be displayed for a subset of the calculated receivers. To calculate a Multi-
point response, make sure to tick both the Multi checkmark on top of the column, as well as the 
checkmark for a particular Job. Click the Run Job button  to run the job. Once calculation is 
finished, the job turns green.  
To see a calculated Multi-point Response, click the calculated desired Job and then click the View 

Multi point response button  (shortcut Alt+M).   

Available Results in the Multi Point Response 
Here is a short overview of the available tabsheets in the Multi Point Response. To navigate the results, 
check the functions in the context-sensitive menu bar. If needed, use the help file for additional info. 
Find the help file by pressing F1 when the display of interest is selected (context sensitive).   

 
3D Sources and Receivers displays the sound sources and the receiver currently active. On the right side 
of the tabsheet you can select groups of receivers, specify which receivers should be active in the 
selected group and save the selected group for later use (remember to do so). The result displayed 
in the multi point response display will be for the receivers currently active. If only one receiver is 
active then some of the tabsheets listed below will not be displayed. 
 
Energy parameters displays the calculated acoustic parameters in table format. The parameters could 
be EDT, T20, C80 and etc. The parameters can easily be selected and copy-pasted into e.g. EXCEL if 
you are interested in making graphs or statistics outside ODEON.  
 
Energy Parameter bars (1) displays the calculated acoustic parameters as bars graphs as a function of 
frequency (octave bands). The parameters could be EDT, SPL, C80 and etc. Use the arrow keys to 
navigate between parameters and the R shortcut to change Receiver. 
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Energy Parameter bars (2) displays calculated room acoustic broadband parameters. The horizontal axis 
displays the receivers.   
 
Parameters versus distance displays parameters as a function of distance, by having the receivers lined 
up from the nearest to the one furthest away (from the source).  
 
Statistics displays statistical calculations of parameters for the selected receivers, e.g. Average, 
Standard deviation, Min/Max values.  
 
Spatial decay curve displays parameters based on ISO 3382-3, for open plan offices, but only if the 
simulation setup is according to the standard. See application notes ISO 3382-3 Open Plan offices - 
part 1 and 2 about using the standard in ODEON: https://odeon.dk/learn/application-notes/.  

 
STI versus distance also displays parameters based on ISO 3382-3, parameters for open plan offices, 
but only if the simulation setup is according to the standard.  
See application notes as above. 
 
Measured versus Simulated display measurements and simulation results for the same room you have 
imported measured results. This is a very useful tabsheet that allow making sure that a model 
matches well to reality in an acoustical renovation projects or to verify your work after a simulated 
room has been built.  

Single Point Responses (A)(C) 
In contrast to the Multi Point response, the Single Point response derives the impulse response and Room 
Acoustic Parameters for one receiver only. The Single Point response allows for more detailed results, 
graphs and curves, as well as for auralisation at the receiver position (see Chapter 7). To calculate 
a Single Point response, make sure to tick the Single Point Response Receiver checkmark on top of the column, 
as well as to select a Single Point response receiver from the drop-down list in the Job List. Click the Run 

Job button  to run the job. Once calculation has finished, the job cell turns green.  
To see a calculated Single Point Response, click the calculated desired Job and then click the View Single 

Point Response button  (shortcut Alt+P).   

Available Results in the Single Point Response  
Here is a short overview of the available tabsheets in the Single Point Response. To navigate the results, 
check the functions in the context-sensitive menu bar. If needed, use the help file for additional info. 
Find the help file by pressing F1 when the Single Point Response is open (context sensitive).   
 
Parameter bars display the calculated acoustic parameters in bars graphs as a function of frequency 
(octave bands). Parameters could be EDT, SPL, C80 etc. Use the arrow keys to navigate within 
different parameters. 

 
Energy parameters display the calculated acoustic parameters in table format. Paarameters could be 
EDT, T20, C80 and many more. It is easy to select, copy and pasted the parameters into e.g. EXCEL 
if you are interested in making graphs or statistics outside ODEON.  

 
Decay curves display the decay curves for each frequency band. Read about decay curves in Chapter 
8. 
 
Decay Roses display how much sound energy is received at cumulative time intervals in the 
horizontal and vertical planes. This can give an idea of how different parts in the decay are formed 
throughout time. 
 

https://odeon.dk/learn/application-notes/
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Reflection density display how many reflections arrive at the receiver position per millisecond as a 
function of time. The graph can be used for judging if enough rays have been used in the 
simulation. A rule of thumb is to have at least 50 reflections per millisecond.  
 
Reflectogram displays the arrival times and strength of Early Reflections arriving at the receiver. Time 
starts counting (0 sec) from the moment the direct sound arrives at the receiver. 
 
3D Reflection paths/Active sources visualises the reflection paths corresponding to the reflections in the 
reflectogram. Use the options from the context-sensitive 3D Reflection Paths menu to exhaust all the 
possibilities of the tabsheet. 
 
BRIR shows the Binaural Room Impulse Response. Only available if activated in the Auralisation 
setup (Chapter 7). The impulse response is filtered for left and right ear, according to the HRTF 
(head-related transfer function) used.  
 
Dynamic diffusivity curves is a specialized research tool for diffusivity. Use the help file (F1) for a 
thorough explanation.  
 
Dietsch echo curves is a tool which helps investigating noticeable echoes. Use the help file (F1) for a 
thorough explanation.  

Auralisation (A)(C) 
Closely related to the Single Point response, the auralisation features in Odeon which makes use of the 
simulated impulse response and combines it with an anechoic (dry) wave file, providing a realistic 
listening experience at the receiver position. In simple words, auralisation gives you the ability to 
virtually place yourself in the room and listen to what any signal sounds like at that position. Please 
read Chapter 7 for a detailed tour. 

5.3 3D-matrix Calculation 
The 3DMatrix calculation is a special type of point response calculation which allows investigating 
the response from one source position at other source positions without the need to define any 
receiver positions. This make it easy to investigate scenarios where sources by nature acts source 
as well receiver. Examples on this may be the occupants in an open plan office or the musicians in 
an orchestra. 
The 3DMatrix utility calculates a matrix of all the point responses from each point source to all the 
other point sources. So, if three-point sources are defined then nine combinations are calculated; 
S1S1, S1S2, S1S3, S2S1, S2S2, S2S3, S3S1, S3 S1 and S3S3.  
The responses S1S1, S2S2 and S3S3 are special in that the source and the receiver coincide. 
Obviously, the direct sound in these combinations would go to infinity due to the source-receiver 
distance of zero. So, in these cases ODEON excludes direct sound. These values occupy the 
diagonal in the source-to-source matrix and are referred to as diagonal values. Although the 
diagonal values are not values that can be physically measured, we do believe that the values can 
give valuable information e.g. as to how loud the room sounds for the source’s point of view. 

The 3DMatrix window has 3 tabsheets:  

  

 

 
3DMatrix Matrix  3DDiagonal 
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3DMatrix, Matrix and 3DDiagonal (self response). For all the displays the selected parameter is displayed 
at the selected frequency (for parameters that are frequency dependent).  
In the 3DMatrix display, double click on a source to make it the active one. Its response is then 
visualized at the other source positions. The Matrix display is difficult to read as there is no obvious 
way to order the sources at the two axis (source/receiver) e. g. distance. However, as all values are 
displayed at one graph, it is possible to spot extreme values. Double clicking a value in the graph 
will be displayed in the appropriate 3D display – the 3DMatrix or the 3DDiagonal. The 3DDiagonal shows 
all the diagonal values for all sources in one 3D graph. 
 

5.4 Results from measurements 
All ODEON editions include a measuring system that makes it possible to capture impulse 
responses in real rooms. ODEON calculates all parameters from measured impulse responses and 
allows comparison with simulations within the Multi-point response interface. For a full overview of 
results from measurements see in Chapter 12. 
 

5.5 Visualisation Tools 
Visualisations in ODEON help to get the overview of sound propagation in the room model and 
they form a great tool for demonstrations to clients that are not familiar with Room Acoustic 
Parameters and scientific terms. Visualisations can provide great screenshots and animations for 
presentations, but should not be used for accurate predictions.  

3D Billiard   
A number of billiard balls are emitted from a source position and gets reflected by the surfaces of 
the room. This is a useful animation tool which visualizes how a burst of sound will propagate in 
the model and to track specific phenomena like flutter echoes or focusing from curved geometries. 
Scattering is included in the animation and to some degree it is also possible to enable visualization 
on how sound gets absorbed. By default, balls change colour every time they are reflected from a 
surface, as an alternative colour can be used for visualization of strength. Read more about the 
different options by pressing F1 in the in this window or by seeing our tutorial videos on our 
website. 

3D Reflector Coverage    
In the 3D Reflector coverage you can visualize which areas a given reflector will cover, up to the 
specified order of reflection. Use the Define reflector surfaces window first in order to define which 
surfaces in the model will act as reflectors.  

3D Investigate Rays  
Rays are emitted from a source, and can you view them as the reflect from the surfaces in the room. 
This is mainly a tool that can be used for checking the geometry for holes. Enable the Display sticky 

lost rays only option to be able to see which rays escape from the geometry and to manage locating 
leaks in your model.  It can also be used for purposes like investigating how the scattering 
coefficients affect backscattering in tunnels, or in what way sound is distributed in coupled spaces. 
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6.1 Overview 
The 3DGrid display displays maps room acoustics parameters in the 3d model. It is a good way to 
present an acoustic parameter in the complete room or for a selected part of it using grid groups. 
It can be used for displaying the variation throughout the room, to provide statistics for the defined 
grid receivers and it is a useful for spotting locations of acoustical problems as well.  
The colour grids option is first presented in the Quick Start Guide and the help file contains a lot of 
information (press F1 from within the 3DGrid display). This chapter will give an overview and 
some extra details. Grids can be defined, calculated and manipulated in four places inside ODEON: 
In the Define Grid, in the Job list, in the View grid response and in the Room Acoustic Parameter list. 

Define grid  
These windows are where you define which surfaces you want to make grids on. The left side 
contains a list of the Room surfaces. Choose to show horizontal and/or vertical surfaces from the 
options at the bottom. Use the Depth column to help you locate the surfaces you are interested in. 
Sort surfaces by clicking on the arrow just next to the column title.  Use the hand  to move 
surfaces to the right side that contains the list of Selected surfaces for the grids.  
 

  
 
You have multiple setup possibilities. Some of them are:  
• Choosing the distance from the surface to the hovering grid. 
• Choosing the same surface multiple times with different distance to make grids in layers. 
• Choosing the distance between receivers (squares) in the grid, thus changing the resolution. 

Be aware that higher resolution increases calculation time exponentially.  
• Grouping the grid surfaces – which will allow display of selected parts of the grid (and 

calculation of statistics of that subset of the grid receivers). 
Use the context sensitive help (F1 shortcut) to learn more about the individual options.  

 Colour Grids – colour maps 
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Joblist 
The Joblist is the window where you choose for which jobs to make a grid calculation and thereby 
which sources should be active. Enable the grid calculation for a Job by checking the grid checkbox 
Grid for the job(s) you are interested in. To calculate jobs, click the Run Single Job or Run All Jobs button 
in the right-side toolbar of the Job List. Once a grid job has been calculated its cell in the Job list will 
be green, to view results click the View grid response in the right-side toolbar of the Job List. 
 

 
 
The sound sources for the grid calculations will be those activated for the job. The receivers 
however, does not relate to the job instead each grid receiver is the centre of each of the squares as 
defined in the Define Grid windows.  

View grid response 
Once a job containing a grid has been calculated (turns green), it is ready to display grid results. 
Click View grid response  to see the calculated grids. Use the arrow-keys to change parameters and 
frequency band.  
By default, an interpolated grid (a feature introduced with ODEON 15) is displayed. Click 
3D_grid>Interpolate Grid (shortcut I) to disable interpolation and see the individual calculated grid 
receivers (squares).  
If grid groups has been defined in the Define Grid window, then it is possible to display subsets of 
the grid surfaces using the G and Shift+G shortcuts. 
 

 

Room acoustic parameter list 
Here you can change the colour, range and labels for your grids.  

 

Remember: Before any calculations have actually been performed, the colours displayed in the Define 

grid are random. 
 

Remember: Disabling the Interpolate Grid option (shortcut I) will allow you to navigate between grid 
results faster. 
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6.2 Accuracy in the Interpolated Grids 
Before version 15, a grid in ODEON was just a grid of squares. Interpolation has made it possible 
to obtain visually appealing maps for reports much faster, since one can achieve a very smooth 
image with few grid receivers (squares). You can toggle between the normal and the interpolated 
grids by choosing 3D_grid>Interpolate Grid (I shortcut) while working in the View grid response.  
Even though grid interpolation looks attractive even when only a few number of grid receivers 
were calculated, be aware that the actual calculation is still done for limited number of grid 
receivers defined, keep in mind that the grid resolution should be high enough (and the receiver 
distance low enough) to display interesting trends in the room. On the other hand, a coarser grid 
will speed up the calculations and might look smoother whereas a too fine grid might give a false 
idea of how accurate the model actually is. Find your own compromise between the two, 
considering the room size, complexity of the geometry and calculation time. 

Quite fine grid with 0.75m between receivers: 
 
EDT: 

 

Quite rough grid with 3m between receiver:  
 
EDT: 

6.3 Range, Colours and Labels for Grid Display 
There are three display parameters for the grids of each acoustic parameter: range, colours and 
labels. 
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Range 
The range of the grid (min to max values) is set automatically by default for most acoustic 
parameters. For STI and similar parameters the limits are by default set to a manual scale ranging 
from 0 to 1. For the other parameters, the range will start around the lowest calculated value 
(extreme values are excluded) and go to around the highest calculated value (extreme are 
excluded). The min and max values for each parameter are the same across the octave bands.  
To use a manual grid range, go to the Room acoustic parameter list  and press the Expand tables button 

 in the upper-right corner. Check the Manual grid box for the desired parameter and set the new min 
and max values. The manual ranges remain fixed between calculations, making it easier to compare 
results before and after a change in the model.  

Colour and Labels  
By default, only a few colour scales are used: the Geography-inspired colour scale and the STI-color 
scale. Particularly for the STI parameters, the colour scale is divided into different categories from 
“Bad” to “Excellent”.  
Colour scales can be defined for all parameters in the Room acoustic parameter list. A few of these 
include labels. You can also make you own colour scale with labels from scratch, but this is a bit 
more complicated. It requires to copy and edit one of the .clr files found in the C:\ProgramData\Odeon 
folder. The ProgramData folder is hidden in Windows by default but you can access this ODEON 
folder form the menu Options|Explore Odeon Application data folder from within ODEON. 
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(Combined and Auditorium editions only) 
 

Auralisation in ODEON makes it possible to listen to the acoustics of simulations and 
measurements. It provides an experience of room acoustics through headphones or through 
speakers, instead of just reading numbers. It can also be a good way to present acoustical results 
for a client who is not familiar with acoustic terms and parameters. 
An auralisation is a pairing of the acoustics of a room with an audio file. This way you can listen 
to auralisations of speech in a canteen, an orchestra in a concert hall, disturbance from co-workers 
in an open plan office etc.   
Although ODEON tries to make the available auralisation features as easy as possible to use, a 
chapter is needed, as this is where the threads from; room acoustics modelling, signal processing, 
wave signal files, transducers, psychoacoustics and recording techniques, all meet. 
In the description of auralisation, special words are frequently used. Please refer to Appendix A: 
Vocabulary for a short description of frequently used words.  
In this chapter it is assumed that you have tried the basic auralisation functions in the Quick start 
guide for ODEON Auditorium or ODEON Combined, so it is recommended to first go through the 
corresponding Quick start guide. 

7.1 What is Auralisation 
When you make an auralisation you normally pair (convolve) an audio file without any room 
acoustics (an anechoic recording) with the room acoustics of a simulation (impulse response).  
 
• This ‘pairing’ is eventually a complicated digital signal process, and in scientific terms is called 

convolution.  
• Auralisations are often based on anechoic recordings, i.e. an audio recording that does not have 

any reflections from a room and therefore does not include any room acoustics. The audio file 
can be anything like speech, music, common sounds or noise. Situations where you would not 
use an anechoic signal are if you are simulating a cinema or concert venue where the speakers 
play recorded music. Then you may use normal music recordings instead.   

• Auralisations made in ODEON use the impulse responses for a specific receiver position which 
describes the acoustics of the room at this specific location with given source positions(s). The 
direction of the receiver is also important as it represents the orientation of the listener’s ears 
relative to the source.  

• Auralisation in ODEON produces audio signals for playback either through headphones or a 
custom surround sound system.  

The Anechoic Recordings 
The way you record an audio file without any room acoustics involved is perform the recording in 
an anechoic environment (without any reflections from a room). This is often done in an anechoic 
chamber with extremely absorptive walls and floor, where practically only the direct sound to the 
microphone is present. Occasionally it can be acceptable to use a file (eg. your own voice) recorded 
in a fairly dry room or office, with a directional microphone close to the source. 
Included with ODEON is a library of sound files including speech, classical instruments and more. 
There is even an entire recording of an orchestra, with the instruments recorded one by one, in an 
anechoic room playing various classical pieces.   
 

 Auralisation 
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Recorded Music Instead of Anechoic Recordings.  
In the cases of auralisations/simulations of a bar, music venue, cinema or similar, where recorded 
music is to be played from speakers, you do not use anechoic recordings but just a music recording 
instead. In the end of the chapter there is a small guide.   

The Impulse Response 
An auralisation is the result of a convolution of a sound signal and an impulse response. The impulse 
response is a short signal that describes the room acoustics for a specific place and direction of a 
receiver in the room. There can be one or multiple sound sources generating the impulse response,  
e.g. a loudspeaker system at a train platform can consist of many loudspeakers which emits the 
same signal. 
The acoustical calculations in the Job List are based on geometry, sound absorption, source positions, 
receiver position, sound levels and more. When paired with the anechoic sound files, it will result 
in a new audio file that sounds just as the original signal would sound like in the actual room (that 
is, affected by the room’s acoustics), at the specific position of the receiver. 
For some types of auralisations, the impulse responses are chosen from the Job List in ODEON. For 
others, new jobs/impulse response are generated automatically. No matter what, there can be only 
one receiver (position and orientation) associated to an auralisation. 

Binaural Auralisation  
For binaural auralisation (see Appendix A for vocabulary), one signal is created for each ear (bin 
meaning two) – when this binaural signal is reproduced in stereo using headphones, a true 3D 
experience coming close to how we experience sound in real rooms can be achieved. Only binaural 
auralisation is covered in this chapter. Odeon does though also cover surround auralisation for 
reproduction over loudspeakers and most of the details and principles covered here are also true 
for surround auralisation – indeed for surround auralisation the aim is also to provide a binaural 
experience.  
 
Depending on whether you are interested in using headphones or a surround sound system, the 
way the simulated acoustics of the room is applied to the audio file will be different.  
For binaural simulations you need to make a calculation of the room acoustics received at the two 
ears of a virtual dummy head (a two channel impulse response; a channel for the left and a channel 
for the right ear). This is called the BRIR (Binaural Room Impulse Response). The BRIR can be 
calculated as part of the Single Point response in the Job List , using the reflection data calculated from 
one or more sound sources to one single receiver. When the BRIR is convolved with an anechoic 
signal and played back over headphones, it will give the same listening experience as would be 
obtained in the real room. 
 
For many Single Point response results, the direction of the receiver does not matter, but for 
auralisation the direction is important. The direction defines the orientation of the simulated 
dummy head that “records” the sound file when it is played in the simulated room.  
 

 
 

7.2 Auralisation Options 
When it comes to auralisations, there are different options available in ODEON. They are all 
explained in more detail later in this chapter.  
 

Tip: If having multiple jobs in the Job List with the same single point receiver and receiver orientation 
then multi-channel simulations are possible (e.g. simulating a stereo setup, background noise versus 
loudspeaker announcements or singer versus orchestra).  
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1. Quick Auralisations / Streaming Convolution 
This is the fastest way of making an auralisation. For every job where a single point 
response is calculated, you can open the Streaming Convolution to listen to different audio 
files paired with the acoustics of that job. However, this type of auralisation cannot be 
exported.  
 

2. Large Auralisations / Offline Convolution  
If you want to make large auralisations, with different audio files played from different 
source positions you can make an offline auralisations, and/or if you want to export it as a 
.wav file to show/send to a client or partner. From version 15, there is a new tool that makes 
it much faster and easier to make large auralisations with many different audio files and 
source positions. This is called the “Multi Source/Signal Auralisation Expert”. 
 

3. Audio Effects 
Because it can be difficult to find enough anechoic recordings to make a full crowd in a 
canteen, or to add small differences on the different instruments in a classical piece, Odeon 
implements an Audio Effects tool. It allows to make a single anechoic audio signal into 
many slightly different audio files so you can use them together. Read more about this later 
in this chapter.  

 
Before using any of these tools, the type of auralisation and other options need to be setup.  
 

7.3 Setup for Auralisations 
The first step to make an auralisation is to define your settings in the Auralisation setup. Here you can 
enable the creation of Binarual and/or Ambisonic impulse responses, which can be used in Streaming 
or Offline convolution, within from the Job List.  

Binaural settings 
These settings concern reproduction strictly through headphones. Enable the Create binaural impulse 

response file option. This will create a binaural impulse response with the calculation of any single-
point response.  
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In the Auralisation setup, the upper-half window refers to binaural reproduction, while the lower-half refers to 
ambisonic reproduction (see next section).  
 

 

Head Related Transfer functions -HRTF 
For most users, the HRTF filters are not very important to learn about in detail. The HRTF file 
contains the filters that mimics the effect of the head of the listener on the perceived sound. When 
sound comes from left to right, the frequency response will be different on either ear and there will 
be a time delay. ODEON includes this in the auralisation to make sound directions perceivable. By 
default, there are two HRTF filters available in ODEON, just with the resolution being different. If 
you are interested in learning more about the HRTFs or how to add new HRTF files, read Appendix 
E. If you are using HRTF to calculate IACC, you will need to create a filtered set of HRTF’s for this 
purpose. Please read section 6.5 about IACC.  

Headphones 
The headphones used for auralisations will influence the experience, because any pair of 
headphones will change the frequency response of auralisation. Therefore, ODEON can minimize 
the influence of the headphones used by applying an inverse filter. Either choose one of the given 
headphone models from the list or add your own. There is a big difference on different headphones, 
so it is important to choose the correct ones if possible. Remember that if you want to show the 
auralisations to a client, the auralisations should be made for the type of headphones the client is 
using.  
For many users it is not possible to either measure the headphones used or find a matching one 
included with ODEON. If you do not have a matching headphone filter – then you should instead 
use the diffuse field filter matching the set of HRTF’s selected. Odeon automatically creates generic 
diffuse field filtered headphone filters for each set of HRTF’s. If e.g. using the Subject_21Res5deg_... 
HRTF then the matching headphone filter has the name Subject_021Res5deg_diffuse. 

Remember: Make sure the Create binaural impulse response file (.Jnn) option is activated when you want 
ODEON to derive BRIR’s for auralisation.  
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The headphone filter design is explained in more detail in Appendix D, as well as how to add the 
frequency response of your own headphones to ODEON. 
 
Besides these, there are other options in the Auralisation setup and these are explained in the help file. 
Press F1 when you are in the Auralisation setup, and a help box will appear.  
 

  
 

Ambisonics settings 
This is the lower half of the auralisation setup window and includes parameters for reproduction 
through the ambisonics technique. This makes it possible to listen to auralisations not only through 
headphones but also through loudspeakers.  
ODEON can produce either a 3D B-format output, which can be decoded into any loudspeaker 
system in an external program or a 2D surround output (decoded already) which can be played 
directly to a horizontal loudspeaker system. Remember to hit the F1 key to receive valuable 
information from the ODEON help. 

Filter settings 
The section controls parameters for the filters used reduce calculation time, as with Binaural 
auralisation (see previous section). As with HRTF, for most users the ambisonic filters are not very 
important to learn about in detail. You should in principle keep the default settings. However, you 
can read more the details and how to change them in the Appendix E.   

Encoding 
Specifies the order of the ambisonic encoding. The higher the order the more precise the encoding 
will be. Three orders are available: 

1st Order 

This provides 4-channel wave files, WXYZ, with W being the omni.  

2nd Order  

This provides 9-channel wave files, ordered according to the Ambisonics Component Ordering, 
ACN (corresponding to Furse-Malham): WYZXVTRSU (used to be ordered WXYZRSTUV in 
Odeon 14 and earlier versions)  

3rd Order 

This provides 16-channel wave files, ordered according to the Ambisonics Component Ordering, 
ACN (corresponding to Furse-Malham): WYZXVTRSUQOMKLNP.  

 
 

Remember: Always press F1 when you need to learn more about specific functions in ODEON. The 
context sensitive will open at the page related to the active window. Often, the ODEON help file 
complements the manual and offers extra information. To learn more about Surround playback and 
how to define a speaker rig for surround playback – which is not covered here - click the Define speaker 

rig button then press F1. 

Note: Currently it is advisable to use 1st Order ambisonics for your ODEON loudspeaker auralisations. 
Higher orders should in principle give more detailed reproduction, but the implementation of the Furse-
Malham algorithm results to a somewhat blurred sound field.    
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B-format settings 
Use these settings to create a B-format output, which can be decoded outside ODEON to any 3D 
or 2D loudspeaker system.  
Check the box Create impulse response (*.BFormat) to create impulse responses corresponding to the 3D 
ambisonic channels, defined in the Encoding. These impulse responses can then be convolved with 
anechoic files in the Job List to provide BFormat convolutions (auralisation files). The Bformat 
convolutions are multi-channel files (4,6 or 16, depending on the chosen order) and have to be 
decoded to a loudspeaker system in an external software application.  

2D surround settings 
Use these settings to create a surround output – already decoded, which can be played directly to 
any 2D surround system that consists of a number of speakers and a receiver (eg. home cinema 
audio systems). The tool does not provide 3D decoding.  
Check the box Create impulse response (*.SurRoundnn) to create impulse responses that correspond to 
each speaker in the defined speaker rig (see just below). These impulse responses can then be 
convolved with anechoic files in the Job List to provide 2D surround convolutions (auralisation files). 
The Surround convolutions are multi-channel files that include one channel for each loudspeaker 
system, and can be played by any media player such as QuickTime, Windows Media Player and so 
on.  
 
Compensate speaker delays 

If all loudspeakers are not at the same distance from the listeners position (sweet spot), ODEON 
will delay some of the speaker feeds as appropriate. Enabling the function makes the quality better 
in the sweet spot - at the same time it might become worse outside the sweet spot. 

Parametrization (2D) 

A system of 3 equations with 3 unknown is solved for 1st order 2D ambisonics, while a system of 
5 equations with 5 unknowns is solved for 2nd order 2D Ambisonics. The results are 3 or 5 
constants; one constant for each part of the Ambisonics equation. The benefit is that the decoder is 
then capable of recreating plane waves correctly even if a regular speaker array is NOT applied. 
By a regular array is meant a speaker rig with equal angles between all speakers.  

 
 
The following buttons are available in terms of defining a speaker rig: 

Define speaker rig 
Here you can define the actual setup of your surround system. Some templates are available, with 
the most common being perhaps the 5.1 and 7.1. The increment .1 indicates the use of subwoofer, 
which comes as an additional (omnidirectional) channel in the file (Check/Uncheck the box Use 

subwoofer). The pre-defined templates are either circular or rectangular, but the coordinates can be 
adjusted on the right side to create a fully customised setup.  

Remember: Make sure to check the Create impulse response (.SurRoundnn) in the 2D surround settings panel 
to make a surround decoding inside ODEON. If you want to export B-format auralisations in order to 
decode into a loudspeaker setup outside ODEON (mainly 3D), make sure to check the Create Impulse 

response in the B-format settings panel. 
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Use program default settings 
Use this to restore the settings like the Overall recording level, the Compensate speaker delays 
etc.  

Make surround settings program defaults 
Use this to assign the custom settings for Overall recording level etc. as default.  

Save speaker rig and make archive file 
Use this to save a custom speaker rig, created in the Define speaker rig.  

Get speaker rig from file 
Use this to load a speaker rig previously saved with the previous function.  
 
 

The Jobs, sources and receivers 

Source and Receiver options 
Each auralisation can only be made for one single receiver, as one can only be listen at one given 
position at a given time. The direction of the receiver also important, as it will be the orientation of 
the receiver (being the simulated dummy head in auralisation). 
  

• If you want to make an auralisation with multiple sound sources from different directions 
with different sound files, make a job for each sound source or use the “Multi source/signal 
auralisation expert”.  
 

• If you want the same sound file from multiple sound sources, you can just make one job 
including all the sound sources.  

 
• If you want different sound files from same position, you can also just make one job, and 

use it for multiple convolutions later.  
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Single Point Response 
Some auralisations made in ODEON are based on the Single point response receiver jobs in the Job list.  
If using these, you have to make jobs with one or more active sound sources and a single receiver.  
 

 

A note on directivity patterns for natural point sources 
It is common to make auralisations with natural point sources. With natural sources we refer to 
sources such as human voice, an acoustical instrument or similar, where a recorded signal for 
auralisation may be associated with a certain directivity pattern. In order to select the right source 
for auralisation purposes, please read Chapter 3. 
 

Sound cards 
A sound card is required in order to play back the auralisation results and may also be useful if 
you wish to transfer (anechoic) signals to the hard disk. As a minimum, the sound card should be 
capable of handling signals in stereo, in a 16-bit resolution at a sampling frequency of 44100 Hz. 
Also consider whether the card is immune to electromagnetic noise, which is always present in a 
PC and whether the analogue output for headphones is satisfactory. (For surround auralisation, 
obviously a multi-channel surround soundcard is needed along with the necessary loudspeakers 
and amplifiers). 

7.4 Making auralisations 
There are different ways of making auralisations. The way to go will depend on what your needs 
are. The needs could be: 
 
• A fast auralisation tool to listen to different jobs. E.g. in a design phase where different things 

are tried out in the model. This can be done with Streaming Convolution. 
 
• An exported .wav file to show/send to costumers or publish on a web-site. This needs to be done 

via an Offline Convolution. 
 

• A single audio file with with many different signals being played from different sound sources 
at the same time. This kind of multi source auralisation requieres to be created as an Offline 
Convolution.  

 
• Multiple audio files played simultaneously, from different sound sources and maybe a delay 

on some of the sources. This needs to be an offline convolution, and for most cases it will be 
easier to use the Multi Source/Signal Auralisations Expert. 

 
• Making eg. a canteen or cafeteria where there is a need for many sound sources, placed all over 

the space, or a full orchestra playing a classical piece. You would probably both need the Multi 
Source/Signal Auralisations Expert to make the setup, and the Audio Effects tool to turn a few 
audio files into multiple, like a few voices into a crowd, or a few instruments into an orchestra.  

 
• Play an impulse response for a job in the Job List using Play Single Point BRIR. You can also 

save it and reload it, if you need the measurement options.  
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Play BRIR – listen to a Dirac signal  
Once a Single point response is calculated, it is possible to play the BRIR, clicking the Play Single Point BRIR 
button. The BRIR may give a first clue as to how the room sounds and it also allows some 
evaluation of the quality of the calculated point response, e.g. whether to use a higher Number of 
late rays in the Room setup. 
 
Although the BRIR may just sound like a click or pop, it may work quite realistically when 
convolved with a signal less transient than an ideal Dirac delta function. To get a more realistic 
presentation of a BRIR as it would sound in the real world you might want to convolve it with the 
Clapping signal file, an anechoic recording of clapping hands, which is a less transient signal than an 
ideal impulse. 

Streaming auralisations – listen to different audio files 
For fast evaluation of the acoustics, use the streaming convolution. In the Joblist, on the Jobs tab, 

you can choose Streaming convolution  in the menu on the right-hand side. The streaming will be 
for the selected job on the Joblist. A menu will open, where you can listen to streaming 
convolutions.  
The main advantage is that you can easily listen to different audio files while the room acoustics of 
your model is applied.  
 
Under Input signal, you choose the audio file you would like. If you press Listen to input signal, you 
hear the anechoic signal, otherwise you listen to the convolved signal for the selected job. Under 
Channel setting you can choose to use a stereo source. This is explained in the help file (press F1 when 
the Streaming convolution menu is open), but for most cases it is recommended to stay with the default 
Mono source.  

Offline Auralisations – Most Options and Export .wav files  
For the best flexibility, mixing different convolutions together, making individual adjustment of 
each channel (delay and level), and storing auralisation results in .wav file, you should use offline 
auralisations. Audio files produced in the offline auralisation may be used online, in Power Point 
presentations, etc. 

Making an offline auralisation 
Since ODEON 15 there are a couple of ways to make an offline auralisation. Either you set 
everything up yourself, you use the Auralisation Expert that will generate everything for you, or 
a mix of both. 
  
• Use manual setup if you want the auralisation for a specific job in the Job List, eg. to be able to 

compare auralisation with parameters.  
  

• Use the Auralisation Expert if you want to choose a receiver position, multiple source 
positions and multiple audio files, and let the expert make the rest.  

 
Both the normal setup and the Auralisation Expert are described in this chapter.  
 

The auralisation Tab Sheet overview 
If you have check-marked Create binaural impulse response file (or Create 2D Surround Impulse Response) in the 
Auralisation setup, you will have an extra tab in the right-hand side of the Job List called Auralisations. 
In this tab you will be able to make auralisations from the jobs you have in the Job List. 
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The auralisation tab consist of a Convolver menu, a Mixer menu and then a range of options on the 
right-side tool bar, including the Auralisation Expert, added in ODEON 15. 

 
In the Convolver (left part), Jobs (Impulse responses) and audio files are paired in different convolutions. In the Mixer 
(right part), convolutions from the left part can be mixed together.  

 

Convolver 
If you are working with auralisations for headphones, you have the Convolve Binaural RIR with signal file 
in the left side. This is where the single auralisations is made, if not using the Auralisation Expert. 
Here, mono signals are convolved (paired) with Binaural Room Impulse Responses (BRIR's, which 
have been calculated as part of the Single Point responses). This process may be compared to a 
binaural recording of a mono signal, played through simulated sources in the room. 
 
The menu consists of: 

• Signal Sub Path are the folders of sound files.  If blank, you have a range of different sound 
available, but you can also choose different classic pieces played by different instruments 
if you are making a full orchestra. 
 

• Signal file is the file is file containing the sound you use for auralisations. All signals 
that come with ODEON are anechoic recordings. If you add new sounds, make 
sure it is (or close to) anechoic.  

 
• Time is the duration length of the recording. 

  
• Channel displays the channel of the audio file being used. If it is a stereo audio file then you 

can choose whether to use the channel 1 (left channel), channel 2 (right channel) or the 
default which is an average of the two.  Audio files with more than two channels can also 
be handled. 

 
• Calib. When the Calib. check mark is checked (see Figure 5), ODEON will 'calibrate' the level 

of the input to have a fixed A-weighted level; so two different recordings, e.g. voice and 
noise, will have a comparable loudness (they are adjusted to have the same A-weighted 
level before they are convolved with the impulse response). 

 
• Job no. is the job number of the impulse response (Single Point Response) in the Job List used for 

the convolution. The Single Point Response defines the receiver position and orientation and 
which sources are active. 

 
• Receiver and Job descr. is the information about the job chosen as taken from the Job List.  

 

Warning: The auralisation toggle button is disabled if Create binaural impulse response file (.Jnn) or Create 

impulse response (.SurRoundnn) is disabled in the Auralisation Setup  (SHIFT+CTRL+A). 
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• Rcd. Lev. is the recording level. By default, 0 but you can change it if the convolution is too 
loud or weak when calculated.  
 

• Max. out displays the peak of the convolution calculated. It corresponds to peak level that 
can be displayed by a recording device used in the real world. The Max. out level must be 
below 0, in order to avoid digital clipping (distortion – ultimately white noise if the 
overload is substantial). If the calculated convolution  is too loud or weak, use the Rcd. Lev. 
to change, then recalculate.  

Mixer 
The mixer is located in the right side of the auralisation tab. The mixer allows convolved results to 
be combined into one wave file allowing multi-channel simulations, e.g. stereo setups, singer 
versus orchestra etc.  
The mixer consists of two lists. The first is the list of all mixes, Mix convolved wave results into one wave 

file. For each mix, there is a list of convolutions in contains -  Convolutions in mix no <xx>.  
 
The two lists consist of:  

• Mix no. is the number of each mix which can help locate the mix later, when exported as wav 
files, as the number will be part of the .wav file name. 

• Enabled Turn on/off a mix. Most important when using the Run All Jobs option.  
• Description is a description of the mix. Recommended if having many mixes.  
• Convolved files are the numbers of the convolution included in the selected mix.  
• Max out is the peak level in dB of the mix. This needs to be below 0 in order to avoid digital 

clipping but is good to keep close to 0 for better sound quality.  
------------ 

• No. Consecutive numbering of the added convolutions. 
• Conv. no. is the number of each convolution you add to the mix. You can add up to 300 

convolutions which may use different sound files and sources, as long as they have the 
same receiver position and orientation.  

• Mix. Lev This is your option to set the different levels if making a mix.  
• Delay in sec. You can delay some of the convolutions. Used mainly for a delay effect e.g. in 

churches or large rooms or outside where the sounds needs to be delayed between 
different speakers in order to avoid echo/delay effects. Can also be used to make the same 
convolutions sound like several, to use in canteen or office cases. 

• Job description displays the description of the job/impulse response used for .convolution. 
• Signal file displays which signal was used for the convolution. 

 Multi Source/Signal Auralisation Expert 
Setting up jobs (impulse responses), convolutions and mixes e.g. for a crowd in a canteen or an 
orchestra in a concert hall using the tables in the Job List can be tedious and extremely time 
consuming. The Auralisation expert makes that process much faster. The Auralisation Expert can be found 
in the right-hand side toolbar of the Job List, but you need first to select (with a mouse click) the mix 
you want to edit in the middle table on the Auralisations tabsheet. So, select a mix number and then 
press the Multi Source/Signal Auralisation Expert tool button.  
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The Auralisation Expert is a really easy way to convolve multiple audio files with multiple sources, 
making auralisations at a specific receiver position. This tool works very well with the tool Audio 
Effects that can create multiple different audio files from a single audio file, to make a crowd in a 
canteen or orchestra in a concert hall, among other scenarios. The Audio FX tool (Audio effects) 
which is explained later in this chapter.  
 
The options in the Auralisation Expert are:  

• Mix description is an optional description describing the auralisation mix, e.g.: Crowd for 
canteen or Orchestra playing Mozart at conductors’ position. 
 

• Receiver is the listener position in the room. All convolutions included in the mix will be 
simulated with this position. 
 

• Receiver looking at defines the direction of the receiver influences the results, as the 
auralisation is either binaural or surround. You can choose between x-axis direction, or 
point it toward a source position. If you have a specific place you want the receiver to look 
at, where there is no source, you can make a dummy source in the source receiver list.  

 
• The list of sources The source number is on the left side, referring to the source number in the 

Source receiver list. You can choose a number of sources with ctrl + mouse click, and when 
you import files (if the same number of files is imported), these files will be assigned to 
these source numbers. All sources that has been defined are included in the list, but indeed 
all the sources does not need to be included in the mix – only the sources to which a sound 
signal file is assigned are included in that particular mix. Each source will be assigned its 
own signal and normally a signal file is only used for one particular source (e.g. the 12th 
violin signal is only played by one violin/musician). 

 
• Select multiple signal files in the upper-right corner of the Auralisation Expert allows assigning 

multiple signal files to multiple sources. First select sources in the list using Ctrl+mouse 
click then click the Select multiple signal files icon and select the audio files in a similar manner 
in the file dialog that appears. When closing the file dialog, the files will be added to the 
selected sources in the list. If you fail to select a matching number of sources and signals 
Odeon will do its best to match them anyway – and usually this works out OK. 

 
When you have closed the Auralisation Expert, Single point responses, convolutions and mix has been 
setup but not calculated yet.   
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  Run the calculations 
When a mix has been setup in the Auralisations tabsheet, you can calculate it by selecting it in the 
Mixer and pressing Run Single Job, or pressing Run All Jobs. The appropriate rows in the mixer will turn 
green when results have been calculated.  

 Play or export wave file  
Once the calculations have been carried out, click the Play wave result button and listen to the result 
through the headphones. If you have selected (left click mouse) the Signal Sub Path or the Signal file 

column in the Convolve BRIR and Signal file table, the (anechoic) input file is played. If you have selected 
Receiver or Job descr. it is the convolved file that will be played. If you have selected the mix, anywhere 
in the Mix convolved results into one wave file, it will be the mix that is played. 
 
If you want to export the wav file, there are several ways to do it. You can save it from the Wave 
player when you are in the Play wave result player window Another way is to simply drag-and-drop 
the wave file from the appropriate cell in the Job/Auralisation list into the desired destination e.g. 
a folder in Windows Explorer your Desktop or directly into Microsoft Power Point. If you need to exchange 
many wave result files, then you can find the wave file in Windows Explorer, open the appropriate 
room folder using the File|Explore current room folder (hint, type RoomName*.*wav in the search field of 
Windows Explorer to locate the relevant wave result files – RoomName being the actual name of your 
current room) 
 
 
In summary, a quick guide on how you use the auralisation expert:  

1. In Auralisation Setup, check-mark Create binaural impulse response file 
2. In the Job list, open the Auralisations tab at the right side 
3. Select mix and open the Auralisation Expert  
4. Choose a receiver and direction 
5. Select the source numbers you want to add audio file to 
6. Open audio Select multiple signal files and choose audio files 
7. Close the the Auralisation Expert 
8. Calculate the mix 
9. Listen and/or export a .wav file.  

 

 
 
 

Ambisonics Auralisations 
When you have enabled either B-format or 
Surround impulse response creation in the 
Auralisation setup (Sec. 7.3) you have to make sure 
to click the toggle Binaural/Surround/B-format mode button 
on the right toolbar to switch between the different 
modes.  
 
 

Remember: The play wave function is sensitive to the cell and row chosen in the table. When the input 
signal cell is selected the play function reproduce the input signal without convolution. You have to 
select one of the cells that have to do with the Job (like Job no., Receiver, Job descr.) in order to listen to 
the convolution result. 
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B-format mode 
The B-format mode only produces B-format files to be decoded in an external decoder, therefore it 
is not possible to play them through ODEON.  
Instead, in this mode you can drag and drop the B-format files to any folder you prefer for further 
decoding processing.  
 

 
 

Surround mode 
In the surround mode you can simply play any convolution through ODEON directly by selecting 
the corresponding convolution and pressing the player button . You can even export any 
convolution, as with any binaural Auralisation, simply by drag-and-dropping into the desired 
folder.    
 

 
 
 
 

7.5 Audio Effects – Multiplying the Audio Files 
A common problem experienced when making auralisations is the limited number of appropriate 
anechoic audio files available. For realistic auralisations of e.g. a cafeteria, an office and a train 
station, many recordings of speech is needed 
and for a full orchestra with groups of many 
similar instruments many input signals are 
needed (eg. 1st or 2nd Violin section). Although 
ODEON comes with an extensive list of audio 
files, they often need to be manipulated for 
proper auralisations. Otherwise, you would 
only be cloning and overlaying the exact 
same audio, which doesn’t give a realistic 
effect of several sources. An Audio Fx (Audio 
efects) interface has been created for that 
purpose in version 15. Five effects are 
available: Change Duration, Phase Vocoder, Chorus 
and Spectrumizer and Gain. 
To get different but still realistic results 
requires a lot from the tool, but we have 
finetuned it extensively and you efficiently 

Remember: The B-format mode does not play any file. You can only drag and drop B-format files to be 
processed in an external decoder. Instead, use the Surround mode to play 2D ambisonic convolutions 
through the built-in ODEON player. 
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turn a single or a few audio files into a full crowd, or make large, full and realistic sounding classical 
orchestras from only one audio file per instrument type. Traditional audio effects are aimed at 
making one fine-tuned version of based on the input file – this is not the purpose of the Odeon 
Audio FX tool – instead it is aimed at making a multiple (a population of) output files with random 
variations between the outputs. Like in any large population, there will be outliers, so if e.g. one 
out of many voice output ends up with a very low tempo or to be very low pitched then do not 
consider that an error -this is an expected behaviour in a population. 

How to Use the Audio Effect Tool   
The Audio Effects tool is located at Tools>Audio FX’s.  
1. Open one or multiple audio files (by SHIFT+LMB or CTRL+LMB). You can open multiple audio files, 

and for each of them the chosen number of new output files will be generated. 
 

2. The waveform of the first of the selected files is displayed. If multiple files have been selected, 
only the waveform of the first is displayed. However, the rest are still kept in memory for further 
processing.    

 
3. Press the + tab sheet to choose an audio effect. 
 
4. Change the settings for the chosen effect (press the F1 key to access the ODEON’s help for details 

on the different parameters). 
 
5. Choose Number of output files for each audio file. This many different audio output files will be 

generated for each input file. For each generated file, the settings for the effects will be varied 
within the chosen limits.  

 
6. Press Play audio file to listen to the effects applied on a single audio file. If loading another input 

file then press the button again to listen to the new sample with the effects applied. If you change 
the effect settings, this will not take effect until you press the Play audio file button again.  

 
7. Press Save to generate and save the Number of output files. Choose output file name(s), press Save 

again and then please be patient. It will take a (little) while for the audio files to be generated.  
 
The Audio Fx tool currently includes the following effects: 

• Change Duration - which will create outputs with fixed duration by repeating the input with 
random start and random pauses in-between.  

• Phase Vocoder – which can change pitch and tempo 
• Chorus – which can outputs like different player(s) playing a violin or singing a song 
• Spectrumizer – makes random changes to the spectrum of the output e.. playing on different 

violins. 
• Gain – which can change the gain by a fixed number of dB, and nothing else. 

 
It is possible and often desirable to use multiple effects on the same input – though you will 
probably not be using all effects at the same time. On sting instruments it is useful to apply the 
Chorus as well as the Spectrumizer effects to simulate different players playing on different instruments. 
For voice samples to be used for crowd simulations, it is often desirable to use the Change duration 
and Phase Vocoder effects to created outputs that are incoherent and with a desired duration and voices 
of different pitch and tempo. 
 
When using the files generated in the Audio FX’s tool for multi-source auralisations, the easiest way 
to do that is to use the Auralisation Expert , and just choose all the generated files at once. 
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7.6 Examples of Auralisation 

Example 1: Single Channel Simulation 
Try to create a one-
channel simulation of a 
person speaking from a 
source position.  
1. Open the room Elmia 

RoundRobin2 detailed.par, 
which is stored in the 
ODEON Rooms folder 
(see Chapter 2.1).  

2. In the Auralisations tab (far right-hand side of the Job list), in the Convolver side, select the Signal file 

field in the Conv. no.1 row and select the Voice Sabine Short file (this is an anechoic recording of a 
voice stored in a Windows Wave file format - residing in the directory set in the Options|Program 

setup|Paths|Wave folder field).  
3. To play the chosen input file after selecting it, click anywhere else in this row (this finalizes the 

selection) then press the Alt+S shortcut (or the Play wave button ) to listen to the file. 
4. Choose a Job from the Job no. column to convolve an impulse response with the selected signal. 

Exit the Job no. cell by clicking anywhere else in the same row. Information about the job will 
then appear.  

5. Press the Run Single Job button . A calculation of the point response between the source(s) and 
the receiver in the selected Job is made if not already calculated. Afterwards the convolution 
between the response, and the selected anechoic signal in the list is performed. 

 
If the convolution line 
turns red at the end of 
the process, then output 
level is too high (above 0 
dB) and therefore digital 
clipping will occur. This 
has to be addressed; 
otherwise you will 
experience unpleasant 
distortion when listening to the auralisation. You can reduce the recording level in the Rcd. Lev. 
column by the same amount as the exceeding dB. In the example the level exceeds by 62.36 dB. 
Setting the recording level down to -63 dB will lead to an output level just below 0 dB. This process 
is very practical for single files, as the absolute level of the playback can be further adjusted by the 
windows volume control. However, when mixing different convolutions you might need to 
preserve their individual levels. For example, if you make an auralisation of an orchestra, where 
all instruments have been recorded separately, their individual dynamics (levels) should remain 
unchanged. To avoid clipping you should reduce the Overall Recoding Level in the Auralisation setup. Once 
this is addressed, you may listen to the result by selecting the convolution’s Conv. no. in Convolutions 

in mix no. 1 in the mixer side, clicking elsewhere in the row, then pressing the Alt+S shortcut (or the 
Play wave button ). 
 

 

Remember: When the output level is higher than 0 dB undesired clipping will occurs. In this case you have 
to reduce the recording level (Rcd. lev column) or the Overall Recording Level in the Auralisation Setup. 
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Example 2: Auralisation of Canteen Area Using Audio FX 
With the Audio FX tools and the Auralisation Expert, making an auralisations of a crowd is much easier. 
In this example, a realistic-sounding canteen area will be made from only a few audio files.  
The example is a simplified model of the canteen we use at ODEON. It has 6 tables with 12 seats at 
each. In this auralisation we will imagine a full canteen with half of the people speaking at the same 
time, so a mix of 36 convolutions. We are only going to use 3 anechoic audio files. You can even 
make a decent auralisation with only one anechoic input file on the other hand using more than 
three files could probably an even better auralisation. 
 

 
 

1. Press File > Open Room and find the CantineExample/CantineExample_Ready.par model 
2. Go to Source Receiver List  in the top menu (or shortcut Shift+Ctrl+S) 
3. Select the source People facing north and press the Tabulate selected source or receiver tool in the 

right-side menu. Set First dimension -X to 1.4 m, Nx to 3, Second dimension -Y to 2.2, Ny to 6. 
This way it will make 3 sound sources placing north for all tables. Do the same thing for 
the People facing south.  

4. Open Tools>Audio FX 
5. Open audio files Agora, “Den Musikalske Erimitage” and “Voice Sabine” (use Ctrl+left click). They 

are all recordings of the same person, so they do sound very similar. Different voices would 
give a better effect. To select multiple file, hold down the Ctrl key while clicking the files. 

6. Add the two effects; Change Duration and Phase Vocoder. Set the final duration to 1 minutte (and 
0 seconds) in the Change duration effect and leave the rest of the default settings. 

7. Set the number of output files to 12. 
8. Press Save.  
9. Open the JobList  (shortcut Ctrl+Shift+J). 
10. Open the Auralisations tab at the far right-hand side of the window. 
11. Select Mix. no. 1 and open the Multi Source/Signal Auralisation Expert . 
12. Change Receiver to the receiver Listening position 
13. Rename the Mix description, for example, to Listening Position” (or any name you desire) 
14. Use the Select multiple audio files icon in the upper-right corner of the Multi source/signal auralisation 

expert, to assign an audio signal for all sources. Only use the signal files which you just 
created in the Audio FX, so the new versions of Agora, Den Musikalske Erimitage and Voice Sabine 

(having the # sign and file number appended to the original file name).  
15. Close the the Multi source/signal auralisation expert 
16. Select Mix nr. 1 and press the Run single job icon  (or shortcut Alt+R) in the right toolbar.  
17. Press the Mix. no. 1 (which should be green by now) and press the Play wave icon  (or 

shortcut Alt+S) in the right toolbar. 
18. Listen to the auralisation, and save it if you want. Now you can try to change the materials 

of the room, or something else, and hear how the auralisations will change. You have to 
recalculate the auralisations after changing materials, but you do not have to set it all up 
again.  
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Example 3: Extended Auralisation with Complete Orchestras 

 
 
Since ODEON version 10 a number of auralisation setups are available, where entire orchestras 
have been modelled for auralisation of a concert hall and in an opera. These are available in the 
WavePack 1 Install which you can download at: https://odeon.dk/downloads/anechoic-recordings/. 
The installation includes  pieces of Beethoven (21 channels), Bruckner (47 channels), Mahler (39 
channels) and Mozart (11 channels). In order to listen to these auralisations: 
• Download and install the WavePack. Remember to generate the required additional files by 

loading the batch file using the AudioFX tool. The instructions are in the file 
“OdeonWavePackLicense_I.txt” in the created WaveSignals\Orchestra2019 folder. 

• Open one of the rooms in the Orchestra2019 folder (e.g. 
C:\Odeon...\Rooms\Orchestra2019\ComptonVerneyOpera-Mozart.par) 

• Open the JobList  (shortcut Ctrl+Shift+J) and click on the Auralisation tab at the far right-hand 
side of the window. 

• Calculate all jobs in the JobList  (shortcut Alt+A). 
• Once the calculations have finished in the Auralisation display, you can play the various tracks 

using the Play wave icon  (shortcut Alt+S). 
 
The auralisation samples include many setups that inform ODEON how jobs and wave files should 
be combined into a few final mixes. If you would like to listen to auralisations in other receiver 
positions than the predefined ones, the fastest way to do this is: 
• Enter the Source receiver list   (shortcut Shift+Ctrl+S) and define the new receiver  (shortcut 

Ctrl+R). 
• Open the JobList  (shortcut Ctrl+Shift+J). 
• In the Auralisation display, duplicate the mix by selecting Mix. no. 1, copying (Ctrl+C), selecting Mix. 

no 2, and pasting (Ctrl+V). 
• Open the Multi source/signal auralisation expert  and select the new receiver. When you close the 

window, ODEON will automatically create new jobs, convolutions and a mix as needed. 
• Calculate all jobs  (shortcut Alt+A). 
 
The anechoic recordings were created by Helsinki University of Technology. For use of the 
anechoic orchestra recordings, the conditions as specified in the software license agreement must 
be observed, see page 2. 

Example 4: Auralisation of Speakers Playing Music 
The next example will demonstrate how to set up a ‘classic’ stereo setup with a receiver position 
and two loudspeaker positions. This example is very simple and does not come with a room 
prepared for it, so choose any room that you like. Either one you create yourself or one of the rooms 
that comes with ODEON. 

• To run this example, you need to have a stereo recording stored on your hard disk as a Windows 
wave file, at a sampling rate of 44100 Hz. You should be able to use most recorded music files.  

• This file, which does not need to be an anechoic recording for this demonstration, should be 
placed in the directory set in the C:\Odeon...\WaveSinals\ directory. 

https://odeon.dk/downloads/anechoic-recordings/
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• Open a room. Choose any room you want to place a speaker system in.  
• Enter the Source receiver list   (shortcut Shift+Ctrl+S). 
•  Make a New point source  (shortcut Ctrl+P) at the position of one of the speakers. Assign a 

Directivity pattern to the loudspeaker or leave the speaker with the default of Omni.SO8 if so desired. 
Note that you’ll have to change the Sub directory of the Directivity pattern to access a preinstalled 
directivity pattern of a loudspeaker. 

• Make a similar source at the other speaker position (you may use the copy icon  (shortcut 
Alt+C) and changes coordinate(s) of the new source. 

• Make a receiver position for the auralisation  (shortcut Ctrl+R). 
• Go to the Job list  (shortcut Ctrl+Shift+J) and into the Auralisations tab. 
• Select a Mix No. and click the Multi Source/Signal Auralisation Expert . 
• Choose the same signal, the stereo music file, for both sources made.  
• In the Channel option, choose channel 1 (left) for the left source and channel 2 (right) for the right 

source.  
• Close the setup, calculate the mix and play the auralisations or export it.   

 

7.7 Sound Pressure Levels for Auralisations 
Headphones 
The binaural auralisation results created in ODEON are by default binaural signals which should 
be presented over headphones. The purpose is to reproduce the same sound pressure at the 
entrance of the ear canals (and at the eardrums for that matter) as is obtained in the real room (if 
the room exists). 

Adjusting levels 
Sound Pressure Level is one of the most important room acoustical parameters, so it is important 
that levels, at which auralisation samples are presented, are realistic. If playing a simulation of 
voice at an unrealistic high level, the speech intelligibility may be over rated. It does not help that 
Clarity or Speech Transmission Index is satisfactory if the Sound Pressure Level is too low. If 
playback levels are too high, echo problems may be exaggerated, because echoes that would be 
below audible threshold (or at least at a very low level) are made audible. Another very common 
effect of presenting auralisations at too high levels is that the room sounds too reverberant. This is 
because the full decay may be audible - even some 90 dB of decay may be audible where the 
definition of RT assumes that at its best only 60 dB of decay is heard. 
 
The levels presented in auralisation samples created by ODEON are influenced by: 
• The HRTF’s. 
• Level in input signal file, e.g. the RMS value or LeqA. 
• Calculated Sound Pressure Level, which is based on geometry, sources, receiver positions, 

materials, etc. 
• Overall recording level in the Auralisation setup. 
• Recording. Level (Rcd. lev) in the Auralisation display of the JobList - if off-line convolution is 

used. 
• Mixer levels (Mix. Lev. in the JobList) if offline convolution is used. 
• Gain in the Streaming convolution dialog if the real-time convolution option is used. 
• Output gain of the sound card, the volume setting. 
• Sensitivity of the headphones. 
• Coupling between headphone and the subject’s ears. 
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Maximised playback levels for maximum dynamic range 
If you only are interested in the sound quality in your auralisation files, you may focus on getting 
an Output Level (Max. Out level in the auralisation display within the Job list) below, but as close to 0 
dB as possible, in the Convolve BRIR and Signal file table. The same applies to the Max. out in the Mix 

convolved wave results into one wave file table in order to obtain the highest dynamic range. If using the 
Streaming convolution option available from the main display in the Joblist, ODEON will maximize 
the auralisation output level.  When changing the input signal or BRIR from within this display, 
you should click the Maximize Gain button to maximize the gain for the new setup. 

Relative playback levels 
In some cases, you'll be interested in obtaining correct relative levels (e.g. for comparisons between 
different seats in a concert hall). In the case of offline convolutions, you should remember to use 
the same levels (recording levels and mixer levels in the convolver and mixer windows of the 
Auralisations window) in the samples to be compared; it is a good idea to use the same input signal 
file to make sure that levels are the same at this point. If you wish to compare across different rooms 
you should also be aware of the source gain you are using in each room. If using the Streaming 

convolution available from the main display in the JobList, ODEON will maximize the auralisation 
output level automatically. Therefore, if you wish to compare different rooms, you should make 
sure to set the Gain in the Streaming convolution window to the same value as in the other rooms. 

Absolute playback levels for headphone auralisation 
Setting the level to an absolute level - so the subject presented to the auralisation sample 
experiences the same level as would have been the case in the real room - is tricky as it involves 
every part in the signal chain. 
 
To obtain a reasonable correct level, a first approach is to adjust the auralisation output against 
levels - of some kind of sound - in the room in which you actually are. If you are simulating a voice, 
try to compare the level of the playback with the level of somebody speaking in your room. This 
method should make it possible to make a rough adjustment - and it is certainly better than none. 
 
A more precise method is to use the calculated SPLA as a reference (if it is calculated at an absolute 
level): 
• Present the auralisation signal over a loudspeaker in the room in which you are sitting. 
• Measure the sound pressure level in the room at the position where you will be listening, and 

adjust the output level of the loudspeaker-amplifier until the measured LeqA corresponds to the 
calculated level. At this point you have a physical reference level, which can be used for 
calibration of your auralisation playback level. 

• Switch between playing your auralisation sample over headphones, and over the loudspeaker, 
while adjusting the level of the auralisation playback until the levels are the same. 

 
This method is somewhat inspired by the old Barkhausen method for measuring loudness level in 
Phon, and should at least in principle allow perfect calibration of the level (the resulting level being 
within one subjective limen). 
 

7.8 Input/Output Signals for Auralisations 
Input signals for auralisation – anechoic recordings 
For auralisation you will be using input signals to convolve with the calculated BRIR's. Usually the 
signals will be anechoic signals although it may also be other types of signals, e.g. if you are 
simulating an ordinary stereo setup in a room you will probably be using a commercial stereo 
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recording. The input signals to be used with ODEON are stored in uncompressed wave files, 
having the well-known .wav extension. Most, if not all, resolutions are supported, so files edited by 
programs such as Audacity or Adobe Audition can be used without any conversion being required: 
• 8, 16, 24, 32 bit PCM. 
• 32 bit IEEE Float. 
• 8, 16, 24, 32 bit PCM, Extensible (tells the number of significant bits). 
• 32 bit IEEE Float, Extensible (includes some additional info which is not used for input by 

ODEON). 
 
To be compatible with the HRTF’s supplied with ODEON the wave files should always be at a 
44100 Hz sampling frequency. 
 

 
 
The ODEON program comes with a few anechoic samples, which are installed to the 
\ODEON...\WaveSignals\ directory. If you wish to extend the library of input signals you should put 
your new signal files here or in a subdirectory to this directory, e.g.: \ODEON...\WaveSignals\English voice\ 
or \ODEON...\WaveSignals\NoiseSignals\. 
 
A few audio albums containing anechoic recordings are commercially available, namely the 
Archimedes album (1992), which contains some recordings of solo instruments and the Denon 
album (1988) which contains (semi) anechoic stereo recordings of orchestral music.  
 
A growing number of anechoic recordings are available from the Odeon home page 
https://odeon.dk/downloads/anechoic-recordings/. Many of the files come in the format of Wave 
pack installations or OdeonZipArchives which installs anechoic recordings, directivity files and 
room models which includes the complete setup of room, materials, sources, receivers, jobs, 
anechoic recordings etc. ready for simulation. 

Output signals 
The output signals from all binaural auralisation are stored in two channel wave files and will have 
the same leading name as the room. The result files, being in the wave format, makes it easy to edit 
and publish the results, e.g. on the Internet or in Microsoft Power Point presentations. It is possible to 
drag and drop the file directly from the tables in the Job List and Auralisations tables into e.g Microsoft 

Power Point or into a folder in the Windows Explorer. 
 
If you need to manage many of the auralisation output files then it is an advantage to know the 
naming convention of these. The binaural impulse response files have the extension .Jnnnn.Wav 
where nnnn refers to the relevant job number. The wave files created as results from the Convolve BRIR 

and Signal file table, will have the extension .ConvAuralnnn.Wav where nnnn refers to the row in the table 
(Conv. no.). The wave files, created as results from the Mix convolved wave results into one wave file table, 
will have the extension .MixAuralnn.Wav where nn refers to the row number in the table (Mix. No.). 
 
The output from surround auralisation follow rules similar to those of the binaural ones. The 
impulse responses are stored in wave files following the WaveFormatExtensible format where a signal 
is available for each loudspeaker/channel in the specified surround setup. The impulse response 
has the extension .SurRoundnnnn.Wav where nnnn refers to the relevant job number. The convolved 
files have the extensions .ConvSurRoundAurannlnn.Wav where nnnn refers to the row in the table (Conv. 

Note 8 bit resolution is not recommended for normal use, but can be useful for education 
purposes in order to demonstrate dithering. Outputs created with the Apply dither and noise shaping 
disabled will sound horrific in the 8 bit resolution and output quality improves greatly when 
dithering is enabled. The improvement in quality caused by dithering is less audiable at higher 
bit resolutions – but still important. 

                  
                  

https://odeon.dk/downloads/anechoic-recordings/
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no.) and vice versa for the mixed files. These files should be playable using most applications for 
for audio play back e.g. the Windows Media Player. 
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ODEON derives a large number of acoustics parameters from simulations as well as 
measurements. Many of them are calculated according to the ISO standard 3382, part 1, 2 and 3 for 
room acoustics, for Performance spaces, Ordinary spaces and Open-plan offices respectively (ISO 3382-
1, 2009). 
This chapter will shortly describe the most common of these parameters, what they are used for, 
and the theory behind. This manual will not cover the use of the individual parameters in depth. 
Recommended values given for the parameters should only be considered as a first suggestion. 
Besides using the default parameters, since ODEON 11 you can define your own ones or edit 
existing ones in the Room Acoustic Parameters List .  

8.1 Decay curve 
Reverberation parameters in ODEON are related to the decay curve. This is the curve that shows 
how sound energy decays in time, after a continuous noise source has been switched off. A decay 
curve is derived from the impulse response, which includes all information regarding reflections 
and absorption at a particular receiver position. Since each subsequent reflection becomes weaker 
due to sound absorption from the surfaces in the room and from the air, a decay curve has always 
a negative slope. Decay curves in ODEON are calculated for eight octave bands (63Hz to 8000Hz) 
separately. The following figure shows an example. Here the overall level, as shown on the left 
axis, is negative, which simply means that the sound power of the sound source used in this 
example is very low. For simulations, where background noise is inherently absent, there is 
absolutely no problem in having very low (e.g.: negative) levels for the decay curves. Since many 
simulated parameters only depend on the slope of the curves and not the actual levels, results will 
be reliable. Some room acoustics parameters does relies on ‘actual’ levels and these will be 
mentioned explicitly further below. 

 

 
 

 

8.2 Reverberation Time and Early Decay Time  
Reverberation time is the most frequently used parameter in room acoustics. Some acousticians 
rely only on reverberation time when evaluating room acoustics, but for most cases this is not 

 Room Acoustical Parameters 

Remember: For reverberation times and many other room acoustic parameters, the actual level of the 
decay curve is not crucial. The parameters depend on the slope and the shape of the decay. Therefore, 
even negative dB values are accepted, which is the case if a very weak sound source has been used in 
the Source-Receiver list (e.g. the default Omni.SO8 source). 
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sufficient. The reverberation time is defined as the time it takes for a sound to decay by 60 dB after 
the sound source has been switched off. This is noted as T60.  
The most common experience of reverberation time in a space is when making a fast hand-clap. 
This corresponds to a loud sound source which has been ‘turned on’ and ‘off’ almost momentarily, 
leaving a decaying tail of sound which often takes one or a few seconds to cease. Reverberation 
time can reveal information about the size of a room and absorption in a room. Large rooms with 
sound reflective surfaces have longer reverberation times, while small rooms with sound 
absorptive surfaces have short reverberation times.  
 
When measuring reverberation time in practice there is always a considerable level of background 
noise in the recording (ambient acoustic noise, electric noise in microphone, electronics, cables, etc.) 
which reduces the range of 60dB required to derive T60. Therefore, reverberation time is calculated 
based on smaller decay ranges (10 dB, 15 dB, 20 dB and 30 dB) instead, which are well above the 
background noise level. However, the corresponding time it takes for each decay range is always 
multiplied by an appropriate factor to extrapolate the time for 60 dB decay. Calculating 
reverberation time in this way results in multiple different numbers for reverberation time:  The 
following graph shows the process:  
 

 
 

• Early Decay Time (EDT) is obtained from the initial 10 dB drop of the backward-integrated decay 
curve, by applying the best-fit linear regression line between 0 and -10 dB. Assuming that decay 
is linear, extrapolation of 10 dB range to 60 dB requires multiplication by 6. In the example 
above, the time elapsed for 10 dB decay is 0.2 s. Therefore EDT=6*0.2=1.2 s.  
Early Decay Time has to do with the early sound reflections only. If a sound source is 
continuous, e.g. speech or music, a lot of the reverberation of a sound incident will be masked 
by the next sound incidents. Thereby the late part of the reverberation will become unnoticeable. 
Early decay time is related to the first -10dB and can be a better parameter to investigate the 
experienced reverberation of continuous sound sources than Reverberation Time is.  
Since the early part of the decay is dominated by the direct sound and it is much steeper than 
the rest, EDT is usually shorter than the rest type of reverberation times. 

• Reverberation time T15, obtained applying the best-fit linear regression line between -5 and -20 
dB (not shown in the graph above), and then multiplied by 4. 
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• Reverberation time T20 is similar to T15.  The linear regression line is found from -5 to -25dB and 
then multiplied by 3. In the example above T20=3*0.6=1.80s. 

• Reverberation time T30 is similar to T15.  The linear regression line is found from -5 to -35dB and 
then multiplied by 2. In the example above T30=2*0.93=1.86s.   

 
For simple rooms, with evenly distributed absorption, the different values of reverberation times 
can be very close to each other, since the decay is almost a straight line (in decibels, therefore a 
logarithmic scale). For coupled spaces and other complex rooms, the decay curve might change the 
slope through time, therefore reverberation time can be quite different depending in which part of 
the energy curve has been used for evaluation.  
 
 

Guidelines for calculating Reverberation time 
It is generally not correct to calculate reverberation time at specific receiver positions In many 
rooms, the number of people present can have a strong influence on the reverberation time. 
Reverberation time measurements should be made in a room containing no people. However, a 
room with up to two persons present may be allowed to represent its unoccupied state, unless 
otherwise specified. If the measurement result is used for correction of a measured sound 
pressure level, the number of persons present in the room should be the same for that 
measurement. In large rooms, attenuation by air can contribute significantly to sound absorption 
at high frequencies. For precision measurements, the temperature and relative humidity of the air 
in the room shall normally be measured. 
The contribution from air absorption is negligible if the reverberation time is shorter than 1,5 s at 
2 kHz and shorter than 0,8 s at 4 kHz. In this case, it is not necessary to measure the temperature 
and relative humidity. 
 
Source-receiver positions 
Source-positions may be chosen as the normal position according to the use of the room. In small 
rooms such 
as domestic rooms or when no normal positions exist, one source-position should be in a corner 
of the room. 
Microphone-positions should preferably be at least half a wavelength apart, i.e. a minimum 
distance of around 
2 m for the usual frequency range. The distance from any microphone-position to the nearest 
reflecting 
surface, including the floor, should preferably be at least a quarter of a wavelength, i.e. normally 
around 1 m. 
Symmetric positions should be avoided. In the special case of a moving microphone, the sweep 
radius shall 
be at least 0,7 m. The plane of the traverse shall not lie within 10° of any plane of the room (wall, 
floor, ceiling). 
The duration of a traverse period shall not be less than 15 s. 
The microphone-positions shall not be too close together. Otherwise the number of independent 
positions is 
less than the actual number of measurement positions. The minimum numbers given in Table 1 
are the 
numbers of independent positions. 
 
Couples spaces 
Coupled spaces and RT measurements: See ISO 3382-1, section 4.3. Last sentence: 
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"If these conditions are not satisfied, then the room is likely to show areas with differing 
reverberation times, 
and these shall be investigated and measured separately." 
 

Impulse Response Resolution 
The energy of all the reflections received at the receiver point is collected in histograms in regular 
time intervals, which are specified in the Room setup>Impulse response resolution. After completion of the 
response calculation, early decay time and rest reverberation times are calculated according to the 
procedure described above. 

Problems Calculating Reverberation Time 
Many times reverberation time fails to be calculated, leaving *.** values in the Energy Parameters 
tabsheet or empty bars in the Parameter bars Tab Sheet. 

 

 
 
Another problem can be number of late rays. If the room is complex, consists of coupled spaces or 
is outdoor, there will be a need for a higher number of rays. Go to Room setup |Number of late rays and 
increase it. You can always look at the Decay curves to evaluate if there are enough rays. A smooth 
slope means enough rays, where one with drastic drops could be a sign (though, not necessarily) 
of too few rays. 

Curvature, C 
Curvature is an important parameter indicating how straight the decay curve is. It is defined as: 
 

𝐶𝐶 = 100 �𝑇𝑇30
𝑇𝑇20

− 1�              (%) 

 
Ideally, decay curves should be as straight as possible, corresponding to an exponentially decaying, 
diffuse field. In such a case, T20 and T30 would be equal and the curvature would be 0. In real life, 
the decay curve is rarely straight, with the early part being typically steeper than the late part. T20 
is affected mostly by the early part, while T30 by the late. Values of curvature below 10% are 
perfectly acceptable for most practical applications, while values higher than 15% are not 
recommended. In such cases, the late part of the decay has significantly shallower slope than the 
early part, typically because of flutter echoes between parallel hard walls and uneven absorption 
in the room. The most common example is absorption concentrated on the ceiling, while the walls 
remain hard. This results in a 2-dimensional sound field (between the parallel hard walls) which is 
illustrated in the double-slope decay curve. When a high curvature value is present, the number of 

Warning: The most common reason for failing to obtain results is that the impulse response 
length in the calculation is too short. Try going to Room setup |Impulse response length and make it 
longer. Typically, 2/3 of the expected reverberation time is enough.  
 
 
 



101 
 

late rays in the Room Setup needs to be increased dramatically, well above the Precision setting. 
Otherwise, the results become highly unreliable and values of room acoustic parameters fluctuate 
with increasing number of rays, until convergence is achieved.  
 
In the following example the bended curve problem is illustrated. The dashed lines roughly 
indicate the slopes that correspond to T20 and T30 for the low-mid bands. The calculated Curvature 
is shown below and it is well above 15%. In this example 22000 late rays were used, instead of the 
recommended 16000 by the Precision setting in the Room Setup. 
 

 
 
 

 
 
The following table aims to give some general guidelines when evaluating curvature in 
simulations.  
 

Curvature 
C(%) 

Situation Number of late Rays 
needed in the Room 

Setup 

Comments 

<10 Acceptable bending of 
decay curve. 

Engineering – Precision 

setting. 
Results are reliable and 
converge with an increasing 
number of rays.  

T30 

T20 

5 dB lower from peak 

Regression line interpolated between  
the points of the decay curve. 
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10-15 Bending of decay curve 
starts to become an 
issue. 

At least 2 times the 
Precision setting.  

You need to increase the 
number of rays beyond the 
Precision setting to achieve stable 
results.  

>15 Extreme bending of 
decay curve  that should 
be avoided. 

At least 10 times the 
Precision setting.   

Simulations become unreliable 
and convergence might only be 
seen after using an enormous 
number of Rays. 

 
 
 

8.3 SPL, G, C80, D50, LF80, STearly, STlate and STtotal 
Multiple acoustical parameters have been defined through time, to investigate different influences 
of the room acoustics on the subjective experience of sound. ODEON includes a range of these, and 
you can add your own based on the same principles. Many of these parameters have to do with 
sound energy arriving at the receiver positions at different time intervals. For example, the 
parameter Clarity (C) is based on the fact that for some music and for speech, the sound energy 
arriving before 50 or 80ms has the most influence on how clearly the sound is perceived, compared 
to the energy arriving later.  
 
When derived in ODEON the energy of each reflection is added to the appropriate term in the 
formula of all the energy parameters, according to its time and direction of arrival. After the 
response calculation, C80 (Clarity), D50 (Definition), Centre Time, SPL (Sound Pressure Level), LF80 
(Lateral Energy Fraction), STearly, STlate and STtotal are derived. 

Explanation of formulae 
Only a few common parameters that are available in ODEON are listed here. You can find the 
definitions of parameters from within the Room Acoustic Parameter List in ODEON where the formulas 
are listed, and you can also enter new parameters.  
 
In the following formulae, baE −  is the sum of energy contributions between time a and time b after 
the direct sound, time t is the end of the calculated response, and tβ  is the angle between the 
incident direction and the axis passing through the ears of a listener, for the reflection arriving at 
time t.  
It is worth noticing that parameters relying on the baE −  term assume that time a and b are well 
defined - however this is not the case when there is no direct line of sight between source and 
receiver. It makes results questionable in simulations as well as in real measurements when direct 
sight between source and receiver is not present. 

SPL (Sound Pressure Level)  
The SPL is the level of the sound pressure. It is a parameter often used in regulations for e.g. 
industrial noise levels, since high levels damage hearing. It is also used for regulations on sound 
levels in living quarters or concerts, for the consideration of neighbours.  
 
When using SPL in ODEON, it is important that the sound source has the correct Sound Power, 
since an arbitrary Sound Power at the source will give an arbitrary SPL at the receiver positions.      
Measurements in real rooms using ODEON will normally give an arbitrary SPL level, because the 
hardware used is not capable of obtaining exact SPL levels. It can, however, give relative SPL levels 
compared to each other. When the source power is 31 dB per octave then SPL equals the G 
parameter (Strength) assuming an omni directional source.  
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)()log(10 0 dBESPL ∞−=  

G (Strength) 
The G parameter (Strength) is defined in (ISO 3382-1, 2009). It helps investigate how much the 
acoustics/reflections of the room contributes the level of the source. In a very reflective space/room 
there will be a high contribution, in an absorptive space there will be a low contribution. The 
reference level of 0 dB is obtained in free field at a distance of 10 metres from an omni directional 
point source. This is obtained by normalizing the Sound Power of an OMNI directional point 
source to 31dB per octave. Odeon will only calculate the G parameter if the job in Job List: 
 

• Contains only one active source 
• The source is a point source 
• The directivity file name contains the substring omni (case insensitive) 

 
In this case Odeon will automatically normalize the source power to 31 dB per octave for the 
calculation of the G parameter(s) – see below. 
 
If you want to measure G using ODEON in a real room, you need to calibrate the measuring 
system, software, and hardware, using one of the different calibration methods available in 
ODEON and you should use an omni directional source.  

Gearly and Glate 
Gearly and Glate are two additional strength parameters used in auditorium acoustics to see how 
much the room contributes to the early and late part G. The early G includes the energy arriving 
within the first 80 ms and the late G the energy arriving after the first 80 ms, relative to direct sound. 
Details given for the G parameter also apply to Gearly and Glate. 

C50 , C80 and C7 (Clarity). 
Early reflections arriving before 80 ms after the direct sound contributes to the clarity of symphonic 
music whereas sound arriving after 80 ms has a “blurring” effect. The (ISO 3382-1) states that C50 
is appropriate for speech and C80 for music. It should be noted that much acoustical research has 
been made for classical music, but for rhythmical music (pop, rock, etc.) it may not apply in the 
same way. C50 investigates the relation between sound energy before and after 50ms. For C80 it is 
80ms. ODEON also includes C7, a parameter that investigates the relation between what may be 
expected to be direct sound (before 7ms) compared to reflections. The C7 is mainly for 
measurements, since direct sound in simulations will be theoretically ideal and will arrive at 0s. 
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D50  (Definition) 
Definition is very close to being the same as clarity, but both exist due to historical reasons. 
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Ts (Centre time)  
Relates to perceived definition, clarity, or the balance between clarity and reverberance, as well as 
to speech intelligibility. 



104 
 

)(
0

0 ms
E

tE
T

t

s
∞−

∞

∑
=  

LF80 (Lateral Energy Fraction) 
LF is a parameter for the spaciousness of the room. A room is acoustically very spacious if it 
makes a sound source be perceived as “wider”.  
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The LF80 parameter has a high correlation with the apparent source width (ASW) as shown in 
(Bradley, et al., 1995). 
 

Lj (Average)1 
This parameter is suggested in (Bradley, et al., 1995) and is included in (ISO 3382-1, 2009). 
Lj(Average) has a very high correlation with the subjective parameter Listener envelopment (LEV).  
 

)()(cos
4
1log10)(

1000

125 80

2
80 dBEAverageLj

Hz

Hz

N

N t
tt 







= ∑ ∑

∞

=

∞ β  

 
An alternative name for this parameter could have been “Late Lateral G”, because the level is 
normalized in the same manner as for G, Gearly and Glate . Details given for the G parameter also 
applies to Lj. 

Example of target values 
Depending of the purpose of a room, the target values for the acoustical parameters will be 
different. Auditorium acoustics as in Concert Halls, Opera Halls, Multipurpose halls, etc. are dealt 
with in (Beranek, 1996) and (Barron, 1993), where halls from all over the world are presented along 
with a judgement of their acoustics, supplied by a guideline for design. Short guidelines on values 
for Clarity and G in concert halls, based on some simple design parameters such as width, height, 
floor-slope, etc. are given in (Gade, 1997). Below some recommended values for room acoustical 
parameters are shown: 
 

Objective parameter Symbol Recommended 
(symphonic music) 

Subj. limen 

Reverberation time T30 1.7 - 2.3 seconds 5 % 
Clarity C80 - 1 to 3 dB 1 dB 
Level rel. 10 m free field G > 3 dB 1 dB 
Early Lateral Energy Fraction LF80 > 0.25 5 % 
Early Support STearly > -13 dB  
Total Support  STtotal > -12 dB  

 

 
 

Recommended values for objective room acoustical parameters (ISO 3382-1, 2009) in large music rooms with 
audience, according to Gade (Gade, 2003). Subjective limen as given by Bork (Bork, 2000) and Bradley (Bradley, 
1986). 
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8.4 Stage Parameters 
Stage parameters refer to how the acoustics influence the experience for the musicians playing on 
a stage. The relation between the direct sound and reflection from the surfaces affects how well can 
they hear themselves and each other. 
 
The parameters are called Early, Late and Total Support, and are described more thoroughly in 
(Gade, 2003): 
 
Stage parameters are calculated as a part of the Single Point response (Auditorium and Combined 
versions only). If the job only contains one active source, the active source is a point source and the 
distance between receiver and source is approximately 1 metre (0.9 to 1.1 metre).  

Early Support or ST1: 
STearly or ST1 is used as a descriptor of ensemble conditions, i.e. the ease of hearing other members 
in an orchestra. 
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Late Support: 
STlate describes the impression of reverberance. 
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Total Support: 
STtotal describes the support from the room to the musician’s own instrument. 
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8.5 IACC – Inter-Aural Cross Correlation  
Since the hearing process is binaural, the spatial impression in a concert hall can be quantified by 
measuring the inter-aural cross correlation between the left and right ear canal (ISO 3382-1, 2009).  
 

IACC in math 
The Inter-Aural Cross Correlation is expressed as a coefficient from 0 to 1. First, the normalized 
inter-aural cross correlation function is calculated: 
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where: 

)(tpl  is the impulse response at the entrance to the left ear canal. 

)(tpr  is the impulse response at the entrance to the right ear canal. 
 
Then, the inter-aural cross correlation coefficient is calculated as: 
 

2121 ,, max tttt IACFIACC =  for ms 1ms 1 +<<− τ . 

 

IACC in ODEON 
To simulate IACC in ODEON you need a virtual dummy head. Therefore, these parameters are 
only calculated as part of the Single point response. In order to calculate IACC correctly a neutral 
dummy head without localization enhancement is needed. To create a new HRTF filter without 
localization enhancement: 

• Open Tools > Create filtered HRTF. 
• Choose Subject_021Res5deg.ascii_hrtf. 
• Press ok (make sure "Apply localization enhancement" is NOT on). 
• Go to the "Auralisation setup" in the top-menu bar. 
• Checkmark "Create binaural impulse response file". 
• For the HRTF choose: 

  Subject_021Res10deg_SRate44100_Apass0,50_Astop40,00_BOvrLap100%_PPrHRTF256. 
• Delete everything in Headphone (the area will turn red).  
• Close window. 

 
If this is something you do often/in many rooms, you can change the default:  

• Go to Options > Program Setup. 
• Choose Auralisations tab. 
• For the HRTF choose: 

ChoosSubject_021Res10deg_SRate44100_Apass0,50_Astop40,00_BOvrLap100%_PPrHRTF256 
• Delete everything in Headphone (the area will turn red).  
• Close window 

8.6 STI – Speech Transmission Index 
To investigate how well speech is understood for a receiver in a room, the Speech Transmission 
Index, STI, can be used. It is calculated in ODEON according to (IEC 60268-16, 2011).  
 
The STI parameter takes into account the background noise, which may be adjusted from the Room 

setup. For the STI parameter to be valid, it is very important to adjust the background noise 
accordingly see below.  
 
Do notice that it is not stated in the (IEC 60268-16, 2011) standard what kind of directivity the source 
in the STI measuring system should have. So, if using a source with a different directivity in 
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simulations than the one used in the real measurements, results may not be comparable. The 
subjective scale of STI is given below: 
 

Subjective scale STI value 
Bad 0.00 - 0.30 
Poor 0.30 - 0.45 
Fair 0.45 - 0.60 

Good 0.60 - 0.75 
Excellent 0.75 - 1.00 

 
In the point response and multi-point response results, five different speech transmission indexes 
are shown: 

STI 
This is the best known form of STI is derived for an average gender-independent voice spectrum. 
This basic STI parameter can be calculated using relative source power levels e.g. you may set the 
power of the source to 0 dB and still get meaningful results If using relative source power levels it 
is important though that the background noise (SPL) is set in a relative level if relative source gains 
are used. To exclude the background noise entirely from calculations, leave the background noise 
levels at -99 dB in the Room setup. 

STIMale and STIFemale 
These are STI values are adapted for male and female speakers, according to their speech spectrum. 
Contributions of each Octave Band to the STI as well as the information overlap from one band to 
another (masking), is taken into account. These two STI values also include compression effects in 
the human hearing which decreases their values at high levels (in particular relevant for Voice 
alarm system). Because calculations depends on the actual sound pressure levels that occurs at the 
receiver, the source power levels of the sources must be the actual ones. In similar manner the 
levels of the background noise in the Room setup must be the actual levels as they are measured in 
the real room. 

STIExpected 

The expected STI value is calculated on a theoretical basis, taking into account the reverberation 
time of the room and the background noise, but not the explicit shape of the impulse response. In 
other words the STIExpected is the value of STI that would be expected in a diffuse sound field with 
the given reverberation time and noise level. Comparing actual STI values with the expected ones 
can indicate if STI has been improved – the actual values should be higher than the one expected 
in a diffuse field. 

RASTI 
An abbreviation of Rapid STI that is considered an obsolete parameter in the revised (IEC 60268-
16, 2011) standard. It is based only on two Octave Bands: 500 Hz and 2000 Hz and provides a faster 
and simplified calculation of the STI. Nowadays, in simulation and in measurements using the 
sweep method as in ODEON, speed is no longer an issue.  
 

8.7 DL2 – Rate of Spatial Decay 
ISO 14257 parameters (ISO 14257, 2001) can be calculated as part of the Multi point response from within 
the Job List. In order to calculate ISO 14257 parameters in ODEON 16, a point source needs to be 
defined using the Point source editor in the Source-Receiver List. This point source must be assigned a 
Directivity pattern which contains the text OMNI in its name. This source and no other source must 
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be activated in a job and a number of receivers with different distances from this source must be 
defined. If the above conditions are not met, these ISO parameters are not available in the Multi point 

response display. 
 

 
 
The rate of spatial decay DL2 is the decay of sound pressure level per doubling of distance. The DL2 
parameter is intended to characterise the acoustic performance of workrooms. 
 
DL2 is calculated in ODEON according to (ISO 14257, 2001). The values to be expected for the DL2 
parameter are, according to (Ondet, et al., 1995): 1 to 3 dB for reverberant rooms and 2 to 5 dB, for 
ideally treated rooms. The design criterion for DL2 is set to 3.5 dB or better according to (ISO 11690-
1, 1996). 
 
The DL2 parameter is calculated as part of the Multi Point response. If the job only contains one active 
source, the active source is a point source, and if more than one receiver is defined, the distance 
between the source and the receivers is not the same for all receivers. Please notice that one 
misplaced receiver may ruin the entire DL2 calculation, thus it is a good idea to check the receiver 
positions - or even better - check the individual results of the Multi Point calculation. 
 
DL2 is stated for the frequency bands 63 Hz to 8 kHz, and DL2,Co.  is the A-weighted Rate of Spatial 
Decay for the frequency bands 125 Hz to 4 kHz. For DL2, as well as DL2,Co the correlation coefficients 
are calculated. If the correlation coefficients are low, this may indicate bad locations of source 
and/or receivers, however it may also indicate a very low damping in the room (the Spatial Decay 
Curve being almost horizontal). 
The measuring points (Receivers) and the source position are of course essential to the DL2 

parameters and should follow (ISO 14257, 2001). As an example, a path of receivers may be chosen 
in the following distances from the source (using logarithmic increment): 
 

1, 2, 4, 5, 6.3, 8, 10 metres 
 
The positions should also follow the standard with respect to distance from floor and reflecting 
surfaces. ODEON will use all the receivers defined in the Receiver list. The Multi point response display 
will calculate and display values for DL2 based on all the receivers visible in the 3D Source and Receivers 
tab in the Multi point response. Make sure to create a group with relevant receivers in this display – or 
simply deactivate irrelevant ones.   
 
 

8.8 ISO 3382-3 (Open-plan offices) parameters 
ISO 3382-3 parameters (ISO 3382-3, 2012) can be calculated as part of the Multi point response from 
within the Job List. In order to calculate ISO 3382-3 parameters in ODEON 16, a point source needs 
to be defined in the Point source editor. This point source must be assigned the Directivity pattern: 
ISO3382-3_OMNI.SO8. This source and no other source must be activated in a job and a number of 
receivers must defined within a distance of 2 to 16 metres from this source. If the above conditions 
are not meet these ISO parameters are not available in the Multi point response display. 
 

Remember: The ISO 14257 parameters need certain conditions to be met in order to show up in the 
Multi point response display: Only one OMNI source active and a number of receivers placed at different 
distances. 
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The ISO standard 3382-3 describes a range of parameters to investigate the influence of room 
acoustics in open plan offices. There are two application notes on our website explaining how to 
work with these parameters (currently located at https://odeon.dk/learn/application-notes/). The 
following parameters are supported: 

Spatial distribution of STI 
This curve shows the decrease of speech transmission index as a function of the distance from the 
source. 

Distraction distance - rD 

It is the distance from the sound source where the speech transmission index falls below 0,50. Here 
we focus on the receiver and his/her ability to concentrate when somebody talks at a distance. 
Further than the distraction distance, concentration and privacy start to improve dramatically for 
the receiver.  

Privacy distance – rP 
It is the distance from the speaker where the speech transmission index falls below 0,20. Here we 
focus on the talker and how well his/her speech is protected from being spied by the receivers in 
the office. Further than the privacy distance, concentration and privacy are experienced very much 
the same as between separate office rooms. 
 

 

Spatial decay rate of A-weighted SPL of speech – D2,S 

This curve shows the decrease of the A-weighted SPL per doubling of distance from the sound 
source. The sound source emits noise with the sound power spectrum of normal speech (directivity 
pattern: ISO3382-3_OMNI.SO8). 

A-weighted speech at 4 meters 
Nominal A-weighted SPL of normal speech at a distance of 4m from the sound source. These levels 
are summed up over the octave bands from 125 to 8000 Hz. 

A-weighted background noise 
The quantity shows the level of background noise summed up over the octave bands from 125 to 
8000 Hz. 

8.9 Edit/Make Room Acoustic Parameters 
In ODEON, the user is able to edit the room acoustic parameters calculated in the point response - 
or define their own. Get more information on how to do this by using the context-sensitive help 
(F1 shortcut) while having the Room Acoustic Parameters list open.  
 
In the Room acoustic parameter list, you can select which room acoustic parameters will be visible in 
results, what range graphs will display for different parameters, change the parameters or make 
new ones. 
 

Remember: The ISO 3382-3 parameters need certain conditions to be met in order to show up in the 
Multi point response display: Only one ISO382-3 OMNI source active and a number of receivers placed at 
within a distances between 2 and 16 metres from the source. 

Remember: We want both Distraction distance and Privacy distance to be as short as possible, but for 
different reasons. In the first, we want to ensure that the receiver is not distracted by people talking in 
the office. In the second we want to ensure that the talker (source) cannot be spied by the receivers.  

https://odeon.dk/learn/application-notes/
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In the unexpanded view, you can see which parameters that will be visible in the results. By 
clicking the plus in the upper-right corner, you go to the expanded view. Here you can change 
visibility the parameters, edit parameter definitions and create new ones.  
 
The more basic user options are:  

• Change the name of a parameter 
• Make a parameter active/inactive by using the ‘visible’ option.  
• Set parameters such as T30 and Centre Time, which have a natural origin, to be displayed 

in graphs with ordinates starting at zero. 
• Set a manual range of values in the grid-display. If not set, the range will be automatic for 

most parameters, and therefore changing for each calculation. 
• Choose if the Jnd is in %. The default settings will be in reference to literature, so only 

change it if needed.  
• Choose which of the parameters are measured at all. 
 

The advanced user options are:  
• Define the Type of a parameter: Reverberation, T30, SPL, Centre Time, Formula, Dietsch,, MTI, 

MTI(corrected), G, G(early), G(late) and Lj. 

• Edit the formula for a parameter. How to do this is mainly described in the help file, press 
F1 when in the Room acoustic parameters list. 

• Make a new parameter. How to do this is mainly described in the help file, press F1 when 
in the Room acoustic parameters list.  
 

You can also:  
• Save a parameter list for later use. 
• Load a saved parameters list. 
• Restore default parameters list. 

 

 
 
The value of energy intervals in the left side of the window can be used as a variable in a parameter 
expression, when changing or making a new parameter. If you have to use an energy interval from 
a specific time point t’ to the end of the response, you have to make use of the predefined whole 
response length and subtract the interval from t=0 sec to t’ (e.g. E_Omni50ms_Total = E_Omni_Total - 

E_Omni50ms). For a formula type, the equation can be written explicitly in the white box. A list of all 
mathematical expressions available in the edit formula mode is found in Appendix G: 
Mathematical Expressions. 
 
 
 
 
 
 
 
 
 
 
 

Hint! Odeon Auditorium and Combined includes a large number of predefined room acoustics 
parameters and allows this list to be expanded. Depending on the type of project you may want 
to entirely exclude and to make some parameters invisible by default. Use the Load parameters from 

program folder to use one of our predefined pre-sets for different kinds of projects e.g. Class room, 

Concert hall, Industri, Open plan office and Rock_venue. This will make the calculations results shorter and 
clearer and make it faster to scroll between parameter results. 
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ODEON is an energy-based room acoustic modeller, meaning that sound waves are represented 
by rays. A ray can be understood as a straight line connecting a source and a receiver. Reflections 
are represented by image and secondary sources, where the sound is still considered as rays.  
These simplifications make it possible to calculate the acoustic response in large spaces, while 
maintaining a short computation time and a high level of accuracy. Phase information is not 
included in the propagation of sound.  
All calculations in ODEON are performed in the energy domain - not in the pressure domain. 
Therefore, the acoustic differential equations cannot be solved directly as it is done in Finite Element 
(FEM) or Boundary Element (BEM) methods.  

9.1 What can be modelled in ODEON 
The calculation methods from room acoustics that are used in ODEON are mostly for geometrical 
tasks, and they are valid for spaces and frequencies where high modal overlap occurs. That is, 
when there are so many modes (standing waves) that the sound field becomes smooth. Single 
modes are prominent at low frequencies, in small, reverberant rooms. But fortunately, a moderate-
sized space (like a classroom) is already considered a big volume where there is high modal 
overlap, so the room acoustic algorithms used in ODEON can be applied safely. The following 
theoretical formula, proposed by Schroeder, gives the minimum frequency at which there is 
guaranteed to be enough modal overlap that such energy-based methods can be applied: 
 

2000sch
RTf
V

=  

 
RT is the reverberation time in the room (inversely proportional to absorption) and V is the volume. 
As an example, in a concert hall with reverberation time 2 sec and volume 600 m3, the Schroeder’s 
frequency would be 115 Hz. Therefore, an energy-based calculation in the octave band 125 Hz can 
be considered reliable in terms of modal overlap, since most of the frequencies in the band are 
already above the Schroeder frequency. Additionally, in practice, we can accept frequencies well 
below the Schroeder’s limit, especially in large halls. Experience has shown that even frequencies 
lower than 50% from this limit can be reliable. 
Taking into account the limitations from the energy-based (high frequency) methods, we assume 
that ODEON calculations are more reliable in moderately-sized and larger rooms. As absorption 
becomes higher, this size can be reduced. ODEON has been successfully used for rooms such as: 
 
• Meeting Rooms. 
• Classrooms. 
• Offices – open plan offices. 
• Auditoriums. 
• Concert halls. 
• Opera halls. 
• Big rehearsal halls. 
• Small scale city plans (outdoor 

modelling). 
• Cathedrals, worship spaces. 

• Restaurants. 
• Shopping malls. 
• Multi-floor buildings with atriums. 
• Cinemas. 
• Theatres. 
• Open theatres. 
• Train stations. 
• Airport terminals. 
• Noise halls (factories). 
• Industrial spaces.

 Calculation Principles 
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9.2 Global decay 
ODEON contains two methods for calculating the global decay of rooms. These should not be used 
in place of calculations from sources to receivers, but are good for first or global impressions: 
• Quick Estimate, which is available from the Materials List, is the fastest method allowing quick 

evaluation of the effect of modifying materials. This method should be considered only as a tool 
for preliminary results. 

• Global Estimate is a more precise method, allowing high quality results, though still not 
representing the sound experience of a receiver at a specific position, which may be slightly 
different. 

Quick Estimate 
The Quick estimate tool  estimates volume and total absorption, which is inserted in the Sabine, 
Eyring and Arau-Puchades formulas to give an estimate of the reverberation time. Instead of 
simply taking the areas of the surfaces and multiplying by the corresponding absorption 
coefficients to obtain the total absorption in the room, ODEON also sends out 'particles' from the 
source - assuming diffuse conditions and reflecting them in random directions, keeping track on 
how many times they hit each surface. Surfaces that are hit very often contain higher influence of 
the overall absorption coefficient of the room. Surfaces, which are not detected at all in the ray-
tracing process, are left out of all calculations - and surfaces which are hit on both sides are included 
twice in the calculation. As a result, the estimated reverberation time corresponds to the sub-
volume in which the selected source is located. Do note that if a part of the area of a surface, which 
is present in the sub-volume, is located outside that sub-volume (e.g. if two sub-volumes share the 
same floor surface) then the area and surface estimates for the statistical calculations may not be 
entirely correct. To partly compensate for that it is possible to set a volume manually. 
 
The classical mean absorption coefficient is given by: 
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iS  and iα  are the area and absorption coefficient of the ith room surface, respectively. 
 
The modified mean absorption coefficient as experienced by the particles is: 
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Hi is the number of hits on the ith room surface. 
 
In ODEON, both mean absorption coefficients are inserted in the Sabine and Eyring formulae to 
calculate reverberation times; the classical values are labelled Sabine and Eyring, and the values 
using the modified mean absorption coefficient are labelled Modified Sabine and Modified Eyring. The 
mean absorption coefficients used for the Arau-Puchades formula are derived in similar ways 
except that separate values for surface hits, area, and the corresponding mean absorption 
coefficients, are calculated as projections onto each of the axes of the room. The Sabine, Eyring and 
Arau-Puchades formulae require a value for the room volume. This is estimated by ODEON from 
the mean free path, experienced by ray tracing and using the well-known relation for the mean free 
path in a 3-dimensional room: 
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where V  is the room volume and S is the total active surface area. The ray-tracing process is 
carried out in order to estimate the room volume, considering scattering coefficients of 1 for all 
surfaces, rather than using the coefficients assigned to the surface in the materials list, where the 
mean free path formula is based on diffuse field assumptions. 
 
The value of S  is used in the sum of the areas of non-transparent surfaces, taking into account 
whether one, two or indeed none of the sides of a surface are visible inside the room. 

Convergence criterion 
A certain number of particles must be sent out and followed around the room for a stable estimate 
to be obtained. More and more particles are sent out in random directions until the value of the 
reverberation time has remained within 1% for at least 50 particles. At the end of a run, the data on 
how many times each surface was hit is stored. Then, if new materials are assigned to the surfaces, 
the reverberation time can be recalculated instantaneously, without repeating the particle tracing. 
 

Global Estimate 
The global estimate tool  calculates the global reverberation times T20 and T30 using the method 
proposed by Schroeder (Schroeder, 1970), as well as the mean free path, and generates estimates of 
decay curves. Particles are sent out in random directions from the source (see Chapter 9.8) and 
reflected using the ‘Vector based scattering method’ (see Chapter 7.5). ODEON records the loss of 
energy in each particle, as a function of time, due to absorption in room surfaces and in the air. 
Summing over many particles, a global energy decay function for the room is obtained. The decay 
curve is corrected for energy, which is lost due to the truncation of the decay curve. This is 
analogous to an ordinary decay curve, except there is no specific receiver. The summation process 
may be carried on for as many rays as desired. 

Evaluating results 
When the decay curve seems smooth, you can derive the results. It is often the case that T30 values 
are larger than T20 values. If T30 values are lower than T20, it is likely that the used numbers of rays 
were too small - in this case you can press the Recalculate button. If the reverberation times are shown 
as *.**, the Impulse response length defined at the Room setup page is too short to derive the reverberation 
parameter. 

9.3 Response from Sources to Receivers 
This section describes the room acoustic simulation methods used to predict the (impulse) response 
from sources to receivers within from the JobList. The results can be shown as Single Point Responses, 
Multi Point Responses and Grid Responses. In ODEON Auditorium and Combined, the predicted response can 
be used for auralisation of any sound clip (see Chapter 7). These simulation methods aim to mimic 
real impulse response measurements, although they all operate in energy domain, while real 
measurements operate in pressure domain (see sec. 9.1). As a result, impulse responses in ODEON 
are inherently positive as a function of time, corresponding to the squared impulse response of a real 
sound pressure measurement. Real measurements show both positive and negative values, like 
plane waves do.       
 
In ODEON, different simulation methods are used in combination to ensure optimal performance 
and precision. These are the Image Source Method (ISM), Early-Scattering Method (ESM), Ray-Tracing 
(RT) and Ray-Radiosity Method (RRM). The first three methods collaborate in the early-reflections 

S
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part, while the last one is essentially the late-reflections part. In point source calculations both the 
‘early’ and ‘late’ reflection parts are used. In line or surface source calculations, only the ‘late’ 
reflection part is used.   

Transition order 
Every reflection is classified by an order, according to how many walls have been involved in the 
reflection path. In ODEON, a transition order is used to determine where the early-reflections part 
stops and the late-reflections part begins. The default value is 2, which means that all reflections 
that involve 2 walls are calculated according to the early-reflections part. Reflections of order 
higher than 2 (more than 2 walls involved) are calculated according to the late-reflections part.  
 

 
 
 

 

User inputs 
Various parameters controlling the calculation methods are accessible by the user in the Room setup. 
The Number of late rays and Transition order are of special importance, and should always be evaluated 
by the user (see Chapter 10).   

Early-reflections part 
During the early-reflections part the Image Source Method (ISM) and Early-Scattering Method (ESM) 
are used to determine the reflections and scattering originated from point sources up to the 
transition order. These two methods provide high deterministic accuracy in tracking the early 
reflections, which are probably the most important in the whole impulse response. The early 
reflections towards the receiver provide significant information about the origin of sound and the 
distance from the source.   

Image Source Method 
An image source is a mirroring of the source behind a wall. In the classical implementation, Image 
Sources are found by just taking all combinations of walls up to a given reflection order, e.g. Source-
Wall1-Wall2, Wall1-Wall3 and so on. After that, a visibility check has to be performed to determine 
which image source is actually visible from the receiver. If not, the image source is discarded. For 
simple rooms with few surfaces construction and visibility check can be easily accomplished. 

ESM 

RRM 
ISM 

Energy 

Reflection order 
Transition order 

Early- reflections Late reflections 

RT 
Ray tracing used to 
detect image sources 

Note: All the three methods may overlap in time, since the transition order can affect reflections at 
different times. The transition order criterion ensures that energy conservation is maintained during the 
gradual shifting from one method to the other.   
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However, for rooms with thousands of surfaces, developing the whole tree of combinations can 
lead to a huge number of image sources, with a significant percentage being not visible – therefore 
being discarded afterwards.  
In ODEON, a more efficient approach is utilized. A fast ray tracing algorithm is initiated from the 
source in order to help ‘detecting’ only visible image sources. Therefore, only the actual amount of 
valid image source is generated. The algorithm works as it follows: 
• A number of early rays is generated from the 

source (ODEON suggests a number based on 
room dimensions, Transition order and surface 
sizes). 

• The rays are reflected specularly until they reach 
the Transition order.  

• For each reflecting surface, a new image source is 
added to an image source tree. The number of 
image sources stored after this process is usually 
much lower than all combinations of reflecting 
surfaces, but the images are all valid because 
hidden surfaces and most very small surfaces are 
excluded. 

• For each of the image sources found in the early 
part of the receiver independent calculation, 
ODEON checks each to determine whether it is 
visible from the receiver. Images may be hidden 
because walls in the room block the reflection 
path to the receiver or because the receiver falls outside the ‘aperture’ formed between the 
image source and the surface generating it. The figure to the right illustrates the concept of 
visible and hidden image sources. If an image is found to be visible, then a reflection is added 
to the impulse response. 

 
 
 
 
 
 
 
 
 
 

 

 

 

Early Scattering Method 
For each visible image source that is generated, a range of early secondary sources is generated on 
the surface the image source corresponds to. These account for  scattering in the following way: 
• These early secondary sources will emit early scatter rays from the image source’s surface as 

defined by the Number of early scatter rays parameter. The early scatter rays will be traced from the 
current reflection order and up to the Transition order. At each reflection point of the early 
scattering rays, including the point of origin, a new early secondary source is created. 

• Every early secondary source visible from the receiver adds a reflection to the impulse response. 

Visible and invisible images. Images S1 and S21 are 
visible from R, while S2, S3 and S12 are not. 

P2

3

1

 
  
  

Image 
source 

Receiver 

Source 
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Source 

Receiver 

 
The attenuation of an image or early secondary source is calculated taking the following into 
account: 
• Directivity factor of the primary source in the relevant direction of radiation. 
• Absorption coefficients of the surfaces involved in generating the image (can be angle 

dependent if Angular absorption is enabled in the Room setup). 
• Air absorption due to the length of the reflection path. 
• Scattering loss (frequency dependent), due to the scattered energy which is handled by a 

‘scattering tree’. Based on the scattering of the surface, the sound energy is distributed between 
image sources (specular contribution) and early secondary sources (Lambert sources) from the 
same surface. If new image sources are again generated based on the current image source (if 
the Transition order has not been reached yet), the distribution will follow a scattering tree because 
of energy conservation principles. This allows a realistic calculation of early scattering. For more 
information about scattering, read section 9.5.  

 

Example 
In short, each time ODEON detects an image source, an inner loop of (scatter) rays (not visualised 
in the 3D Investigate Rays display) is started, taking care of the scattered sound which is reflected from 
this image source/surface.  
If all scattering coefficients in a room are 0.5, then the specular energy of a first order image source 
is multiplied by (1-0.5) - and the specular energy of a second order image source is multiplied by 
(1-0.5)*(1-0.5). The scattering rays handle the rest of the energy. 

Late-reflections part 
The Late-reflections part uses an ODEON-modified Ray-tracing method, called Ray-radiosity 
method, which proves to be very efficient. In the classical implementation of Ray-tracing, rays are 
thrown from the source, get reflected and traced by the algorithm. A detection sphere is formed 
around the receiver, so that whenever a ray intersects the sphere, the corresponding the reflection 
is added at the impulse response. Two main disadvantages of this method are that: 
• the size of the detection sphere is quite arbitrary - despite of the various methods used to specify 

it.  
• the ray tracing needs to be re-run for every new receiver.     
 
The Ray-radiosity method removes these disadvantages by dividing the process in two parts, the 
Rendering and Gathering. The rendering part of the calculation only stores geometrical information 
which does not involve material data nor receiver position. For the gathering part, the sources are 
“collected” by the receiver adding information to the energy curve. 
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Rendering (receiver-independent part) 
The purpose of this process is to find virtual sources that radiate energy into the room. Rather than 
thinking of reflections, the idea is to substitute the room with a number of sources at various 
positions in space, each of the sources given the appropriate delay.  
The process is divided into an early part (for point sources only) and a late part (for all source 
types).  
• A number of late rays specified in the Room setup are emitted from the source. 
• These will hit the surfaces of the room, be reflected, hit new surfaces, be reflected again, and so 

on until reaching the Max. Reflection order as specified in the Room setup. They will be reflected 
according to the vector based scattering method (described later) and taking into account the 
scattering due to the surface size and surface roughness.  

• Each time a ray gets reflected; its reflection order is increased by one. The first orders of 
reflections have been included already during the Early-reflections part; therefore, no action is 
taken for the ray up to the Transition order set in the Room setup.  

• Once the reflection order is higher than the Transition order, the ray will start generating one late 
secondary source every time it hits a surface. This process creates a map of late secondary sources 
all over the room and we call it rendering. 

• The late secondary sources may have a Lambert, Lambert Oblique or Uniform directivities, depending on 
the calculation settings. 

 
The late reflection process does not produce an exponential growing number of reflections 
(with respect to time), as the image source method would suggest. Instead, it keeps the same 
reflection density during the whole calculation, allowing for reasonable calculation times. The 
attenuation of a secondary source is calculated taking the following into account: 
• Directivity factor of the primary source in the relevant direction of radiation (used with 

point sources only). 
• Absorption coefficients of the surfaces involved in generating the image (can be angle 

dependent if Angular absorption is enabled in the Room setup). 
• Air absorption due to the length of the reflection path. 
• Directivity factor for secondary sources e.g. the Lambert, Oblique Lambert or Uniform directivity, see 

later. 

P1

Each time a ‘late’ ray hits a surface, a late secondary source is generated. The process is 
repeated for all the late rays set in the Room Setup. 
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Gathering (receiver-dependent part) 
In this part, the information from all generated late secondary sources is collected (gathered) to a 
desired receiver location. ODEON checks each secondary source to determine whether it is visible 
from the receiver. If it is visible, the contribution is added to the impulse response. 
At this point the contributions of direct and reflected sound are collected at the receiving point 
allowing the calculation of the results known as Single Point, Multi Point, Grid Response and 3DMatrix. 
When more than one receiver is involved, the receiver-dependent part of the process is simply 
repeated for each receiver. When more than one source is involved, the response at a given receiver 
is simply the superposition of the responses from the individual sources, each one delayed 
appropriately, if a delay is applied to the source. 

 

 
 
One of the advantages of the late ray tracing method (ray radiosity) used in ODEON compared to 
more traditional methods is that rays do not even have to come near to the receiver to make a 
contribution - and a late ray, being reflected 100 times, has a potential of generating 100 secondary 
sources. Thus, even in coupled rooms, with only a modest number of rays, it is possible to obtain 
a reasonable number of reflections at a receiver (which is required to obtain a result that is 
statistically reliable). This gives a fine balance between high reliability of the calculation results and 
short calculation time. 

Remember: The rendering (receiver-independent part) stores a large file containing the ray history. 
These files will speed up calculations of other receivers, making use of the same late secondary sources. 
However, if these files are not erased when finishing a project, you may gradually fill up your hard drive. 
Use File>Delete files>Delete calculation files to save space from such history files, which can be easily 
recalculated. 
 

When all calculations in a room have been carried out, use the File>Tidy directory tool to free some more 
disk space. The Tidy directory tool will clean a complete directory and its sub-directories and delete all 
calculation files for all rooms (A directory in this context can also be the C:\ drive in which case it will be 
a lengthy process). 

Remember: ODEON automatically takes care of handling which of the calculations and result files are 
currently consistent with user-entered data, erasing those that are no longer valid. Thus, in some 
situations you may experience that ray tracing calculations have already been done and are still valid, 
in other cases they have to be recalculated. 

P1

After the ray tracing process is completed, the receiver will ‘collect’ the contribution to 
the impulse response from the secondary sources. 
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A complete histogram, containing both early and late energy contributions, is generated and used 
to derive Early Decay Time and Reverberation Time. The other room acoustical parameters are 
calculated on basis of energy collected in time and angular intervals. 
For surface sources and line sources, a number of secondary sources are placed randomly on the surface 
(or line) of the source, each emitting one ray, and radiating a possible contribution to the receiver. 
The rays emitted from these source types generate an independent secondary source each time 
they are reflected. Compared to the calculation principle applied to the point sources, you might 
say that Transition order is always zero, and that only late energy contributions are collected for these 
source types, or rather that calculations are based exclusively on ray-radiosity. For point sources, 
only the late reflections are handled like surface sources and line sources. For the first couple of 
reflections, a method including image sources is used.  
 

Summarizing the calculation method used for point response 
calculations in ODEON 
We can summarize the descriptions above in the following steps. The early-reflection part is 
described by steps 1 to 7, while the late-reflection part by steps 8 to 11: 

1. The early ray tracing is initiated from the source. Rays are reflected specularly. 
2. Each time the ray collides with a surface, a new image source is added to the image source 

tree. Since the image source results from an existing reflection, it is valid at the same time.  
3. Soon all valid image sources have been generated behind each wall, up to the specified 

transition order.  
4. ODEON checks each image source to determine whether it is visible from the receiver. 
5. If the image source is visible, then a reflection is added to the energy curve and a range of 

early secondary sources are generated on the surface the image source corresponds to. 
6. ODEON simulates a surface source, which emits the number of early scatter rays up to the Transition 

order.  
7. Each ray that reaches the receiver without colliding with any obstacle, adds a reflection to the 

energy curve. 
8. The late rays are emitted from the source and are reflected around the room, taking the 

scattering of the surfaces into account. The rays start to be traced from the very first orders of 
reflection, but no action is taken up to the Transition Order, since it has been taken into account 
in the Early-reflections part already. The late rays are reflected until the Max. Reflection order. 

9. Late secondary sources are generated at each reflection point (when a ray hits a surface).  
10. The ray path is traced from the late secondary sources directly to the receiver. 
11. ODEON checks each late secondary source to determine whether it is visible from the receiver. 

If visible, the contribution is added to the energy curve. 
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The following figure illustrates the process of adding reflections during the early and the late part.  

 
 
 
The reflections generated by the image sources and early secondary sources, during the early 
reflection method, occur before the Transition order. Generally, the reflections from early secondary 
sources are reinforcing the reflection from the image source related to the same surface. After the 
transition order, reflections are generated by the late secondary sources using the late reflection 
method. In reality, all three methods will overlap in time as the transition criterion is the transition 
order which is not strictly linked to time. This creates a smooth transition between the methods 
creating no sudden jumps in the decay of sound. 

9.4 Angle-dependent absorption   
In reality sound absorption of materials depends on the angle of incidence. However, information 
on angle dependent absorption is difficult to measure and rarely available. Therefore, ODEON has 
implemented algorithms which derives angle dependent absorption from the random incidence 
absorption coefficients which are commonly available – in the Odeon material library, from 
manufacturers of acoustics materials etc.  
 
Absorption is angle dependent, but will work differently between “soft” and “hard” materials. 
Hard concrete would be an example of a hard material, and a porous absorber would be an 
example of a soft material. ODEON determines if the material can be seen as a soft material, hard 
material or something in between from the absorption coefficients.  
 
The average absorption coefficient for the 1k, 2k and 4k Hz octave bands gives a value that is used 
as follows: 
• If the average value is exactly 0.3, the random incidence absorption coefficient for the material 

(as set in the material list) will be valid for all angles of incidence.  
• If the average value is exactly 0, the material is seen as a hard material and the absorption will 

be affected by the angle of incidence as explained further below.  
• If the average value is exactly 1, the material is seen as a soft material and the absorption will 

be affected by the angle of incidence as explained further below.  
• If the average is between 0 and 0.3, the material is something in between hard and not. The 

absorption will be a mix of the random incidence absorption coefficient (as given in the material 
list) and the angle absorption for hard materials. A material can be more or less hard, and 
therefore the mix is based on linear interpolation from where it is placed between 0 and 0.3.  

A representation of the contributions added to the reflectogram. 
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• If the average is between 1 and 0.3, the material is something in between soft and not, and the 
absorption will be a mix of the random instance absorption coefficient (as given in the material 
list) and the angle absorption for soft materials. A material can be more or less soft, and therefore 
the mix is based on linear interpolation from where it is placed between 1 and 0.3.   

 
The absorption for hard and soft materials will change based on the angle of incidence of the sound. 
On one end we a have perpendicular, direct incidence, which is said to have an angle of incidence 
of 0 degrees. On the other end we have a parallel, grazing, incidence which corresponding to an 
angle of incidence of 90 degrees. And then we have that: 
 
• Hard materials: the absorption will be higher the larger the angle of incidence (that is, the closer 

the angle is to 90 degrees). And the angle will affect the higher frequencies the most. See graphs 
below.  

• Soft materials: it will be the opposite from hard materials. The absorption will be higher for 
smaller angle of incidence, but the angle will still affect the higher frequencies the most.  

  
The statistical information can be seen in the graphs below from (Rindel 1993).  
 

 

Hard material (high impedance). Soft material (low impedance). 
Calculated absorption coefficient as a function of angle of incidence and with the frequency as the parameter. A statistical absorption 
coefficient of 0.5 and a square area of 11 m2 has been assumed. (Rindel 1993). 

Hard material (high impedance). Soft material (low impedance). 
Calculated absorption coefficient as a function of frequency and with the angle of incidence as the parameter. A statistical absorption 
coefficient of 0.5 and a square area of 11 m2 has been assumed. (Rindel 1993). 
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9.5 Scattering 
This chapter covers the calculation methods used for scattering. For a guide on how to choose a 
correct scattering coefficient for a project/material, please look in the Materials chapter (chapter 4) 
of this manual.  
 
Scattering in ODEON uses multiple different methods to get the best results. This, however, can 
make it a bit difficult to fully understand as a user, but for most users it is not necessary to 
understand the details in order to use scattering.  
 
The acoustical calculations in ODEON is divided into two parts: early and late. And scattering is 
dealt with two different ways in the two parts. Besides this, scattering is both surface size 
dependent and frequency dependent, and ODEON takes this into account. 
 
A total scattering coefficient is applied to each surface based on both the user chosen coefficients 
and, if active, calculations of extra scattering from the size of the surface and distance to the source. 
 
Scattering is part of three different calculations. Very briefly, the following can be stated (explained 
in more detail further below):  
 

• The reflections of the rays used in ‘late’ rays will be based on the scattering coefficients. 
This scattering is not influenced by frequency.  

• The late secondary sources (Oblique Lambert Sources) made by ‘late’ reflections will be 
based on the scattering coefficients, angle of incidence, and frequency of the octave band.   

• The ‘early’ reflections will make normal Lambert Sources and Image Sources, and the 
distribution of sound energy between them will be based on the scattering coefficients.   

 
How scattering generally works for the late reflections: 
 

• A chosen number of so-called ‘late rays’ is emitted from the sound source. When a ray hits 
a surface, it will get a reflected direction. The calculation of the reflected direction is based 
on the user-chosen scattering for the surface and if Reflection based scattering is enabled; on the 
angle of incidence, the size of the surface and distance from the source. For every point 
where a ray hits a surface, a late secondary source is generated. 

• If a late secondary source is visible to a receiver, it will have influence on the decay curve and 
the acoustical results. The amount of sound power is based on the absorption coefficients 
the ray has met, but also (if active) on the Oblique Lambert method. The Oblique Lambert is based 
on the scattering coefficient of the surface, the angle of incidence, and frequency of the 
octave band. 

 
How scattering generally works for the early reflections (explained in detail further below): 
 

• For the early reflections, up to the set transition order, another method involving mirror 
sources is used. 

• Beside an image source, there will be made a number of early secondary sources on each of 
the surfaces involved in the early reflection paths. The 0. order early secondary sources will 
follow Lambert directivity. For higher reflection orders up to the transition order Oblique 
Lambert is applied, in any the directivity will be different for each octave band, according 
to the scattering coefficients. 

• The sound power will be distributed between the image sources and the early secondary 
sources according to the chosen scattering for the surface. If 100% scattering, only the early 
secondary sources will be active, if 0% scattering only the image source. 
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Vector Based Scattering – reflecting a ‘Late ray’ 
Vector based scattering is an efficient way to include scattering in a ray-tracing algorithm. The 
direction of a reflected ray is calculated by adding the specular vector according to the laws of 
reflection, scaled by a factor ( )s−1  to a scattered vector with random direction (where s is the 
scattering coefficient), following the angular Lambert distribution of ideal scattered reflections: 

( )ϕ2Sin  (Rindel, 1995) which has been scaled by a factor s . If s  is zero, the ray is reflected in the 
specular direction, and if s equals 1, the ray is reflected in a completely random direction. Often 
the resulting scattering coefficient may be in the range of say 5 to 20 percent, and in this case, rays 
will be reflected in directions which differ just slightly from the specular one, but this is enough to 
avoid artefacts due to simple geometrical reflection pattern. 
 

 

 
 

The Reflection Based Scattering coefficient 
When the reflection based scattering coefficient is activated in the Room setup, ODEON will do its 
best in estimating the scattering introduced due to diffraction. The user defined scattering 
coefficients assigned to the surfaces should only include scattering occurring due to surface 
roughness, then diffraction phenomena are handled by ODEON.  In many cases a scattering 
coefficient of, say 5%, for all smooth surfaces may be sufficient. The Reflection Based Scattering 
Method combines scattering caused by diffraction (due to typical surface dimensions, angle of 
incidence, incident path length and edge diffraction) with surface scattering. Each of the two 
scattering effects is modelled as frequency dependent functions. The benefits are two-fold: 

• Separating the user defined surface scattering coefficient from the scattering that results room 
geometry, makes it easier for the user to make good estimates of the coefficients. 

• Scattering due to diffraction is distance and angle dependent, and as such it is not known before 
the source and receiver are defined and the actual ‘ray-tracing’ or image source detection takes 
place. One example could be a desktop providing a strong specular component to its user, 
whereas it will provide scattered sound at remote distances. 

 
The method has several advantages. For starters, it makes life easier for the user because the same 
scattering coefficient can be used for different surfaces, no matter their size. It also allows a better 
estimate of the actual scattering occurring at a reflection point, because scattering caused by 
diffraction is not fully known before the actual reflections are calculated, thus angles of incidence, 
path-lengths, etc., are known. In order to allow these features to be included in predictions, the 
Reflection Based Scattering Coefficient rs  is calculated individually for each reflection as 

Resulting 

Incident 
Specular (weight: ) 

Vector based scattering. Reflecting a ray from a surface with a scattering coefficient of 50% results in a 
reflected direction which is the geometrical average of the specular direction and a random (scattered) 
direction. Note: Scattering is a 3D phenomenon, but here it is shown in 2D for simplicity. 

Scattered (weight: s ) 
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calculations take place, by combining the surface roughness scattering coefficient ss with the 
scattering coefficient due to diffraction ds : 

)1()1(1 sdr sss −⋅−−=  

Ss -Surface scattering 
Assigning materials to the surfaces, 
the scattering coefficient can be 
defined by the user in the surface 
list. This is the scattering coefficient 
at mid frequencies (logarithmic 
average of 500 and 1000 Hz). 
 
However, for the calculations, 
ODEON uses scattering 
coefficients that vary with the 
frequency. The actual scattering 
coefficients used in each octave 
7band are shown in the figures. 
Interpolation between the curves is 
applied for other values. 
 
Of the two figures, one is shown 
with a linear y-axis and the other 
with a logarithmic y-axis. 
Scattering coefficients are best 
displayed with a logarithmic axis. 
The scattering coefficient decreases 
towards low frequencies, and 
theoretically the slope is a factor of 
4 per octave. This is clearly shown 
as straight lines in the display with 
logarithmic axis. 
 
Very small scattering coefficients 
can be applied for very smooth 
surfaces, but the scattering 
coefficient can never be 0. 
 

 
 

Sd -Scattering due to diffraction 
In order to estimate scattering due to diffraction, reflector theory is applied. The main theory is 
presented in (Rindel, 1986; Rindel, 1992). The goal in these papers was to estimate the specular 
contribution of a reflector with a limited area; given the basic dimensions of the surface, angle of 

Remember: The scattering coefficients influence the simulations, and the effect of changing the 
scattering coefficient depends on the relative change. For example, a change from 0.05 to 0.1 is 
comparable to a change from 0.1 to 0.2. Scattering coefficients higher than 0.5 means in practice a 
strong scattering, and a further increase will change very little. 
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The scattering of a material changes due to frequency. The user chooses 
the scattering for the mid frequency (707Hz). This value determines a 
curve, which is extrapolated towards high and low frequencies, and is 
used for the frequency dependent calculations in ODEON. 

 

Same as above, but with a logarithmic y-axis. When changing scattering 
coefficient, a doubling is comparable in a logarithmic axis. For example, 
a change from 0.05 to 0.1 is comparable to a change from 0.1 to 0.2. 
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incidence, incident and reflected path-lengths. Given the fraction of the energy which is reflected 
specularly we can however also describe the fraction ds  which has been scattered due to 

diffraction. A short summary of the method is as follows: For a panel with the dimensions wl× : 
above the upper limiting frequency wf  (defined by the short dimension of the panel) the frequency 
response can be simplified to be flat, i.e. that of an infinitely large panel. Below wf  the response 
will fall off with by 3 dB per octave. Below the second limiting frequency lf , a decay of 3 dB per 
octave is added, resulting in a decrease of 6 dB per octave. In the special case of a quadratic surface, 
there will only be one limiting frequency below, which the specular component will decrease of 6 
dB per octave. The attenuation factors lK and wK  are estimates to the fraction of energy which is 
reflected specularly. These factors take into account the incident and reflected path lengths (for ray-
tracing we have to assume that reflected equals incident path length), angle of incidence, and 
distance of reflection point to the closest edge of the surface. 
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If we assume energy conservation, then we must also assume that the energy which is not reflected 
specularly has been diffracted - scattered due to diffraction. This leads to the following formulae 
for our scattering coefficient due to diffraction: 
 

)1(1 elwd sKKs −×−=  
 
In order to compensate for the extra diffraction which occurs when a reflection appears close to an 
edge of a free surface, the specular component is reduced by a factor ( )es−1 . The edge scattering 
coefficient is defined to be 0.5 if the reflection occurs at the edge of a surface saying that half of the 
energy is scattered by the edge and the other half is reflected from the surface area. If the reflection 
point is far from the edge, the edge scattering becomes zero – initial investigations suggests that 
edge scattering can be assumed to zero when the distance to the edge is greater than approximately 
one wave length, therefore we define the edge scattering coefficient as: 
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As can be seen, scattering caused by diffraction is a function of a number of parameters, of which 
some are not known before the actual calculation takes place. An example is that oblique angles of 
incidence lead to increased scattering, whereas parallel walls lead to low scattering, and sometimes 
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flutter echoes. Another example is indicated by the characteristic distance *a , if source or receiver 
is close to a surface, this surface may provide a specular reflection even if it is small, on the other 
hand if far away it will only provide scattered sound, 1≈ds . 
 

 

 
 

Boundary walls and interior margin 
As long as surfaces are truly freely suspended surfaces, they will act as effective diffusers down to 
infinitely low frequencies. For surfaces which are elements in the boundary of the room (such as 
windows, doors, paintings, blackboards etc), it is not provided effective scattering down to 
infinitely low frequencies. From diffuser theory, it is found that the typical behaviour is that the 
effectiveness of a diffuser decreases rapidly below a cut-off frequency, which can roughly be 
defined from the depth of the diffuser (wall construction) being less than half a wavelength. At two 
octave bands below the cut-off frequency, the diffuser is no longer effective. At the lowest 
frequencies however, the dimensions of the room will provide some diffraction, therefore the 
dimensions of the reflecting panel as used in the formulae for lf  and wf apply for the lowest 
frequencies, substituted with the approximate dimensions of the room. For frequencies in-between 
high and low, a combination of surface and room dimensions are used. It is worth noticing that it 
is not only the depth of the wall construction which enables the elements of the wall construction 
to provide diffraction. The angling between the surfaces, offsets e.g. the door being mounted in a 
door hole, or the surfaces being made of different materials, all provide phase shifts which result 
in diffraction. Therefore, it may be reasonable to assume that the boundary walls have a minimum 
depth of, say, 10 cm, in order to account for such phase shifts. 
 

  

log(E) 

log(frequency) 

Energy reflected from a free suspended surface given the dimensions 𝑙𝑙 ∙ 𝑤𝑤. At high frequencies the surface 
reflects energy specularly (red), at low frequencies, energy is assumed to be scattered (blue). 𝑓𝑓𝑤𝑤 is the upper 
specular-cut off frequency defined by the shortest dimension of the surface, 𝑓𝑓𝑙𝑙  is the lower cutoff frequency 
which is defined by the length of the surface. 
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The typical depth of the surfaces attached to the wall such as windows and blackboards, should be 
specified in the Interior margin in the Room setup. ODEON will use this number in order to distinguish 
between interior and boundary surfaces. In case any surface is inside this margin, it will be 
considered as a boundary surface. Once the margin has been entered and the Room setup dialog has 
been closed the 3DView will display surfaces which are considered to be interior in a dark green 
colour, while the boundary is displayed in black. Diffraction from the boundary will be calculated 
taking into account that diffraction is limited towards the lowest frequencies because of limited 
depth of the wall constructions. 
 

Limitations 
In special cases, the Reflection Based Scattering Coefficient may overestimate the scattering provided 
by small surfaces which are only fractions of a bigger whole, e.g. small surfaces being part of a 
curved wall or dome. Such surfaces should not cause diffraction due to their individual area, 
because the individual surfaces do not provide any significant edge diffraction. In these cases, the 
overestimation can be bypassed by setting the surface Type to Fractional in the Materials List, see Chapter 4. 
When setting the Type to Fractional, the surface area used for calculating the Reflection Based Scattering 
Coefficient is determined from the box subscribing the room, rather than the individual surface - if 
the construction part of which the fractional surface is part of, is considerable smaller than the 
‘room box’ scattering, it might be underestimated and a higher scattering coefficient should be 
assigned to the surface. 
 

 

 
 

Boundary 

Interior Margin 

Furniture 

Ground plan of a room with the interior margin marked as a dashed green line. Surfaces between the boundary 
and the interior margin (black) provide low scattering at low frequencies, while surfaces inside the interior 
margin (green) provide high scattering throughout the whole frequency range. 

A typical diffuser depth (interior margin) entered by user, determines which parts of the geometry should be 
considered exterior of a room, thus limiting the scattering of the boundary surfaces which cannot be 
considered freely suspended at the lowest frequencies. 
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9.6 Oblique Lambert 
In the ray-tracing process, a number of secondary sources are generated at the collision points 
between walls and the rays traced. It has not been investigated yet which directivity to assign to 
these sources. A straight forward solution, which is the one ODEON has been applying until 
version 8 is, to assign Lambert directivity patterns. That is, if the diffuse area radiation is modelled 
via cosine directivity. The result would be that the last reflection from the secondary sources to the 
actual receiver point is handled with 100% scattering – regardless of the actual scattering properties 
for the reflection. This is not an optimal solution; in fact, when it comes to the last reflection path 
from wall to receiver, we know that not only the incident path length to the wall, but also the path 
length from the wall to the receiver are available, allowing a better estimate of the characteristic 
distance *a  as in the case of the ray-tracing process, where refld was assumed to be equal to incd
. So which directivity to assign to the secondary sources? ODEON proposes a directivity pattern 
which we call Oblique Lambert. Reusing the concept of Vector Based Scattering, an orientation of our 
Lambert sources can be obtained taking the Reflection Based Scattering coefficient into account. If 
scattering is zero then the orientation of the Oblique Lambert source is found by the laws of 
reflection. If the scattering coefficient is equal to 1, then the orientation is that of the traditional 
Lambert source, and for any scattering value between 0 and 1, the orientation is determined by the 
vector found using the Vector Based Scattering method. 

 

 
 
If Oblique Lambert was implemented as described without any further steps, this would lead to 
an energy loss because part of the Lambert balloon is radiating energy out of the room (notice the 
incomplete circle in the second figure above). In order to compensate for this, the directivity pattern 
has to be scaled with a factor which accounts for the lost energy. If the angle is 0, then the correction 
factor is 1 as no correction is necessary, and if the angle is 90° the factor becomes 2, because half of 
the balloon is outside the room. This is the maximum possible correction factor, and factors for 
angles between 0° and 90° have been found using numerical integration. 

Traditional Lambert directivity at the left and Oblique Lambert at the right. Oblique Lambert produces a 
shadow zone where no sound is reflected. The shadow zone is small if scattering is high, or if the incident 
direction is perpendicular to the wall. On the other hand, if scattering is low and the incident direction is 
oblique, then the shadow zone becomes large. 
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A last remark on Oblique Lambert is that it can include frequency depending scattering at (close 
to) no computational cost. This part of the algorithm does not involve any ray-tracing which tends 
to be the heavy computational part in room acoustics prediction. Only the orientation of the 
Oblique Lambert source has to be recalculated for each frequency of interest in order to model 
scattering as a function of frequency. 
 

9.7 Diffraction over screens and round objects (Screen 
diffraction) 

When no direct sound is received from a point source at a receiver position, ODEON will try to 
detect a one- or two-point diffraction path, using the methods suggested by Pierce in “Diffraction 
of sound around corners and over wide barriers” (Pierce, 1974). By only calculating the diffracted 
contribution when the point source is not visible, the contribution can be added to the impulse 
response without considering the phase-interaction between direct sound and the diffracted 
component, just like the reflections are added to the impulse response. Only diffraction from one 
edge of the diffracting object is taken into account, the one with the shortest path-length. The edge 
of diffraction is considered infinitely long. More information and validation is found in (Rindel, et 
al., 2009). 
 
By using the algorithms by Pierce, rather than simpler ones, ODEON is capable of handling more 
complicated objects than the single surface screen, e.g. objects such as book shelves, the corner in 
e.g. a L-shaped room and buildings out-doors or diffraction over a balcony front edge, or over the 
edge in an orchestra pit. 

Estimating diffraction points around objects 
In order to calculate diffraction, it is essential that the diffraction path is established. In rooms with 
moderate complexity, it becomes virtually impossible for the user to describe which surface edges 
will act as diffracting edge, and therefore ODEON has a built-in detection algorithm. In order to 

Oblique Lambert attenuation factors
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Correction factor for Oblique Lambert. When the oblique angle is zero, Oblique Lambert corresponds to 
traditional Lambert and the correction coefficient is 1. When the oblique angle is 90° corresponding to grazing 
incidence on a smooth surface, the correction factor reaches its maximum of 2. 



130 
 

limit the complexity and time consumption of the detection, there are some limitations to the type 
diffraction paths ODEON can detect. In order to understand the limits, here is a short description. 
 
When a source is not visible from the receiver, ODEON will try to detect the shortest diffraction 
path from source to receiver in the following way: 

1. A ray is sent from source towards the receiver and the first surface hit is registered (A) 
2. A ray is sent from receiver towards the source and the first surface hit is registered (B) 

A diffraction path should follow the path Source-An-Bm-Receiver, where An and Bm are the nth and 
mth point on an edge of each of the surfaces. The shortest path with full visibility between the three 
sub paths; Source-An, An-Bm and Bm-Receiver is used for the further calculations. 
 
In cases where there are other surfaces which block the paths between one of the sub paths, 
ODEON will not detect a diffraction path. 
 

 

 
Contribution from diffracted sound over a screen, around a corner or around a book shelf, is not 
likely to change results noticeably. However, in rooms such as an open plan office with very 
absorbing ceiling or in outdoor situations, diffraction around edges may play an important role. 
 

9.8 Radiated rays from a source 
In ODEON (Combined and Industrial version only) three different kind of sources are available; 
the point source, the line source, and the surface source. 

Point Sources 
For Single, Multi and Grid response calculations (and for the 3D Investigate Rays and 3D Billiard displays) rays 
are radiated in directions distributed as evenly as possible over a solid angle. To obtain the even 
distribution, rays are emitted in directions given by the Fibonacci spiral. Using a spiral also ensures 
that there will be no preference towards (or away from) e.g. horizontal rays as might be the case if 
rays were radiated from a number of e.g. horizontal rings. For Quick Estimate and Global Estimate, the 
radiated directions are chosen randomly, allowing the calculation to be finished after any ray, 
without getting a very uneven distribution of radiated directions. 

Surface Sources and Line sources (Industrial and Combined versions 
only) 
For these source types, points of origin for the rays and their initial directions are the same, no 
matter the calculation type. For each radiated ray, a random point or origin point is chosen at the 
line or surface source. From this point the ray is sent out in a random direction, and two types of 

An Bm 

R R R 
R 

a) b) c) d) 

S 
S S S 

 

An Bm An An Bm 

Diffraction paths and their detection. a) Odeon detects a 1 point diffraction path over a thin screen. b) 
Odeon detects a 2 point diffraction path over a wide barrier. C) Odeon fails to detect a diffraction path 
because the path from An-Bm is obscured by a third surface – in fact it’s a 3 point diffraction path. d) Odeon 
detects a diffraction path over two thin barriers. 
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radiation can be chosen: Lambert and Spherical. When Lambert is chosen, the strength of each ray is 
proportional to the cosine of the angle between its direction and the normal. Practically, rays 
radiated parallel to the surface have zero strength, whereas rays perpendicular to the surface will 
carry the maximum of the energy. Spherical radiation introduces uniform strength to the rays, 
regardless of their direction. 
 
Lambert radiation is preferable for ordinary surface sources, such as noise emission from 
machinery. Spherical radiation is recommended when several point sources are modelled as a 
surface source, instead of modelling each one individually (e.g. many people distributed over a 
large canteen hall). Spherical radiation is also a good option for modelling traffic noise, which can 
be considered as a dense array of vehicles, acting as individual point sources. 
 

 

 

9.9 Processing reflection data for auralisation in Single 
Point Response 

A typical point response calculation in ODEON includes from 100.000 to 1.000.000 reflections per 
source/receiver. The reflections are calculated in terms of time of arrival, strength in 8 octave bands 
and angle of incidence (azimuth and elevation). The information on size of the reflecting surfaces 
and absorption coefficients are also available as a part of the calculation. 
 
Binaural filters for headphone playback: When the Auralisation setup|Create binaural impulse response file is 
turned on, reflections are processed in order to create a binaural impulse response (BRIR). First of 
all it is determined whether a phase shift should be applied to the reflection, based on surface size 
and absorption coefficients of the last reflecting surface (Rindel, 1993). The reflection is 
filtered/convolved through 9 octave band filters (Kaiser-Bessel filters, the ninth being extrapolated) 
and finally the reflection is filtered/convolved through two corresponding directional filters, one 
for each ear (Head Related Transfer Functions), creating a binaural impulse response for that 
reflection. This process is carried out for each reflection received at the receiver point, 
superimposing all the reflections as a result; the Binaural Room Impulse Response (BRIR) for that 
particular receiver point is obtained. The actual order in which the filtering is carried out in 
ODEON, differs from the description above (otherwise the calculation time would be astronomic), 
but the BRIR results contain the full filtering with respect to octave band filtering in nine bands, as 
well as directional filtering. 
 

Lambert (left) and spherical (right) types of radiation, applicable to line and surfaces sources. 
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Calculation of B-format filters for external decoding and Surround filters for loudspeaker playback 
is based on the Ambisonics technique which is covered in (Gerzon, 1992; Bamford, 1995; Malham, 
2005; Furse). Most of the specific steps in involved in the generation of these filters are similar to 
those used for generation of BRIR’s. HRTF’s are not used in the calculation, since it aims at 
loudspeaker representation where the listener will receive reflections from the head and torso. 

9.10 Calculation method for Reflector Coverage 
25.000 rays are sent out from the selected source, and if the rays hit one of the surfaces defined as 
reflector surfaces at the Define reflector surfaces menu, a cross is painted where the reflected rays hit 
the room surfaces. Note that the value of the Transition order is taken into account; if it is zero and 
the Lambert scattering is active, the chosen reflectors will show a degree of scattered reflection 
corresponding to their scattering coefficients. Sound from line and surface sources will include 
scattering upon reflections, if the Lambert scattering is on. 
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The calculation parameters specify how calculations are carried out in ODEON. As a starting point, 
ODEON suggests values that may be considered suitable for most calculation parameters, but 
please be aware that they may not apply perfectly to every situation, e.g. in a room with strong 
decoupling effects or very uneven distribution of absorption more late rays will be needed 
(explained in more detail further below), and in a room with strong focusing a transition order 
higher than 2 is suggested. Select one of the pre-sets: Survey, Engineering or Precision, which represent 
different levels of quality of results. ODEON will adjust the calculation parameters accordingly. 
There are a couple of parameters in the General settings which should always be adjusted the Impulse 

response length and Number of late rays. The Specialist settings normally don’t need to be adjusted. 
 
There is more information on how to setup calculation parameters in the help file. Find it in 
ODEON by pressing F1 when the Room setup window is open.  
 

 
 

10.1 Impulse response length (Job calculations and 
Global Estimate) 

The Impulse response length should always be specified. It should be at least 2/3 of the longest 
reverberation time over all 1/1 octaves. It determines how many milliseconds of “decay curve” are 
to be calculated. It is a key parameter - if it is shorter than approx. 2/3 of the reverberation time in 
the room, then T30 cannot be calculated (because the dynamic range of the decay curve is less than 
35 dB), instead results for T30 will be displayed as *.** in result displays. For reliable results, it is 
recommended to use an Impulse response length which is comparable to the estimated reverberation 
time. To get an estimate of the reverberation time in a room, use the Quick Estimate available in 
the Materials list. The maximum allowed Impulse response length is 200000 ms. It is tempting just 
to use a very long impulse response length in order to avoid that reverberation time is not 
calculated at some frequencies – however using a length many time the expected T30 may harm 

 Calculation Parameters   
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quality of results because the very late and unreliable decay at say -200 dB will be included in the 
regression line from which T30 and other reverberation parameters are derived.  
 

10.2 Number of late rays (Job calculations) 
The Number of late rays influences the density of reflections in the late part of the decay. Having too 
few late rays is a very typical cause of errors, but on the other hand more late rays will extend the 
calculation time.  
 
In the Room Setup, ODEON can suggest a number of rays for a survey, engineering or precision calculation.  
The number is derived taking into account the aspect ratio of the room as well as the size and 
number of surfaces in the geometry. In short, this means that ODEON will suggest more rays for 
very long room with many surfaces, than for a basically cubic room with few surfaces.  
The suggested number of rays will be sufficient for many rooms, however in some cases more rays 
may be needed in order to obtain good results (please read further down for an explanation).  
 
The ODEON algorithms are hybrid methods based on the Image Source Method and Early 
Scattering Method for the early part of the energy, and Ray-Radiosity for the later part of energy. 
Therefore, there is also a Number of early rays parameter, which will be described later. 
 

More rays needed? 
There is no definite way of telling if more rays are needed for a specific calculation, but to get an 
idea there are some good tips.  
 
A good thing to investigate is the decay curves. For all editions, a decay curve can be derived in 
the Global Estimate in the top menu. And for ODEON Auditorium and Combined, a decay curve is 
always calculated in the Single point response results.  
 
If a decay curve has suspicious spikes/drops you may try to increase the number of late rays. Please 
see the graph below. This can also be caused by other effects, and be a part of the actual acoustics, 
but for most cases it is a sign of too few rays used.  
 

 
 
It is also worth checking if the Global Estimate stabilizes slowly or the global decay demonstrates a 
‘hanging curve’ effect. A rule of thumb is to let the Global Estimate run until the decay curve seems 
stable, then use, say, between 0.1-1 times the number of rays used in the Global estimate to specify 
the number of rays to be used in the calculation of the point responses (specified in the Room setup).  
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It is a good idea to experiment with different Number of late rays and study the decay curves in Single 

Point Responses. If many surfaces are added to a model, in-between calculation, it is recommended to 
re-specify the Number of late rays too. 
 
ODEON also includes a tool to investigate the actual number of reflections per millisecond used in 
the calculation of a point response. The tool is called Reflection density and it is included in the 
calculated parameters of the Single point, Multi point and Grid response results. The Reflection_density 
parameter is included and set to Visible in the Room Acoustics Parameter List.   
 
Additional to the numerical value, a graph like the one shown below is displayed in the Single Point 

response in the job list.   
 

 
 
For reliable results, the reflection density parameter (Reflection_density) should be higher than 25 
reflections/ms, as explained further below.    
 

What could affect the numbers of rays needed 
If the room model contains strong decoupling effects or uneven distribution of the absorption, it is 
recommended to increase the Number of late rays, even if the calculated reflection density seems high 
enough. Other complex geometry could also increase the needed number of late rays.  
 
1) Strong decoupling effects: If a dry room is coupled to a reverberant room, then more rays may 

be needed in order to better estimate the coupling effect. An example could be a foyer or a 
corridor coupled to a classroom. If the room where the receiver is located is only coupled to the 
room where the source is located through a small opening, then more rays are also needed. 
 

2) Very uneven distribution of the absorption in the room: In some rooms the reverberant field in 
the x, y and z dimensions may be very different. An example of this could be a room where all 
absorption is located on the ceiling while all other surfaces are hard. Another example could be 
an open-air theatre (modelled as having a ceiling with 100% absorption). In particular, if 
surfaces are all orthogonal while having different materials in the x, y and z dimensions of the 
room and if low scattering properties on the surfaces are used, then more rays should be used. 

 
On the other hand, if multiple sources with similar source power are visible from all/or most 
receivers, then the Number of late rays can be decreased significantly. 
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10.3 Specialist settings 
Below the General settings are the Specialist settings, which should only be adjusted if you are an ODEON 
expert or experimenting. One exception is if you are importing rooms from much earlier versions 
of ODEON, then it will be a good idea to enable Screen diffraction to make sure diffraction around 
screens is included in future calculations. 

Impulse response details 

Max. reflection order (Job calculations only) 
Max. reflection order is a stop criterion which determines how many times a ray can be reflected. Under 
normal conditions it should be as large as possible. In that case the Impulse response length will be the 
actual stop criterion and the Max. reflection order is only taken into account when stopping rays that 
have been trapped between two very narrow surfaces. This number may be decreased if you are 
only interested in the very early reflections. The Maximum allowed reflection order is 10000. 

Impulse response resolution (Job calculations and Global Estimate) 
The Impulse response resolution is the width of the time steps in the Impulse response histogram 
in which the energy of the reflections is collected during a point response calculation. The 
histogram is used for calculation of reverberation parameters such as EDT and T30. A resolution of 
1 ms is recommended – in Odeon Auditorium and Combined a resolution of 1 ms allows special 
scale bars for Music, Studio and Speech to be selected in the 3D part of the Decay curves and the Reflectogram 
in the Single Point response (resolutions of 0.5, 0.25 and 0.1 ms will also allow that). 

Early reflections: 

Transition Order (Job calculations only) 
The Transition order (TO) determines at which reflection order ODEON changes from the early Image 
Source Method to the late Ray-Radiosity method.  
 
In special cases you may want to alter the parameters to conduct special investigations. E.g. to 
investigate a high order echo problem, you may want to increase the Transition order to get the 
reflections displayed in the Single point response|reflectogram display (Auditorium and Combined 
editions only). However, this will rarely result in better calculation results for the room acoustical 
parameters. In such cases create an extra copy of the room using the Files|Copy files menu and conduct 
the special investigations on the copy.  
 
The Transition order applies only to point sources. The current recommendation is TO = 2 for most 
rooms. For rooms that are heavily packed with various fittings or rooms where no or few image 
sources are visible from the receivers, a lower Transition order of 0 or 1 may be used. If a Transition order 
of zero is selected then point responses will be calculated using Ray Tracing/Ray-Radiosity only - 
which has better robustness to cases where the wave front is cut into small pieces e.g. by apertures 
in the room - a situation which is not handled elegantly by the Image Source Method. 

Number of early rays (Job calculations only) 
The Number of early rays is normally best left for ODEON to decide. ODEON will estimate a Number 

of early rays to use in order to detect important early reflections (Image sources) based on the number 
and size of surfaces, the dimensions of the room as well as the user defined Transition order. It is not 
given that more is better. 
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Number of early scatter rays (Job calculations only) 
If the specified Number of early scatter rays is greater than 0, the early reflections from point sources are 
split into a specular part (an image source) and a scattered part (given by the scattering 
coefficients). 100 scatter rays (per image source) should be sufficient. The scatter rays are traced 
from the reflection order of the images source up to the selected Transition order. 

Select calculation methods 

Angular absorption (Job calculations and Global Estimate) 
When this option is on, angle dependent reflection factors are taken into account. The calculation 
method uses the diffuse field absorption coefficients as input but generate angle dependent ones 
taking into account angle of incidence and the size of the surface. The method is based on the work 
in (Rindel, 1993). In some situations, this option does not improve the results (but on the other hand 
it does not seem to harm) and in many situations it means a significant improvement. Three options 
are available; Disabled, All materials and Soft materials only. The All materials is the thorough method whereas 
the Soft materials only is a trade-off between calculation time versus prediction quality. The Soft materials 

only method is usually almost as fast as the Disabled option and yields a quality almost as good as the 
All Materials method which is somewhat slower. 

Screen diffraction 
If this option is checked, ODEON will try to calculate the 
sound diffracted around objects when the source is not 
visible from the receiver. The diffraction method is the 
one suggested by (Pierce, 1974). This method includes 
one and two-point diffraction, allowing diffraction over 
or around single surface screens, wedge shaped screen 
and two-sided objects. The Screen diffraction is only 
carried out for the primary source (not for its image 
sources) when it is not visible from the receiver. Screen 
edges are detected automatically by ODEON and the 
shortest path around an object is used for the 
calculations. For more information on methods and 
limitations please see Chapter 3. If one or more diffraction contributions are included in a point 
response, they can be viewed as part of the Single point response>3DReflection paths when all reflections 
are displayed (A-shortcut). 

Surface scattering (Job calculations, Global Estimate and Quick Estimate) 
If Surface scattering is set to Actual, all directions of late reflections are calculated using the scattering 
coefficients assigned to the surfaces in the Materials list or according to the reflection based scattering 
method (see below). If the scattering coefficient is 10%, then the vector of new ray direction will be 
calculated as 90% of the specular vector plus 10% of the scattered vector (random direction due to 
the Lambert distribution). If the Scattering method is set to None (s = 0), scattering is not taken into 
account, thus all reflections are calculated as specular. If the surface scattering is set to Full scatter (s 
= 1) all surfaces will scatter 100%. The Full and None scattering methods are NOT recommended 
except for educational or research purposes. 

Oblique Lambert 
The Oblique Lambert method allows frequency dependent scattering to be included in late 
reflections of point response calculations - this option is recommended. 
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Reflection Based scattering 
The Reflection based scattering method automatically takes into account scattering occurring due to 
geometrical properties such as surface size, path lengths and angle of incidence. The use of this 
method is recommended unless that part of scattering has already been included in the scattering 
coefficients assigned to the room’s surfaces. 

Interior margin 
By default, the typical geometrical offset in the boundary of the room is 10 centimetres. Surfaces 
which are closer to the boundary surfaces of the room than the distance specified by the Interior 

margin will also be considered boundary surfaces - this means that surfaces such as doors and 
windows which may be modelled as being slightly on the inside of the boundary walls, will still 
be considered as boundary surfaces. Interior surfaces are displayed in a green colour (teal) in the 
3DView whereas boundary surfaces are black, so a change to the Interior margin will be reflected in this 
display when the Room setup dialog is closed. This measure tells ODEON that the effective scattering 
provided by boundary room surfaces should be restricted below a frequency derived from this 
measure. To get an idea of our suggestions to this value please look into the geometries supplied 
with the installation of ODEON - whether a value of 10 or 20 centimetres is chosen may not be 
critical, but for rooms with a very 'jumpy' boundary it should be considered to specify this 
parameter. 

Key diffraction frequency 
In order to obtain the best result in the mid-frequency range for speech and music, the default 
diffraction frequency is 707 Hz. This is the frequency at which diffraction is calculated for the ray-
tracing part of calculations. All other parts of point response calculations take into account 
frequency dependent scattering. This frequency should only be changed in special cases where the 
focus is on another frequency range. 

Scatter coefficients > x.xx handled as uniform scatter 
From published material on measured scattering coefficients, there seems to be a general trend that 
modest scattering tends to be area based whereas high scattering is better represented by uniform 
scatter. In ODEON, small scattering coefficients below a certain value referred to as “x.xx”, is 
handled either with the Lambert Oblique or Lambert algorithms, whereas scattering coefficients 
above x.xx are handled using uniform scattering. Scattering coefficients in the context above are 
the Reflection Based Scattering coefficients (if that option is activated); a typical result of this algorithm is 
that reflections close to an edge will be handled with uniform scattering which is desirable. 
Through empirical studies we have found that x.xx = 0.5 yields best results. If using a value of 0, 
then all reflections are handled uniformly, and if using a value of 1, then all reflections are handled 
using Lambert or Lambert Oblique as was the case in ODEON 8.0 and earlier. 
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The following chapter discusses how to obtain good results and indeed what is a good result. This 
is not a straight answer on how to obtain the best result, but merely a discussion that may provide 
some ideas as to what can be done in order to obtain reliable results in a program such as ODEON. 

11.1 What are Good Results 

The desirable precision - subjective limen 
Before discussing how to achieve good results, it is a good idea to outline just what a good result 
is. The subjective limen (or “just noticeable difference” - JND) on room acoustical parameters 
should give a good suggestion as to the desirable precision. If the error between the ‘real’ 
(measured with some precision) and the simulated room acoustical parameter is less the one 
subjective limen, then there is no perceivable difference and there would be no need for more 
precise results. In some cases it will be difficult or even impossible to obtain results at this precision, 
but in most of the cases, being slightly above 1 JND will still be satisfactory. 

 

Parameter Definition  
(ISO 3382-1, 2009) and (IEC 60268-16, 2011) for STI 

Subj. limen 

T30 (s) Reverberation time, derived from –5 to – 35 dB of the decay curve 5 % rel. 
EDT (s) Early decay time, derived from 0 to – 10 dB of the decay curve  5 % rel. 
D50 (%) Deutlichkeit (definition), early (0 - 50 ms) to total energy ratio 5 % abs. 
C80 (dB) Clarity, early (0 – 80 ms) to late (80 ms – ∞) energy ratio 1 dB abs. 

Ts [ms] Centre time, time of first moment of impulse response or gravity 
time 

10 ms abs. 

G (dB) Sound level related to omni-directional free field radiation at 10 
m distance 

1 dB abs. 

LF (%) Early lateral (5 – 80 ms) energy ratio, cos2(lateral angle) 5 % abs. 
STI (RASTI) Speech Transmission Index  0.03 abs. 

Room acoustical parameters and their subjective limen as given by Bork (Bork, 2000) and Bradley 
(Bradley, 1986). 

Example 1: 
If the real G value is 1 dB and the simulated is 1.9 dB then the difference is not noticeable. 

Example 2: 
If the real LF value is 12 % and the simulated is 17 % the difference is only barely noticeable. 
 
Note! When comparing measured parameters to the ones simulated it should be kept in mind that 
the measured parameters are not necessarily the grand truth as there are also uncertainties on the 
measured result. These errors are due to limited tolerances in the measuring equipment as well a 
limited precision in the algorithms used for deriving the parameters from the measured impulse 
response (or similar errors if results are not based on an impulse response measuring method). 
There may also be errors due to imprecise source and receiver positions. 
 

 Achieving Good Results 
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11.2 Sources of Error 
There are many sources of error in a room acoustical simulation, leading to results which are less 
than perfect (within one subjective limen). Sometimes this is quite acceptable because we are just 
interested in rough results, at other times we are interested in results as good as possible. In any 
case, being aware of the sources of error may help getting the best possible results out of ODEON. 
The sources of error (or at least some of them) are: 
 
• The approximations made in the ODEON calculation algorithms.  
• Inappropriate calculation parameters (e.g. number of late rays). 
• Imprecise material absorption coefficients. 
• Imprecise material scattering coefficients. 
• Not accurate or optimal geometry definition for use in ODEON (e.g. too detailed). 
• Not accurate measured reference data to which simulations are compared. 

Approximations made by ODEON 
It should be kept in mind that algorithms used by software such as ODEON are only a rough 
representation of the real world. In particular, the effect of wave phenomena is included in the 
calculations only to a limited extent. There is very little to do with this fact for you, the user, except 
to remember that very small rooms and rooms with very small surfaces are not necessarily 
simulated at high precision. 

Optimum calculation parameters 
A number of calculation parameters can be specified in ODEON. These settings may reflect 
expected reverberation time, a particular shape of the room or a trade-off between calculation 
speed and accuracy. 

Number of Late rays 
Too few rays used in simulations is a very common reason for errors. Please read about how to 
find a reasonable number of rays in chapter 10.2.  
 

A short explanation:  
ODEON by default specifies a suggested Number of late rays to be used in point response 
calculations. For some rooms however, this number of rays will be too low. The rooms 
could be coupled rooms, or rooms with very uneven absorption. A good way to test if the 
number of rays is sufficient, is by inspecting the decay curves as shown in section 10.2.  

Transition order 
The Transition order is less often a source of error, but in very detailed models it can be. The Transition 

order applies only to point sources. Current recommendation is TO = 2 for most rooms. For rooms 
with a high level of geometrical detail, with many small surfaces or rooms where no or few image 
sources are visible from the receivers, a lower Transition order of 0 or 1 may be used. Please read about 
Transition order in chapter 10.3. 
 

Materials/absorption data 
Wrong or imprecise absorption data is probably one of the most common sources of error in room 
acoustic simulations. This may be due to lack of precision in the measurements of the absorption 
data, limitations in the measurement method itself, or because the construction material in the 
model was assumed based on guesswork – in any case it is a good idea to remember this and to 
estimate the size of error on the material data as well as the impact on the simulated results. It has 
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been observed that absorption coefficients outside the range 0.05 to 0.9 should be used with care 
(Christensen, et al., 2008). In the Material list in Odeon, there is a button which will limit the range of 
absorption coefficients assigned to surfaces in a room to a selected range. 

Solution if materials’ data is uncertain: 
There is really not much to do about the uncertainty of material data if the room does not exist, 
except taking the uncertainty of the materials into account in the design phase. If the room does 
indeed exist and is being modelled in order to evaluate different possible changes it may be a good 
idea to tweak uncertain materials until the simulated room acoustical parameters fits the measured 
ones as good as possible. 
 
In ODEON 13 the Material Optimization Tool based on genetic algorithms was introduced. An initial 
estimate of materials is required. Then the algorithm searches for the best set of absorption 
coefficients, by a genetic evolution process, which makes simulations match better with 
measurements. See Chapter 13. 
 
Absorption properties in a material library are often assumed by users to be without errors. This is 
far from being the truth. For high absorption coefficients and at high frequencies the values are 
probably quite reliable. However, low and even mid-frequency frequency absorption data and 
absorption data for hard materials will often have a lack of precision. 

Low frequency absorption 
At low frequencies the absorption coefficients measured in a reverberation chamber are with 
limited precision because: 
• There are very few modes available in a reverberation chamber at lowest frequency bands. 
• Low frequency absorption occurs partly due to the construction itself rather than its visible 

surface structure. Often it may not be possible to reconstruct a complete building construction 
in a reverberation chamber, and if reconstructing only a fraction of the wall in the reverberation 
chamber it will have different absorption properties, because it becomes more or less stiff. 

Hard materials 
Hard materials such as concrete are often listed as being 1% or 2% absorbing. It may sound like a 
difference of 0.5% or 1% is not a significant difference. However, if a room is dominated by this 
material (or one of the dimensions of the room is), a change from 1% to 2% is a change of to times 
as much absorption! 

Materials/scattering coefficients 
The knowledge on scattering coefficients is currently rather limited. Hopefully in the future, the 
scattering coefficients will be available for some materials. Meanwhile the best that can be done is 
to make some good guesses on the size of the scattering coefficients and to do some estimates on 
the effect of uncertainty. Please read chapter 4.  

Measurements 
The reference data which you may use to compare simulated room acoustical parameters against, 
is not guaranteed to be perfect. We must accept some tolerances on the precision of the measured 
parameters. 
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Receiver position(s) 
Common errors are: 
• to base the room acoustic design on simulations in one or only few receiver positions. 
• to place the receiver close to a surface. 
• to use too short source-receiver distance. 

Source-Receiver distance 
Point response calculations made in ODEON are to be compared with point response 
measurements and as such the (ISO 3382-1, 2009) standard should be followed: 
 
To obtain good estimates of reverberation time, the minimum source-receiver distance should be 
used in order to avoid strong influence from the direct sound. The minimum source–receiver 
distance according to ISO 3382-1 is: 

 
 
(m) 
 

where : 
V is the volume of the room (m3). 
c  is the speed of sound (m/s). 
T is an estimate of the expected reverberation time (s). 
 
Thus, for a typical concert hall a source-receiver distance less than 10 metres should be avoided in 
order to get good predictions (measurements) of the reverberation time. 

Minimum distance from the receiver to the closest surface 
If a receiver is placed very close to a surface then results will be sensitive to the actual position of 
the secondary sources generated by ODEON’s late ray method. If such a secondary source happens 
to be very close to the receiver, e.g. 1 to 10 centimetres, this may produce a spurious spike on the 
decay curve, resulting in unreliable predictions of the reverberation time – indeed if the distance is 
zero then in principle an infinitely large contribution would be generated. To avoid this problem, 
it is recommended that distances to surfaces are kept greater than, say, 0.3 to 0.5 metres. Anyway, 
for other reasons, it is recommended to keep distances greater than a quarter of a wavelength, i.e. 
1.3 metres at 63 Hz. A distance of 1 metre is required by ISO 3382. 
  

Tc
Vd
*

2min =
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A measurement system is integrated in all editions of ODEON. It helps to obtain the impulse 
response of real rooms, loudspeakers, headphones and other acoustic systems. You can either 
measure or import an impulse response, and from it, the decay curves, the room acoustic parameters, 
and many other relevant quantities are calculated.  
The measuring system consists mainly of two buttons, available in the main toolbar: 
 

 
 

• Measure impulse response .  It makes an impulse response measurement using the 
measurement system in ODEON. The measurement system uses the sine sweep method, being 
very effective to suppress background noise and getting accurate results. To use this option, 
you need at least a speaker and microphone.  

• Load impulse response .  It loads an impulse response stored on your computer. This can either 
be a measurement made using ODEON or similar software measurement software, or it can be 
a sketch measurement just using a hand clap or balloon with a handheld recorder like a phone. 

 
These buttons are always active, whether or not a room has been opened. The Room Acoustic Parameter 

List button  always remains active as well, in order to make it possible to edit parameters that 
are displayed in the Load impulse response window (there are limited options in the Basics & Industrial 
edition). 
 

 
 
In addition to the two main buttons, several relevant tools can be found under the Tools menu from 
the main menu bar: 
 

 
 
 
 
 
 
 

 Measurement System  

Note: The measuring facilities in ODEON can be used as a stand-alone tool without any associated room 
model. You can record, load, edit and store impulse responses without having to perform any 
simulation.   



144 
 

What is an Impulse Response and a Sine Sweep 
An impulse response is the output of a system when the input is an impulse. Mathematically, an 
impulse is considered to contain all frequencies, therefore the impulse response contains the full 
behaviour of the system. In room acoustics, the system is the room, the input was traditionally a 
hand clap or a balloon pop, and the output is the obtained recording. However, these inputs are 
only rough approximations to a true impulse, and are not as accurate compared to modern 
measurement methods like the Sine Sweep (Müller, 2001). In the sine sweep, the frequencies are 
played one sine tone at the time, and ODEON then translates this into an impulse response. This 
is explained in more detail later. You can still use the hand claps or balloon recordings with 
ODEON, but we call these “Sketch Measurements” and recommend to use the Sine Sweep method 
with ODEON if accuracy is important.  

Standalone measurement system 
If no room is loaded, most buttons, are grayed and inactive, except the ones for the measuring 
system, plus the button that leads to the video tutorials page.  
 

 
 
In this mode you can only use ODEON as a standalone measuring system. You can either measure 
a new impulse response with the Measure impulse response   interface or load impulse responses 
with the Load impulse response  function. See further down in sections 12.3 and 12.4 for a detailed 
walk-through.   
If you load more than one impulse responses (SHIFT/CTRL files in the Select impulse response file(s) 

dialogue), a statistics window will be displayed automatically, with various results displayed in the 
same manner as in Job List>Multi-point Response.  
 

  

Compare simulations and measurements 
Generally, the use of the measuring system goes beyond to be just a standalone tool. One of the 
strongest parts of having a measuring system inside ODEON is the possibility to compare 
measurements with simulations. If a room is loaded, measurements and simulations can be 
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displayed side by side at the same time for easy comparison of results, as ODEON aims at 
displaying measured and simulated results in similar graphical ways.  
 
You can transfer measured room acoustics parameters to the Multi point response display available in 
the Job List, facilitating comparison of measurements and simulations. See how in Section 12.6. 
 

 

Sketch Measurements 
If you are not bringing the full set of measurement equipment (PC, amplifier, loudspeaker etc.), 
you can record a hand clap, the popping of a balloon or a paper bag, or even the gunshot of a start 
gun, e.g. using a smart phone with an application that supports recording wave files or a dedicated 
portable audio recorder. The clapping hands will act as the source and the phone/recorder will act 
as the receiver-microphone. The files containing impulse responses can be loaded into ODEON using 
the Load impulse response  button. As the energy of a handclap is limited, ODEON may not be able 
to derive energy at all frequency bands (in particular lower ones) due to background noise – but 
still this may be better than nothing. You can read more on how to make a sketch measurement in 
the application note “Measurements with a Smart Phone”on the application notes page 
https://odeon.dk/learn/application-notes/. 

12.1 Technical Background 
This is a chapter on the technical background of the measurements system, and for the basic user 
it is not necessary to know to such detail how to do measurements. 

High Quality Measurements Using the Sweep Method 
The room impulse response measurements in ODEON can be performed using linear and 
exponential sweep signals, which is superior to other methods in suppressing background noise, 
leading to high Signal-to-Noise ratio (Müller, 2001) and high immunity to distortion. A sweep is 
simply a pure sinusoidal signal, with frequency increasing monotonically in time. The sweep 
method for measuring impulse responses is the least sensitive method to time variance and 
distortion and it is expected to work well on most hardware systems. ODEON uses sweeps to excite 
a room and record the response to this signal at a microphone (receiver) position in real time. This 
sweep response is then deconvolved to give the impulse response between the source and the 
microphone. This process uses upward sweeps, instead of downward, meaning that low 
frequencies are played first. The energy of low frequency sound typically takes more time to decay 
than the energy of high frequency sound in a room. Therefore, upward sweeps are preferable over 
downward ones, in order to ensure that the decay of low frequencies is captured within the 
recording of the whole sweep response, and harmonic distortion is suppressed. An extra decay 
period of a few seconds is recorded after the end of the sweep, so that the remaining decay for 
middle and high frequencies can be completely captured. 
 

Octave Band Filtering 
The broadband impulse response obtained by the sweep method is filtered in octave bands 
between 63 Hz and 8 kHz, using 2nd order Butterworth filters, according to the IEC 61260 (1995-08) 
standard. These analog Butterworth filters are implemented by digital Infinite Impulse Response 
filters (IIR filters), which introduce unwanted transients in the beginning of the response. 

Remember: ODEON functions both as a room acoustics simulation software as well as a room acoustics 
measurement software. You can compare measured with simulated results in the Multi point response 
display. 

https://odeon.dk/learn/application-notes/
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Although the length of the impulse response of the filters is infinite, a finite effective length is used, 
so 99.9% of the energy of the filtered response is included. The length of the transients in the filtered 
response is considered equal to the effective length of the filter. Moreover, reversed filtering is 
applied for decay analysis so that all the transients appear at the tail of the impulse response, 
instead of the beginning, and the filter phase distortion is suppressed. ODEON automatically 
excludes the transient tail when processing the impulse response. 
 

Detection of Direct Sound 
An ideal impulse response, according to geometrical acoustics (Kuttruff, 1973), would consist of an 
ensemble of Dirac impulses with appropriate delays and strengths. The ideal direct sound from a 
source should be a perfect Dirac impulse too, arriving at a time equivalent to the distance between 
the source and the receiver. However, in reality the direct sound and all the other reflections are 
not perfect Dirac impulses. In fact, each reflection consists of an onset and some decay. As the 
frequency gets lower, the decay of a reflection may overlap with the onset of a subsequent 
reflection. In the derivation of many of the ISO 3382 parameters it is vital to capture the amount of 
early energy correctly. ODEON uses advanced algorithms for successfully detecting the energy 
from the direct sound and discriminating it from the following reflections. For every impulse 
response the correct onset time is indicated in the display. According to the ISO 3382 standard (ISO 
3382-1,2008) the onset of the direct sound and of the whole impulse response should be counted at 
least -20 dB below the peak level of the direct sound. This dB value is called Trigger level. In many 
cases a lower value for the Trigger level may be desirable and this is the reason why this is an 
adjustable parameter in the ODEON measuring system. 
 

Detection of Noise Floor 
Most of the impulse response recordings, whether recorded directly or obtained using the sweep 
method, come with a noise tail, due to the ambient background noise and noise of the transmission 
line involved (PC sound card, cables and microphone). This noise tail should be excluded before 
deriving the decay curve and the ISO 3382 room acoustic parameters (ISO 3382-2, 2008). The 
ODEON measurement system utilizes a modification of the algorithm by Lundeby for 
automatically detecting the noise floor and truncating the impulse response at an appropriate time 
(Lundeby, 1995). 
 

12.2  Equipment to Use with the Measurement System 
The ODEON measuring system is very flexible. Only elementary equipment is needed for an initial 
measurement: 
 
• Microphone (receiver). 
• Loudspeaker (source). 
• Sound card (audio interface). 
• Amplifier(s). 
• Computer. 
• Cables. 
 
These devices can be connected according to the diagram below, with several variations allowed 
depending on whether an external or internal sound card is used and whether the microphone and 
loudspeaker require external amplifiers or have their own type of internal amplification.  
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Microphone 
A microphone is used to record the impulse response at a specific ‘receiver’ location. Many types 
of microphones are suitable for our purpose, and choosing any of them is a matter of budget, ease 
of use and precision. One of the most important prerequisites is that the frequency response is as 
flat as possible for the octave bands between 63 Hz and 8000 Hz. If using the built-in microphone 
amplifier, it has a (mixer) slider which should be set to max manually by the user. 

Microphone type 
According to the technology used, microphones can be divided in Condenser, Electret, Digital and 
Dynamic ones.  
Condenser microphones have an ultra-light diaphragm and are extremely sensitive to soft sounds, 
therefore are the ideal type for room acoustic measurements in order to capture even the weakest 
reflections in the room. These microphones require phantom (external) power, typically 12V or 48V, 
which is often provided by external sound cards (audio interfaces).   
Electret microphones require a steady electric charging (supply) to activate them. Their diaphragm 
is light enough to vibrate with subtle sounds, therefore they have high sensitivity and are highly 
suitable for room acoustic measurements. Usually the electric charging comes from an internal 
battery, although some models can accept phantom power from the audio interface.  
Dynamic microphones are the least sensitive type. They consist of a diaphragm that can be excited 
by sound waves and start vibrate. The movement generates electric signals which are then 
transmitted into the rest of our equipment. Such microphones do not require electricity to operate, 
but since they do not have high sensitivity, amplification is typically required to boost the recorded 
impulse response in the room. Another characteristic is their typically large diaphragm which 
makes the whole microphone big and not as close to an ideally ‘point’ receiver. Therefore, dynamic 
microphones are not the best for room acoustic measurements.  
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Microphone class 
The class defines how accurately the microphone records sounds. Class 1 is more accurate than 
Class 2, because it allows less tolerance (deviation) of sound level at the different octave bands.  
For example: At 1kHz, Class 1 microphones have tolerance +/- 1.1 dB, while Class 2 ones have 
tolerance +/- 1.4 dB. At 20 Hz, Class 1 microphones have tolerance +/- 2.5 dB, while Class 2 ones 
have tolerance +/- 3.5 dB.  
Somebody can find a full comparison of the two Classes in the IEC 61672-1:2002 standard. 
However, for room acoustic measurements in ODEON, the class is not crucial, simply because all 
room acoustic parameters are derived for each octave band independently and without taking into 
account the actual sound level that is recorded by the microphone, as long it is well above the 
background noise. Even for parameters like Sound Strength G, the measuring system has to be 
calibrated (see Section 12.9). Therefore, any imprecisions of the microphone will be included 
automatically, as correction factors, in calibration.     

Ambisonics (B-format) Microphone    
Since ODEON 16, 4 input channels can be recognized when a 1st order ambisonics (B-format) 
microphone is connected. Various conventions exist for the order of the 4 ambisonics channels, but 
ODEON recognizes the FuMa (Furse Malham) convention (please read more in the ODEON help, 
in the Auralisation Setup). The microphone should be connected to a sound device that encodes the 
4 channels directly into W, X, Y, Z, according to the FuMa convention. ODEON does not perform 
the encoding. The first channel W is always the omni one.   

Setting microphone amplification 
It is not uncommon to have a dedicated microphone amplifier (boost) which can typically be set in 
the range 0 to 30 dB, and if so, be sure to set it so a desirable response is achieved (for sufficient 
SNR). If using a different setting in your measurements than those used in the calibration, be sure 
to adjust the external adjustments in the measurement setup accordingly.  
Often, the sound card (the audio interface) – described just below - offers sufficient microphone 
amplification. Most modern sound cards are equipped with phantom power to be used with 
condenser microphones.  It is worth checking the capabilities of your sound card and whether they 
are sufficient for your microphone requirements, before investing in an expensive dedicated 
microphone amplifier. 
 

Source (loudspeaker) 
A flat frequency-response loudspeaker source can help to obtain enough Signal-to-Noise ratio 
(SNR) for as many as possible octave bands.  
The loudspeaker should also be as omnidirectional as possible, according to the specifications in the 
ISO standard 3382-1 (2009). As reported in the standard, the source should be able to produce a 
sound pressure level sufficient to provide decay curves with the required minimum dynamic 
range, without contamination by background noise.  
 
Some loudspeakers come with a built-in amplifier (active loudspeakers). They can be very useful 
as no external amplification is needed. 
When the source has no internal amplification (passive source) an external amplifier is needed.  

Sound Card 
Even built-in sound cards of a portable PCs (laptops) could be used for a simple measurement. 
However, better quality of measuring equipment yields results of higher accuracy. Built-in sound 
cards often use low-quality filters which introduce distortion and additional background level in 
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the recorded response, and in some cases there may also be electrical noise coming from other of 
the PC’s components. USB audio interfaces of moderate prices, intended for gaming or music 
recordings, can work pretty well. Power supply directly from the USB port is preferable, for 
increased portability. 

Analog filters of sound cards 
Some cheap sound cards may have very poor realisation filter (which should cut off high 
frequencies above the Nyquist frequency2). If this is the case you will notice that the sweep 
reproduced over the loudspeaker does not appear to be going monotonically from low to high 
frequencies. If pronounced, it is recommended to use a better interface e.g. studio-quality external 
sound card. Brands like Focusrite, Motu, RME and Behringer produce external sound cards of decent 
studio quality, well suited for room acoustic measurements as well, in a wide range of budgets.   

Setting up your sound card correctly 
Set up your sound card correctly for use with the ODEON measurement system. Many sound cards 
are equipped with advanced features such as noise cancellation, echo cancellation, reverberation, which 
may be useful when using internet/video conferencing or listening to music. However, such 
features are highly undesirable when using the sound card for room acoustics measurements, thus 
they should be disabled. 
For example, many PCs come with the built-in Realtek audio device. You can access the global 
settings for this device within from the Realtek Audio Manager. The noise suppression and echo 
cancellation options for the recording device (microphone) should be deactivated. 

SNR of sound card and microphone 
The sound equipment you use for measurements (sound card, microphone and amplifier) should 
provide a decent Signal-to-Noise ratio (S/N) – otherwise you will need long measurement times in 
order to suppress background noise caused by the equipment. In principle, the longer the sweep 
signal, the higher the suppression of the background noise. For every doubling of the sweep length 
a suppression of background noise by 3dB is achieved. However, even if over-prolonging the 
sweep can be an option, it is far more convenient to record at shorter times with a better SNR from 
your equipment, in order to avoid accidental noise interfering during the measurement.   

General recommendations 

Disable system sounds in mixer 
This is important so that no disturbing sounds are suddenly played during a measurement. Since 
ODEON 15, the measuring software makes use of the Windows Audio Session Programmers 
Application Interface (WASAPI) which allows better measurement quality. It bypasses the 
Windows Kernel Mixer, thus avoiding noise from other audio devices and applications on the PC, 
as well as the low-quality re-sampling of the Kernel Mixer. This also allows playback/recording in 
Exclusive mode by default. Therefore, it shields the measurement from disturbing sounds by other 
applications (e.g. notification from a Skype call).  
If for some reason you want to deactivate Exclusive mode for any input or output device, try to 
access the device properties window and uncheck the ‘Allow application to take exclusive control 
of this device’ box in the Advanced tabsheet. See the screenshot below.  
 

 
2 The Nyquist theorem states that sampling rate should be twice the highest frequency of concern. In room acoustic 
applications the sampling frequency is 44100 Hz or 48000 Hz, which offers fine sampling up to 22050 Hz and 24000 Hz 
respectively. These frequencies are well above the highest octave band of concern (8000 Hz). 
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Other methods to record impulse responses 
If someone wishes to experiment with some other stimuli than the sweep signals used by ODEON 
– such as gunshots or balloon/paper bag popping only a portable recorder is necessary. The 
impulse response can be recorded as a .wav file and be post-processed afterwards in ODEON. 
 

12.3  Measurement Setup Options 

Measure Impulse Response Options 
The Measure Impulse Response window in ODEON provides a range of options for the measurements. 
Most of the options are found in the “Settings” tab in the upper right corner. 

 

 
The Measure impulse response interface.  



151 
 

Input Levels, Test and Start: 
• Input Levels: There are two level bars at the left side of the window. The blue bar shows the 

current level captured by the microphone, while the red bar shows the maximum (peak) value 
being captured so far. You can set the input and output levels with the two large sliders in the 
center.  

• Test: If you press Test, the sine sweep will loop, but not record. You can change the level of the 
input and output, to find the correct level before making a recording or measurement. The rest 
of the settings will be locked, until you stop the loop with the Stop button.   

• Start: If you press Start, an actual measurement is made, with a sweep playback and recording. 
After the sweep has been played, you are prompted to save the recorded impulse response file. 
When this is done, the decay curve and acoustical parameters are calculated and displayed.  

Input/Output 
You can use the sliders for the output and input levels.  
• Output: The Output will go through your soundcard to the speaker. In order to reduce the effect 

of background noise, both in the room/space and from hardware, a high Output Level is 
important. But be careful not to set the level of the sound source (speaker) so loud that it starts 
distorting, which will affect the measurement quality. And be aware that loud noises can 
damage your ears, so ear protection is often necessary if you don’t leave the room while 
measuring.  
Hidden link: Double-clicking the text Output Device in the menu will take you to the Windows 
output setup. 

• Input: The input slider controls the input level of the soundcard of the microphone. In 
Windows, the input level in ODEON and the level in the Microphone properties window will be 
locked together and change simultaneously. Some soundcards will have an extra slider in the 
Microphone properties window called Boost. This will change the level, but not be registered by 
ODEON as a change is settings, and should only be used before the first measurement. Read 
more about this in the next bullet point.   
Hidden link: Double-clicking the text Input Device in the menu will take you to the Windows 
input setup. 

 

 
 

• Set Levels/SPL Compensation: You can also change the levels directly at your hardware or 
somewhere else outside ODEON (e.g. on the soundcard or mixing software accompanying the 
soundcard). However, the advantage on changing levels inside ODEON (the output and input 
sliders) is that ODEON will compensate for the internal changes when evaluating the results.  
For example, if you measure at the same microphone position two times with changed slider 
values, the SPL levels will stay the same. In other words, if you realize that the output level 
needs to be increased in the middle of a measurement session, you should use the internal 
sliders. This will ensure that the SPL variation at the different microphone positions will not be 
affected by this adjustment.  
On the other hand, if you change the levels outside ODEON, the software will not know about 
the changes, and the measurements become incomparable in terms of SPL.  
If SPL, G, or STI is part of the measurements, the levels may be changed outside ODEON only 
before the first measurement.  
If you have changed the level outside ODEON and know by how many dB the SPL was 
increased or decreased, you can compensate for this in Options > Program Setup > Measurement setup 

> External adjustments > Gain. 

Note: Changing the input level can be beneficial, especially to avoid clipping, but be aware that 
setting a higher level rarely lowers the background noise. The microphone becomes more sensitive 
and it pics not only higher signal, but higher background noise too. For lowering the background 
noise, use a higher output level or longer sweeps.  
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Measurement settings 
(Right part of the Measure Impulse response window) 
The settings are saved when either Test or Start is pressed. If you make changes to the settings and 
leave the menu again without either pressing Test or Start, the changes will be discarded.  
• Escape time [ms]: This is the time from the moment you press the button until the 

measurements starts. If making many loud measurements without ear protection, we 
recommend leaving the room to protect your hearing. This parameter gives you time to leave 
the room before the measurement starts, hence “escape time”. 

• Silence before [ms]: How much silence you want to be part of the actual measurement before 
the sweep. Distortion from the speakers can be detected in this part of the file.  

• Sweep Duration [ms]: One of the most important parameters. The longer the sweep, the lower 
the background noise will be. For every doubling of the sine sweep length, the background 
noise will be attenuated by 3 dB. The maximum allowed duration is 80 sec. 

• Impulse response length/Silence after [ms]: Here you should set enough length to make sure 
to capture the entire reverberation across all frequency bands. In addition, the recording of an 
impulse response continues after the sweep is finished, for a time equal to the impulse response 
length (Silence after). This is to make sure that the highest end of the sweep (the highest 
frequencies) have enough time to excite the room, for a healthy impulse response.     

 
 

• Legacy sweep: Use if you need a very long sweep.  If you turn this on, you can use an older 
implementation of the sine sweep, which can produce sweeps up to 300 sec.  

• Output Device: Choose which output and sampling rate you are using for the measurements. 
This output needs to be connected to your speakers or sound source. The sampling rate is often 
controlled by the hardware used.  

• Input Device: Choose the input device for the measurements. The input device needs to be 
connected to (or be itself) the microphone. The input can contain more than one channel. If that 
is the case, the following input types are available: 
o Individual channels: each channel is saved as a separate impulse response measurement. 
o Omni and Figure of 8 (2 channels): channel 1 is an omnidirectional microphone and channel 

2 is a Figure of 8 microphone. 
o Binaural (2 channels): the two channels are measured on both ears of a dummy head. 
o First Order Ambisonics (4 channels): It reads the four B-format channels W, X, Y, Z (FuMa 

convention), already encoded by the recording device. 
Measurements with more than one channel yield extra spatial information on the 
measurements, such as the spatial parameters LF80 and LFC80 (Omni and Figure of 8, First 
Order Ambisonics). The omnidirectional channel is sufficient in order to calculate 
parameters such as EDT, T30, SPL, C50, C80 etc. 

• Calibration: Here you can choose a calibration file, if you have one, to add to the measurements 
directly. All calibration files are stored by default inside the Application data>Calibrations folder. Only 
for backup purposes you can access this folder by choosing Options>Explore Application data folder. 

• Sweep Slope: You can choose the slope type of the sine-sweep. The White(Linear) sweep has 
frequency energy spread equivalent to white noise and the spectrum is a line in logarithmic axis. 
The Pink (Exponential) sweep has frequency energy spread equivalent to pink noise and the 
spectrum is an exponential curve. In other words, the Pink sweep provides longer playback time 

Remember: The output device in the setup affects only the sweep signal during the measurement. 
Auralisation, both in measurements and simulations is played back though the device chosen in 
Windows playback devices panel. 
 

Remember: You should always remain silent both throughout the sweep recording and the silence 
after, until the measurement save dialog shows up. 
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for low frequencies, thus more energy at this range, while the White sweep provides longer 
playback time at mid and high frequencies. For most room acoustic measurements, the Pink 

(Exponential) sweep is preferred against the White(Linear) sweep. On the other hand, White(Linear) may 
be preferable in measurements of sound transmission between rooms, because partitions often 
provide attenuation at high frequencies. You can also make a manual slope, by choosing Manual 
and specifying the Spectrum slope in the dB/Octave box. 

• Frequency Range: To be more time efficient, you can choose only to measure the frequency 
range of interest.  

• Sweep spectrum correction: you can modify the sweep’s spectrum per frequency band by 
entering corrections in dB. This will change the speed of the sweep as a function of frequency, 
while the level remains constant during the measurement. This tool can be used to enhance the 
measurement in octave bands with a low SNR, because of background noise or the frequency 
response of the speaker used for example. Note that overall, the sweep length remains the same, 
so the corrections are relative. For instance, boosting one frequency band will automatically 
reduce the power in other bands. A consequence is that very large variations across bands will 
only be possible for sufficiently long sweeps. If the sweep duration is too short, the variations 
will be truncated.  

• Automatic correction: the button Calculate from impulse response makes it possible to correct the 
sweep’s spectrum automatically, using a previously measured impulse response. The correction 
is based on compensating for the variations in the measured decay range across bands. Follow 
the steps described below: 
o Measure a first “pilot” impulse response with an uncorrected sweep. Save the resulting pilot 

impulse response. 
o Before carrying out the actual measurement, click on Calculate from impulse response and select 

the pilot impulse response (wave file). 
o Perform the actual impulse response measurement with the corrected sweep. 
o Note that both the pilot and the actual measurement must be carried out in the same 

conditions for optimal use. 
 

 
 

 
 

Other Setup Options 
In the Options>Program setup>Measurement setup important parameters can be adjusted, concerning the 
measurement signal, the post processing of the impulse response, the calibration and your sound 
equipment. 

Remember: 
1. In order to calculate parameters like LF(80) and LFC(80), input type Omni and Figure of 8  must be 

selected – and both the omni and figure 8 microphones must be connected to the sound card. If 
Omni and Figure of 8 is not selected then you should uncheck the Measured option for those 
parameters in the Room acoustics parameters list. Press Expand tables in the upper right corner in the 
Room acoustic parameters list to be able to change settings. 

2. In order to obtain meaningful values for a parameter such as SPL, it is essential that meaningful 
values are entered for the Source Power Spectrum (described below) and that a system calibration 
has been performed. If you do not perform any system calibration then you should uncheck the 
Measured option for SPL (and other parameters that may rely on calibration) in the Room acoustics 
parameters list. Press Expand tables in the upper right corner in the Room acoustic parameters list to 
be able to change settings. 

Tip: If during the measurement, a sudden peak causes the recording to clip, ODEON terminates the 
measurement showing a warning message. This way, ODEON helps you avoid storing such faulty 
measurement which you may not have noticed. 
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Parameters for detection of onset time 
The Noise floor window length specifies the time interval used to detect the noise floor before the onset 
time of the impulse response. When a sound file contains more than one impulse response in a row 
(e.g. hand-clap recordings in a sequence), a sufficiently short Noise floor window length is required, in 
order for ODEON to successfully discriminate the different impulse responses. In cases where 
magnetic feedback introduces strong spikes at the beginning of the impulse response (this 
measurement error happens if microphone and loudspeaker cables lie parallel and close to each 
other for some distance), this setting can help the user get rid of it. 
The Trigger level is the level that determines the onset time of the impulse response. Since no real 
impulse response starts with a perfect DIRAC pulse, there is always some build-up of energy that 
happens before the first peak of the response. ODEON first takes the square of the impulse 
response so that all peaks appear positive. Then it detects the first and strongest peak of the squared 
impulse response and searches backwards for a drop equal to the Trigger level. The corresponding 
time at this level is the onset time of the impulse response. The default value for the Trigger level is -
40 dB. ODEON finally shifts the whole impulse response, so that the onset time is always aligned to 
0 seconds.  
In the following example, a squared impulse response is zoomed-in close to the first peak, which 
is at around -50 dB. The onset time is shown by a vertical pink dotted line and has been located at -
90 dB, that is 40 dB below the peak, equal to the Trigger level.  
 

 
Detection of Onset time when loading an impulse response. By default, the onset 

time starts at 40 dB below the peak. 
 

Source power spectrum 
ODEON comes with two types of source power spectra that can be used with the calibration of the 
measuring system: A flat frequency spectrum source, called G-ISO 3382-1 and a speech spectrum 
source, called Speech-ISO 3382-3. The source type G-ISO 3382-1 should be chosen for almost all 
room acoustic cases, covered in the ISO 3382-1 (auditoria, concert halls etc.). On the other hand, 
source type Speech-ISO 3382-3 should be chosen if the measurement is or has been carried out in 
an open plan office (ISO 3382-3 standard). Apart from the default settings, the user can define a 
custom source spectrum. 
 

Peak 



155 
 

Background noise 
This specifies the absolute RMS dB value of the background noise in the room per octave band. 
The values are obtained from the Room setup if a room has been assigned, otherwise default values 
are used. The level of the background noise is used in the calculation of STI (Speech Transmission 
Index) and other parameters using noise, as well as for the ISO 3382-3 results presented in the 
multi-point response of ODEON. 

Decay curve settings 
Here you can adjust the resolution of the impulse response, as it appears at the Decay curves 
display (see Load Impulse Response section in Chapter 12). When no room is assigned to ODEON 
the default setting for the resolution is 3.0 ms. With a room assigned, the value is taken directly 
from the Room setup, so that the measured energy response can be compared side by side to the 
simulated energy response obtained in the Single Point Response. 

External adjustments 
The overall Gain for the sweep signal playback can be adjusted here. 

12.4  Load Impulse Response 
You can load an impulse response file in uncompressed .wav format by pressing the Load Impulse 

Response button  or by clicking Tools>Load Impulse Response (SHIFT+CTRL+L). In principle, you can load 
and process any sound .wav file in the ODEON measuring system. You should be able to see even 
a music signal in the ODEON measuring system editor, but calculated parameters may not make 
any sense and the room acoustic parameters may not be calculated at all for such a file. The larger 
the file is the longer it will take for ODEON to open. A folder called ‘Measurements’ is included in 
the ODEON main folder where impulse responses are stored by default. High quality Impulse 
responses can be measured using the sweep feature in ODEON if loudspeaker, amplifier, 
microphone, etc. are available. It is also possible to record handclap, popping of balloon or paper 
bag etc. e.g. using a smart phone or a portable audio recorder, and then load the impulse response 
file into ODEON. If a file contains multiple impulse responses (such as hand claps) ODEON will 
try to make use of the one providing the best Signal-to-Noise ratio (S/N). The next figure shows a 
typical impulse response loaded on the Measured Impulse response window. 
 

   
The Measured response window in ODEON, accessed via the Load Impulse Response button. 
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For a multi-channel impulse response, you can select its type by using the context-sensitive menu 
for any of the available Tabsheets. For example, a 4-channel measurement can either be used as a 
B-format impulse response or reduced to its first channel, by choosing Raw Impulse response>Change 

Impulse Response Type.  
 

Loading a B-format impulse response 
Since ODEON 16, four-channel B-format impulse responses can be recognized. The responses 
should be already encoded into the W, X, Y, Z channels. Such a response will look like in the 
following screenshot, with the first channel (W) being the omni, while the rest correspond to the 
axes of the x, y, z coordinate system (Gerzon, 1973).    
 

 
 
All subsequent Tabsheets show results for the W channel only, while the last Tabsheet allows 
auralisation using all the channels. Since the B-format impulse response includes all necessary 
directional information. The Play it! Interface allows for adjustment of the direction of the receiver.  
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12.5  Results from Measurements 
Raw Impulse Response 
The Raw Impulse Response displays the broadband and filtered pressure impulse response. For a 
multi-channel measurement, all the channels are displayed in the graph. You can switch between 
different octave-band filters by using the Up and Down arrow keys on the keyboard. A vertical dotted 
purple line indicates the onset time of the impulse response. ODEON detects the strongest peak in 
a recording, whether this is a typical impulse response or any sound file. If the recording consists 
of a series of impulse responses (e.g. hand-claps), the onset time of the strongest impulse response 
will be detected. A vertical dotted red line, unique to each octave band, indicates the truncation at 
the noise floor. Whenever there is not sufficient Signal-to-Noise ratio in the impulse response 
recording, the truncation time cannot be determined (safely). Instead of the truncation time, the 
estimated end of the response is displayed, again by a vertical dotted red line. 
 
You can zoom-in by clicking the left mouse button and dragging towards the lower right corner of 
the graph. In that way a zoom-in rectangle is specified between certain values of the horizontal and 
the vertical axes. Releasing the mouse button, the selected area is magnified to fit the whole 
window. Zoom out again by clicking the left mouse button and dragging it towards upper left 
corner.   
 

 
 

Raw Decay Curve 
This is a display of the squared pressure impulse response (i.e. energy impulse response) together 
with the onset and truncation times. In this graph, the values of the squared pressure are in dB (re 
20 μPa), which makes details more visible. However, these values will only be meaningful if the 
impulse response was obtained from a calibrated simulation or measurement, otherwise the 
decibels will be arbitrary. Similarly to the Raw Impulse Response, both the onset and truncation 
times are displayed. In addition, a horizontal solid blue line indicates the noise floor in the impulse 
response. When the noise floor of the response has a high degree of fluctuation, this solid line 
becomes dashed, indicating that the noise floor is far from being flat, and consequently that the 
estimation is not reliable. 

Decay Curves 
On this display the pure part of the impulse response between the onset and truncation times is 
processed further. Three types of curves are displayed in the graph for each octave band: 
• E, Measured: This is the energy impulse response (Raw Decay Curve) between the onset and 

truncation times with a resolution specified either in the Room setup or the Measurement setup. 
The display is fully compatible with the Decay Curves displayed in the simulated Point 
responses in the Single Point display in ODEON Auditorium and Combined. 

• E, Integrated: This is the result of the backwards Schroeder’s integration of the energy impulse 
response between the onset and truncation times. 

• E, Corrected: This is the E, Integrated curve with compensation for the lack of energy at the 
end of the response, which is caused by the backwards Schroeder’s integration. 

For a B-format impulse response, these additional curves are also displayed: 
• I, Measured: This is the estimated norm of the intensity vector with the same time resolution 

as the measured energy. The intensity vector is calculated using the X, Y and Z channels as an 
estimate of the particle velocity vector. 

Remember: Navigate through octave bands by pressing the Up and Down arrows at the keyboard or by 
clicking next frequency band / previous frequency band in the Measured Response menu (that should be already 
activated in the top menu bar). 
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• I, Integrated: This is the result of the backwards Schroeder’s integration of the intensity norm 
between the onset and truncation times. 

 
For B-format measurement, a 3D reflection view can also be opened by clicking on the button on 
the right of the graph. ODEON locates intensity peaks from the measured intensity curve and 
displays each peak as a spike in the 3D view. The length of the spike corresponds to the intensity 
norm, its direction is the direction of the intensity vector and its colour is related to its time of 
arrival. A hedgehog view displays all the intensity peaks in the time interval shown by the Decay 
Curve graph. You can navigate through the intensity peaks using P and Shift+P. If a room is loaded, 
it is possible to display the 3D visualization at the location of a receiver by selecting the 
corresponding job. This visualization tool can be useful for detecting strong reflections and flutter 
echoes. 

Decay Curves (all bands) 
Here the corrected energy decay curves (E, Corrected) are displayed for all bands on the same 
graph. You can enable/disable the different octave bands in the right-side menu. 

Energy parameters 
All calculated room acoustic parameters are displayed in a table of the same format as that for the 
single and multi/point responses (see Chapter 8). 

Parameter curves 
The room acoustic parameters are displayed in bar graphs. You can scroll among the different 
parameters by using the Left and Right arrow keys in the keyboard. 

Frequency Response 
Displays the frequency response of the whole impulse response file, including the truncated parts. 
Therefore, if you want to derive the frequency response of specific part you need to crop the 
response with the Crop Impulse Response tool, described in Sec. 12.7.   

Frequency Response  
Displays the frequency response (spectrum) of the whole impulse response file, including the 
truncated parts. Therefore, if you want to derive the frequency response of specific part you need 
to crop the response with the Crop Impulse Response tool, described in Sec. 12.7.   

Cepstrum 
Displays the inverse Fourier transform of the logarithm of the Spectrum (Frequency Response). 
The Cepstrum brings the signal from the frequency domain to a new domain with the unit seconds 
(or preferably ms). In order to distinguish from the time domain, the independent variable in the 
cepstrum is called Quefrency. It is noted that the terms Cepstrum and Quefrency have been made 
by reversing the order of the first letters in spectrum and frequency.  
The cepstrum analysis is very efficient to find any periodic behaviour of the spectrum. So, a single 
peak in the cepstrum at quefrency Δt is an indication that the spectrum contains harmonics with 
frequency spacing 1 / Δt. For more information about the cepstrum technique see (Rindel, 2016). 

Spectrogram, 
Displays the frequency response as a function of time. In other words, it shows the level for time 
and frequency for the impulse response. It can help locating colouration issues including flutter 
echoes (where some frequencies may repeat in time).  

Play it! (A)(C) 
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Makes it possible to listen to the measured impulse response as well as to listen to a signal 
convolved with the same impulse response. So, one can hear how the room measured sounds at 
the given measurement position with the given source(s).  
For B-format measurements, extra settings are shown at the lower half of the window. You can 
choose any wave file to convolve with the synthesized impulse response. The orientation of the 
listener’s head can be modified both in terms of azimuth and elevation. A binaural impulse 
response is synthesized, so the you should listen to the result with headphones. 
 

12.6 Inserting measured room acoustics parameters into 
a multi-point response 

If a room model has been loaded into ODEON, then it is possible to insert the room acoustics 
parameters derived from a measurement file which has been opened with the Load Impulse Response. 
Use the Add measured parameters (INS shortcut) or Add measured parameters and close (Ctrl+INS shortcut) 
available from the Measured response menu and specify the appropriate job and receiver number in 
the dialog that appears. Once the parameters have been added, you may view them in the Multi point 

response  (with the given job number and if the receiver number has been specified in the Source 

receiver list), available from the JobList e.g. together with simulation results (see Chapter 2.1). Even if 
no simulations have been carried out, you may benefit from the Multi point response display as it can 
provide results that is related to multiple receivers, e.g. statistics or results according the new ISO 
3382-3 standard on open plan offices. You can toggle between simulated and measured mode in 
the Multi point response by pressing the M key. The Figure below shows an example of measured and 
simulated T30 in the Multi point response. 
 

 
Simulated and measured reverberation time T30 inside the Auditorium 21 at the Technical University of Denmark. The 
graph on the left shows the values at all receivers for a given octave band, while the graph on the right shows the 
values at all octave bands for a given receiver. Press the Up and Down arrows to change frequency. Press R to change 
receiver. 

 

12.7  Editing Impulse Responses 
Three functions are available for editing an impulse response. Cropping, Manual onset time and Manual 

truncation time. All these options are available in the first two tabsheets: Raw impulse response and Raw 
Decay curve. 
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In the next figure it is shown how to access the editing functions from the context-sensitive menu 
on the main menu bar. See below for analytic descriptions of the editing functions. 
 

 
Click on the Measured Response menu to see all available tools for editing and other functions. 

Cropping 
To crop an impulse response click the left mouse button, hold down and drag a rectangle around 
the part you want to crop. Release the mouse button. ODEON now zooms the cropped part to 
occupy the whole window. Choose Measured Response>Crop Impulse Response (C shortcut). Now the part 
will be saved as a new .wav file. Odeon asks you to choose a file name and confirm. By default, the 
name of the original file is suggested, but make sure to rename it first, if you want to keep the 
original file. 

Manual onset time 
In most cases the automatic onset time by ODEON is totally acceptable. However, since ODEON 
13 it is possible to decide on your own onset time. Choose Measured Response > Manual onset time (O 
shortcut). The mouse cursor becomes a cross symbol when hovering on the impulse response. Click 
anywhere on the impulse response to define a new onset time for the current frequency band. If 
needed, zoom the area of interest by dragging a rectangle from top left to right bottom (to zoom 
out drag the opposite way). The pink dotted line defining the onset time moves now to the new 
point. If Onset snap window is active the onset time tends to snap at the strongest peak. Disable Onset 

snap window when complete manual control is required. When you click on another tabsheet, all 
acoustic parameters are immediately updated for the corresponding band. In this way different 
onset times can be defined for each band. To permanently save the changes click Measured Response 
> Save Impulse response. 

Manual truncation time 
Similarly to the onset time you can decide where you want to truncate the impulse response by 
enabling the Manual truncation time option. Choose Measured Response > Manual truncation time (T shortcut). 
The mouse cursor becomes a cross symbol when hovering on the impulse response. Click anywhere 
on the impulse response to define a new truncation time for the current frequency band. If needed, 

Tip: The Raw Decay curve display is more convenient for editing an impulse response as all values have 
been converted to dB, leading to a better view of the dynamic range. In addition, all reflections become 
positive (same phase) and they are displayed in the upper part, making it easier to decide what is the 
beginning and the end of the response. 
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zoom the area of interest by dragging a rectangle from top left to right bottom (to zoom out drag 
the opposite way). The red dotted line defining the truncation time moves now to the new point. 
When you click on another tabsheet, all acoustic parameters are immediately updated for the 
corresponding band. In this way different onset times can be defined for each band. 

Restore automatic onset/truncation times 
Choose the option Restore automatic truncation times or Restore automatic onset times and truncation times to 
restore the original settings by ODEON for the selected impulse response. 

Save Impulse Response 
When you make a manual change, the option Save impulse response becomes active so that any new 
onset or truncation times can be saved with the impulse response file. Click on the option, enter a 
new name, and click OK. 

12.8  Making Auralisations with Impulse Responses 
Auralisation features have been included in the 
measuring system since ODEON 13. This 
allows convolution of the measured impulse 
response with an anechoic signal and listening 
to the result, that is, the way the signal would 
sound if it was played inside the real room. 
However, quality might be limited by the 
microphone used for the impulse response 
recording, and by the loudspeaker used for playback. 
Choose Play impulse response file (P) from the Measured response menu to listen to the impulse response. 
 
Choose Auralisation (A) to listen to an anechoic signal convolved with the impulse response. In the 
Input signal section, you can make your folder and file selection, while in the Convolution section 
you can choose the location of the convolved file. The file receives its name from the name of the 
impulse response in use and by default it is stored in the Temp folder, meaning that it will be 
deleted when shutting down Windows. 
 

 
 

12.9  Calibration of Measurements 
So far, recording and processing of impulse responses have been described without taking 
calibration into account. In order to derive level parameters such as Sound Strength (G) and Speech 
Transmission Index (STI), the system set-up should be calibrated. Two calibration methods are 
available in ODEON that follow the ISO 3382-1 standard (ISO 3382-2, 2008): Diffuse-field and Free-
field calibration. On the application notes page http://www.odeon.dk/application-notes you can 
read more about the calibration methods described in this section. Choose Tools>Measurement 

Calibration to reveal all available calibration tools. 
 

Remember: The Play impulse response file tool plays back the whole file, including the noise floor or 
any other content. The Auralisation tool uses only the part between the onset and truncation times 
for convolving with the signal. Therefore, manual changing of onset and truncation times will 
affect auralisation. 

http://www.odeon.dk/application-notes
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Choose Tools>Measurement Calibration to see the available calibration tools in ODEON. 

Diffuse-Field Calibration 
This should be carried out in a room with long reverberation time and diffuse field, preferably a 
reverberation chamber. A group of source-receiver combinations is required. According to ISO 
3382-2, at least two source positions and three receiver positions (6 source-receiver combinations), 
correspond to a moderate precision setting (Engineering precision). A minimum of 2 source-receiver 
combinations corresponds to the lowest acceptable precision (Survey precision), while at least 12 
source-receiver combinations correspond to a top precision (High precision). The impulse response 
for each combination inside the reverberation chamber should be recorded and saved. Depending 
on the type of Diffuse Calibration desired, One step or Two step has to be selected: 

One step 
A One step diffuse calibration corresponds to the 
classical procedure described in ISO 3382-1 (ISO 3382-
2, 2008). The major requirement for this type is that all 
settings in the measuring equipment should stay 
fixed. This means that all devices (sound card, 
amplifier, microphone, cables) and gain settings 
(volume in the Operating System, amplifier volume) 
should remain unchanged when moving from the 
reverberation chamber to the actual room under 
measurement. 
 
1. Perform a number of impulse response measurements at different locations of the source and 

the receiver in the reverberation chamber. Any positions are acceptable as long as the following 
are taken into account: 
• The height of the acoustic centre of the source should be 1.5m above the floor. 
• The height of the microphone should be 1.2m above the floor. 
• Different microphone positions shall be at least 2m apart. 
• The distance of any microphone position to the nearest reflection surface – including the 

floor – shall be at least 1m. 
• No microphone position should be very close to the source. 

2. Record sufficient number of impulse responses according to the accuracy desired (from at least 
2, for a Survey precision, to at least 12, for a High precision. 

3. Click Tools>Measurement Calibration>Diffuse-field>One step (requires fixed signal chain). 
4. ODEON asks for the volume of the reverberation chamber. 
5. Once this is entered you are prompted to select and load at once all impulse responses obtained 

in step 1 for the same calibration (use the Ctrl-key and left mouse button). 
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6. ODEON will calibrate the level according to the average of the reverberation time (T30) and 
Sound Pressure Level (SPL) parameters derived for each response. The calibration process 
derives a correction factor for each octave band, from 63 Hz to 8000 Hz. 

7. ODEON asks for a name to save the file. 
8. Choose whether you want the calibration file to be active or not. 

Two-step 
A Two-step diffuse calibration keeps all important aspects of the classical one step diffuse 
calibration, but it removes the requirement of having a fixed measuring system when moving from 
the reverberation chamber to the measurement in-situ. In the paper “Applying In-situ 
Recalibration for Sound Strength Measurements in Auditoria” (C. L. Christensen, 2015) the 
underlying theory of this method is analyzed. All phases of the one step calibration are kept, but 
an extra phase is added at the end, which ensures that the acoustic properties of the source have 
been recorded. This final phase makes it easy to recover any changes in the measuring equipment 
that affected the output of the source and occurred between the reverberation chamber and the 
measurement in-situ. Apart from the series of impulse responses recorded normally for the diffuse 
calibration method, one more impulse response measurement has to be loaded when the 
microphone is placed at a known distance in front of a known direction from the source. This 
happens still inside the reverberation chamber. In this way, ODEON will try to isolate the direct 
sound from the source at this exact position. Later on, the measurement can be repeated in-situ. If 
there is any change in the equipment that affects the power of the source, it will be reported as a 
correction factor. Since the direct sound – or at least a big part of it - has to be isolated from 
subsequent reflections the heights of the source and microphone should be at least 1m. Moreover, 
the distance between source and receiver should be less or equal to 1 m. 
 
Follow the procedure described in steps 1 and 2 in the One step calibration method. Then: 
1. Click Tools>Measurements Calibrations>Diffuse-field>Two step (requires in-situ correction). 
2. ODEON asks for the volume of the reverberation time. 
3. Once this is entered you are prompted to select and load at once all impulse responses obtained 

in step 1 for the same calibration (use the Ctrl-key and left mouse button). 
4. ODEON displays all impulse responses and derives the correction values for the diffuse-field 

calibration. 
5. After that, the following warning message is displayed. 
 

 
 
6. Load one or more impulse responses recorded inside the Reverberation Chamber at a well-

known position and distance in front of the source. 
7. The relative levels of the source for each frequency are stored and an intermediate calibration 

file is derived. 
8. Save the intermediate calibration file. 
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In-situ correction 
The intermediate calibration file can now be used to 
make an in-situ correction in the room under 
measurement. It cannot be used as a final 
calibration file on a series of measurements. Make 
one more measurement in-situ with the 
microphone placed at the same position and 
distance as step 8 of the Two-step calibration. Now 
the final calibration file can be obtained: 
1. Click Tools>Measurements Calibrations>Diffuse-field>In-situ correction.  
2. ODEON asks you to load the intermediate calibration file which the complete calibration will 

be applied on. 
3. The same warning message as in step 5 during the Two step procedure is displayed. Heights of 

source, microphone and distance between them must comply with this warning message.  
4. Load one or more impulse responses recorded in-situ at a well-known position and distance in 

front of the source (same as in step 6 during the Two step procedure). 
5. The differences in levels for the recording in the reverberation chamber and in-situ are stored. 

The final calibration file has been derived. 
6. Save the final calibration file. 
7. Choose whether you want the calibration file to be active or not. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Remember: After the calibration procedure is finished you are asked if you want to set the saved 
calibration file as active. The active file will be displayed in the Measure impulse response (sinusoidal sweep) 
window and will be applied in any subsequent measurement, unless changed in the drop-down menu. 



165 
 

Free-Field Calibration 
 
Ideally this should be carried out in an anechoic room, but in many cases it can be carried out in a 
relatively dry room. The receiver should be placed close to the source and the impulse responses 

should be recorded. ODEON will try to 
capture the very early part of the 
response, corresponding to the direct 
sound. According to the distance between 
the source and the receiver and their 
heights from the floor, the arrival time of 
the 1st reflection is calculated so that the 
impulse response is truncated at this 
place. Ideally only the energy of the direct 
sound should remain after the truncation. 
Unfortunately, the truncation is quite 
approximate at low frequencies because 

the direct sound and the subsequent reflections overlap to each other, due to the long wavelengths 
of the sound waves and the presence of phase shifts. 
 
It is recommended that more than six source-receiver combinations should be used for the free-
field calibration since it is very likely that the source does not produce a perfect omni directional 
pattern, but a pattern with side lobes. This means that in contrast to the diffuse field calibration, 
the free-field calibration is very sensitive to receiver positions around the source. Similarly to the 
diffuse calibration, you should select and load all impulse responses obtained for the same 
calibration at once, so that ODEON will calibrate the level according to the average of the values. 

One step 
A One step free-field calibration corresponds to the classical procedure described in ISO 3382-1 
(ISO 3382-2, 2008). The major requirement for this type is that any external level adjustment not 
adjusted inside ODEON, is set to same level during measurement as was the case during 
calibration. This includes levels set for play back level (if set to 100% it’s easy to remember and set), 
recording level (if set to 100% it’s easy to remember and set) and microphone boost set inside the 
Operating System as well as gain factors set on external devices used in the measurements. The 
equipment itself (sound card, amplifier, microphone, cables) should also remain unchanged. 
 
1. Perform a number of impulse response measurements at different locations of the source and 

the receiver in the anechoic chamber. Any positions are acceptable as long as the following are 
taken into account: 
• The height of the acoustic centre of the source should be 1.5m above the floor. 
• The height of the microphone should be 1.2m above the floor. 
• Different microphone positions shall be at least 2m apart. 
• The distance of any microphone position to the nearest reflection surface – including the 

floor – shall be at least 1m. 
• No microphone position should be very close to the source. 

2. Record sufficient number of impulse responses according to the accuracy desired (from at least 
2, for a Survey precision, to at least 12, for a High precision. 

3. Click Tools>Measurement Calibration>Free-Field>One step (requires fixed signal chain). 
4. ODEON asks for geometry values (Source Height, Receiver Height and Source-Receiver 

distance). 
5. Once this is entered you are prompted to select and load at once all impulse responses obtained 

in step 1 for the same calibration (use the Ctrl-key and left mouse button). 
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6. ODEON will calibrate the level according to the files selected. The calibration process derives a 
correction factor for each octave band, from 63 Hz to 8000 Hz. 

7. ODEON asks for a name to save the file. 
8. Choose whether you want the calibration file to be active or not. 

Two-step  
A Two-step diffuse calibration keeps all important aspects of the classical one step free-field 
calibration, but it removes the requirement of having a fixed measuring system when moving from 
the anechoic chamber to the measurement in-situ. As in the Two-step diffuse calibration method, 
all phases of the one step calibration are kept, but an extra phase is added at the end, which ensures 
that the acoustic properties of the source have been recorded. This final phase makes it easy to 
recover any changes in the measuring equipment that affected the output of the source and 
occurred between the anechoic chamber and the measurement in-situ. The tool is available at 
Tools>Measurement calibration>Free-field calibration>Two-step (requires in-situ correction) for a calibration when 
the main step is in an anechoic chamber. 
 
Apart from the series of impulse responses recorded normally for the free-field calibration method, 
one more impulse response measurement has to be loaded when the microphone is placed at a 
known distance in front of a known direction from the source. This happens still inside the 
Anechoic Chamber. In this way ODEON will try to isolate the direct sound from the source at this 
exact position. Later on, the measurement can be repeated in-situ. If there is any change in the 
equipment that affects the power of the source, it will be reported as a correction factor. Since the 
direct sound – or at least a big part of it – has to be isolated from subsequent reflections the heights 
of the source and microphone should be at least 1m. Moreover the distance between source and 
receiver should be less or equal to 1 m. 
 
Follow the procedure described in stage 1 and 2 in the One step free-field calibration method. 
1. Click Tools>Measurements Calibrations>Diffuse-field>Two step (requires in-situ correction). 
2. ODEON asks for geometry values (Source Height, Receiver Height and Source-Receiver 

distance). 
3. Once this is entered you are prompted to select and load at once all impulse responses obtained 

in step 1 for the same calibration (use the Ctrl-key and left mouse button). 
4. ODEON displays all impulse responses and derives the correction values for the diffuse-field 

calibration. 
5. After that, the following warning message is displayed: 
 

 
 
 
6. Load one or more impulse responses recorded inside the Anechoic Chamber at a well-known 

position and distance in front of the source. 
7. The relative levels of the source for each frequency are stored and an intermediate calibration file 

is derived. 
8. Save the intermediate calibration file. 
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In situ correction 
The intermediate calibration file can now be used to make an in-situ correction in the room under 
measurement. It cannot be used as a final calibration file on a series of measurements. Make one 
more measurement in-situ with the microphone placed at the same position and distance as step 8 
of the Two-step calibration. Now the final calibration file can be obtained: 
1. Click Tools>Measurements Calibrations>Diffuse-field>In-situ correction. 
2. ODEON asks you to load the intermediate calibration file which the complete calibration will 

be applied on. 
3. The same warning message as in step 7 during the Two step procedure is displayed. Heights of 

source, microphone and distance between them must comply with this warning message. 
4. Load one or more impulse responses recorded in-situ at a well-known position and distance in 

front of the source (same as in step 8 during the Two step procedure). 
5. The differences in levels for the recording in the reverberation chamber and in-situ are stored. 

The final calibration file has been derived. 
6. Save the final calibration file. 
7. Choose whether you want the calibration file to be active or not. 
 

 
 

Figure 8 calibration 
In ODEON 14, one more calibration method was added: the figure 8 microphone calibration. This 
is necessary for measuring the Early Lateral Energy parameter, which expresses the fraction of 
energy LFJ  arriving from lateral directions within the first 80 ms (2009): 
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In this equation: 

)(tPL  is the instantaneous sound pressure of the impulse response in the room, measured with a 
figure-8 pattern microphone. 

)(tP  is the instantaneous sound pressure of the impulse response measured at the measurement 

point with an omni-directional microphone. 
From the foregoing equation it is shown that for such a measurement a microphone with two 
channels is needed: An omni and a figure-8 channel. The sensitivities of these microphones should 
be adjusted so that the peaks of the two channels coincide. 
 

Remember: After the calibration procedure is finished you are asked if you want to set the saved 
calibration file as active. The file will be displayed in Options>Program setup>Measurement setup and will be 
applied in any subsequent measurement when it is loaded in ODEON. 
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For measurement of the LFJ parameter the sensitivities of an omni and a figure 8 channel should be aligned, i.e. the 
maximum sensitivity value of the figure 8 channel should be equal to the sensitivity value of the omni directional 
channel.  
 
 
An impulse response in a fairly damped room needs to be captured with both the omni and the 
figure 8 channels being active. Please make sure that 2 Channels: Omni+Figure 8 is the active input 
device type in Measure Impulse Response>Type. 
 

 
 
ODEON will try to separate the direct sound arriving at the microphone from subsequent 
reflections. 
1. Click Tools>Measurements Calibrations>Figure of 8 Microphone Calibration. 
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2. ODEON asks for a 2-channel impulse response. 
 

3. Load one or more impulse responses recorded with the 2-channel microphone. 
4. ODEON calculates the difference between the omni and the figure-8 channel. This difference is 

then used to equalize the peaks of the corresponding sensitivities. 

 
5. Save the calibration file. 
6. Choose whether you want the calibration file to be active or not. 

 

Assign Calibration to existing measurements 
In many cases it is more convenient to 
perform all impulse response recordings 
first and apply calibration afterwards. This 
means that impulse responses can be 
obtained both in the reverberation or 
anechoic chamber and in-situ at once and 
later on be used for deriving the calibration 
files and the final calibrated measurement 
files. 
 
Once the calibration files have been 
derived with one of the methods described already, click Tools>Measurement Calibration>Assign calibration 

to existing measurements. ODEON will ask for the calibration file that can be used to calibrate the 
measurements. Now the in-situ recordings can be loaded. The recording steps that need to be 
followed for a post-measurement calibration can be summarized as follows: 
 
1. Perform and store as many impulse response recordings as required for a diffuse or a free-field 

calibration inside an anechoic or reverberation chamber respectively. 
2. If a two-step method is chosen, record an extra set of impulse responses at a specific distance 

and location from the source. Write down the distance and the exact location of the microphone 
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relative to the source. If possible, take more than one measurement, even though the position is 
the same. This will help to smooth out any random errors. 

3. Enter the actual room under measurement (in-situ). If a two-step method is chosen, repeat the 
set of measurements for the same distance – location. If any changes in the gains of the 
measuring equipment have been made, they will be corrected. If nothing is changed there will 
be just a null correction. 

4. Record and store all impulse responses desired in the room under measurement (in-situ). 
 

12.10  Examples of Impulse Responses – Warnings 
 
A reliable measurement result relies on a healthy impulse response. Although it is difficult to give 
a general definition on what a “healthy” impulse response is, here are some guidelines that may 
help in obtaining acceptable results: 
 
1) Sufficient signal noise ratio (at least in the octave bands of interest). 
 

 
 
2) A noise floor as flat as possible (if the noise floor is included in the impulse response) at the end 
of the response is a good indication that the impulse response is not polluted by impulsive noise. 
3) No presence of quantization artefacts due to poor recording resolution (input level at recording 
of the impulse response should be high enough). 
4) Presence of spikes/hills in the impulse response could indicate presence of impulsive noise 
during the measurement no matter if the impulse response was recorded directly (using external 
impulses) or obtained using the sweep method implemented in ODEON. If in doubt, it is a good 
idea to make an extra measurement while still in the field to see if it is consistent. Try to make a 
measurement with a much longer sweep (if using the sweep method). Normally such errors will 
issue a WARNING message in the title bar of the measurement window stating the value of XI 
(non-linearity parameter) is too high. 
 

 
 
In the Errors subfolder inside the Measurement folder of your ODEON installation there are examples 
of bad impulse responses, due to distortion, low Signal-to-Noise ratio and electromagnetic 
feedback. While Signal-to-Noise ratio or electromagnetic feedback may be something easy to track 
in the measurement, distortion does not provide clear signs and might let us accept an overall pure-
quality impulse response. Examples of good and bad impulse responses are given below. 

Warning messages 
Depending on the quality of the measurement, ODEON may display a warning message in the title 
bar of the measurement window informing of a possible concern with the measurement, prioritized 
in the order listed below.  
 
• Significant distortion products. 

Tip: If your equipment does not allow sufficient increase of gain for obtaining a good signal to noise 
ratio, set the sweep length as long as possible (eg. 60 sec). Every doubling of the sweep length results 
to a suppression of the noise floor by 3 dB. As an example, increasing a sweep signal from 2 sec to 64 
sec will result to a 15 dB gain in the signal to noise ratio. 

Remember: ODEON helps you making a high-quality measurement by displaying WARNING messages 
in the title bar of the measurement window. Moreover, when the Signal-to-Noise ratio is not sufficient, 
ODEON will display asterisks “*” instead of values for the various acoustic parameters. 
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• Issues with the impulse/squared impulse responses (i.e. suspicious bumps). 
• Problems with estimating onset and truncation. 
• Unable to derive some room acoustic parameters 
 
In these cases, it is recommended to perform a visual inspection of the impulse response and check 
that - remember that there is more than one octave band to look at. The warning messages concern 
frequencies between 125 and 4000 Hz, which are the most important according to the ISO standard 
3382 (2009). 

Impulse response with well-defined noise floor 
The following figure displays the raw decay curve for a typical impulse response filtered at the 
octave band of 1000 Hz. The particular impulse response has a well-detected noise floor (solid blue 
line) with well-defined onset (pink line) and truncation times (red line). In the ODEON measuring 
system, the noise floor is automatically calculated individually for each octave band. Subsequently 
a truncation time is automatically derived. If another truncation time is needed, you can do so 
manually following the instructions in Chapter 12.8. 
 

 
A typical impulse response with a well-defined “healthy” noise floor, that is easy to be detected by ODEON. 

Impulse response with fluctuating noise floor 
The tail of the impulse response in the following figure is polluted by a high degree of non-flat 
noise floor, full of dips and notches. This can be an indication of presence of strong background 
noise during the measurement and the Signal-to-Noise ratio is insufficient for the calculation of all 
room acoustic parameters. In these cases, ODEON typically displays a fluctuating noise floor with 
a dashed blue line. However, in this particular case this prolonged fluctuating noise floor cannot 
be detected as fluctuating and ODEON places a normal blue line instead. In such a case, it is wise 
to visually inspect the fluctuating envelope of the noise floor and repeat the measurement under 
less noisy conditions. 
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An impulse response with highly fluctuating noise floor.  

 

Series of impulse responses 
The next two figures show an impulse response recording containing 4 hand claps in a row. Only 
one of the impulse responses has to be processed. ODEON detects the one that has the highest peak 
in the broadband version – i.e. the 2nd one. The beginning of the 3rd impulse response defines the 
end of the noise floor for the 2nd impulse response, so that the truncation point is correctly placed 
with respect to the noise floor associated with the 2nd impulse response. If you wish to process 
another impulse response you should crop the desired part of the recording and save it as a new 
file (zoom the relevant part – then save it using the c-shortcut). Once the file has been saved it is 
automatically opened in the Measured Response window. You can also redefine the onset and 
truncation times, as described in Chapter 12.8 and save the impulse response with a new name. 

 
A series of hand-clap recordings in a room. The 1000 Hz octave band is shown. Hand–claps are an effective way to 
obtain sketch impulse responses in rooms. 

In the next figure the broadband signal is shown. Onset and truncation times are derived 
automatically but the Signal-to-Noise ratio is very poor for the selected impulse response and its 
length is too short, so that a stable noise floor cannot be derived. Therefore, some acoustic 
parameters cannot be calculated in this case. 

E, Measured
Noise floor
Onset time
Truncation time

C:\Odeon12Combined\Measurements\Elmia RoundRobin2 detailed.ImpRespFile0.wav
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The same hand-clap recordings as in previous figure but in dB, so that the dynamic range is more visible. Broadband 
signal is shown. 

Impulse response with electromagnetic feedback 
When long cables are used in a measurement for the microphone as well as for the loudspeaker 
and the cables lie close to each other and parallel for some distance, this can lead to electromagnetic 
feedback, resulting in an early peak with virtually no delay, arriving some time before the start of 
the impulse response is actually detected by the microphone. This peak is undesirable and should 
be removed. Changing the noise floor window length can help in placing the truncation time at a 
correct place, but the onset time will be still placed wrongly at the peak of the magnetic feedback. 
The best solution is to zoom the healthy part of the impulse response then save this cropped version 
using the c-shortcut. Manual setting of onset time is also possible, according to Chapter 12.8. It is 
of course better to avoid long parallel cables in the first place – if you are still in the field then by 
all means repeat the measurement. 
 

 
Electromagnetic feedback in an impulse response recording. 
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Electromagnetic feedback in an impulse response recording. Same file as in previous figure but in dB for better 
visualizing the dynamic range. 

Impulse response with harmonic distortion 
Harmonic distortion can occur at excessive high gains in some loudspeakers. It can be a significant 
problem, not easy to track and it can pollute the entire impulse response. However, part of a 
distortion is visible at the beginning of the impulse response as a build-up – before arrival of direct 
sound. Always inspect an impulse response for distortion and repeat the measurement if in doubt 
of the quality. The following figures give examples of harmonic distortion. 
 
The following common enhancements in sound cards can lead to distortion products. Be sure to 
deactivate them: 
• Echo cancellation. 
• Automatic gain control. 
 

 
Harmonic distortion visible as a build-up before the beginning of an impulse response. Pressure domain. 
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The impulse response shown on the previous figure but in dB. It is clearly seen that the harmonic distortion leads to a 
blurred onset of the impulse response. 

 

Impulse response with distortion at the end 
Distortion at the end, which appears as a “notch” of noise may have been caused due to presence 
of spikes in a measurement with the sweep method. 
 

 
Impulse response with a prominent notch at the end. Such a type of hill indicates that strong spikes were present during 
the measurement. When using the Sweep method, spikes in the recording are converted to hills after the 
deconvolution. 

High Non-linearity in the decay 
When the energy decay is non-linear, calculation of reverberation time may be questionable, as by 
definition reverberation time is calculated for an exponential energy decay – translated to a linear 
decay in a dB scale. Not only reverberation time but a group of many other parameters require an 
exponential energy decay, as described in the ISO standard 3382 (2009). The XI parameter is used 
to quantify the degree of non-linearity in an impulse response. Values greater than 10 ‰ indicate 
a questionable non-linearity in the decay. Τhis may indicate that there is something wrong with 

E, Measured
Noise floor
Onset time
Truncation time

C:\Odeon12Combined\Measurements\B0_04.WAV
Raw decay curve at 63Hz
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the captured impulse response (e.g. sudden noise during the measurement) or indeed that the 
behaviour of the room is non-linear. As an example, assume a rectangular room with uniform low 
absorption on all surfaces except from the ceiling – which is highly absorptive. The resulting decay 
curve experiences a “knee” point that changes the slope and leads to a double curved decay, with 
a high XI value. 
 
In the figure below, ODEON has placed the following warning message in the title bar: 
“WARNING max. XI = 158.16 at 8000 Hz” (the XI value shown is per-mille). 
 

 
Impulse response with decay of high non-linearity. 

 

 
Impulse response with decay of high non-linearity. Same recording as in previous figure but in dB scale, where a 
normal exponential decay should look like a straight line. 

 
Similar messages are displayed for other frequencies. If you are suspicious about the quality of 
measurement and if you believe the high value of XI is due to the recording, repeat the 
measurement. Check if the errors (like high XI) are reproducible. In addition, check if there is any 
sign of harmonic distortion, as described previously. 
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Insufficient Signal-to-Noise ratio 
In order to derive T30 at least 35 dB of valid decay must be present for each octave. Reasons for not 
obtaining a valid decay curve might be: 
• The captured impulse response may be too short because the impulse response length used 

during the measurement was too short – in this case, make a new measurement with a longer 
impulse response length. 

• The Signal-to-Noise ratio was too poor, i.e. the decay disappears into the noise floor – in this 
case increase the level of the loudspeaker (at the same time making sure your signal does not 
clip) and/or extend the sweep length. 

 
In the following impulse response (shown both in pressure and dB units) the Signal-to-Noise ratio 
is not sufficient. According to the ISO standard 3382, the measured impulse response should be 
valid at least an additional 10 dB below the lowest decay level required to derive the decay 
parameter. For example, for the T30 parameter, the decay range should reach 10 dB below -35 dB, 
resulting in a total decay range of 45 dB. Results may be fairly reliable as ODEON tries to 
compensate for the noise floor. In the following example the decay range is less than 45 dB at 1000 
Hz and therefore T30 cannot be reliably derived. 
 

 
Impulse response with insufficient Signal-to-Noise ratio. 

 

 
Impulse response with insufficient Signal-to-Noise ratio. Same recording as in previous figure but in dB. 
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Impulse response between buildings 
This is an example of measurement outdoors, between several buildings. In this case distant strong 
spikes at high frequencies indicate the presence of prominent echoes between the buildings. At low 
frequencies the effect is less prominent. In addition, the reverberation time is much longer at low 
frequencies. 
 

 
Impulse response with prominent spikes at regular distances that indicate the presence of (flutter) echoes in the field 
between the buildings. The frequency is 4000 Hz. 

 

 
At 250 Hz the echoes are less distinct, but the reverberation time is longer. 

  

E, Measured
Noise floor
Onset time
Truncation time
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Tip: Every doubling of the sweep length results to a suppression of the noise floor by 3 dB. As an 
example, increasing a sweep signal from 2 sec to 64 sec will result to a 15 dB gain in the signal to noise 
ratio. 
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(Combined and Auditorium editions only) 

 

A very special feature of newer versions of ODEON, Auditorium and Combined, is a state-of-the-
art optimization tool that allows you to refine the materials in a model in order to match the real 
acoustic conditions in an existing room. The tool is based on a research presented in Forum 
Acusticum 2014, Krakow, Poland (Christensen C.L., 2014). A genetic algorithm is utilized in the 
optimization tool. The optimization process can also be called material calibration or material tuning. 

 

Optimizing the absorption coefficients of materials inside an acoustical room model to match with 
measured data is a well-known problem among room acoustic consultants. So far, the task had to 
be performed manually in an iterative process of trial and error. The reason for requiring such an 
optimization process is that materials in an existing room are not completely known. For example, 
we might be able to know that the wall is made out of concrete but we probably cannot know the 
actual type of concrete and the corresponding absorption data. Usually 5 to 15 materials are present 
in a room and most of them can be known to some degree.  

 

Common parameters to evaluate in a calibration procedure are Early Decay Time EDT, 
Reverberation Time T30, Centre Time Ts and Clarity C50, C80. Reverberation time is complementary 
to Centre time and Clarity, meaning when the one increases, the other decreases and vice versa. 
Among the numerous types of search algorithms, the ODEON optimization tool uses Genetic 
Algorithms, which are proven to be efficient for searching in multi-dimensional search spaces 
(multi-variable problems). 
 

13.1 General Steps for Material Calibration 
So far, any optimization process had to be done manually. With the Genetic Material optimizer tool in 
ODEON, the largest part of the process is done automatically, but the time to set up the calculations 
remains roughly the same. The general steps for a calibration are as follows: 

1. Visit the room and inspect the walls. If no official data for the materials used on the natural 
walls are available, an initial estimation has to be done and the closest materials in the ODEON 
library should be assigned. Remember you can also add your own materials in the ODEON 
library by pressing the Add Materials (CTRL+M) button in the local toolbar in the Materials list. 

2. A group of impulse response measurements should be performed using the ODEON Measuring 
System (see Chapter 12) or another application (see step 7). The measurements have to be done 
at known positions inside the room. The ISO standard 3382 presents the guidelines regarding 
the number of sources and receivers required for a given precision. 

3. A virtual model of the existing room should be made in ODEON, where sources and receivers 
have to be placed at the same positions as in measurements. 

4. Define one multi-point response job for each source in the room in the JobList. 

5. The measured impulse responses should now be loaded in ODEON using the Load impulse 
response tool (see Chapter 12). 

 Genetic Material Optimizer 
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6. After inspecting the measured results and paying attention to warnings, insert the room 
acoustic parameters into the multi-point responses defined in step 4. See Chapter 12 for how to 
import measurements to multi-point response. 

7. If your measured data comes from another application as a .txt file, you can import them 
directly into the multi-point response. 

• Open the simulated multi-point response results for a selected job. 

• Click the Measured versus Simulated tabsheet. 

• Choose Open/Edit measured data file. 

 

 

 

• Now you can enter the measured data. You need to follow the format shown below: 
RECEIVER 1          
T(30)  - 2,09 2,04 1,92  2,01 1,97 1,84 - 
EDT - 2.11 2,2 2.09 2,09 2.02 1.89 - 
D(50) - 0.1927  0.4857  0.4753  0.4519 0.5582  0.5768 - 
C(80) - 2.36 1.14 0.76 1,10 2.59 3.15 - 
Ts - 162,29 112,26 107,36  112,23 90,32 85,17  - 
SPL - 10,49 10,84  10,54 9,69   8,56 8,82 - 
LF(80) - 0.0062 0.0026 0.0067  0.0247 0.0458 0.0781 0.0273  
STI 0.7               
SPL(A) 12.2               
         
RECEIVER 2         
T(30)  - 2,20 1,95 1,99  2,01 1,76 1,81 - 

Example of input file. Measured results for Receiver 1 and 2 are to be imported. For Receiver 2 only the T30 

parameter is available. In most cases parameters are only available for the 125 to 4000 Hz bands. For these a dash 

should be assigned to the 63 and 8000 Hz bands. 

 

 
 

Remember: Click F1 while working in the Measured versus Simulated tabsheet to get the corresponding 
section in the help file, which includes instructions on how to merge measured results to simulations. 
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Manual Optimization 
A manual optimization-calibration of a room model against a real one is based on trial and error. 
Usually two complementary acoustic parameters have to be used. Complementary parameters are 
those ones which vary in different directions. A common pair is T30 with C80. In principle as T30 
increases, C80 decreases and vice versa. In addition, C80 is a rather sensitive parameter that varies 
highly with position. With an initial guess of materials, a first simulation has to be carried out. If 
measured results have been imported properly into the multi-point response, the Measured versus 

Simulated tabsheet will show the degree of the agreement. If the agreement is not satisfying, some 
materials need to be changed. 
 
When small changes are needed for a material, there is no need to change or define a new material 
in the Global or the Room material library. You can just modify the absorption coefficient values 
on the surface list (left part), which will only affect the surfaces that use this material. 
 

 
 

  
 

 
 
 
The best approach is to focus your calibration procedure on a few most critical materials (two or 
three) and try to vary them until you get the best possible match. 
Example: In a classroom all materials are pretty well known except from the ceiling. An initial 
estimate for the ceiling is chosen and the first simulation shows higher simulated T30 than the 
measured one. The user has to go back in the Material List and increase the absorption of the ceiling 
so that the simulated T30 becomes lower and approaches the measured one better. 

Genetic Algorithm Optimization 
Instead of following the tedious manual optimization procedure described above, you can make 
use of the ODEON’s feature called Genetic material optimizer. The tool makes use of Genetic Algorithms 
and tries to modify the absorption coefficients of selected materials in the room in order to achieve 
a good agreement between simulations and measurements. This optimization is done on the basis 
of room acoustic parameters. The user can determine which acoustic parameters should be 

Remember: If you have to define new materials in the library you have the chance to make changes 
only for the library associated with the room. Press the Toggle between local and global room library button 

. The title on the top of the material library will change from Global material library to Room material 

library. Now, when you add a new material or delete an existing one it will not affect the default global 
library. 
 

Change absorption coefficients here in order to leave the 
material in the list unchanged. 
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involved in the process by changing their visibility in the Room Acoustic Parameter list . Before 
performing any calculation, it is worth getting familiar with the basic principles of Genetic 
Algorithms. 

 

13.2 How Genetic Algorithms Work 

Introduction 
Genetic algorithms (GA) are widely used for optimization processes in diverse areas, such as 
industrial design, artificial life systems and economics. GA starts with an ensemble of individuals 
(chromosomes) and evolve new and improved individuals by applying principles found in 
molecular genetics and biology: crossover (recombination), mutation, etc. In any stage of the 
evolution the ensemble of individuals is called population and corresponds to one generation. An 
individual is essentially a candidate solution to the optimization problem and normally consists of 
more than one gene. 

 

The criterion that is used from the evolution process to create an improved generation is the fitness 
function. Properties of the individual that give good fitness between simulated values and target 
values will have better chances of propagating into the following generations. The reason that GAs 
have become popular is their ability to find useful solutions in a very complex search space having 
many minima/maxima without getting stuck in the first occurring local minimum/maximum. 

 

In our optimization problem there are eight different GAs that run independently for each octave 
band. Translating the foregoing terms to our problem, an individual consists of a complete set of 
absorption coefficients for a particular frequency band, corresponding to the different materials in 
the room. Henceforth we shall use the term “material” for describing its absorption coefficient. One 
material is one gene. The terms are shown in Table 1. All frequency-dependent GAs start with a 
random pass (Monte Carlo method) where all individuals of the population are generated with 
absorption coefficients which vary randomly according to a user specified search range. This can 
be called 0th generation. After this pass, the evolution process is initiated by filtering out the best 
individuals as parents and producing children that are likely to inherit some of the advantages 
from their parents. The process continues indefinitely until the solution fully converges (criterion 
is satisfied) or until the user terminates the calculation. It is unlikely that the solution will converge 
fully in the acoustic optimization problem, so in practice, calculations are terminated by the user. 

Target Value and Fitness Function 
In order to evaluate how well a room simulation model with a given set of materials (an individual) 
matches against the measured room one needs a fitness function (see Table 1). The fitness function 
returns a number (fitness) to the GA that allows it to determine which individual (candidate 
solution) is better than others, controlling the genetic evolution. In our problem the GA seeks for 
individuals that minimize the fitness value, while in other GA problems the criterion might be a 
maximization of the fitness. In principle it can be considered to evaluate directly how well the 
simulated impulse responses match against the measured ones. However, there is bound to be 
differences between them as neither measurements nor simulations are perfect (Christensen C.L., 
2014). Instead, we have chosen to compare how well some of the room acoustic parameters match 
- as these are supposed to be good measures for important attributes of the acoustics in a room. 
Indeed, a group of room acoustic parameters is one of the most important tools of the room 
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acoustician for the evaluation of the acoustic quality. In order to evaluate the fitness of a set of 
materials, point responses for a number of source-receiver pairs are simulated and the average 
deviation of a number of room acoustic parameters is calculated. The parameters are normalized 
to their JND (Just Noticeable Deference) (ISO 3382-1, 2009) (e.g. 5% for reverberation time and 1 dB 
for C80) so it is possible to merge different parameters into one fitness number. If the difference 
between measured and simulated parameter is less than 1 JND - e.g. less than 1 dB for C80 - this is 
fairly accurate as it is not possible for the human receiver to perceive the difference subjectively. 
The fitness function used is given by the following formula: 
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where ε  is the fitness value (error between simulated and measured value) in JNDs and [Par ]k
i Sim

, [Par ]k
i Meas  represent the simulated and measured acoustic parameter i for the source-receiver 

combination k. K is the total number of source-receiver combinations, while I is the total number of 
used acoustic parameters. 

Table 1: Terms used in GA and their interpretation to the acoustic optimization problem. 

GA Terms Analogue to material optimization 
Gene Absorption coefficient of a material for a specific frequency band. 

Chromosome Set of genes (materials) that characterize an individual. 

Individual A candidate solution that consists of a list of genes (materials) - associated to a 

chromosome. 

Population Ensemble of Individuals - all different material combinations for one generation. 

Generation A stage in the evolution process corresponding to a population. 

Evolution Process of obtaining new sets of materials. 

Target Measured acoustic parameters. 

Fitness The error between simulated and measured data for an individual. Should be minimized. 

Fitness function Calculation of fitness according the formula presented previously. 
 

Search Space 
In order to optimize the search process, it is important to limit the search space. The search space 
can be limited by telling the GA that some of the absorption coefficients should only vary within 
certain limits and even that some should not be changed at all. 

This variation can be called search range and is given in percentage. A value of 100% would lead 
to a search range from 0 to 1 absorption coefficient, regardless the initial values. A value of 0% 
leads to no change at all, meaning that the material is excluded from the optimization process. A 
search range between 0 and 100% gives lower and upper limits depending on the initial absorption 
coefficient. Careful estimation of the search range is crucial for achieving realistic solutions. For 
example, if it is suspected that two hard parallel walls may cause a flutter echo once extra 
absorption is installed in the refurbished room, then it is important to restrict the absorption 
coefficients and search range to low values e.g. maximum 2%. If a material is only installed on a 
small surface area or it is believed to be well known it may be assigned a search range of 0% - on 
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the other hand there is always uncertainty when it comes to absorption coefficients, so leaving the 
search range to its default of 50% may often make sense. By limiting the range of absorption 
coefficients, the search process becomes more efficient as the GA will only search where there are 
possible valid solutions - e.g. if it is known that there is mineral wool in the ceiling, the GA should 
not specify absorption corresponding to wooden floor and vice versa. This will not only make the 
search faster, but it will also prevent unrealistic solutions which match the target well but are 
obviously wrong (wooden floor on the ceiling and mineral wool on the floor). It is recommended 
that the user initially assigns materials as realistic as possible. In the ODEON Genetic material 

Optimization tool it is possible to assign a search range between 0% and 100% to each material. 
 

 
The interface of the Genetic material optimizer before any calculation has started. Later in this chapter an overview of 
the different parameters is presented. 

13.3 Perform a Material Optimization 
The room Auditorium 21 at the Technical University of Denmark (DTU) will be used as an 
example. A wire frame is shown in the following figure: 
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Load the room 
Open the room Auditorium 21 at DTU.par that is pre-stored in the ODEON’s rooms folder (e.g. 
C:\Odeon...\Rooms). Inspect the room in the 3DView  and have a look at the Source/Receiver list . Two 
sources and five receivers have been set, giving 10 combinations. Open the Material list . There are 
11 different materials assigned to surfaces. The back wall, which is some kind of resonator panel 
with unknown resonance frequency, and ceiling are set to 50% absorption for all frequencies. In 
the real room it was not possible to inspect the ceiling material so an initial estimate is 2 x 13 mm 
gypsum board with mineral wool back. 

 

 

 

Have a look at the jobs defined in the Job list . The first two jobs are of particular interest, since 
they have the Multi point response enabled. The material optimization is done based on responses of 
multiple receivers and comparison to measurements. Run both Job 1 and Job 2 and see the results in 
the Measured versus Simulated tabsheet in the Multi point response results. The difference between 
measurements and simulations for most of the parameters is significant. 
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Choose Room Acoustic Parameters 
Before starting the Genetic Material Optimizer, you may want to limit the optimization process to a 
selected number of parameters – not the default bundle. To do so, open the Room Acoustic Parameter 

list . Initially the list is collapsed showing only the active parameters (visible ones). To change 
the state of each parameter, click the Expand tables button at the top right corner. The window 
becomes like the one in the following figure. The visibility column appears where you can select 
which parameters will be displayed in the single point response, multi-point response and grid response. The 
selected parameters will be taken into consideration in the genetic material optimizer as well. 
 
 

 

Remember: In the Measured versus Simulated tab-sheet you can change receiver by hitting the R or 
Shift+R key, frequencies by using the Up/Down arrows, and parameters by using the Left/Right arrows.  
 
 

Tip: Double - click on the graphs to get a table displaying the deviations between measurements and 
simulations in JNDs (Just Noticeable Differences). 

Click here to expand the list 
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Which parameters to include 
Reverberation-type parameters and fractional-type parameters are probably the best and more 
stable ones to use in a material optimization process. A common (but not unique) set can be:  
 

• EDT, T15, T20, T30 (reverberation parameters)  
• Ts, C50, C80 (fractional parameters) 

 
Reverberation-type and fractional-type parameters have a high degree of complementarity among 
them. For example, if T30 increases, C80 degreases and vice versa. This makes the GA fitting process 
more accurate (although more difficult), because the algorithm tries to balance counter forces.  

Which parameters NOT to include 
There are certain parameters in ODEON that cannot be compared with measurements, because 
they are not calibrated with proper references. The optimization process can be ruined if you 
include such parameters, therefore it is important to uncheck:  

• All SPL parameters that have been obtained with the ODEON measuring system. At the 
moment it is not possible to calibrate the system using a pistophone at a standard level (eg. 
94 dB or 114 dB) at a particular frequency (eg. 250Hz or 1 kHz). Therefore, any SPL 
parameter is not meaningful and typically very low compared to reality.  

• G, G(early) and G(late) parameters, if the system is not calibrated for them. However, in 
contrast to SPL, it is possible to calibrate ODEON for G, according to Section 12.8. 

• STI, STI(male) and STI(female) parameters, if the system is not calibrated for them. 
Similarly to G, there is a procedure to calibrate the system for including them. See Section 
12.8. 

• Although not-depended on calibration, parameters like Curvature and Dietsch Echo is better 
to be avoided because they are very sensitive on measurement conditions and background 
noise, therefore rather unstable. 

Select the active (visible) parameters 
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• Clarity parameters that include background noise, such as U(50) and U(80) may be used if 
background noise has been carefully set in the Room Setup of the model. Ideally it has to be 
measured by an SPL meter inside the real room.  
 

 

Open the Optimization Tool 
Click the Genetic material optimizer button  in the Main Toolbar or press the shortcut SHIFT+CTRL+Q. The 
interface should look like in the following picture: 
 
 
 

 
 
 
 

The following main areas are available in the interface: 

 

List of Jobs: Jobs that have active sources and which has been assigned measured results are listed 
here. In this example, 12 jobs have been used in the JobList, while only two of those has been assigned 
measured room acoustics parameters as can be seen in the Multi point response displays of these jobs 
(simulations does not need to be completed to see measured room acoustics parameters). Multi point 

Live display of error Absorption coefficients 

List of jobs List of genetic parameters Original and best error displays Editable list of materials 
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response’s relevant to the optimization procedure are activated by default. Keep these first two 
jobs activated. 

 

List of parameters: These parameters are for the research user of Genetic Algorithms only. As a 
common user you can leave the settings at their default values. Otherwise you can read the green 
box with the title “Expert’s parameters”. 

 

Editable list of materials: The list of materials as they have been assigned in the material list are 
displayed here. The materials can be edited and their absorption spectrum is illustrated directly on 
the right side. If absorption or measurement data are not well defined or measured for specific 
bands, you can exclude them from the search process by unchecking the associated column header. 
The allowed variation for each material during the optimization process is defined by the Search 

Range value. When this is 0%, it means that the material will not change at all, while when it is 100%, 
any absorption coefficient value can be assigned. When it is desired to exclude a material from the 
search process - to reduce the search space of the algorithm and to increase the speed - all that 
needs to be done is to make the Search Range value 0%. When calculations start, such a material stays 
inactive. 

 

 

 

Extra functions for materials: Two buttons allow more flexibility when editing the list of materials: 

Restore coefficients. The button restores the absorption coefficients in all octave bands for the selected 
material. It is useful when you have started modifying the coefficients for a material and want to 
return to the original coefficients. 

Copy range to other materials. If you have modified the Search Range of a material (default value is 
50%), you can assign the same value to all materials by pressing this button. 

 

Original and best error displays: The Best Fitting graph presents the original error between 
simulations and measurements versus the best value so far. The error is represented in JNDs. The 
Last Error Decrease shows the time elapsed since the last update of the best value so far, at the Best 
Fitting graph. 

 

Live display of error: Here the error for every individual (solution) per generation is shown. 
Normally the error fluctuates highly in the beginning of an optimization process and becomes 
smaller and smoother as the genetic algorithm converges. 

 

Absorption coefficients: Three different lines of absorption coefficients are updated constantly 
during a calculation.  

• The Initial line corresponds to the absorption coefficients of the original material. 
• The Optimized line shows the absorption coefficient that provides the best results so far. 
• The Current line corresponds to the absorption coefficient of the currently running solution 

(which may or may not be a good solution). 

Warning: Assigning Search Range 100% might be attractive because it allows any adjustment for a 
material and can lead to a very good match between simulations and measurements. However, the 
optimized material might be unrealistically different than the original material. Imagine beginning your 
search with a carpet material on the floor and ending with a variation of glass.  
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Additional to the three constantly updated curves, two fixed are displayed: 

• The Low limit specifies the lowest values the corresponding material can be assigned per octave 
band during the optimization process. It directly depends on the Search Range value. 

• The Upper limit specifies the highest values the corresponding material can be assigned per 
octave band during the optimization process. It directly depends on the Search Range value. 

 

 

 

Run a calculation 
Now it is time to run a first calculation. Press the Start Calculation button. ODEON starts a preliminary 
run, during which the original fitness values are evaluated (red bars in Best Fitting graph). 
Depending on the problem this step can be extremely fast - almost unnoticeable. 

 

Just after the preliminary run, the main Genetic Algorithm starts with the 0th generation that 
involves generating completely random individuals (list of materials). However, this random 
search is always restricted between the low and the upper limits specified by the search range for 
each material. For example, a material that has been assigned a search range of 5% it will remain 
almost the same as the original even during the random 0th generation. 

 

After the 0th generation is finished, parents are selected with one of the methods described in the 
Expert’s parameters. Then they start to evolve the next generation. From now on, the generation of 
new individuals is not random. This procedure will continue until you press the Stop Calculation 
button. 

 

During the whole evolution process, all graphs in the interface are updated constantly. The 
following picture shows a screenshot after about 7 generations in a calculation. You can find the 
calibrated room in the Rooms folder with the name Auditorium21 at DTU_Calibrated. 

 

 

 

Tip: For a direct comparison of different materials uncheck the Auto scale option. Then 0 becomes the 
minimum value and 1 becomes the maximum one. 
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Now have a look again at Multi point response for jobs No 1 and 2 in the JobList . The deviation 
between measurements and simulations for most of the parameters has been reduced significantly. 
Double click on the display to get a table with the differences in JNDs. 
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Expert’s parameters 

 

Crossover Method: Defines the way individuals mix together to form a new individual. Two options are available: 
Gene exchange and Vector mixing. With the Gene exchange option, new individuals are created completely 
genetically by re-arranging. 

Frequency optimization: When the individual bands option is selected, Genetic optimization is applied for each 
band independently. When broadband scaling is selected, optimization is performed using an average fitness value 
across all octave bands. This option aims to optimize the materials, while maintaining the exact shape of the 
absorption coefficient curve. 

Evolution Method: Controls how parents are selected for generating new individuals. Five options are available: 

Roulette: Parents are selected based on a “roulette-wheel” selection. Each parent is assigned a portion in the 
“roulette-wheel” according to its fitness. Parents with higher fitness value are more likely to be selected. 

Random: Parents are selected completely randomly. 

Tournament: A fixed number of individuals are selected randomly from the whole population. This is a “Tournament 
Field”. Only the best parents are kept from this field. This process is repeated several times until a specified 
number of the best individuals is collected. 

Stochastic Tournament: The best parents from a Tournament Field are selected by selecting better fit individuals 
proportional to the number of individuals per generation. 

Elitist: The top n% of the population is chosen and re-chosen. 

Individuals per material: A sufficient population of individuals is needed for a genetic evolution. By default, 2 
individuals per material are generated. For example, if we use 10 materials in our search, 20 individuals will be 
included in the procedure. Other common values are 4, 6 and so on. The values always need to be multiples of 2. 

Crossover Probability: Determines which portions of two parents will be combined to create two new offspring. 

Inversion Probability: Controls the likelihood that inversion will occur in a child’s chromosome, e.g., whether a 
portion of the child’s chromosome will be flipped. The probability is between 0 (never) and 1 (always). 

Mutation Probability: Controls the likelihood that each bit of a child’s chromosome will be mutated (flipped) 
between 0 (never) and 1 (always). When 2 parents reproduce and create a new child, their chromosomes are 
combined using Crossover and then the child’s chromosome may be mutated. 

Elitist percent: Describes the percentage of “elite” parents used every generation for evolution. When this 
percentage is 0 it means no elite parents are chosen. When this is 50%, it means that half of the parents are selected 
as elite. The best 50% are chosen. 
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This chapter gives an introduction to the use of the line array option in ODEON. The examples are 
chosen in order to demonstrate some basic properties of line arrays, and they are not representing 
recommended solutions. It is a delicate process to adjust and optimize a line arrays sound system 
for a particular room, and the knowhow and technique needed for that is beyond the scope of this 
manual. 
 

14.1 Stacking the units 
By stacking a number of loudspeaker units on a vertical line with a constant distance d between the 
centres of the units, the first thing to note is that the splay angle changes. The sound is radiated in 
a more or less concentrated beam, and the splay angle narrows in when the array gets longer. With 
N units the length of the array is L = d (N-1), and this should be longer than one wavelength in 
order to obtain the narrowing of the splay angle. This can be expressed by a lower limiting 
frequency: 

 
where c = 344 m/s is the speed of sound. However, the concentration into a single beam only works 
at frequencies below the upper limiting frequency, i.e. when the distance between the units is short 
compared to one wavelength: 

 
Above fu the sound radiation breaks up into a number of directions. The near field radiation at 1 
kHz is shown in Fig. 14-1, with different number of units in the array, from 1 to 11. The unit in the 
example is SLS_LS8800.CF2 imported from the CLF collection of loudspeakers and the distance 
between units is d = 20cm. Whereas the single loudspeaker unit spreads the sound in a wide fan, 
the level decreases rapidly with distance. With increasing number of units in the array the sound 
gradually concentrates in a beam with very small splay angle. 
 
The sound radiation in the octave bands from 250 Hz to 8 kHz with 7 units is shown in Figure. 14-
2. 
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Figure 14-1. The radiation at 1 

kHz from arrays with increasing 
number of units, from a single 

unit to 11 units (1, 3, 5, 7, 9 and 
11). 

 
Figure 14-2. The radiation in 

octave bands from 250 Hz to 8 
kHz for a line array with 7 units. 

 
Figure 14-3. Similar to Figure 10-

2, but the array is bent, see 
Table 1. 

 
In order to increase the splay angle to fit an audience area, it is usual to apply different elevation 
angles to the units, and thus creating a bent array. An example is shown in Figure 14-3 and the 
coordinates and elevation angles of the units are shown in Table 14-1. At high frequencies it is 
obviously a problem in this example that the sound radiation splits according to the number of 
units and there are gaps with poor sound radiation. 
 

Table 14-1. Coordinates and elevation angles of the 7 units in the array example in Figure 10-3. 

Transducer x y z Elevation 
1 0.000 0.000  0.000 15 
2 0.100 0.000 -0.200 10 
3 0.150 0.000 -0.400 5 
4 0.200 0.000 -0.600 0 
5 0.150 0.000 -0.800 -5 
6 0.100 0.000 -1.000 -10 
7 0.000 0.000 -1.200 -15 

 

14.2 Playing with delay 
One advantage of the line array is the possibility to control the direction of the main lobe of sound 
by means of small phase shifts, different for each of the units. So, instead of physically tilting the 
loudspeaker the line array can be mounted in a vertical position and still direct the sound towards 
the audience. 
 
If the units all have the same distance d and the delay from one unit to the next is Δt, the angle of 
sound radiation relative to the normal direction perpendicular to the array line is: 
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Figure 14-4 shows an example with Δt = 0.1 ms per unit. Figure 14-5 the same with Δt = 0.2 ms per 
unit. 
 
Note: In order to turn the beam downwards the delays should be set from 0 ms in the upper unit 
to (N-1)Δt ms in the lower unit, e.g. 1.2 ms in the case of N = 7 and Δt = 0,2ms. 
 
 
 

 
Figure 14-4. The radiation in octave bands from 250 
Hz to 8 kHz for a line array with 7 units and a time 

delay 0.1 Δms per unit. 

 
Figure 14-5. Same as Figure 14-4, but with a time 

delay 0.2 Δms per unit. 

 
At the 2 kHz band and higher frequencies (i.e. above the upper limiting frequency, 1720 Hz in this 
example) a rather strong side lobe of radiation is seen at various directions slightly upwards. This 
is the effect of the units being more than one wavelength apart from each other. If the phase is 
shifted by one period, another angle of radiation is found. Geometrically, the angles that 
correspond to i periods phase shift can be calculated from: 
 
 

where f is the frequency and i = ± 1, ± 2, etc. 
 
The theoretical angles of radiation corresponding to this example are shown as a function of the 
frequency in Table 14-2. The direction of the main lobe relative to the horizontal direction is 10° for 
Δt = 0.1 ms and 19° Δt = 0.2 ms. The results for i = -1 explain the upward side lobes seen at 2 and 4 
kHz in Figures 14-4 and 14-5. 
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Table 14-2. Calculated angles of radiation from the example array with d = 0.20 m. Positive angles are 
downwards and negative angles are upwards. Calculated for two different values of the delay per unit, Δt. 

Δt 0,1 ms   Δt 0,2 ms   
i 0 -1 1 i 0 -1 1 

f (Hz) θ θ-1 θ1 f (Hz) θ θ-1 θ1 
125 10 -86 86 125 19 -86 86 
250 10 -82 82 250 19 -81 82 
500 10 -73 75 500 19 -72 75 
1000 10 -57 62 1000 19 -54 64 
2000 10 -35 46 2000 19 -27 50 
4000 10 -14 31 4000 19 -5 38 
8000 10 -2 21 8000 19 7 29 

 
Delays for individual transducers in a line array should not be confused with the overall delay 
assigned to one point source or array source of many in a room in order to benefit from the Haas 
effect, although the devices used in order to obtain the delays may be identical: 
 
• Different delays assigned to individual transducers in a single line array have the purpose of 

achieving the effects described in this section, with the assumption that the individual 
transducers are close to each other and periodically spaced. 

 
• For the Haas effect, on the other hand, more than one loudspeaker in the room is required, and 

delays are mainly applied a whole loudspeaker (in the case of an array, the same delay is 
applied to all of its transducers). The assumption is that the loudspeakers are sufficiently far 
away from each other. 

Example: 
If transducer 1 is delayed by 0 ms and transducer 2 is delayed by 3 ms, then at t = 3 ms transducer 
2 emits the same signal value as transducer 1 emitted at t = 0. 
 

14.3 Playing with level 
If the level is not the same for all the units in the array, but if it increases gradually from bottom to 
top, the beam of radiation becomes asymmetric. An example is shown in Figure 14-6 with a level 
increase of 2 dB per unit. 
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Figure 14-6. The radiation in octave bands from 250 

Hz to 8 kHz for a line array with 7 units. The level 
increases by 2 dB per unit from bottom to top. 

 
Figure 14-7. The radiation in octave bands from 250 

Hz to 8 kHz for a line array with 7 units. The time 
delay is 0.1 ms per unit and the level increases by 2 

dB per unit from bottom to top. 

 

14.4 Combining delay and level adjustments 
With the combination of delay and level adjustments it is possible to design a sound radiation that 
is asymmetric and directed off the horizontal axis, see the example in Fig. 14-7. This can be used to 
create a very uniform sound level over an extended audience area. 
 

14.5 Using the equalizer 
In addition to the general equalizer for the array, there are equalizer options for each transducer. 
This may be used for fine adjustments or to turn off some transducers at some frequencies. E.g. if 
you want to use a shorter array at the high frequencies, you can enter a high attenuation of the 
transducers in question. 
 

14.6 Bringing the array into the room 
The position of a line source in a room is similar to that for a simple point source, but with some 
extra options: 
• If the transducer coordinate system is Absolute it means that the x, y, z, coordinates of the array 

indicate the position of the transducer with relative coordinates (0, 0, 0), if any (there doesn’t 
need be a transducer in this position, but all transducer coordinates are relative to this point). 

• If the transducer coordinate system is Relative hanging it means that the x, y, z, coordinates of 
the array indicate the position of the transducer in the top of the array, and the coordinates of 
the other transducers are relative to this. 

• If the transducer coordinate system is Relative standing it means that the x, y, z, coordinates of 
the array indicate the position of the transducer in the bottom of the array, and the coordinates 
of the other transducers are relative to this. 
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• In all three cases it is possible to include an additional offset of the coordinate system. For 
example, this can be used with the relative standing position to specify the distance from the 
centre of the lowest transducer to the physical bottom of the array loudspeaker. 

 
The direction of the array is controlled from the acoustic centre of the array, Figure 14-8. It may be 
convenient to define a receiver point to be the aiming point, or the OpenGL option will let you look 
into the room from the centre of the array and the aiming point is the centre of the picture (the 
crossing point of the two diagonals will indicate the exact point). 
 

 
 

Figure 14-8. An array source with 7 units (as specified in Table 14-1). The ray tracing in the room acoustic simulations 
is made from the acoustical centre, shown just behind unit T4. The coordinates defining the position of the array 
refers to the cross on top of the array.  
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The techniques of auralisation make use of many of technologies, and a lot of technical terms and 
abbreviations are commonly used in the literature. Here is a short vocabulary to some of the most 
used expressions - the vocabulary is not a complete description of the individual words - the 
context under which the words are used are many and the subjects are rather complex. 
 

Anechoic recording 
Anechoic recordings are recordings of sound sources made without any reflections from the 
surroundings contributing to the recordings. A common problem with anechoic recordings is that 
they may often include too many high frequency components, because they are usually near field 
recordings and because they are recorded 'on axis' where these components usually dominate. 
When using such recordings with auralisation systems this may often result in unrealistic sharp 's'-
sounds especially in case of long reverberation times. Anechoic recordings are usually recorded in 
an anechoic room, but semi-anechoic recordings may also be acceptable for use with auralisation 
systems, this could be outdoor recordings of machinery, trains etc. or studio recordings of music. 
 

Auralisation, auralization 
The term auralisation was invented by Mendel Kleiner who gives the following definition: 
Auralisation is the process of rendering audible, by physical or mathematical modelling, the sound 
field of a source in a space, in such a way as to simulate the binaural listening experience at a given 
position in the modelled space. 
 
When used in ODEON, one may think of auralisation as the art of creating digital simulations of 
binaural recordings in rooms (which may not even be built yet). The aim is to provide the same 
three-dimensional listening experience to the listener as would be achieved in the real room at the 
given receiver position with the simulated source position(s) and signals. 
 

Binaural (recording) 
Humans (usually) listen using two ears. This allows us to perceive sound as a 3D phenomenon. To 
create a binaural recording, it is not enough to create a two-channel recording (stereo), since also 
the effect of diffraction from the human body on sound has to be included. This is usually done by 
using a dummy head with a microphone mounted at the entrance of each ear canal - this recording 
may be recorded using an ordinary stereo recorder - but is now referred to as binaural. Binaural 
recordings are usually played back through headphones to avoid room effects on the played sound, 
as well as avoiding diffraction from the human body to be included twice (once in the recording 
and additionally during playback). If one has measured or indeed simulated the BRIR's (see below) 
in a room, it is possible to 'simulate' a binaural recording. 
 

BRIR – Binaural Room Impulse Response 
The BRIR is the key to binaural room acoustic auralisation. The BRIR is a set of impulse responses 
detected at the left and right entrance of the ear canals of a dummy head, or indeed at blocked 
entrenches of the ear canals of a (living) person residing in a room, when a sound source (or some 
sound sources) has emitted an impulse. The BRIR should include all the (necessary) information 
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on receiver position and orientations, source position(s) and orientation(s), room geometry, surface 
materials and the listener’s geometry (described by the HRTFs). Convolving the left channel of the 
BRIR and the right channel of the BRIR with a mono signal, a binaural signal is created, which 
when presented to the listener over headphones gives the impression of the three-dimensional 
acoustics at a particular position in the room. It is also possible to simulate the recording of the 
BRIR's, which ODEON is able to do. 
 

DIRAC 
The Dirac delta function (often called a Dirac or Dirac function) was introduced by the physicist 
Paul Dirac. In room acoustics it is used for defining a reflection which has a value of 1 at the time 
of the reflection (in an infinitely short interval – thus the delta). This Dirac is them multiplied by 
the actual strength of the reflection e.g. in a given octave band. 
 

Dither 
Dither improves the quality of audio containing harmonic signals (not impulse responses) when 
storing the signals in an integer format. Audio signals are normally saved in 16 bit integer format 
which is more compact than ‘standard’ 32 bit floating point data and better supported playback 
software (and it’s the format on audio CD’s). This means that software like Odeon has to quantize 
the floating point signals which are results of calculations into integer values (e.g. 16.35345 becomes 
16 etc.) by doing this a difference between what the signal sound have been and what it is become 
occurs and this difference can be quite audible and sound bad for harmonic signals (having 
sinusoidal shapes in them). Dither is a smart technique to overcome this problem. By adding a 
weak noise signal to the original floating point signal before performing the quantization the 
audible artefacts are reduced. As strange as it may sounds adding a noise signal reduces noise and 
distortion introduced by the quantization. Still adding noise to your audio signal sounds 
undesirable right! That’s were noise shaping comes into play, by applying a desired spectrum to 
the dither noise it possible to put the dither noise at frequencies where we know humans are not 
very sensitive to sound namely at very high and low frequencies. 
If Apply dither and noise shaping is enabled in the Auralisation setup in Odeon then Odeon will apply 
dithering to convolved output signals which may contain harmonics. Dithering is never applied to 
impulse responses (and is not used at all if Wave result file is set to a floating point format in the 
Auralisation setup. Odeon applies a dither signal with values between +/-1 with a triangular 
distribution. 
 

HRTF's – Head Related Transfer Functions 
In short terms, the HRTF describes how an impulse arriving at a person /dummy head is smeared 
out by diffraction phenomena from head and torso of the 'person'. While an incoming impulse is 
only 1 sample long, this will result in an impulse response arriving at the right and an impulse 
response arriving at the left ear, which may typically have a length (of interest) of some 2 -3 
milliseconds (approximately 100 samples at a 44100 Hz sample rate, or if you prefer a length of 1 
metre or so) - this is what is described by the HRTF's. A set of HRTF's used for auralisation will 
typically contain a library for many different angles of incidence. The HRTF's that come with 
ODEON are those made available by the CIPIC Interface Laboratory at 
http://interface.cipic.ucdavis.edu/index.htm as well as those from by Bill Gardner and Keith Martin 
at MIT Media Lab. at http://sound.media.mit.edu/KEMAR.html. HRTF’s will be slightly different 
depending on the specific shape of a person’s body, so if possible it would be optimal to measure 
and use an HRTF measured for a specific person. Then, the auralisation would turn out very 
accurate for that person. Though, one should keep in mind that measuring someone’s HRTF 
requires special equipment and may be a tedious and costly process. If you have the capability of 

http://interface.cipic.ucdavis.edu/index.htm
http://sound.media.mit.edu/KEMAR.html
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measuring HRTF's it is possible to import new sets for use with ODEON. To compensate for the 
fact that you’ll typically not use your own HRTF’s in the auralisation process and that many 
different people may indeed listen to the same auralisation, Odeon can enhance the directional 
cues in the HRTF’s and does so by default. This process involves enhancing some of the spectral 
differences in the HRTF while ensuring that the overall process doesn’t spectrum the auralisation 
output too much. The result is typically better externalisation (out of head experience) and better 
localisation. 

Noise shaping 
See dither. 

Scattering Coefficient 
It has values from 0 to 1. Defines the portion of energy that is reflected in a diffuse manner from a 
surface. The rest of the energy is assumed to be reflected in a pure specular manner. 
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Since ODEON 9 transmission through walls can be simulated, taking into account multiple 
transmission paths, allowing walls to have a thickness and to have different materials on either 
side of the transmission wall. Any transmission properties work completely independently from 
absorption. This means that you shouldn’t expect a material to absorb more sound because it has 
transmission properties. 
For any transmission calculation in ODEON, only 10% of the rays are let pass through a wall, while 
the remaining 90% are kept inside the source room for simulation of room acoustics. Compensation 
is made concerning the energy, so the calculation result in the source room is not affected by some 
rays being transmitted to another room – only the absorption data for the wall is used. In general, 
it is a good practice to use a higher number of rays (e.g. double the amount) when making 
transmission calculations to ensure enough rays will reach the receiving room (behind the wall). 

Assigning transmission data 
Once a Type of a wall has been set to Transmission 
in the Material List, it becomes possible to specify 
transmission data, using the Edit transmission data for 

surface (  button or Alt+Y shortcut). This opens a 
dialog where reduction indexes can be specified 
in one-third octave bands from 50 Hz to 10 kHz. 
The data can be entered directly or copied from a 
spreadsheet (or from a text file) using the common shortcuts Ctrl+C and Ctrl+V. For an example of 
transmission, open the room Transmission rooms in the ODEON Rooms folder. 
 

 
In the Specify transmission data interface you can insert transmission coefficients in dB for 1/3 octave bands. 
If your data comes only in full octave bands you can insert the full octave band values and copy the data to 

Appendix B: Specify Transmission 
Though Walls 
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1/3 side bands by pressing the Copy center bands to 1/3 octave side bands button. The option Double sided wall 
allows having the same transmission coefficient for two surfaces of different absorption. 

 

 
 

Copying transmission data from MsExcel 
A material to be copied may contain a leading comment/name and must end by 24 floating point 
values, corresponding to the 24 reduction indexes from 50 Hz to 10000 Hz. The first value is always 
assumed to be for the 50 Hertz one-third octave band. So if less than 24 values are pasted, the 
highest bands will be left empty, and if more than 24 values are pasted, the exceeding values are 
discarded. To copy the values from MsExcel, mark the relevant cells and press Ctrl+C - to paste the 
values into Transmission dialog, simply press Ctrl+V. Likewise to copy data from the Transmission 
dialog to MsExcel press Ctrl+C while the dialog is the selected window in ODEON - then select the 
first cell in MsExcel or whichever cell is relevant) and press Ctrl+V. Data can also be imported from 
Insul Sound Insulation Prediction software (Ins11), simply by copying the spectrum for Bastian 
format and pasting into ODEON. 

 

Copying transmission data of the reduction index from MsExcel. 

 

A wall with different material on either side and walls modeled with 
thickness 
Sometimes a transmission wall may be composed by two individual surfaces (two separate 
surfaces in the Materials List) as shown in the illustration from the 3DBilliard display below. It is 
possible for ODEON to link together such a pair of surfaces if they are (almost) parallel, allowing 
transmission through walls with different absorption properties on either side. The reduction index 
itself takes into consideration the wall thickness. So for a wall consisting of two parallel surfaces, 
the reduction Index should only be used once. To accomplish this, it is important that: 
• Transmission type is assigned to both surfaces in the Materials List. 
• The same set of reduction indexes is selected on either surface in the Transmission dialog. 
• Double sided wall check mark is selected for both surfaces in the Transmission dialog. 

Remember: With the transmission tool, ODEON is able to calculate the transmission of airborne sound 
through a wall. It cannot calculate the structure-borne sound propagation nor flanking transmission. 
ODEON requires the transmission properties (coefficients) of the wall as input data – exactly like for 
absorption coefficients. When a composite structure – such as a sandwich panel - is used in ODEON 
simulations, the transmission properties shall be obtained externally in four ways: 
• By the datasheet from the manufacturer of the structure. 
• By measurements. 
• By hand calculations, using analytic formulas. 
• By using software dedicated for calculating transmission coefficients of different materials (eg. 

INSUL by Marshall Day Acoustics). 
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Most of the above can usually be accomplished if the Update double sided wall upon exit is checked 
when Transmission data for the first wall is edited. It is recommended checking and rechecking 
the data entered for transmission data before making calculations, a check may involve using the 
3DBilliard or 3D Investigate Rays to ensure that walls do in fact transmit sound and that double-sided 
walls has been set up correctly. 

 
Figure B2: 3DBilliard display illustrating Transmission through a double sided wall – as can be seen, ODEON 

understands correctly that balls should jump through the wall, from one surface to another. 

 
The principle of calculations is shown in the figure above. Statistically 10% of the balls (rays) are 
transmitted and 90% are reflected. However, this is compensated for in the calculations, so the 
energy losses in the two rooms are determined by the absorption coefficients and reduction 
indexes, as used. 
 
The Transmission Rooms.par sample is installed with ODEON. This example illustrates how 
transmission data is assigned to transmission walls, when transmission walls are composed from 
a single surface, two surfaces and three surfaces. Once the room has been loaded into ODEON, 
additional information is available in the Notes editor using the Shift+Ctrl+N shortcut. In the JobList, 
some example setups have been prepared for calculations in source rooms as well as in receiver 
rooms. 
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The ODEON XML format for array loudspeakers allows importing array parameters, that specify 
how a number of transducers are combined together to form an array loudspeaker. Arrays can be 
beam-steered (a digital filter being assigned to each transducer) or a more conventional array 
where each transducer is fed directly (or through an equalizer, with a delay etc.). External files 
needed: a directivity pattern for each transducer. Currently the following directivity formats are 
supported; Common loudspeaker format (.CF1, .CF2) and ODEON’s native format .So8. 
 
The frequency range needed by ODEON covers the full octaves from 63 Hz to 8 kHz, however in 
order to make the format as versatile as possible (e.g. for future use or for use in other programs), 
frequencies from lower and higher bands can be included – ODEON will just ignore those bands.  
 
XML (eXtensible Markup Language) has been chosen as the format for import of data for arrays 
loudspeakers, because: 
• It’s a standard (1986). See also http://www.w3.org/XML/ 
• It allows eXtending the data being exported and imported when needed, by adding new 

attributes to nodes and by adding new nodes. 
• Parsers for writing and reading the format are available in most (or all?) modern programming 

environments. 
• Even if a parser is not available to the people exporting data (e.g. Loudspeaker Manufacturer), 

it is fairly easy to write XML formatted data – the import part which is more complex is left to 
ODEON (or similar programs). 

The layout of the XML file 
To understand and learn the format, the XML files installed with ODEON e.g. in the 
C:\ODEON10Combined\ArrayXML\ should be studied. This manual explains details of the 
format, but most of the format is best understood from reading through the sample files. The node 
(or tree) structure of XML files is complicated but best understood by studying the sample files and 
looking in this manual when more details are needed. See the figures on next page to get a picture 
of the tree structure. 

The following XML sample files are installed with ODEON: 

Monopol.xml 
Dipol.xml 
Quadropol.xml 
Octopol.xml 
Dipol_Domain_Frequency.xml 

 
The names of the first four files are almost self-explanatory, those are the classic textbook examples 
built from 1, 2, 4 and 8 sources. These sources utilize the Omni.so8 directivity pattern for all their 
transducers. The four sources are all conventional arrays which have been assembled inside the 
ODEON Array source editor and exported from there. The only trick is that the Invert phase option 
has been applied to half of the transducers in the Dipol, Quadropol and Octopol arrays in order to 

Appendix C: Importing Array 
Loudspeaker Data (XML format) 

http://www.w3.org/XML/
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get the special behaviour of those source types. The Dipol_Domain_Frequency.xml file is essentialy 
identical to the Dipol.xml and will give same results when used inside ODEON, but this file has 
been defined using Domain=Frequency which is the option that can be used when defining beam-
steered arrays. 
 

 
Figure E1: Tree structure for the Array source node - The Domain Data nodes are described separately in figure E2. 

 

 
Figure E2: Tree structure with the details of the Domain Data node. This note comes in two versions depending on 
weather Domain=Octave or Domain=Frequency. 
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Viewing the sample files in ODEON 
The XML files are text files and can be viewed in a text editor such as Notepad or ODEONEdit. 
Because the sample files follow the format outlined in this description, they may also be viewed in 
the ODEON Array Source Editor. It is described how to view the files from within the Array Source 
Editor in the “Testing if XML files…” section below.  
 

Having loaded one of the files into the 
Array Source Editor, the near field balloon, 
far field balloon and a 3D_Direct display 
can be studied. Note that these directivity 
patterns are strongly frequency dependent 
and have pronounced symmetry 
properties; at high frequencies their 
patterns break down and show strong 
fluctuations (see figure E4), and viewing an 
Octopol in the Near field balloon display 
may not prove interesting because it will 
never radiate any energy in its symmetry 
planes, which is what is displayed in this 
window (horizontal or vertical as selected). 
On the other hand, the Quadropol in the 
following figure gives a meaningful 
display.  

 

 
The Quadropol sample viewed in the near filed balloon tab in the Array source editor. To the left at 63 Hz, to the right 
at 4 kHz. 

Testing if XML files can be imported correctly into ODEON 
The demo version of ODEON (or a full version of ODEON Auditorium or Combined) can be 
used for this purpose. If you are reading this, you have probably already installed it, if this is not 
the case, you may download the demo version from https://odeon.dk/downloads/free-trial/. To 
model and view the array in ODEON, you only need to use a very limited number of features – 
there is no need knowing all features in the ODEON software. In a full version, you may import 
your array into any room. In the demo version, you should open the ArraySpeakerTestRoom.Par 
room located in the “Extra Rooms>Appendix-Speaker Array” folder 
(e.g. C:\ODEON11Combined\Rooms\Extra Rooms\Appendix – Speaker Array\ArraySpeakerTestRoom.Par). 
  
The ArraySpeakerTestRoom.par room is a large box measuring 100x100x20 metres, by default all 
surfaces have been assigned 100 % absorbing material as its not intended for room acoustics 
predictions: 

• To load this room, use the File>Open Room menu entry. 
• Once loaded, open the Source receiver list (shortcut Shift+Ctrl+S) 
• In the Source receiver list, define an array (shortcut A) 
• In the Array source editor, import a XML array file (shortcut Ctrl+O) 

 

https://odeon.dk/downloads/free-trial/
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That’s it. Hopefully the array imports without problems, otherwise load it into the ODEONEdit 
editor to study the XML code. When the file is loaded, you have the chance to study the array in 
various tabs of the Array source editor. 
 

Viewing and editing XML documents 
If your program writes data to be imported into ODEON then we will refer to it as WRITER, 
ODEON on the other hand will be referred to as the READER (ODEON will normally be the reader, 
but being able to export array data, it is a WRITER as well). 
 
When developing export facilities for array loudspeaker data you may need to inspect or manually 
edit the files. XML files can be browsed and edited in simple programs like Notepad, however, the 
ODEONEdit editor will perform syntax highlighting. The ODEONEdit editor is installed with 
ODEON 10 or later (including the free demo version). 
 
Decimal point can be either “,” or “.” in the XML files. ODEON will convert the XML files upon 
import to conform to the regional settings of the PC on which it’s running. 
The format is case-sensitive, therefore it is important that Attribute and Node names are spelled 
with upper and lower case as defined – use one of the examples installed with ODEON (and cut 
and paste directly from there to your code). 
 
Encoding and formatting of XML documents 
Encoding should be set to UTF-8: <?xml version="1.0" encoding="UTF-8"?>, or in a coding 
environment, XMLDocument.Encoding := 'UTF-8'. Most parsers should be able to read a number 
of other encodings though. To allow reading the XML document by eye, consider to set 
XMLDocument.Options := [doNodeAutoIndent], if that option is available in your programming 
environment. 
 

XML document content 
Much of the data given in the XML file is optional. If not given in the XML file, ODEON will set a 
default value. The nodes and Attributes of the tree-structure is described below and should be 
compared with the XML-file to keep on track. See also figures E1 and E2 (page 187). 
 
Main node (all nodes below included) 
ArraySource – Main node in the XML file which holds the entire array. 
 
Attributes to ArraySource  
 
ODEONArrayVersion=”10.0” If this number is higher than the version number known by the READER 
then the reader should not accept to read on. This version number is the version number of ODEON when 
the format was last revised. That is to say, if the READER is ODEON 10.0 (or another program aware of 
ODEONArrayVersion=”10.0”) then it should not accept data written in ODEONArrayVersion=”10.2”. 
This on the other hand implies that if your WRITER does not use any specifications added in a later 
ODEONArrayVersion then you might consider using the lowest version number possible, to make it 
compatible with READERS not knowing of the higher version. READER should assume no more than 4 
decimals in the version number. 
 
Gain="8" overall in dB per octave band – defaults to 0.  
 
Delay="0.007" Delay in seconds of the entire array.  
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ArrayCoordSys="Absolute" Can be "Rel. hanging", "Rel. standing" or "Absolute". Most programs 
will probably export as “Absolute”. ODEON has the two other options in order to allow automatic aligning 
and sorting of transducers relative to the upper (rel. hanging) or lower (rel. standing) transducer. The origo 
of the transducers can be offset using the node CoordSysOffSet node. 
 
FarFieldDistance="-1" In metres, -1 indicates that ODEON should make its own estimate of the far field 
distance. For distances greater than FarFieldDistance ODEON will use a pre-calculated balloon (calculated 
for that distance). This far field balloon is calculated and handled entirely by ODEON. 
 
FarFieldResolution="2" Far field balloon resolution in degrees: 1, 2, 3, 5 and 10 degrees allowed. 
 
NumberOfSubBands="6" Frequency resolution per octave band applied for phase summation in the 
calculations. Can be 3,6,9… A resolution of 6 is suggested as a good compromise between calculation time 
and quality of results. 
 
Nodes to ArraySource  
Position  
Orientation 
CoordSysOffset 
EQ 
Transducer (there can be multiple) 
 
Position Node 
Attributes to Position  
X="1"  
Y="1"  
Z="1" 
Uses the same coordinate system as in ODEON and as in the room to be imported into. Defaults to (1,1,1) 
and can easily be changed from within ODEON.  
 
Orientation node 
Attributes to Orientation 
Azimuth - +/- 180°, around vertical axis, counter-clockwise is positive. 
Elevation – +/-90°, up is positive and down is negative. 
Rotation"-10" – +/-180°, counter-clockwise rotation around loudspeaker axis is positive. 
 
Nodes to Orientation 
Vector 
 
 
Vector node 
Attributes to Vector 
X="1"  
Y="0"  
Z="0" 
Is used for defining orientation, need not be a unit vector. Above is the default orientation of an array or a 
loudspeaker – right turned coordinate system assumed. Vector is just another way to specify Azimuth and 
Elevation - not needed if Azimuth and Elevation have been specified – defaults to (1,0,0). READER should 
allow both, WRITER should normally just use the most comfortable one. 
 
CoordSysOffSet node 
Offset of array coordinate system, see ArrayCoordSys.  
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Attributes to CoordSysOffSet 
X="1"  
Y="0"  
Z="0" 
 
EQ node 
Overall equalization in dB of the array speaker, one value for each octave band. 
Attributes to EQ 
Octave_31="0"  
Octave_63="0"  
Octave_125="0"  
Octave_250="0"  
Octave_500="0"  
Octave_1000="0"  
Octave_2000="0"  
Octave_4000="0"  
Octave_8000="0" 
Octave_16000="0"  
 
ODEON will only make use of 63 to 8000 Hz octaves; other bands are ignored by ODEON. Any omitted 
band defaults to 0 dB. 
 
Transducer node (there should be at least one transducer in an array, typically there will be more) 
 
Transducer (all nodes below included) 
Attributes 
Description="A descriptive text"  
Gain="5"  
Overall in dB per octave band – defaults to 0  
Balloon="Omni.So8"  
Balloon data are stored in a directory known to the reader e.g. “C:\ODEON9Combined\DirFiles”. The 
balloon name may include a sub directory name (it probably should), e.g. 
Balloon=“LspManufacturerName\SpeakerModel23.CF2”. Balloons can be in .CF1, .CF2 and .So8 
formats.  
Delay="0.012" - Delay of that transducer in seconds. 
 
InvertPhase="false" Whether phase is inverted 180° - defaults to FALSE 
SampleRate e.g. 44100 Hz or 48000 Hz. Not in use yet. Specifies the sample rate if the filter for a transducer 
is an FIR filter. 
PhaseCF2="false" True if directivity balloon containing phase angles should be used for the transducer. See 
section on “phase balloons” at the end of this appendix. 
 
For transducers which have been assigned a directivity pattern in the Common Loudspeaker 
Format CF2 version 2, the transducer may belong to a multi part speaker, e.g. having separate 
balloons for the low frequency unit and the high frequency unit in a loudspeaker. In that case, a 
filter (e.g. low pass and high pass), may also be assigned to each transducer. This is what 
CLFPartNo, CLFPartMax and CLFFilter is for. 
 
CLFPartMax=”2” 
How many transducers with CLF2v2 balloons belongs to this speaker (array) 
CLFPartNo=”1” 
Which part of a multi part CLF is this transducer (e.g. part 1 or 2 of a two-way speaker) 



215 
 

CLFFilter=”true” 
Whether a filter assigned to the transducer in the CLF2v2 file (e.g. a low pass or a high pass filter) 
 
Domain="Frequency"  
So far options are "Frequency" for beam-steered, otherwise "Octave" (future should include "Time" in 
which case an attribute, SampleRate, will be needed e.g. 44100 Hz or 48000 Hz)  
Nodes 
Position 
Orientation 
DomainData 
 
DomainData node 
There are two kinds of domain data, so far also described in figure E2. If Domain= "Octave", simple 
octave band equalization is applied to each transducer. This can be used for exporting and 
importing simple array types as they are defined inside ODEON. The format is convenient since it 
is compact, and in some cases it may even be used for typing data manually into a text file. 
If Domain=”Frequency”, then beaming-filters are entered as an amount of Complex numbers per 
octave band. We suggest that NumberOfSubBands, an attribute of the ArraySource, is set to 6. 
Attributes 
DomainData has no attributes 
 
Nodes to DomainData 
EQ  
or 
Octave_31, Octave_63, Octave_125, Octave_250, Octave_500, Octave_1000, Octave_2000, 
Octave_4000, Octave_8000, Octave_16000 
  
EQ node 
EQ node is only present if Domain="FullOctave" (Attribute of Transducer)  
 
Attributes to EQ  
Octave_31="0"  
Octave_63="0"  
Octave_125="0"  
Octave_250="0"  
Octave_500="0"  
Octave_1000="0"  
Octave_2000="0"  
Octave_4000="0"  
Octave_8000="0" 
Octave_16000="0"  
 
ODEON will only make use of 63 to 8000 Hz octaves; other bands are ignored by ODEON. Any omitted 
band defaults to 0 dB. 
 
Octave_31, Octave_63, Octave_125, Octave_250…. nodes 
These nodes are only present if Domain = “Frequency”, then a number of Octave nodes are defined 
– each of these Octave nodes have Sub nodes. 
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Nodes 
Each Octave band has the centre frequency fc, defined according to ISO (31.5, 63, 125, 250, 500, 1000, 
4000, 8000 and 16000 Hz). For each of the octaves there are Ns (number of Sub-bands) nodes of the 
Sub type, and the center frequency of the sub bands are defined from the following algorithms: 
 
The frequency f1 of the lowest sub-band in an octave is defined as follows: 

 
And the following frequencies fn sub-bands are defined as: 
 

Where n=2 to n 
 
The 6 sub bands (Ns=6) centered around 1000 Hz have the following centre frequencies: 

Sub band number – n Frequency (Hertz) 
1 749.153538438340749 
2 840.896415253714543 
3 943.874312681693497 
4 1059.46309435929526 
5 1189.20711500272106 
6 1334.83985417003436 

Frequency of nth sub band in 1000 Hz octave for Ns = 6 
 
Results of calculations should be for full octave bands for the octave bands 63, 125, …8000 Hz 
ISO suggests that center sub octave frequencies should be derived from 1000 Hz. For an uneven 
number of bands e.g. 1/3rd octave bands this gives us one band below, one band at, and one band 
above the center frequency of the Octave center frequency – so the 3 sub-octaves are in balance 
relative to the octave band – however for an even number of sub-band frequencies thing becomes 
unbalanced if using ISO frequencies; there will be 2 sub-bands below and 3 sub-bands above the 
full octave band centre frequency (or opposite 3 below, 2 above)  
 
Attributes 
Re 
Img 
The energy of the transducer is emitted in Ns Sub nodes. The center frequencies of the Sub bands 
are centered around the full octave band centre frequency, in order best to simulate the energy in 
each octave band. If Ns is odd, e.g. 5 then these frequencies will coincide with ISO centre 
frequencies. Be aware though that the centre frequencies used will differ if an even number (e.g. 6) 
is used. 
 
Getting the voltage and energy right 
Values are in tension [V]. The values should be reduced by a factor which compensates for the 
NumberOfSubBands. Ns used if Ns sub-bands are used, then the Re and Img attributes of each node 
should be multiplied by a factor 1

�Ns
. 

If there were 6 sub-nodes in each band, and Re= "1.15534266201273234" and Img= "0.0" for each of 
them, then the equivalent voltage for one sub-band representing the total power in that band would 
be 1.15534266201273234xSqrt(6)=2.83 V. 2.83 V is the standard voltage for which sensitivity at 1 
metre is given for loudspeakers, so with this setting it will reproduce the sensitivity values at a 

sN
nn ff

1

1 2−=

sNcff ××= 2
1

1 2
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distance of 1 metre, see the Dipol_Domain_Frequency.xml sample. 2.83 V may seem like an 
arbitrary value, but it is generally agreed upon as ‘standard voltage´– this is the voltage at which 
an 8Ω speaker deliver 1W. The reason why the industry has moved from 1W to 2.83V? 
Loudspeakers rarely have a frequency-linear impedance (of 8Ω), whereas an amplifier is actually 
fairly capable of supplying constant voltage. 
 
Position node 
Attributes 
X="1" 
Y="2"  
Z="-0,324"  
Position of Source of transducer origin given in metres. Position defaults to (1,1,1)  
 
Orientation node  
Attributes 
Azimuth="27" - +/- 180°, around vertical axis, counter-clockwise is positive 
Elevation="-10" – +/-90°, up is positive and down is negative 
Rotation"-10" – +/-180°, counter-clockwise rotation around loudspeaker axis is positive 
Nodes 
Vector 
 
Vector node 
Attributes 
X="0,993768018134063"  
Y="0,0694910287794796"  
Z="0,0871557402186753" 
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Two types of inverse filters can be calculated: a “true” inverse filter that compensates for both magnitude and phase 

responses of the headphones or a minimum-phase filter which only aims at correcting the magnitude response  

Select impulse response 
The Headphone filter design tool allows selection of the impulse response section that will be used for 
calculation of the inverse filter. To select a fragment of the impulse response, left-click and drag the 
mouse cursor from the top-left to the bottom-right part of the plot. To reposition the selected area, 
Right-click and drag towards the left or right area. 

Auto detect start of the impulse response 
Optionally, the Headphone filter design tool offers a button that can be used to detect/adjust the onset 
of the impulse response, which is calculated as the point in time where the amplitude of the impulse 
response is -25dB below the peak amplitude. 

Fade in/out impulse response  
Sometimes, when adjusting the start and end of the impulse response, discontinuities can occur. 
These discontinuities can be controlled by applying a fade in/out window. 

 

Appendix D: Headphone filter design 
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Show linear amplitude time graph 
Impulse responses might be difficult to visualize when the amplitude is displayed in linear scale. 
The Headphone filter design tool provides the option to visualize the signal energy in decibels. This 
makes it easier to manually select onset and truncation time, and decide if there is a need to apply 
the fade in/out window. This will not affect the calculation of the inverse filter. 
 

Smoothing type 
Three types of smoothing can be applied to the magnitude of the frequency response, which is used 
to calculate the inverse filters: 

• “None” corresponds to no smoothing. 
• “Local” is a simple moving average between the specified low and high frequencies. 
• “Global” is also a moving average. The average magnitude of the frequency response is 

calculated between the specified low and high frequencies. Then the magnitude response 
is limited in a range specified by the Amplitude range around the average magnitude, and 
the moving average is performed on the resulting curve. This type helps to limit 
compensation of high peaks or dips. 

Regularization 
The inverse filters of the Headphone filter design tool are calculated using regularization. The effect of 
regularization is to limit the effort created by the inverse filter to correct the headphones’ response, 
i.e. at frequencies where the headphones do not respond very well – typically low and very high 
frequencies. The inverse filter would originally need to add a lot of energy to achieve a flat 
response. By increasing regularization, the effort can be limited at the expense of more error. 
 
The mathematical formula used for calculation of the inverse filter is the following: 
 

𝐻𝐻(𝑓𝑓) =  
𝐶𝐶𝐻𝐻(𝑓𝑓)

𝐶𝐶(𝑓𝑓) × 𝐶𝐶𝐻𝐻(𝑓𝑓) + 𝛽𝛽
+ 𝐺𝐺𝐺𝐺𝐺𝐺𝐺𝐺 

Where: 
 𝐻𝐻(𝑓𝑓) is the calculated inverse filter of the headphones. 
 𝐶𝐶(𝑓𝑓) is the frequency response of the headphones. 
 𝐶𝐶𝐻𝐻(𝑓𝑓) is the Hermitian transpose of the frequency response of the headphones. 
 𝛽𝛽(𝑓𝑓) is the regularization parameter. 
 Gain is an optional parameter that can be applied to the inverse filter. 
 
A typical characteristic of the inverse filter calculated using regularization is that it is non-causal, 
i.e. the filter starts responding at negative times. In practice, this behaviour is managed by 
introducing an artificial modelling-delay. The peak is placed at the middle of the buffer used for 
calculation. The consequences of this property are additional delay, and possibly audible artefacts 
that can be controlled with the amount of regularization (Norcross, et al., 2004). However - this 
filter aims at correcting both the magnitude and phase of the headphones. An alternative to this 
filtering process is to derive a minimum-phase filter that contains the same magnitude response as 
the inverse filter calculated using regularisations, but which does not aim at correcting the phase 
response of the headphones. In most cases the latter type of filter should be preferred. 
 
By selecting the type of inverse filter (“Inverse filter” or “Minimum-phase Inv. Filter”/right side), 
most parts of the interface show the evaluation of the performance of the filter by means of a 
convolution between the impulse response and the inverse filter, which in the ideal case will be a 
perfect delta, but due to the adjustments of smoothing and regularisation, it will broaden.  
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To create binaural simulations, a set of HRTF's is needed. The HRTF's are different from subject to 
subject. In principle, and for best accuracy, you can measure your own and import them into 
ODEON using the Tools>Create filtered HRTF menu entry in the ODEON program. Measuring HRTF's 
are, however a complicated and costly task, so using the supplied ones is the simplest option. 
 
If you should be interested in creating your own sets of HRTF’s for ODEON, additional information 
can be found when clicking F1 when inside the ODEON program. Here search for HRTF.  
 
The imported HRTF's to use for auralisation are pre-filtered into octave bands in order to reduce 
calculation time. The octave band filter parameters for the selected filter bank can be seen on the 
filter bank name at the Auralisation Setup menu. The filter parameters are: 

M 
The M value is taken into account if the “Apply enhancement” option is checked. If the file name 
contains the ‘word’ Mddd where ddd is a floating-point number, then localization enhancement was 
applied to the HRTF's (Zang, et al., 1998). This means that frequency dips and notches in the 
individual HRTF's have been exaggerated in order to improve the directional cues in the HRTF's. 
The M-factor determines how much the dips and notches have been exaggerated; If M is 0 then the 
effect is neutral, a value of 3.0 improves localization without too much undesired colouration. An 
M value greater than 3.0 does not seem to give any noticeable advantages whereas a value less than 
3.0 gives less colouration. The enhancement algorithms are further developments of those used in 
earlier versions of ODEON, as a result the M factor can be set as high as 3.0, allowing a significant 
improvement of the 3D experience through headphones without noticeable drawbacks. 

A 

When an A is appended after the M-factor, this tells that Minimize colouration effects (diffuse field approach) 
was not enabled so the HRTFs were optimized for Anechoic conditions (no reflections present). If 
no A is found in this place in the name then ODEON has attempted to minimize colouration effects; 
the enhancements applied may give some colouration effects because some frequencies are 
amplified for individual directions. When this option is checked, ODEON will try to accomplish 
that colouration is kept at a minimum in a multi-reflection environment, that is if the average 
frequency response for all directions in the set of HRTF's is kept neutral. 

Sample rate 
The sample rate of the HRTF. This sample rate should be the same as the sample rate of the signal 
files (anechoic recordings) to be used. The supplied HRTF's are sampled at 44100 Hz. 

Apass 
Ripple of octave band filters in dB. Smaller is better, 0.5 dB is sufficient. 

Astop 
Maximum possible attenuation of octave bands. To allow complete attenuation of all reflections of 
a 16 bit signal (96 dB dynamic range), Astop should be 96 dB, however due to auditory masking we 

Appendix E: Head Related Transfer 
Functions (HRTF’s) and digital 
filtering 
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are not able to hear such differences so 40 dB is probably sufficient. Smaller Astop leads to shorter 
calculation time (of the BRIRs). 
 

Band overlap in percent 
Octave bands implemented using FIR filters are not completely rectangular, it takes some 
frequency span before they attenuate completely. An overlap between the filters of 100 percent 
gives a smooth transition between the filters, which is probably a more realistic representation of 
real world reflections than with shorter overlaps. At the same time, long overlap gives shorter 
calculation time (of the BRIRs). 
 
If you should need to use filters with other filter parameters e.g. Astop being 96 dB you should create 
a filtered set of HRTF's with these parameters, use the File|Create filtered HRTF's option. Then from 
within your room, select the new filter bank from the Auralisation Setup. 
 
The ODEON installation includes some HRTF’s: the Kemar (Gardner, et al., 1994), which has to be 
manually imported from the ODEON folder, and Subject_021Res10deg (Algazi, 2001) which is 
already imported. If you need HRTF’s other than these ones, you should create a text file following 
the same format as used in the files Unity.ascii_hrtf, Kemar.ascii_hrtf and 

Subject_021Res10deg.ascii_hrtf. These files can be found in the \HeadAndPhone\EE\ and 
\HeadAndPhone\EC\ directories. To import a set of HRTF’s, select the Tools|Create filtered HRTF’s option, 
then select the specific HRTF ASCII file e.g. C:\ODEON…\HeadAndPhones\EE\Kemar.ascii_hrtf, finally specify 
miscellaneous parameters when the import dialog appears – for help on these parameters please 
press F1 from within the dialog. You may also desire to import a set of HRTF’s which has already 
been imported in order to specify an alternative filtering approach e.g. to enhance the HRTF’s in 
different ways. 
 

Headphone filters and HRTF pairing  
It is possible to compensate for non-linear frequency response of headphones. When a headphone 
is selected, ODEON will filter the audio output with a minimum phase filter, which has a frequency 
response inverse to that of the headphones. 
 
A number of headphone filters are supplied in ODEON's .hph format. Filters ending on .ee.hph are 
measured on a dummy head at the entrance of a blocked ear canal whereas filters ending on .ec.hph 
are measured at the end of the ear canal (at the ear drum, so to speak). The selected headphone 
filter should match the HRTF’s used; for example the Subject_021Res10deg.hrtf doesn’t have an ear 
canal, therefore an .ee filter should be used, whereas the Kemar.hrtf does have an ear canal, so the .ec 
filters should be used. If the corresponding filter for the headphone used is not available then a 
generic filter matching the set of HRTF's may be used, e.g. Subject_021Res10deg_diffuse.hph. If a diffuse 
field filter (equalization) is selected, the results are filtered in order to obtain an overall flat 
frequency response of the HRTF's; that is, the average frequency response of all the HRTF filters 
are calculated and the auralisation results are filtered with the inverse of that. If using headphones 
which are diffuse field equalized (most headphones attempt to be) and a matching headphone filter 
is not available, then the matching diffuse filter headphone filter can be used. 
 
For your convenience, two directories with matching HRTF’s and headphone filters are installed 
with ODEON - the \HeadsAndPhones\EE\ and \HeadsAndPhones\EC\ directories. The first directory contains 
a set of HRTF’s which were measured on a live subject with blocked ear-canal by the CIPIC 
Interface Laboratory (Algazi, 2001) along with our matching .ee.hph headphone filters. The next 
ones contains the well-known Kemar HRTF’s, which includes ear-canals along with our matching 
.ec.hph filters. One of the directories can be selected in the Options>Program setup>Auralisation setup 
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dialog – once done - matching the HRTF’s and headphone filters can be selected in the same dialog, 
as well as in the Auralisation setup in the individual room. 
If installing new HRTF’s (or installing some of the additional CIPIC data which can be downloaded 
from https://www.ece.ucdavis.edu/cipic/spatial-sound/hrtf-data/), headphone filters are 
acceptable in the .wav format. In that case the filters should contain the impulse response(s) of the 
headphone as measured on a dummy head of the same type as the one selected in the HRTF drop 
down menu (i.e. with or without ear canal or a corresponding ear coupler). The filter may be one 
or two channels; two channels are desirable if compensating a specific headphone, which is 
preferable than compensating for the model (the actual headphone may deviate slightly from the 
model specifications). The measurement of the impulse response of headphones can be done using 
ODEON’s Measurement System (see Chapter 12), and creating the inverse filter to be used will be 
taken care of by ODEON. 
 
  

https://www.ece.ucdavis.edu/cipic/spatial-sound/hrtf-data/
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The ODEON .Par modeling format /language 
Geometry models can be made using the parametric modelling language, which is built-in 
to ODEON. The model data is typed into a text file with the file extension .Par using the 
modelling language described below. You may use the supplied editor ODEONEdit to 

create and edit your text files. The ODEON modelling format is not case-sensitive, so upper and 
lower-case letters can be used as desired. 
 

A simple modelling example 
At its simplest (but not fastest), a floor with the dimensions 4 x 4 metres can be defined as follows 
(using the reserved keywords Pt and Surf in order to define points and surfaces):  
 

FloorSurface.Par 
### 
Pt 1 0 0 0 
Pt 2 4 0 0 
Pt 3 4 4 0 
Pt 4 0 4 0 
Surf 1 floor 
 1 2 3 4 
### 

 
One may choose to model the room point-by-point and surface-by-surface as in the example above. 
However, for many geometries, it will be an advantage to use parameters to describe basic 
dimensions in the rooms and to use high level statements to describe multiple points and surfaces 
in a fast and flexible way. Before starting your first large modelling project it is a very good idea to 
read through Chapter 3 or at least skim it - it will pay off in the end.  
 
Another way to learn about the modelling language is to study the examples, which are installed 
in the \ODEON...\Rooms\Manual samples directory along with the ODEON program – open the room(s) 
in ODEON, then click the Open the ODEON Editor icon on the toolbar in order to study the geometry 
file. 
 

Components in the modelling format 
The basic function of the modelling format is to allow modelling of surfaces in room geometries. 
The surfaces can be modelled point-by-point, surface-by-surface, however it is also possible to 
make use of symmetry and to create repeated features in a room such as columns, using loops. 
Finally, it is possible to use hybrid functions, which create points as well as surfaces in terms of 
shapes such as boxes, cylinder and domes. 

Constants, variables and counters 
Constants and variables can be defined and used in the file format. It is a good habit to use 
constants whenever a value is used more than a few times in a file, this reduces typing errors and 
it also makes it easier to make general changes to geometry such as changing the height of a room. 

Appendix F: Modelling rooms in the 
ODEON Editor 
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Mathematical expressions 
Mathematical expressions can be used to express any real or integer number in the file e.g. 
coordinates, constants, variables, counters, point numbers, surface numbers, etc. If you use a value 
that is not an integer, to describe a point or surface number, then that value will be rounded to the 
nearest integer value. 
 
You may describe coordinates using mathematical expressions like:  
 

Length*Sin(PI/4) 
 
where Length is a user-defined constant or variable. Mathematical expressions may not contain any 
SPACE or TAB (tabulation) characters. To get a complete overview of the mathematical functions 
available, please refer to appendix F. 
 

Points  
A point is made up from a unique point number and its X,Y and Z coordinates. Use the Pt, MPt and 
CountPt statements to define points. Points can also be defined implicitly, using one of the hybrid 
statements. 
 

Surfaces 
A surface is made up from a unique number, an optional descriptive text and a number of points 
connected to one another. All the points must be coplanar; otherwise the surface cannot be 
constructed. To define surfaces use the Surf, MSurf, CountSurf, ElevSurf, ElevSurf2 and RevSurf 
statements. Surfaces may also be defined implicitly using the hybrid statements.  
 

Hybrid statements 
Hybrid statements are: Box, Cylinder, Cylinder2, Cone, Dome, Dome2 and ElevSurf. The hybrid statements 
create the points and surfaces needed to model the specified shape. The points and surfaces created 
must always have unique numbers.  
 

Coordinate manipulation functions 
A set of functions for coordinate manipulation (and surfaces made up from coordinates) is 
included. This includes rotation around the various axes, scaling and translation. These functions 
are needed in order to insert shapes defined by the hybrid statements in the geometry with the 
correct position and orientation. 
 

Comments and empty lines 
Lines containing comments, and empty lines, may be inserted anywhere in the file, as long as they 
do not come between data items, which should occur on one line. Comment lines must begin with 
a colon (:), a semicolon (;), a slash (/) or an asterisk (*). The semicolon can also terminate a non-
comment line, allowing the non-comment line to be followed by a comment. 
 
A series comment lines are started with a ‘{‘ and terminated by a ‘}’ at any position on a line. This 
is useful to disable a section of lines. 
Syntax highlighting in the ODEON editor makes it easy to spot comment lines. 
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Reserved keywords, predefined counters and constants 
The following keywords are reserved by ODEON and have a special meaning in the parametric 
modelling language: 
 
Line folding markers 
BeginBlock, EndBlock 
 
Constant and variable statements 
Const, Var 
 
Point statements 
Pt, MPt, CountPt 
 
Point list statements 
Plist0 – Plist9 
ResetPList0 – ResetPList9 
PlistA, PListB  
 
Surface statements 
Surf, MSurf, RevSurf, CountSurf, ElevSurf, ElevSurf2 
 
Hybrid statements 
Box, Cylinder, Cylinder2, Cone, Dome, Dome2 
 
Loop statements 
For…End,  
 
Transformation statements 
Mreset, MPop, MScale, MTranslate, MRotateX, MRotateY, MRotateZ  
(and for compatibility with earlier releases of ODEON: Scale, UCS) 
 
Predefined constants 
PI = 3,14159265358979312 
 
Predefined variables 
NumbOffSet, ONVert 
 
Predefined Counters 
PtCounter 
 
Coordinate system definition statements 
Unit, CoordSys  
 
Debugging Facilities 
DebugIsOn, Debug     
 

Line folding markers 
Line folding is a feature of the ODEON editor where a section of lines (e.g. a part of the geometry) 
can be collapsed (folded) into one line in the editor for a better overview. This is the only 
functionality of the two keywords BlockBegin..BlockEnd, they are ignored by ODEON when a .par 
file is loaded. The keywords are automatically generated when a room is generated by 
ODEONExtrusionModeller or when a room is imported in the .dxf format. 
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BeginBlock <optional comment> 

NumbOffSet 100 
Pt 1 0 -1 0 
Pt 2 0 1 0 
Pt 3 1 1 0 
Pt 4 1 -1 0 
 
Surf 1 A surface 
 1 2 3 

EndBlock <optional comment> 
 
 

Any code between a corresponding set of BlockBegin and BlockEnd lines can be collapsed by 
clicking a small + in the left side of the editor, making it easier to handle large files, in particular 
with many layers. All blocks can be collapsed from the view menu in the ODEONEditor. And 
Blocks can be nested, that is, have Blocks contained within Blocks. 
 
 

Defining constants 
Constants must follow the syntax:  

 
Const <Name> <Value> 

 
where <Value> is a mathematical expression, which may be based on numbers or constants and 
variables that have already been defined. 
 
Example 1: 
 

Const CeilingHeight 3.4 
   
Example 2: 
 

Const  FloorLevel 1 
Const  CeilingHeight  FloorLevel+3 

 
Example 3: 
 

Const FloorLevel 1 
Const Length  6 
Const CeilingHeight FloorLevel+Length*TanD(30) 

 
 

Defining and reassigning variables 
The definition of variables must follow the syntax:  

 
Var <Name> <OptionalValue> 

 
Example 1; defining the variable FloorLevel: 
 

Var FloorLevel  
 
 
Example 2; defining the variable FloorLevel and assigning the initial value 0: 
 

Var FloorLevel 0 
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Example 3; reassigning a variable /adding 1 metre to the FloorLevel: 

 
FloorLevel  FloorLevel+1 

 
Remark: The predefined variable NumbOffSet may be used like any other variable, but has a special 
meaning because it offsets point and surface numbering. This variable is useful if copying a part of 
a geometry from another geometry file, it is also useful in connection with the for..end statements. 
Auto can also be assigned to NumbOffSet, in doing so ODEON will automatically increment the value 
of NumbOffSet to be greater than any point and surface number previously defined. This has the 
advantage that repeated point and surface numbers can easily be avoided without having to keep 
track on the numbers used - the drawback is that slight changes in the geometry file may change 
numbers on many subsequent surfaces, ruining the relationship between surface numbers and the 
material assigned to that surface inside the ODEON program. The Auto option is very useful in 
combination with loop constructions (see description of the for..end constructs later on). Typing 
PtAbsRef after the value assigned to NumbOffSet forces absolute number references for points while 
using the specified offset on the numbers of surfaces – this is explained later. 
 
Example on the use of NumbOffSet; creating surface 101 containing the points 101 to 104 and surface 
201 containing the points 201 to 204: 
 

NumbOffSet.Par 
### 
NumbOffSet 100 
Pt 1 0 -1 0 
Pt 2 0 1 0 
Pt 3 1 1 0 
Pt 4 1 -1 0 
 
Surf 1 A surface 
 1 2 3 4 
 
NumbOffSet NumbOffSet+100 
Pt 1 0 -1 1 
Pt 2 0 1 1 
Pt 3 1 1 1 
Pt 4 1 -1 1 
Surf 1 Another surface 

1 2 3 4 
### 
 

Example creating points 1–4 and surface 1, setting NumbOffSet to Auto, then creating Point 5-8 and 
surface 5:  

### 
Pt 1 0 -1 0 
Pt 2 0 1 0 
Pt 3 1 1 0 
Pt 4 1 -1 0 
 
Surf 1 A surface 
 1 2 3 4 
 
NumbOffSet Auto 
Pt 1 0 -1 1 
Pt 2 0 1 1 
Pt 3 1 1 1 
Pt 4 1 -1 1 
Surf 1 Another surface 

1 2 3 4 
### 
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Defining a point using the Pt statement 
Use the Pt statement to define a single point. The syntax must be as follows: 

 
Pt <Point Number> <XMathExpression> <YMathExpression> <ZMathExpression> 

 
Example defining point number 100 in (x,y,z) = (1,1,1): 
 

Pt 100 1 1 1 
 
Hint: Point number and coordinates can be written using mathematical expressions, allowing 
greater flexibility and reusability. 
 
 

Parametric modelling – defining multiple points 
Use the MPt statement to define a series of points, which is typically used in connection with the 
ElevSurf or ElevSurf2 Statement. The syntax must be as follows: 
 

MPt <Number> <NumberOfPoints> 
<XMathExpression1> <YMathExpression1> <ZMathExpression1> 
<XMathExpression2> <YMathExpression2> <ZMathExpression2> 
....NumberOfPoints lines each defining a point in the multi point sequence, should follow the MPt statement. 

  
 
<Number> 

A unique number from 1 to 2.147.483.647 for identification of the first point in that multi point 
sequence. 
 

<NumberOfPoints> 
The number of points defined by this multipoint statement - if the number is 3, then 3 lines should 
follow, each describing the coordinates of a point. 
 
Example 1; defining point number 100 in (x,y,z) = (1,1,1) and point number 101 in (x,y,z) = (2,2,2) 
 

MPt  100 2 
  1.0  1.0  1.0 
  2.0  2.0  2.0 

  
As a special option for multi points, it is possible to repeat a coordinate used in the previous point 
of that multipoint sequence or to repeat the coordinate while adding or subtracting a value from 
that point: 
 
Example 2; defining point number 100 in (x,y,z) = (1,1,1) and point number 101 in (x,y,z) = (1,2,0) 
 

MPt  100 2 
  1  1  1 
  =  =+1  =-1 
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Defining a series of points using the CountPt statement 
The CountPt statement must follow the syntax: 

 
CountPt<FirstPointNo><MaxCount><XMathExpression><YMathExpression><ZMathExpression> 

 
Use the CountPt statement to define a series of points using a counter. This statement makes use of 
the predefined counter PtCounter, which will run from 0 to MaxCount-1, producing the points with 
the numbers FirstPointNo to FirstPointNo+MaxCount-1. Use the PtCounter in the expression of the x,y 
and z coordinates to create the desired differences between the ‘count points’. 
 
Example; defining 7 points on a circle with a radius of 10 at Z=0 metres: 
 

CountPt 100 6+1 10*CosD((PtCounter)*360/6) 10*SinD((PtCounter)*360/6)
 0 

 
Note! First and last point in this series of ‘count points’ are equal (redundant). This will typically 
be desirable when using the CountPt statement along with RevSurf statement. 
 
 

Defining a single surface using the Surf statement 
A Surf statement is divided into two lines and must follow the syntax: 

 
Surf <SurfaceNumber> <Optional Description> 
 <ListOfPointNumbers> 

 
The Surf statement is used to define a single surface (in some situations with symmetry, two 
surfaces). The Surf statement is constructed from two lines, one identifying the surface by a number 
and an optional name and another with a list of corner numbers. 
 

<SurfaceNumber> 
A unique number from 1 to 2,147,483,647 for identification of the surface. Using the same number, 
but with negative sign defines the surface and its counterpart mirrored in the XZ-plane (Y = 0). The 
surface number may be defined using mathematical expressions. 
 

<Optional Description> 
A string displayed and printed for easy identification of the surface, i.e.: ‘Main floor'. 
 

<ListOfPointNumbers> 
Each surface may be bounded by between 3 and 500 corners, which all lie in a plane. Corner 
numbers refer to the corners, which must have been defined (e.g. using the Pt or CountPt statements) 
before using the surface statement. The order of listing must be as obtained by travelling around 
the surface's perimeter (in either direction). The list of corner point numbers must be on the same 
line. A room may contain up to 10000 surfaces. 
 
Example 1, surface made from point 1, 2, 3, 4: 

 
Surf 100 floor 

1 2 3 4 
 
Example 2, surface made from point 1,2,10,11,12,13,14,4,5: 

Surf 200 Ceiling 
 1 2 10>14 4 5 

If there is a need to programmatically build a list of points, this can be done using the PList and 
ResetPList statements. 
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Building lists of points using PList and ResetPList 
The PList and ResetPList statements are used in special cases together with the Surf statement. Twelve 
lists are predefined namely PList0 to PList9 (and PlistA and PListB which are handled automatically 
by ODEON when modelling a box and other solids). The PList statements allow to 
programmatically construct a list of points e.g. a list like: 
 

100 110 120 130 140 150 160 170 180 190 200 
 
this can be done using a for..end construct in the following way (adding a point number at a time): 
 

for MyCounter 0 10 
PList0 100+MyCounter*10 

end 
 
It is also possible to add a number of points to a point list, e.g. another PList to a PList. In the 
following example PList1 is assigned the points 100 110 120 130 140 150 160 170 180 190 200 10 11 
12 13 15): 
  

Plist1 Plist0 10>13 15 
 
A point list can be referenced in the following way (adding point 1 before and 2 after the list in this 
example): 
 

Surf Test_surface 
 1 PList0 2 

 
To reset the list use the statement (list 0 used in this example): 

ResetPList0 
 
 

Multi Surface - MSurf 
The multi surface MSurf is essentially just a variant of the Surf statement. Instead of typing one 
header line (e.g. Surf 1 A surface name) for each surface, the header can be shared by multiple surfaces. 
 

MSurf <SurfaceNumber> <NumberOfSurfaces> <Optional Description> 
<ListOfPointNumbers1> 
<ListOfPointNumbers2> 
<ListOfPointNumbers3> 
<NumberOfSurfaces> lines with lists of points describing each surface. 

  
<SurfaceNumber> 

A unique number from 1 to 2,147,483,647 for identification of the surface. Using the same number, 
but with a negative sign defines the surface and its counterpart mirrored in the XZ-plane (Y = 0). 
The surface number may be defined using mathematical expressions. 
 

<NumberOfSurfaces> 
The number of surfaces in the MSurf.  
 

<Optional Description> 
A string displayed and printed for easy identification of the surfaces. Could be something like 
Main floor. 
 
Example on multi surface, containing 5 sub-surfaces: 

MSurf 1 5 Steps on a stair 
5544>5534 5112>5122 
5111>5101 5212>5222 
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5211>5201 5312>5322 
5311>5301 5412>5422 
5411>5401 5512>5522  

 
 

Elevation surface  
Use the ElevSurf statement to define a series of vertical surfaces from a series of 
perimeter points plus an elevation height. The perimeter points are typically 
defined using the MPt statement. The syntax of ElevSurf is: 
 

 
 
 
 
 
 
 
 
ElevSurf <FirstSurfaceNumber> <FirstPointNumber> <SectionsInElevSurf> <Height> <Optional name> 

  
Example on use of the MPt and ElevSurf statements: 
First the perimeter points (point 1 to 23) at the floor level of an office environment are described 
using the MPt statement. Then the elevation surface is created from these points, creating the 
perimeter walls of the office with a constant height of 2.7 metres. Finally, the floor and ceiling are 
created using the Surf statement. 
 

 

1 

2 3 
4 5 

6 7 

8 9 
10 11 

12 
13 

14 
15 16 

17 
18 19 

20 21 
22 

0.00 10.00 20.00 30.00 40.00 metres 

 
Perimeter points at the floor level 

 

Example file: MPt and ElevSurf.Par  
Demonstrates the use of MPt (multi point), Surf (Surface) and ElevSurf (Elevation surface) statements. 
In this example the X-coordinates are expressed in absolute values whereas the Y-coordinates in 
most cases are increased or decreased using the =+ or =- operators, respectively. 
 
To create a closed ElevSurf (that is, the first wall joins the last wall), the first and last point in the 
series of points handled to the ElevSurf must be identical - in this example, point 1 and point 23 are 
identical. If an elevation surface has 22 surfaces, then 23 points must be made available to the 
ElevSurf as in this example. 

### 
MPt 1 23 
0 0 0 
= 7.48 = 
2.3 = = 
= =-2.38 = 
8.35 = = 
= =-1.26 = 
10.76 = =  
= =+4.64 = 
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64.78 = =  
= =-2.68 = 
51.52 = =  
49.62 =-2.02 = 
48.22 =+1.1 = 
45.3 =-2.68 = 
43.85 =+1.45 = 
42.40 = =  
40.98 =-1.45 = 
= 0 =  
34.5 = = 
= =2.1 = 
30.13 = = 
= =-2.13 = 
0 0 0 
 
ElevSurf 1 1 22 2.7 walls 
 
Surf 200 Floor 
1>22 
 
Surf 201 Ceiling 
24>24+22-1 
###  

 
 

Elevation surface 2 
Use the ElevSurf2 statement to define a series of vertical surfaces from a series of perimeter points 
plus an elevation height. The perimeter points are typically defined using the MPt statement. The 
syntax of ElevSurf2 is: 
 

ElevSurf2 <FirstSurfaceNumber> <FirstPointNumber> <SectionsInElevSurf> <Height> <T/B/N> <Optional 
name> 
 

The ElevSurf2 only differs from ElevSurf in that a top and bottom surface may be specified (the 
T/B/N option). 
 

<FirstSurfaceNumber> 
 

A unique number from 1 to 2,147,483,647 for identification of the first surface in the ElevSurf2 
surface. Using the same number, but with negative sign, defines the surfaces and their counter 
parts mirrored in the XZ-plane (Y = 0).  
 

<FirstPointNumber> 
First point number in the floor perimeter. The floor points are typically MPt statement. See example 
below. 
 

<SectionsInElevSurf> 
 

The number of surfaces to be created by the ElevSurf2 statement. If creating a cylinder, a number 
between 16 and 24 is suggested (if it’s a column, use only six to eight surfaces). 
 

<Height> 
Height is oriented in the Z-direction. 
 
 
 
 

<T/B/N> 
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The T/B/N parameter specifies whether the ElevSurf2 should have a top and /or a bottom. The 
options are T, B, TB and N (for none). Top or bottom may only be included if all of the points in the 
floor in the elevation surface are in the same plane. 
 

Example on use of the MPt and ElevSurf2 statements.  
First the perimeter points (points 1 to 23) at the floor level of an office environment is described 
using the MPt statement. Then the elevation surface is created from these points, creating the 
perimeter walls of the office with a constant height of 2.7 metres.  
 
In this example the X-coordinates are made in absolute values whereas the Y-coordinates in most 
cases are increased or decreased using the =+ or =- operators, respectively. 
 
To create a closed ElevSurf2 (that is, the first wall joins the last wall), the first and last point in the 
series of points handled to the ElevSurf2 must be identical - in this example, point 1 and point 23 
are identical. 
 
If an elevation surface has 22 surfaces then 23 points must be made available to the ElevSurf2 as in 
this example. 
 

### 
MPt 1 23 
0 0 0 
= 7.48 = 
2.3 = = 
= =-2.38 = 
8.35 = = 
= =-1.26 = 
10.76 = =  
= =+4.64 = 
64.78 = =  
= =-2.68 = 
51.52 = =  
49.62 =-2.02 = 
48.22 =+1.1 = 
45.3 =-2.68 = 
43.85 =+1.45 = 
42.40 = =  
40.98 =-1.45 = 
= 0 =  
34.5 = = 
= =2.1 = 
30.13 = = 
= =-2.13 = 
0 0 0 
 
ElevSurf2 1 1 22 2.7 TB walls 
### 

 
 

Defining a number of surfaces using the CountSurf statement 
The CountSurf is mostly available for backwards compatibility. In most cases it will be easier to use 
the Surf statement along with a for….end loop. 
A Counter surface is divided on two lines and must follow the syntax: 

CountSurf <First Surface Number> <NumberOfSurfaces> <Optional name> 
<ListOfPointNumbers>  

 
 

<FirstSurfaceNumber> 
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A unique number from 1 to 2,147,483,647 for identification of the surface. Using the same number, 
but with negative sign defines the surface and its counterpart mirrored in the XZ-plane (Y = 0). A 
CountSurf will take up several surface numbers, which must all be unique. 
 

<NumberOfSurfaces> 
The number of surfaces to be created by the CountSurf call. 
 

<Optional name> 
Optional user defined name for easy identification of the surface, e.g. ‘Beam'. 
 

<ListOfPointNumbers>  
Each surface may be bounded by between 3 and 50 corners, which all lie in a plane. Point numbers 
refer to the corners, which must have been defined (e.g. using the Pt or CountPt statement) before 
using the surface statement. The order of listing must be as obtained by travelling around the 
surface's parameter (in either direction). The list of corners must be on the same line of code. A 
room may contain up to 10000 surfaces. 
 

Example: 
 

CountSurf 1000 5 Beam in ceiling 
  1000 1100 1200 1300  

 
will produce five surfaces, the first one containing the numbers given in the ListOfPointNumbers, and 
the next surface with 1 added to all the corners in the list, etc. Of course, all the points referred to 
need to be defined, typically this is done using a CountPt definition for each of the corners referred 
to in the corner list of the CountSurf statement. In the above example the points 1000-1004, 1100-
1104, 1200-1204 and 1300-1304 need to be defined. 
 
Sample room files: 
Beams.Par 
BeamBox.Par 
BeamBoxWithWindows.Par 
 
 

Revolution surface RevSurf 
RevSurf must follow the syntax:  
 

RevSurf <FirstSurfaceNumber> <CurveStart1> <CurveStart2> <SectionsInRevSurf> <Optional name> 
 
The RevSurf command is typical used together with two CountPt statements to create a revolution 
surface using two ‘curves' of points. The curves must contain the same number of points. The 
RevSurf command will always create a number of surfaces each build from four points. 
 

<FirstSurfaceNumber> 
A unique number from 1 to 2,147,483,647 for identification of first surface in the revolution surface. 
Using the same number, but with negative sign, defines the surface and its counterpart mirrored 
in the XZ-plane (Y = 0). 
 

<CurveStart1> 
First point number in the first revolution curve. The ‘curve of points' is typically created using the 
CountPt statement and the curve must contain one more point than number of sections in the RevSurf. 

<CurveStart2> 
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First point number in the second revolution curve. The curve of points is typically created using 
the CountPt statement and the curve must contain one more point than the number of sections in 
the RevSurf. The second curve must always contain the same number of points as the first curve. 
 

<SectionsInRevSurf> 
The number of surfaces to be created by the RevSurf statement. If creating a cylinder, a number 
between 12 and 24 is suggested. Although it is easy to create many surfaces in a revolution surface, 
too many small surfaces should be avoided. If the FirstSurfaceNumber is 100 and SectionsInRevSurf is 
3, surfaces 100, 101 and 102 will be created. 
 

<Optional name> 
Optional user defined name for easy identification of the surface, e.g. ‘cylindric wall'. 
 
Example: 
 

RevSurf  1000 100 200 6 Cylinder 
 
creates a revolution surface divided in 6 surfaces (surface 1000 - 1005). This call requires two curves 
of each 6+1 points to be defined, namely point 100 to 106 and point 200 to 206. If the two curves of 
points define corners in the lower and upper edge of a cylinder, a cylinder of 6 sections is created 
(see example room: RevSurfCylinder.Par) 
 

 

Loop surface <LSurf> 

 
LSurf must follow the syntax: 

LSurf <FirstSurfaceNumber><NumberOfLoops><Optional name> 

    <ListOfPointNumbers1> 

    <ListOfPointNumbers2> 

    <ListOfPointNumbers3> 

    <NumberOfSurfaces> lines with lists of points describing each loop - the first line preferably being the 

outer loop 
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The LSurf command is typical used for creating walls with window holes in them. In the special 
case where NLoops is equal to 1 the surface is identical to that created using the Surf command. 
 

<FirstSurfaceNumber> 
A unique number from 1 to 2,147,483,647 for identification of the first surface in the LSurf surface. 
Using the same number, but with negative sign, defines the surface and its mirrored counterpart 
in the XZ-pane (Y = 0). 
 

<NumberOfLoops> 
A least 1 for the outer perimeter of the surface. If e.g 3 then there is to addiotional loops 
describing 2 holes (e.g. windows in the surface). In order to close the holes in the surfaces 
additional surfaces has to be added e.g.using the Surf command. 
 

<Optional name> 
Optional user defined name for easy identification of the surface, e.g. ‘cylindrical wall’. 
 
Example 
 
Pt    1    0    0    0 

Pt    2    5    0    0 

Pt    3    5    0    3 

Pt    4    0    0    3 

Pt    5    2    0    1 

Pt    6    3    0    1 

Pt    7    3    0    2 

Pt    8    2    0    2 
 
LSurf    1   2    Wall with a window hole 

    1    2    3    4 

    5    6    7    8    
 
... creates an LSurf with the outer perimeter defined by points 1-4, and a hole defined by points 5-
8. 
 
 
 

Loops using the FOR....END construct 
 
The For statement must follow the syntax: 

 
For <CounterName> <CountFrom> <CountTo> 

 
 

<CounterName> 
Name of counter to be used by the For statement. The counter is automatically defined by the For 
statement and becomes undefined when the loop finishes. The counter can be referenced within 
the for..end loop as an ordinary constant or variable if desired so. 
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<CountFrom> 
First value the counter takes. The CountFrom value is considered an integer value. If the number 
entered here is not an integer, it will be rounded to the nearest integer value.  
 

<CountTo> 
Last value the counter takes. The CountTo value must be greater or equal to the CountFrom value. 
The For statement will take CountTo-CountFrom+1 loops. The CountTo value is considered an integer 
value, if the number entered here is not an integer, it will be rounded to the nearest integer value.  
 
 
The following example will produce the points 1 to 5 with the X-coordinates 5, 10, 15, 20 and 25 
metres, while the counter (MyCounter) loops through the values 1 to 5: 

 
For MyCounter 1 5 
 Pt MyCounter MyCounter*5 0 0 
end 

 
When using For..End constructs, it should be remembered that point and surface numbers must be 
unique. This is easily obtained by incrementing the special variable NumbOffSet appropriately in 
each loop. An example on this kind of numbering can be found in the sample file 
BoxColumnRoom.Par where NumbOffSet is incremented by eight in each loop (each time a new 
column, which contains 4 surfaces and 8 points, is created).  
 
Sample room files: 

ForRotunde.Par 
BoxColumnRoom.Par 

 
 

Unit 
The Unit statement is used if you wish to model in a unit different from metres. The unit used in 
the parametric file is by default assumed to be metres, however if you prefer to model in another 
unit, this is possible using the Unit statement.  
 
Example, modelling in Inches: 

Unit  Inches 
 
You may choose your unit among the following predefined: 

Metres, Centimetres, Millimetres, Inches, Feet and Yards 
 
Or if you need a different unit, simply type the scaling factor from your unit into metres, e.g. 

Unit Inches  
 
corresponds to: 

Unit   0.0254 
 
The Unit statement may be used more than once in the same .par file: 
 

### 
Unit Inches 
;e.g. imported model data in inches 
.....model data....... 
.....model data....... 
Unit 0.57634 
; model data measured on a paper drawing which appeared in an odd unit 
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.....model data....... 

.....model data....... 
Unit Metres 
; model data appended in the ODEON editor / modelling environment 
;it is most practical to use metres as the unit when modelling in the ODEON  
;environment - then coordinate values will be the same in the Editor as inside the 3DView in ODEON 
.....model data....... 
.....model data....... 
### 
 

 
 
 
 
 

CoordSys statement 
The CoordSys statement is used if you wish to redefine the orientation or the coordinate system in 
which the geometry was modelled. The statement is typically used if the geometry was ‘by 
accident’ modelled in an orientation different from the one assumed by ODEON or if it was 
imported from a CAD drawing where the orientation may also be different. To obtain the easiest 
operation inside ODEON the following orientation should be used (using a concert hall as the 
example): 
 

• X-axis pointing towards the audience 
• Y-axis pointing to the right as seen from the 

audience 
• Z-axis pointing upwards  

 
The syntax is: 

CoordSys <X> <Y> <Z> 
 

where X, Y, Z indicate which axis should be used as the x, y and z axis inside 
ODEON. X, Y and Z may also have a sign to indicate that the axis should point in the opposite 
direction. 
 
Example 1, the default orientation (which is assumed by ODEON if the CoordSys statement is not 
used in the geometry file): 
 

CoordSys X Y Z 
 

Example 2, changing the direction of the X-axis: 
 

CoordSys -X Y Z 
 

Example 3, Swapping the X and the Z-axis 
 

CoordSys Z Y X 
 

Example 4, The CoordSys statement may be used more than once in the same .par file: 
 

### 
CoordSys -X Y Z 
;e.g. if the X axis was inverted in imported model data 
.....model data....... 
.....model data....... 
;resetting the coordinate system to the default 
CoordSys X Y Z 
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; model data appended in the ODEON editor / modelling environment 
;it is most practical if using the default Coordinate system when modelling in the ODEON ;environment - 
then coordinate system will have the same orientation in the ODEON editor as well as in the 3DView inside 
ODEON. 
.....model data....... 
.....model data....... 
### 

 
 
 
 
 

User coordinate system 
The UCS command is mostly there for compatibility with previous versions of ODEON – the 
coordinate manipulation functions MTranslate, MRotateX, MRotateY, MRotateZ, MScale, MPop and MReset 
included from version 4.21 allow far more flexibility. For your own convenience, it is not advisable 
to mix the UCS method with the M-family method. 
The UCS command must follow the syntax: 

 
UCS <TranslateX><TranslateY><TranslateZ><RotateZ> 

 
The UCS command is used to create a User Coordinate System, with its own X, Y and Z translation. 
It also allows a rotation around the Z-axis (specified in degrees). All point definitions made after a 
UCS call will be created in the specified coordinate system. The default coordinate system is defined 
as: 
 

UCS 1 1 1 0 
 
The UCS command corresponds to:  
 

MReset 
MTranslate  <TranslateX><TranslateY><TranslateZ> 
MRotateZ  <RotateZ> 

 
If the UCS command doesn’t fulfill your needs for coordinate manipulation, you may use the matrix 
manipulation family MTranslate, MRotateX, MRotateY, MRotateZ, MScale, MPop and MReset.  
 
 

Scale 
The Scale command is mostly there for compatibility with previous versions of ODEON – the 
coordinate manipulation functions MTranslate, MRotateX, MRotateY, MRotateZ, MScale, MPop and MReset 
included from version 4.21 allow far more flexibility. For your own convenience, it is not advisable 
to mix the Scale method with the M-family method. 
  
The Scale command must follow the syntax: 
 

Scale <ScaleX><ScaleY><ScaleZ> 
 
The scale command will multiply/scale all the points generated after the scale call, using the 
specified x, y and z-scale. The default setting is: 
 

Scale  1 1 1  
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The Scale command evokes scaling of coordinates after all other coordinate manipulation is carried 
out. If you require more advanced scaling options, you may use the MScale option. 
 
 

Coordinate manipulations – the M-family 
Advanced coordinate manipulation can be carried out using matrix manipulation. The coordinate 
manipulation functions, which is essential to the use of hybrid statements (Box, Cylinder, etc.) is 
implemented as the following functions: 
 

MTranslate <TranslateX><TranslateY><TranslateZ> 
MRotateX <Rotation angle> 
MRotateY <Rotation angle> 
MRotateZ <Rotation angle> 
MScale <ScaleX><ScaleY><ScaleZ> 
MPop 
MReset 

 
The manipulations carried out by the M-family are cumulative. This means that you can specify 
more than one operation to be carried out, e.g. first rotate 90° around the Z-axis, 
then rotate 90° around the Y-axis and finally translate 10 metres 
upwards. The following example shows these operations carried out 
on a cylinder shell (the Cylinder statement is described later): 

 
Manipulating a cylinder.Par 
###  
MRotateZ  90 
MRotateY 90 
MTranslate  0 0 10 
Cylinder 1  20 5  180 10  TB Cylindrical ceiling 
### 

 
The transformation commands to be carried out must always be stated before the points/geometry 
on which they should work is created. To reset all previous coordinate manipulations, use the 
MReset command. To reset/cancel the most recent manipulation (MTranslate in the example above), 
use the MPop command (which will pop the operation of the matrix stack).  
 

Hints! 
The order in which the coordinate manipulations are carried out is important: usually (but not 
necessarily always), the MScale commands should come first, then the MRotate commands and 
finally the MTranslate commands. 
If you are not familiar with coordinate manipulations, it may be a good exercise to try different 
manipulations on the sample geometry above and load the geometry into ODEON upon each 
change.  
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Using layers in ODEON  
The Layer statement allows dividing 
geometry into separate parts, which 
can be displayed separately and in its 
own layer-colour in the 3DView, 
3DOpenGL and Materials list. This 
makes it easier to model and investigate 
selected groups of surfaces. When 
importing geometry from a .dxf file 
(e.g. from AutoCAD where layers are 
an integrated part) the layers included 
in that file will be preserved in the 
imported version of the room.  
 
If layers have been used in geometry, the layer can be activated or deactivated in the 3DView, 
3DOpenGL and Materials list. The layers menu is activated from these windows using the Ctrl+L 
shortcut. 
 
 

Vocabulary – what’s a layer? 
Layers are commonly used in CAD modelling programs such as AutoCAD in order to make 
complicated geometries more easily manageable. Layers in CAD programs (and some drawing and 
picture editing programs) can be compared to overhead sheets (without any thickness). You define 
a number of layers with different names (and possibly different line colour/thickness etc.) and draw 
the different parts of your geometry on the different layers. The layers can be turned on or off in 
the CAD program allowing better overview by hiding parts of the geometry that are not relevant 
in a part of the 'drawing' process. 
 
Syntax for the Layer statement:  

 
Layer <"Layer name in quotes"> <R-intensity><G-intensity><B-intensity>  

 
or as another option: 
 

Layer <"Layer name in quotes"> <LayerColour>  
 

<"Layer name in quotes">  
A name which must start and end with a quote sign (").  
 

<R-intensity><G-intensity><B-intensity> 
Three floating-point values between 0 and 1, which together is describing the colour of the layer as 
a Red-Green-Blue intensity. If using the Layer command Shift+Ctrl+L from within the ODEON 
editor, the colour intensities are set by clicking the desired colour in a dialog-box. Do note that it’s 
not advisable to choose a greyish colour as it may not be easily visible in ODEON. 
 

<LayerColour> 
As another option the colour of the layer can be described, using one of the predefined colours 
Black, Blue, Cream, Fuchsia, Gray, Green, Lime, Maroon, Navy, Olive, Purple, SkyBlue, Teal, MoneyGreen or White. 
The LayerColours.par example demonstrates the different colours. 
 
The LayerStatement.par example shows how to create a geometry on three different layers.  
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Selected surfaces can be selected for display in the 3DView, 3DOpenGL and the Materials list. 
  

LayerStatementRoom.Par  
### 
const L 40 
const W 30 
const H 3 
const NumColX 4 
const NumColY 3 
const ColumnW 0.3 
 
MTranslate l/2 0 0 
Layer "Walls" 1.000 0.502 0.000  ;orange colour 
 Box 1 l w h tb walls in the room 
 MPop 
 :modelling the columns 
 
for ColYCnt 1 NumColY 
 for ColXCnt 1 NumColX 
 MReset 
 MTranslate ColXCnt*L/(NumColX+1) w/2-ColYCnt*W/(NumColY+1) 0  
 
 NumbOffSet Auto 
 Layer "Columns" 0.502 0.502 0.000 
 Box 1 ColumnW ColumnW h n columns in the room ;olive colour 
 NumbOffSet Auto 
 MTranslate 0 0 1.2 
 Layer "Table plates" 0.000 0.502 1.000 ;bluish colour 
 Box 1 3 3 0.1 tb tables 
 end 
end 
###  

 
 

Symmetric modelling 
Symmetric rooms can be modelled, taking advantage of the ODEON convention for symmetric 
models. This allows generation of symmetric or semi-symmetric rooms with symmetry around the 
XZ-plane, (Y = 0) – symmetric modelling is always carried out in the main coordinate system, it 
does not take into account manipulations carried out using UCS and MTranslate. Modelling a surface 
as symmetric around the main axis' (e.g. a reflector above the stage) can be done using symmetric 
points. Modelling left and right walls at the same time can be done using a symmetric double 
surface.  
 

Symmetric points 
Surfaces symmetric around the XZ-plane, Y= 0 can be made using symmetric points. If defining the 
point: 
 

Pt 2  1.0 1.0 1.0 
 
in the geometry file, using the point -2 in a surface definition of the geometry file will refer to the 
auto generated point: 
 

Pt -2  1.0 -1.0 1.0 
 
Thus the following surface definition: 
 

Surf 1000 Symmetric surface 
 1 2 -2 -1 
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will model a surface symmetric around the XZ-plane, Y=0 (e.g. an end wall or a reflector). 
 
If the surface is completely symmetric as above, then the symmetric points can also be specified 
using the Mirror word, which should be the last component in the corner list: 
 

Surf 1000 Symmetric surface 
 1 2 Mirror 

      
Note: You should not try to define the point -2 in the geometry file, as it is automatically generated. 
 

Symmetric double surface 
Symmetric double surfaces are pairs of surfaces symmetric around the XZ-plane, Y= 0 (e.g. a right 
and a left wall): 
 

Surf -2 Right wall/ Left wall 
 12 22 23 13 

 
 
will appear as two surfaces inside the ODEON program. Thus, you will have the following two 
surfaces (inside the ODEON program): 
 

-2  Right/ Left wall  
 
containing the symmetric points: 
 

-12 -22 -23 -13 
 
and the surface: 
 

2  Right/ Left wall  
 
containing the points: 
 

12 22 23 13 
 
as they are defined in the geometry file. 
 
Note: You may not define surface 2 if you are using the symmetric double surface -2, because 
ODEON automatically generates surface number 2.  
 
 



244 
 

 

The Box statement 
The Box statement defines a Box with or without top and 
bottom. The Box statement may typically be used for Box-
shaped rooms and columns. A special case of the Box 
statement is when one of the dimensions Length, Width or Height 
is zero; in this case only one surface is created. 
 
The syntax of the Box statement is: 
 

Box <Number> <Length> <Width> <Height> <T/B/N> <optional name> 
 

 
 
<Number> 

A unique number from 1 to 2,147,483,647 for identification of the first point and surface in the Box. 
Using the same number, but with negative sign defines the box and its counterpart mirrored in the 
XZ-plane (Y = 0). A Box will take up several point- and surface numbers, which must all be unique. 
 

<Length> 
Length is oriented in the X-direction on the Figure. 
 

<Width> 
Width is oriented in the Y-direction on the Figure. 
 

<Height> 
Height is oriented in the Z-direction on the Figure. 
 
 
 
 

<T/B/N> 
The T/B/N parameter specifies whether the Box should have a top and /or a bottom. The options are 
T, B, TB and N (for none). 
 

Insertion point: 
The insertion point of the Box is always the centre of the floor (bottom) surface. 
 

Connection points: 
The four foot-points in Box are stored in PListA 
The four top-points in Box are stored in PListB 
 
The Box example shown was generated with the following code: 
 

BoxStatement.par 
### 
const L 6 
const W 4 
const H 2.7 
 
Box 1 L W H TB Walls, floor and ceiling 
### 
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The Cylinder statement  
The Cylinder statement defines a cylinder shell with or without 
top and bottom. The statement may typically be used for 
modelling cylindrical room or columns. The Cylinder2 
statement, which creates a cylinder of the calotte type, will 
usually be preferable for modelling cylindrical ceilings.  
 
 
 
 
The syntax for Cylinder is: 
 

Cylinder <Number> <NumberOfSurfaces> <Radius> <RevAngle> <Height> <T/B/N> <optional name> 
 
<Number> 

A unique number from 1 to 2,147,483,647 for identification of the first point and surface in the 
Cylinder. Using the same number, but with negative sign defines the cylinder and its mirrored 
counterpart in the XZ-plane (Y = 0). A Cylinder will take up several point- and surface numbers, 
which must all be unique. 
 

<NumberOfSurfaces> 
For a full cylindrical room (with a revolution angle of 360°), around 16 to 24 surfaces are 
recommended. For columns, a number between 6 to 8 is recommended. 
 

<Radius> 
Radius of the cylinder must always be greater than zero. 
 

<RevAngle> 
RevAngle must be within the range +/-360° and different from zero. If RevAngle is 180°, a half cylinder 
is generated, and if it’s 360°, a full cylinder is generated. Positive revolution angles are defined 
counter-clockwise. 
 

<Height> 
If the height is less than zero, the orientation of the cylinder is inverted. If height is zero, one circular 
surface is generated. 
 

Insertion point: 
The insertion point of the cylinder is always the centre of the floor (bottom) surface. 
Connection points: 
The foot-points in Cylinder are stored in PListA 
The top-points in Cylinder are stored in PListB 
 
The example shown was generated with the following code: 
 

CylinderStatement.Par 
### 
const N 16 
const R 15 
const H 10 
 
Cylinder 1000 N R 270 H TB Cylindrical room 
### 

 
Hint! The cylinder can be made elliptical, using the MScale statement. 
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The Cylinder2 statement 
 
Cylinder2 is a cylinder shell of the calotte type. Rather than specifying the radius and 
revolution angle, Cylinder2 is specified in terms of the width and height. Cylinder2 is 
typically used for cylindrical /curved ceilings. 
 
The syntax for Cylinder2 is: 
 

Cylinder2 <Number> <NumberOfSurfaces> <Width> <Height> <Length> <T/B/N> 
<optional name> 

 
<Width> 

Width is oriented in the X direction on the Figure. 
 

<Height> 
Height of the cylinder shell is oriented in the Y direction on the Figure and may be positive (concave 
shell) as well as negative (convex shell). Height must be different from zero and less or equal to 
½*Width. 
 

<Length> 
Length of the cylinder shell is oriented in the Z direction the Figure. If Length is negative the 
orientation is inverted. 
 

Insertion point: 
The insertion point of Cylinder2 is always foot point of the calotte floor (bottom) surface. 
 

Connection points: 
The foot-points in Cylinder2 are stored in PListA 
The top-points in Cylinder2 are stored in PListB 
 
The example shown was generated with the following code: 
 

### 
Const N 10 
Const W 5 
Const H 1 
Const L 10 
 
Cylinder2 1 N W H L TB Cylinder calotte 
### 

 
Hint! The cylinder can be made elliptical, using the MScale statement. 
 
 
 

The Cone statement 
 
The Cone statement models a cone. Typical use of the Cone 
statement is for modelling half cone or cone shaped ceilings. 
 
 
The syntax for Cone is: 

Cone <Number> <NumberOfSurfaces> <Radius> <RevAngle> <Height> <optional name> 
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<Number> 
A unique number from 1 to 2,147,483,647 for identification of the first point and surface in the Cone. 
Using the same number, but with negative sign defines the surface and its mirrored counterpart in 
the XZ-plane (Y = 0). A Cone will take up several point- and surface numbers, which must all be 
unique. 

 
<Radius>  

Radius of the Cone must always be greater than zero. 
 
<RevAngle> 

RevAngle must be within the range +/-360° and different from zero. If RevAngle is 180°, a half-cone is 
generated, and if it’s 360°, a full cone is generated. Positive revolution angles are defined counter-
clockwise. 
 

<Height> 
The height must be different from zero. If the height is less than zero, the orientation of the cone is 
inverted. Height is oriented in the Z-direction on the Figure. 
 
The Cone example shown was generated with the following code: 
 

### 
const N 16 
const R 15 
const H 10 
 
Cone 1 N R 270 H Cone shaped ceiling 
### 

 
Hint! The cone can be made elliptical, using the MScale statement. 
 
 

The Dome statement 
The Dome statement generates a full dome (half hemisphere) 
covering the full 90° vertical angle. In most cases the Dome2 
statement is probably better suited. 
 
 
The syntax for Dome is: 
 

Dome <Number> <NumberOfSurfaces> <Radius> <RevAngle> 
<optional name> 
 
<Number> 

A unique number from 1 to 2,147,483,647 for identification of the first point and surface in the Dome. 
Using the same number, but with negative sign defines the dome and its mirrored counterpart in 
the XZ-plane (Y = 0). A Dome will take up several point and surface numbers, which must all be 
unique. 
 

<Radius>  
Radius of the Dome must always be greater than zero. 
 

<RevAngle> 
RevAngle must be within the range +/-360° and different from zero. If RevAngle is 180°, a half Dome is 
generated, and if it’s 360°, a full Dome is generated. Positive revolution angles are defined counter-
clockwise. 
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Connection points: 

The right-side vertical points in Dome are stored in PListA 
The left-side vertical points in Dome are stored in PListB 
In the special case where the revolution angle is 180°, all points are stored in PlistA and the number 
of vertical subdivisions is stored in ONVert.  
 
The example shown was generated with the following code: 
 

### 
const N 16 
const R 15 
 
Dome 1 N R 270 This is a dome 
### 

 
Hint! The dome can be made elliptical, using the MScale statement. 
 

The Dome2 statement 
The Dome2 statement is a Dome shell of the calotte type, 
where the vertical revolution angle is not necessarily 90°. 
Rather than specifying the dome by a revolution angle, it is 
specified by the width and height. Dome2 may typically be used 
for modelling dome shaped ceilings. 
 
 
The syntax for Dome2 is: 
 

Dome2 <Number> <NumberOfSurfaces> <Width> <Height> <RevAngle> <optional name> 
 

<Number> 
A unique number from 1 to 2,147,483,647 for identification of the first point and surface in the 
dome. Using the same number, but with negative sign defines the surface and its mirrored 
counterpart in the XZ-pane (Y = 0). A dome will take up several point- and surface numbers, which 
must all be unique. 
 

<NumberOfSurface> 
Specifies the number of surfaces in one horizontal ring of the dome, around 16 to 24 surfaces per 
ring is suggested. ODEON will automatically calculate the number of subdivisions in the vertical 
level. If the revolution angle is 180° the number is stored in the ONVert variable, which would have 
been 9 in the example above. The ONVert variable may help when connecting a Dome2 to a Cylinder2 
in order to specify the correct number of surfaces in the cylinder. 
 

<Width> 
Width at the beginning of the dome. The width must always be greater than zero. 

 
 

<Height> 
The Height must be different from zero. If the height is less than zero, the orientation of the dome is 
inverted. Height must be different from zero and less or equal to ½*Width. 
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<RevAngle> 
RevAngle must be within the range +/-360° and different from zero. If RevAngle is 180°, a half-dome 
is generated, and if it’s 360°, a full dome is generated. Positive revolution angles are defined 
counter-clockwise. 
 

Connection points: 
The right-side vertical points in Dome2 are stored in PlistA 
The left-side vertical points in Dome2 are stored in PlistB 
 
In the special case where the revolution angle is 180°, all points are stored in PlistA and the number 
of vertical subdivisions is stored in ONVert.  
 
The example shown was generated with the following code: 
 

### 
Const N 16 
Const W 10 
Const H 3 
Const L 10 
 
Dome2 1 N W H 270 Dome calotte 
### 
 

Hint! The cylinder can be made elliptical, using the MScale statement. 
 
 
 
 
 
 

DebugIsOn and Debug 
The debug options are useful when creating large or complicated geometries in the ODEON .par 
format. Using these facilities can speed up geometry loading when loaded for preview only and 
allow debugging of parameter values in geometry files. DebugIsOn is a Boolean, which can be set to 
TRUE or FALSE, the syntax is: 
 

DebugIsOn <Boolean> 
 
Typically, you will insert the DebugIsOn flag in the beginning of the geometry file in order to 
investigate parameter values, when loading geometry. When this Boolean is set to TRUE: 
 

• ODEON will not prepare the geometry for calculation - as result the loading of rooms is 
sped up. 

• ODEON will enable debugging of parameters with the Debug statement. 
The syntax for Debug is: 
 

Debug <debug string> 
 

In effect, anything can be put after the Debug keyword, i.e. you may put a complete copy of a line 
in the .par file there. The contents following the Debug keyword is evaluated or if it can’t be 
evaluated, it is echo'ed directly to the debug window in ODEON when loading the geometry and 
it has no effect on the geometry. If DebugIsOn is set to FALSE, then debug lines are ignored. Contents 
in the Debug strings, which cannot be evaluated, are displayed in quotes ("). 
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Example: When loading the following .par file into ODEON: 
 

### 
DebugIsOn TRUE ;debug option turned on - if DebugIsOn is set to false then Debug lines are ignored 
const L 6 
Debug L ;debug a single constant 
const W 4 
Debug const W 4 
const H 2.7 
Debug L W H ; Debug values of L, W and H 
 
Box 1 L W H TB Walls, floor and ceiling 
Debug Box 1 L W H TB Walls, floor and ceiling ; Debug a complete line 
### 
 

ODEON will create this Debug window as a response: 
 

 
 
 

Creating a new .Par file - time saving hints 
The golden rule when creating a .Par file to model a room is to think carefully before you start 
typing. For very simple rooms, it is not too difficult to keep track of things, but for realistically 
complex rooms a systematic approach is desirable. You will typically have a set of drawings, which 
have to be used as the basis for the ODEON model. It pays to spend quite a long time working out 
how the room can be simplified to a manageable number of sensibly shaped plane surfaces, 
sketching over the drawings. These ideas will have to be modified when you start to work out the 
actual coordinates, to ensure that the surfaces really are plane. Here are some ideas that may help 
you to create correct surface files faster:  
 

• Exploit symmetry: If the room has an axis of symmetry, place the coordinate axis on it. 
Then use the ‘sign'- convention for symmetric /semi symmetric modelling. 

• If there are vertical walls and /or features, which repeat vertically (e.g. identical balconies), 
use the CountPt, CountSurf, RevSurf statements or indeed For..End constructs. 

• Build the room gradually, testing the .Par file at each stage of growth by loading it into 
ODEON and have a look at the result. 

• Use hybrid statements such as Box, Cylinder etc. 
 
Where it is difficult to get surfaces to meet properly without either warping or using lots of small 
surfaces to fill the gaps, allow the surfaces to cut through each other a little. This will usually ensure 
a watertight result, which is more important, and has only minor drawbacks. These are (i) the 
apparent surface area will be a little too big, affecting reverberation times estimated using Quick 
Estimate Reverberation and the room volume estimated by Global Estimate, (ii) crossing surfaces 
can look odd and hinder clarity in the 3D displays. 
 
Do not try to include small geometrical details at the first attempt. If there are some large surfaces, 
which are basically plane but contain complex geometrical features (e.g. a coffered ceiling), model 
them at first as simple planes. Then once the room has been made watertight, make the necessary 
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alterations to the geometry file. The simplified version can also be used in the prediction exercises, 
to give some idea of the effect of the feature in question. 

Examples on parametric modeling 
This section will give some short examples on the modelling of rooms using the parametric 
modelling language of ODEON. The options in this modelling format are many, ranging from 
typing the model number by number, to dedicated programming. This section will try to give an 
idea on how to use the language and its keywords. In the default room directory created at the 
installation of ODEON you may find several other examples in .Par format. 
 
 

Four ways to model a box 
These examples show four ways to model a box-shaped room; using plain numbers, using 
constants, using constants plus symmetric modelling and using the Box statement along with the 
MTranslate statement. In each example the dimensions of the room are: (W, L, H) = (4, 6, 2.7). 
     
Below the box-shaped room is modelled using plain decimal numbers: 
 

Parametric sample BoxFromPureNumbers.par 
### 
Pt 1 0 2 0 
Pt 2 0 -2 0 
Pt 3 6 -2 0 
Pt 4 6 2 0 
:ceiling points 
Pt 11 0 2 2.7 
Pt 12 0 -2 2.7 
Pt 13 6 -2 2.7 
Pt 14 6 2 2.7 
Surf 1 floor 
 1 2 3 4 
 
Surf 2 ceiling 
 11 12 13 14 
Surf 3 end wall 
 1 2 12 11 
 
Surf 4 end wall 
 1 2 12 11   
  
Surf 5 side wall 
 1 4 14 11 
 
Surf 6 side wall 
 2 3 13 12 
### 

 
Below the box-shaped room is modelled using constants for the definition of W, L and H. Some of 
the advantages of using parameters in modelling rooms are that it makes it much easier to apply 
changes to the model (allowing reuse) and often it will also improve the clarity of a model data. 

 
Parametric sample BoxFromParameters.par 
The box measures are: 
Width = 4 metres  
Length = 6 metres  
Height = 2.7 metres 
### 
const  W 4   
const L 6   
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const H 2.7 
 
Pt 1 0 W/2 0 
Pt 2 0 -W/2 0 
Pt 3 L -W/2 0 
Pt 4 L W/2 0 
 
Pt 11 0 W/2 H 
Pt 12 0 -W/2 H 
Pt 13 L -W/2 H 
Pt 14 L W/2 H 
 
Surf 1 floor 
 1>4 
 
Surf 2 ceiling 
 11>14 
 
Surf 3 end wall 
 1 2 12 11 
 
Surf 4 end wall 
 1 2 12 11   
 
Surf 5 side wall 
 1 4 14 11 
 
Surf 6 side wall 
 2 3 13 12 
### 

 
Below the box-shaped room is modelled using parameters and symmetric modelling syntax (signs 
on point and surface numbers). The symmetric modelling syntax means less typing and less typing 
errors: 
 

Parametric sample BoxFromParametersUsingSymmetricModelling.par  
### 
const  W 4   
const L 6   
const H 2.7 
 
Pt 1 0 W/2 0 
Pt 2 L W/2 0 
 
Pt 11 0 W/2 H 
Pt 12 L W/2 H 
 
Surf 1 floor 
 1 2 -2 -1 
 
Surf 2 ceiling 
 11 12 -12 -11 
 
Surf 3 end wall 
 1 11 -11 -1 
 
Surf 4 end wall 
 2 12 Mirror    ;Mirror works just as well – defines point -12 and -2 
Surf -5 side wall 
 1 2 12 11 
### 
 

Below the box-shaped room is modelled using the Box statement, which is the easiest way to create 
this simple geometry. A MTranslate statement is used to insert the Box at the same position as in the 
three other examples: 
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Parametric sample BoxStatement.Par 
### 
const L 6 
const W 4 
const H 2.7 
 
MTranslate l/2 0 0 
 
Box 1 l w h tb Walls and floor 
### 

 
 

Modeling a cylinder 
This example shows two different ways to create a cylindrical room with a floor and a ceiling. In 
the first example the room is modelled using the Cylinder statement: 
 

Parametric Sample CylinderStatement.Par 
### 
const N 16 
const R 15 
const H 10 
 
Cylinder 1000 N R 360 H TB Cylindrical room 
### 

 
The Cylinder statement is of course the easiest way to model a cylinder, however sometimes more 
flexibility is needed (e.g. different radius in top and bottom). In the second example the corners in 
the room are modelled using the CountPt statement and the cylindrical surfaces are modelled using 
the RevSurf statement. Notice that the number of points created by the CountPt statement is one 
higher than the number of sections in the RevSurf statement. The bottom and top of the room is 
modelled using the Surf statement, notice that points used by these surfaces are referenced using 
the statement 100>100+N-1 rather than writing each of the sequential points. This is not only a faster 
way to write things, it also allows a rapid change to the number of sections in the cylinder by simply 
changing the N constant. 
 

Parametric sample, a cylinder RevSurfCylinder.Par 
### 
const N 16 
const R 15 
const H 10 
 
CountPt 100 N+1 R*CosD((PtCounter)*360/N)  R*SinD((PtCounter)*360/N) 0 
CountPt 200 N+1 R*CosD((PtCounter)*360/N)  R*SinD((PtCounter)*360/N) H 
  
RevSurf 300 100 200 Sections cylinder walls 
  
Surf 100 Circular floor 
 100>100+N-1 
  
Surf 2 Circular ceiling 
 200>200+N-1 
### 
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Modelling a box-shaped room with columns in two dimensions, using two level For..End 
constructs 
When modelling geometries that have more than one level of symmetry, it is advantageous to use 
For..End constructs. This example shows how to model columns in two dimensions in a room using 
a two-level For..End construct. 
Each column is created using 8 points and 4 surfaces, thus the numbering used by points and 
surfaces is incremented by 8 each time a column is created. This is done by incrementing the 
predefined variable NumbOffSet by eight for each column in order to make surface and point 
numbers unique. The different positions of the points used for each column are obtained, using 
MTranslate and MReset.  
 

Parametric sample BoxColumnRoom.Par 
### 
 const L 10 
 const W 4 
 const H 3 
 const NumColX 4 
 const NumColY 3 
 const ColumnW 0.3 
 
MTranslate l/2 0 0 
Box 1 l w h tb walls in the room 
:modelling the columns 
 
for ColYCnt 1 NumColY 
MReset 
  MTranslate L/(NumColX+1) w/2-ColYCnt*W/(NumColY+1) 0  
 for ColXCnt 1 NumColX 
    NumbOffSet NumbOffSet+8   ;comment: hint! setting NumbOffSet to Auto would do the same 
job 

 Box 1 ColumnW ColumnW h n columns in the room 
  MTranslate L/(NumColX+1) 0 0 
 end 
end 
### 

 
 

Using hybrid statements and coordinate manipulation 
The following example demonstrates an example on how to use the hybrid statements Cylinder2 
and Dome2 as well as the coordinate manipulations, which are essential for the use of the hybrid 
statements.  
 
This example is a rather complex one, so the main parts of the file is explained below: 
 
Line 3-7  Defining constants. 
Line 8-9  Inserting the cylindrical wall, which needs a rotation of 90° around the Z-axis. 
Line 11  The foot-points of the cylindrical wall, which are temporarily stored in PListA, are 

stored in PList0 for later use (definition of the floor).  
Line 12-13 Inserting the dome shaped ceiling. The Z-rotation has already been set to 90° 

when the wall was created. 
Line 14-18  Setting the coordinate manipulation for the ceiling and creating the ceiling. 
Line 19  Resetting the coordinate manipulation to work in absolute coordinates 
Line 20-23 Creating wall/floor points 
Line 24-25    Defining floor, using the ‘cylinder points’ stored in Plist0. 
Line 28-29 Defining side walls using symmetric modelling. 
Line 30-31 Defining back wall, using the ‘ceiling cylinder points’ which is still stored in 

PListB. 
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1. Dome2 and cylinder2 x 2 room.par 
2. ### 
3. Const H 5 
4. Const L 10 
5. Const W 15 
6. Const N 12  
7. Const HCurve 4 

 
8. MRotateZ 90 
9. Cylinder 1000 N W/2 180 H N  
10. //Stores PListA for later use with floor 
11. PList0 PListA 

 
12. MTranslate 0 0 H 
13. Dome2 2000 N W HCurve 180 Halfdome 

 
14. MReset 
15. MRotateZ 90 
16. MRotateY 90 
17. MTranslate 0 0 H 
18. Cylinder2 3000 ONVert W HCurve L n Cylindric ceiling 

 
19. MReset 
20. Pt 1 0 W/2 0 
21. Pt 2  L W/2 0 
22. Pt 3 0 W/2 H 
23. Pt 4  L W/2 H 

 
24. Surf 1 Floor 
25. 2 PList0 -2 

 
26. //when done using PList0, it’s a good habit to Reset it 
27. ResetPList0 

 
28. Surf -2 Side Walls 
29. 1 2 4 3 
30. Surf 3 BackWall 

2 PListB -2 
31. ### 

 
 

Defining surfaces with concave edges 
Most surfaces in the geometries used with ODEON will probably have convex edges (rectangles, 
cylindrical surfaces etc.), however in ODEON, it is possible to define surfaces with cavities, even 
surfaces with holes. Such surfaces are defined just like any other surface, by creating a list of corners 
where the listing is obtained by travelling around the surface's edge (in either direction). Below are 
two examples; one with a donut-shaped balcony floor and another with a cylindrical window 
opening in a ceiling. 
 
In the donut example two ‘rings of corners’ are 
created using the CountPt statement, notice that 
the point 100 is equal to point 112 and point 200 
is equal to point 212. The donut surface is 
created, simply by connecting the inner and 
outer ring of points into one surface. It doesn’t 
matter whether one of the rings are created clock 
or counter-clockwise. The surface is created from 
the following list of points: 
100,101,102,…,110,111,112,200,201,202,….,210,211,212. 
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DonutSurface.par 
### 
Const R1 10 
Const R2 15 
Const N 12 
CountPt  100 N+1  R1*CosD(360*PtCounter/N)  R1*SinD(360*PtCounter/N) 0 
CountPt 200 N+1    R2*CosD(360*PtCounter/N)  R2*SinD(360*PtCounter/N) 0 
 
Surf 100 Donut surface 
 100>100+N 200>200+N 
### 

 
The window example shows how a cylindrical window opening is created in ceiling surface. The 
interesting surface in this example is surface 1, the ceiling surface. The surface is created from the 
following list of points:1,100,101,102,103….,111,112,1,2,3,4 
 

CeilingWithWindowTube.par 
### 
Const R1 0.75 
Const R2 0.5 
Const N 12 
 
Pt 1 1 1 0 
Pt 2 1 -1 0 
Pt 3 -1 -1 0 
Pt 4 -1 1 0 
 
CountPt 100 N+1 R1*CosD(360*PtCounter/N) 
R1*SinD(360*PtCounter/N) 0 
CountPt 200 N+1 R2*CosD(360*PtCounter/N) 
R2*SinD(360*PtCounter/N) 2 
 
Surf 1 Ceiling 
 1 100>100+N 1>4  
 
RevSurf 2 100 200 N Window tube 
 
Surf 100 Window /glass 
 200>200+N-1 
 

###  
1

100
101

102

103

104

105
106107108

109

110

111

112

1

2

3

4

O

X

Y

Z



257 
 

 
In this section, mathematical expressions used in the .Par modelling format and in the Room 
acoustic parameter list are presented. Constants, variables, point numbers, surface numbers and 
coordinates may be defined using mathematical expressions. Where integer numbers are expected 
(Counter ranges in for…end loops, point, surface numbers, etc.), the results of mathematical 
expressions are automatically rounded to the nearest whole number.  

 

Appendix G: Mathematical 
Expressions 

Operation Syntax Example 
Addition + 2+5 = 7 
Subtraction - 3-1 = 2 
Multiplication * 2*3 = 6 
Division / 4/2 = 2 
Power Base^ Exponent 

or 
Power(Exponent,Base) 

2^3 = 8 
or 
Power(3,2) = 8 

Root Root(Index,Radicand) Root(3,8) = 2 
Round Round(X) Round(2.67676) = 3 
Truncation 

  

Trunc(X) 
or 
Int(X) 

Trunc(1.7) = 1 

  
Sine of an angle in radians Sin(X) Sin(0) = 0 
Cosine of an angle in radians Cos(radians) Cos(PI/4)= 0,707106781186547573 
Tangent of an angle in radians Tan(radians) Tan(PI/4) = 1 
Cotangent of an angle in radians Cotan(radians) Cotan(180) = 0 
Hyperbolic Sine of an angle in radians Sinh(radians) Sinh(0) = 0 
Hyperbolic Cosine of an angle in radians Cosh(radians) Cosh(0) = 1 
Sine of an angle in degrees SinD(radians) SinD(90) = 1 
Cosine of an angle in degrees CosD(degrees) CosD(0) = 1 
Tangent of an angle in degrees TanD(degrees) TanD(45) = 1 
Cotangent of an angle in degrees CotanD(degrees) CotanD(90) = 0 
Inverse Sine in radians ArcSin(Y) ArcSin(-Sqrt(2)/2)*180/PI = -45 
Inverse Cosine in radians ArcCos(X) ArcCos(Sqrt(2)/2)*180/PI = 45 
Inverse Tangent in radians ArcTan(Y) ArcTan(1)*180/PI= 45 
Inverse Tangent II in radians ArcTan2(X,Y) ArcTan2D(1,-1)*180/PI = - 45 
Inverse Sine in degrees ArcSinD(Y) ArcSin(-Sqrt(2)/2)*180/PI = -45 
Inverse Cosine in degrees ArcCosD(X) ArcCos(Sqrt(2)/2)*180/PI = 45 
Inverse Tangent in degrees ArcTanD(Y) ArcTan(1) = 45 
Inverse Tangent II in degrees ArcTan2D(X,Y) ArcTan2D(1,-1) = - 45 
Exponential Exp(X) Exp(1)= 2.71828182845904509 
Natural Logarithm Ln(X) Ln(2.718281828459045091) = 1 
Logarithm base 10 Log10(X) Log10(100) = 2 
Logarithm base 2 Log2(X) Log2(8) = 3 
Square Sqr(X) Sqr(2) = 4 
Square root Sqrt(X) Sqrt(2)= 1.41421356237309515 
Radius Radius(A,B) Radius(3,4) = 5 
Absolute value Abs(X) Abs(-2342) = 2342 
Sign Sign(X) Sign(-2) = -1; Sign(0) = 0; Sign(3) = 1 
Minimum of two numbers Min(X,Y) Min(23,12) = 12 
Maximum of two numbers Max(X,Y) Max(23,22) = 23 
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